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 About This Manual
 
In This Section...
Manual Requirements
Updates
 

Manual Requirements
The QC5000 Manual is designed to run with the following:

Operating System - Windows 98 or Windows NT v4.0 and higher
Browser Version - Internet Explorer v4.0 or higher
Resolution - 1024x768
Color Depth - 65K or higher
Audio - 16 Bit
Added Components - Support for VRML (Click HERE to install)

Updates
Click here to go to the Updates Page
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 Contact Us
Metronics is dedicated to providing you with complete technical support solutions. You can contact us using one of
the following methods:

In This Section:
Telephone
Fax
E-mail
Web-site
 

Metronics Customer Support (Telephone): Back To The Top

(603) 622-0212
Bedford, New Hampshire U.S.A.

Please have the following information ready:

Type of Unit
-QC1000, QC2000, QC3000, QC4000, QC5000
Serial Number
-Located in the back of the unit
Software Version
-QC1000 & QC2000 displayed on power-up
-QC3000 on the first screen
-QC4000 & QC5000 located under FILE/ABOUT
Options purchased with your Quadra-Chek
-For example: Edge Detector, CNC, VED
History of the problem
-Did the problem start after a power surge?
-Does the problem occur only when you perform certain functions?
-Can the problem be duplicated or is it intermittent?

Metronics Customer Support (Fax): Back To The Top

(603) 623-5623
Bedford, New Hampshire U.S.A.

Metronics Customer Support (E-Mail): Back To The Top

techsupport@metronics.com

Please have the following information ready:

Type of Unit

file:///D|/MANUAL/updates.htm
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-QC1000, QC2000, QC3000, QC4000, QC5000
Serial Number
-Located in the back of the unit
Software Version
-QC1000 & QC2000 displayed on power-up
-QC3000 on the first screen
-QC4000 & QC5000 located under FILE/ABOUT
Options purchased with your Quadra-Chek
-For example: Edge Detector, CNC, VED
Describe the history of the problem
-Did the problem start after a power surge?
-Does the problem occur only when you perform certain functions?
-Can the problem be duplicated or is it intermittent?
Please include
-Name
-Telephone Number
-Fax Number
-E-Mail Address
If it is an application question or a programming problem, please send, fax or e-mail the drawing or program
so that we may better understand your problem.

Metronics Customer Support (Web-site):

www.metronics.com

Back To The Top

 

http://www.metronics.com/
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 QC5000 Basics
 
In This Section...
Starting The QC5000
Setting The Machine Zero
Summary
Tips
 

Starting The QC5000 
Turn on the QC5000 computer. After logging in, the desktop appears.

The QC5000 icon

Notice the QC5000 icon on the desktop. Click twice on it with the left mouse button to start the QC5000. The Quadra-
Chek status box appears, and in the lower left corner it informs you that it is, "Loading software," and, "Configuring
System." In a moment, the QC5000 main screen appears. Notice the dialogue box in the middle prompting you to, "Set
Machine Zero." If the Set Machine Zero dialogue box is not displayed on-screen, the Set Machine Zero option may be
turned off on your computer. If this is the case, find out from your supervisor whether or not you need to set a machine
zero.

Warning: It is recommended that the machine zero be set every time you open the QC5000. The machine zero is used
by the QC5000 for internal functions (SLEC: Segmented Linear Error Correction). If you do not set a machine zero,
SLEC will not occur.

The QC5000 Image Map 
The QC5000 image map is designed to familiarize you with the layout and windows of the QC5000. Click HERE to go
there. Return to this section when you are finished.

Setting The Machine Zero 
There are many ways to set a machine zero (Hard stops, reference marks, etc.). How it is done on your machine
depends on how your machine was set up by your supervisor/OEM. The QC5000 will automatically prompt you for the
correct method, so don’t worry about deciding which to use. Setting the machine zero is very important, but it is also
very easy:

Note: Your supervisor will be able to tell you where the machine zero position is located.

Ask your supervisor if you are unsure where the machine zero position is, or if the QC5000 has already been zeroed
for the day.
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Summary: 
Many of the ideas in this section may already have been familiar to you, especially if you have worked in the
Microsoft Windows environment in the past. If anything seems strange, practice with it (activating toolbars, activating
windows, moving windows and toolbars, etc…). 

You should now be able to activate and deactivate the QC5000 main screen windows: DRO, Part View, Results,
Feature List (Program View will be covered later).
You should now be able to activate and deactivate the QC5000 toolbars: View, Datum, Measure, Probe,
Tolerance (Custom toolbars will be discussed later).
You should now be able to activate and deactivate the QC5000 View Rotator (which we will use later).

Tips: 
Use the three icon bar to minimize, maximize, and close windows.
To move windows around the screen, "click and drag" on the window’s title bar (name bar).
To move toolbars around the screen, "click and drag" on the toolbar’s title bar (name bar).
Remember, it is possible to "bury" a window behind a larger window (the DRO can get lost behind the Part
View, for example). If this happens, move the windows around until you find the "buried" window.
If anything is missing from the screen, don’t panic. All windows and toolbars can be activated from either the
Windows selection on the main menu, or the View > toolbars selection on the main menu.
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 System Setup
 
In This Section...
About this section...
Hardware Setup
Encoder Setup
Supervisor Setup
 

About this section... 
This section contains information that is used during the initial setup of the QC5000. Most of the options and areas
covered in this section are set by your distributor. They need to be set only once: resolution and scales do not
spontaneously change, and so these settings do not change. If you move the QC5000 to another CMM, or if you move
the entire system (QC5000 with CMM), then you may need to correct certain settings that can be found in this manual.

This manual contains a troubleshooting guide for each section. Use this guide to troubleshoot the QC5000 . . .
otherwise you may change settings that are correct, further complicating any problems that you have. Do not change
the settings in the Encoder Setup program or the Supervisor Setup options screen experimentally . . . most of these
settings will not need to be changed after the first, correct, installation of the QC5000.

Remember, the QC5000 is only reading the input that it receives from your CMM; it does not cause scale errors, it
merely detects them. It is essential that your CMM has undergone a thorough calibration and mechanical check before
the QC5000 is installed.

Hardware Setup 
Before you connect the QC5000 to your CMM, the CMM should be thoroughly inspected; all of the mechanics should
be checked, and the CMM should be calibrated. If your CMM is mechanically flawed, or improperly calibrated,
then it will perform measurement inaccurately. The QC5000 is capable of performing SLEC (segmented linear error
compensation), but you must be aware of the errors inherent in your CMM to take advantage of this option.

Once you have inspected and calibrated your CMM, you can begin to install the QC5000 hardware. Set up the PC as
you normally would: connect the mouse, keyboard, and monitor to the CPU. Additionally, plug the monitor and the
CPU into a surge-protected electrical outlet.

Now attach the QC5000 axis cable to its connector on the rear panel of the CPU (note the rear panel diagram for an
explicit view of the rear panel and description of each connector). Once the QC5000 axis cable is connected to the
CPU you are ready to attach the existing axis cables to the QC5000 cable. The QC5000 cable is split three ways, and
each split is labeled (X, Y, Z); attach the pre-existing cables to the appropriate QC5000 cable.

If you are using a touch-probe, attach the touch probe connector to the probe input connector on the rear of the CPU
(note the rear panel diagram). Once you have done this, the QC5000 hardware is in place.

QC5000 Rear Panel

file:///D|/MANUAL/cnc.htm
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You may have a "tower" style computer case. If so, the rear panel configuration will be the same. Com 1 will be at the
top, and the axis board will be at the bottom. If your system is equipped with a foot-switch, then the three-way axis
cable will have a fourth tendril labeled "foot switch." Plug the main cable connector of the axes' cable into the CPU
axes connector. Plug each of the tendrils into the existing cables (the QC5000 cables are labeled X, Y, and Z; you must
determine the correct existing X, Y, and Z cables).

Encoder Setup 

Note: Before QC5000 installation occurs, the CMM should be calibrated and inspected for mechanical flaws.
Note: The Encoder Setup program is included only for analog encoders. If you are using TTL encoders, this
procedure is unnecessary. Do not perform it.

The QC5000 software package includes a separate Encoder Setup program. Do not use the Encoder Setup program
when the QC5000 is running. If the QC5000 is running, shut it down. You can not correctly set up the encoders while
the QC5000 is running. To start the Encoder Setup program simply double-click on the encoder setup icon that appears
on the Windows desktop:

How to set up encoders using the Encoder Setup program:
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1. Make sure the QC5000 is shut down. (The QC5000 can not merely be minimized, it must be entirely closed
down.)

2. Start the encoder setup program by double-clicking the Encoder Setup icon located on the desktop. The encoder
setup dialog box appears (grayed out), and the "Make sure the QC5000 is not running" prompt appears.

3. If the QC5000 is closed, select OK. If the QC5000 is running, select Cancel, and repeat steps 1 and 2. Once you
select OK, a blue progress bar appears in the lower-right corner of the encoder setup window (if this bar does
not appear, or gets stuck for more than 30 seconds, consult the troubleshooting section that follows this
procedure.)

4. Select the axis you will calibrate. Do this using the radio buttons in the lower left corner of the encoder setup
window. A dot appears beside the selected axis.

5. Select the Calibrate button from the lower right corner of the encoder setup dialog box. A message box appears
asking, "Is the (X, Y, Z) Axis Encoder a current output encoder?" Heidenhain encoders, Acu-rite analog
encoders, and RSF analog encoders are current output encoders; if you are calibrating one of these encoders
select Yes. If you have another type of encoder attached to the selected axis select No. (Note: If you have TTL
encoders you do not need to use the encoder setup program, just select TTL under the QC5000 OPTIONS
menu). You are informed that "Calibration is about to begin."

6. Select OK to continue with calibration. Select Cancel to abort the calibration. Once you select OK you have two
seconds to begin the next step.

7. Move the encoder back and forth along the selected axis. Maintain approximately the same speed during
calibration. Do not stop moving before calibration is complete. Calibration will take about 30 seconds
(depending on the CPU speed of your computer). Note that the calibrate button has changed to STOP; pressing
this will abort the calibration.

8. Once calibration is complete a counter window appears displaying the currently selected axis' scale count value,
and the number of scale errors since calibration. It is normal for one or more scale errors to be reported
immediately after calibration. If scale errors count persistently, select Recalibrate (and repeat steps five through
ten). If the encoder counts up and down, and there are few errors, select OK.

9. Visually verify that the encoder is calibrated properly. In the wave display, the encoder waveforms should be
sinusoidal waves which are centered around the center horizontal line of the display. They should extend in
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amplitude to the top and bottom gray horizontal lines of the display. If either waveform does not fit the above
criteria you will need to repeat the calibration.

10. Use the phase mode to determine if the encoder's two waveforms are adjusted to each other. A perfectly adjusted
encoder will result in a circle which fits perfectly in the box shown on the encoder setup window (Access the
phase mode by clicking in the phase radio button). If the waveforms looked good in the wave display mode, but
you can not get the phase mode circle to match up with the square, then the encoder's reader head may need to
be aligned.

11. Use the Freeze button to freeze the display and examine "frozen" encoder signals. Press display to reactivate the
display.

12. Calibrate each axis before proceeding.
13. Select OK at the bottom right corner of the encoder setup dialog box to save the calibration and exit encoder

setup. Select Cancel to exit encoder setup without saving the calibration.

Troubleshooting The Encoder Setup Program:

Topics:

The Encoder Setup Program does not work properly.
You get one or two scale errors after calibrating an axis.
You get numerous after calibrating an axis.
On a given axis, the Wave (amplitude) calibrates, but the Phase won't.
TTL encoders won't calibrate properly.
Persistence defined...
Encoder Program initializations errors.
Missing Encoder Setup icon.

The Encoder Setup Program does not work properly. - Back To Topics

The Encoder Setup program is onscreen, but it is acting crazy. You have not been able to do any calibrating because
you see continual scale errors, beeping, and/or strange wave output on the screen: If this is the case, then either the
QC5000 or a second copy of the Encoder Setup program is running while you are trying to perform Encoder Setup.
Close all programs (do not confuse "closed" with "minimized"--the only items on the bar at the bottom of the screen
should be Start, and a clock / date item). If there is a QC5000 item on that bar, then the QC5000 is running. If there is
an Encoder setup item on that bar, then it is running. Close everything. Now double click the Encoder Setup icon and
try again.

You get one or two scale errors after calibrating an axis. - Back To Topics

This is normal. You may see one or two scale errors immediately after calibration; you may even see three or four; you
may see none. As long as these errors are not counting uncontrollably you should be alright. If you see more than four
errors try re-calibrating. Remember: calibration requires a smooth, uniform motion; you cannot stop when you reach
the scale limits (begin moving in the opposite direction without pause), and you cannot alter your speed.

You get numerous after calibrating an axis. - Back To Topics

You get a large number of errors. The errors scroll upward, counting fast and continuously: Your first action should be
to try calibrating again, and hope it works. Remember to calibrate with a smooth, uninterrupted, uniform motion.
When you reach the limit of axis motion, begin moving in the opposite direction without pause. If the re-calibration
does not work, you will have to do some connecting and disconnecting of cables. This is the recommended method:

1. Attempt to calibrate all axes. Determine which axes are problematic. If no axis will calibrate be sure that no
other programs are running, and try again. If no axis will calibrate properly still, you will need to contact a
technical support representative (the person from whom you purchased the QC5000).
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2. Disconnect the working axes. If only one axis calibrated correctly, disconnect it. If two axes calibrated correctly,
disconnect both. Only axes that could not be calibrated should remain connected.

3. Now disconnect an axis cable that would not calibrate, and connect it to an axis that would. You are swapping
cables here; if the X axis calibrated and the Y axis could not be calibrated, then plug the Y axis cable (CMM
side) into the QC5000 X axis connector.

4. Now attempt calibration on previously working axis (the axis that corresponds to the QC5000 input cable). If you
have connected the CMM "Y" to the QC5000 "X," attempt to calibrate the "X" axis.

5. If the calibration fails, then the error followed the CMM cable, and something is wrong on that side of the
operation. You may want to contact a calibration service, and have the CMM and encoders examined.

6. If the calibration succeeds, then the error stayed with the QC5000 "Y" connector, and you should contact your
distributor for repair information.

On a given axis, the Wave (amplitude) calibrates, but the Phase won't. - Back To Topics

You perform the encoder setup. You have minimal (or zero) scale errors. The scale error count does not increase if you
move the axis, but you are unhappy with the shape of the Phase display: If the Phase is off to a significant degree, you
will get scale errors . . . if you do not get scale errors then the phase is within an acceptable range. You can attempt to
recalibrate (by running the Encoder Setup program again) . . . maybe you'll get a nicer result, but if you are not getting
scale errors after calibration relax . . . life is good.

TTL encoders won't calibrate properly. - Back To Topics

TTL encoders do not require the use of the Encoder Setup program. Calmly exit the program, open the QC5000, and
set the "Encoders" option for TTL.

Persistence defined... - Back To Topics

Persistence is a "display only" setting (yes, you can set it, click in the field to change the setting) that indicates the
number of dots that compose the Phase circle at any one time. As the display updates the circle, dots are added and
dots disappear . . . persistence designates how many dots appear at once. This setting does not affect calibration.

Encoder Program initializations errors. - Back To Topics

(e.g., the status bar gets stuck, or, you get a hardware or software message)

Try a full power down. Shut everything off, and then turn it back on again. Now try running the Encoder setup
program again. If the problem persists, and calibration is impossible, you may need a hardware or software upgrade.
Please contact the person that sold you your QC5000.

Missing Encoder Setup icon. - Back To Topics

The desktop icon is merely a shortcut. Look in the QC5000 directory for the encsetup.exe program file. You can
double click this to launch the Encoder Setup program, or you can drag and drop a shortcut to the desktop. If you
cannot locate the encsetup.exe program, try using the Windows Find option: select "files or folders," make sure that
you are searching the entire C: drive, and then enter encsetup.exe into the find field. It should show up. TIP: after you
successfully complete the encoder setup, drag the desktop icon to the recycling bin . . . you are not deleting the
program, only the 2KB shortcut . . . this will prevent curious users from experimenting with the QC5000 calibration.

Encoder Setup Program Tips:

1. Remove the encoder setup icon from the desktop after calibration has been successfully completed. This will
prevent curious users from experimenting with, and possibly destroying, the encoders setup. If the setup program
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is performed incorrectly, you will not measure accurately.
To remove the encoder setup icon from the desktop . . .

This is a simple procedure. Click on the encoder setup icon with the mouse, and drag the icon to the recycle bin
(you are not deleting the program, only the shortcut to the program . . . so you will still be able to "recalibrate"
the encoders if necessary (by finding the encsetup.exe program in the directory where it resides).

2. The Encoder Setup program is not an oscilloscope. It cannot be used as an oscilloscope. Don't try to read, infer,
or imagine any type of oscilloscope reading from this display.

3. If you are using TTL encoders, skip the whole encoder setup program . . . it is irrelevant to your system.

Troubleshooting QC5000 Encoder Setup

Topics:

The QC5000 counts double, or half, or wrong...
The QC5000 DRO contains too many, or too few, zeroes.
I entered a brand name encoder in Encoder type, why won't it work?
My axis count is reversed. Up is down and down is up.

The QC5000 counts double, or half, or wrong... - Back To Topics

If the QC5000 is counting double, or half, of what it should then your resolution is set incorrectly. First, determine the
resolution of your scales . . . this is information that should be on hand. If you do not know your scale's resolution, then
this process will be trial and error.

1. Under the Encoders tab: make sure that the mm boxes are checked. Even if you will view your
measurements in inches the resolution must be set in millimeters. The QC5000 will do the conversion
automatically.

2. Set the encoder resolution in millimeters (one micron = .001). Be sure to set all three scales in mm.
3. While you’re here, make sure the Encoder Type is selected correctly. Either X, Y, Z should all read TTL

Encoder; OR, X, Y, Z should read Custom 1, Custom 2, and Custom 3. As long as this is the case, leave
those settings alone.

4. Click the Display tab. Under Display Resolutions: metric should be set to the same value that you entered
for the encoders; and inch should be set for the appropriate equivalent (i.e. if you have a one micron scale
set the display resolution to .0001 inches).

5. Measure a gage block. If your result is half the standard, then go back into the Encoder tab and double
the resolution (everywhere that it appears). You should be aware that there are a few non-standard
resolutions floating around out there.

The QC5000 DRO contains too many, or too few, zeroes. - Back To Topics

You designate the resolution of the QC5000 DRO (digital read out). The Display tab allows you to set the display
resolution for both inches and millimeters. If you set an inch display resolution of .002, the DRO will count in
increments of .002 when in "inch" mode. In most cases, the display resolution is set the same as the encoder
resolution in terms of mm. If this sounds confusing, just think of it like this: if you decrease the display
resolution, you are chopping zeroes from the end of the readout.

I entered a brand name encoder in Encoder type, why won't it work? - Back To Topics

The only valid selections (and by valid we mean selections that will work) are TTL, and Custom 1, 2, and 3. If
you select any other entry in this list box, then you have failed to follow instructions. Click on the arrow to drop
the list box, and select an appropriate entry. If you are using TTL encoders, X, Y, and Z should all say TTL. If
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you are using analog encoders: X is Custom 1, Y is Custom 2, and Z is custom 3.

My axis count is reversed. Up is down and down is up. - Back To Topics

Easy problem to fix. Go into the Encoders tab. Find the axis that is counting backwards, and check its Reverse
box. Do not check the Reverse box for axes that are counting correctly.

Supervisor Setup 
The QC5000 V2 General Options dialog box (available from the "Tools" drop menu) tab box contains
supervisory settings. To make changes in the tab box, you must know the supervisor password. Once you have
entered the password, everything in the Options tab box can be altered. For more information on Supervisor
settings and the Options dialog box, click here.

file:///D|/MANUAL/options.htm
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 QC5000 Main Menu
QC5000 main menu bar Back to the QC5000 Image Map

Select a menu title (File, Edit, etc.) in the image below to view its corresponding menu.

 The QC5000 main menu bar, by default, contains the File, Edit, View, Measure, Datum, Probe, Tools, Windows,
and Help drop menus. If your system is configured with added options (VED for example), then the main menu may
contain additional menus.

The primary functions of the default menus are as follows:

Back to the QC5000 Main Menu Bar

File — Allows you to perform basic file operations, such as:
Create New... Parts or Runs.
Open..., Save, or Save As... Part files.
Import... or Export... DXF, TAP, or IGS files.
Print... data to an external printer.
Output... data to an external application.
Exit the QC5000.

Back to the QC5000 Main Menu Bar

Edit — Allows you to perform standard editing options such as:
Cut, Copy, Paste, Paste Special..., and Delete selected items.

file:///D|/MANUAL/qc5kmapx.htm
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Select All or Select None of the items in the currently selected window.
Find... a specific value within the current window.
Change a features name.
Display Features Properties... for the currently selected feature.

Back to the QC5000 Main Menu Bar

View — Allows you to change the way that items appear in either the Part View window or the Feature Stamp
window. Available options include:

Zoom All selected items within either a selected Part View pane or the Feature Stamp window.
Select a rectangular Zoom Window within either a selected Part View pane or the Feature Stamp
window.
Perform a Zoom Special... function, such as Zoom In, Zoom Out, or Zoom Selected.
Laterally Pan within either a selected Part View pane or the Feature Stamp window.
Switch to an absolute Preset View (Top, Bottom, Right, Left, etc.).
Easily recall a pre-established viewpoint with the Set Viewpoint... option.
Switch the current view to the angle as seen from the probe with the View From Probe option.
Activate the View Rotator window.
Toggle the option to display the current position indicator with the Show Position Indicator option.
Edit Layer Control... options.
Activate, deactivate, or edit Toolbars....
Change Units between inches and millimeters or between Cartesian, Polar, or Spherical.
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Back to the QC5000 Main Menu Bar

Measure — Allows you to create features and establish measurement variables, such as:
Measure Magic... will create a feature and assign it a geometry (sphere, plane, etc.) based on the
location and orientation of incoming probe hits.
Create standard 2D (two dimensional) geometries by selecting the applicable type from the Measure
drop menu. These include Point..., Line..., Arc..., Circle..., Slot..., and Blob.... The QC5000 will then
open the applicable dialog and wait for the necessary data to come in from the probe.
Create features based on the Distance... or Angle... of other previously created features .
Create standard 3D (three dimensional) geometries by selecting the applicable type from the Measure
drop menu. These include from Plane..., Cylinder..., Sphere..., and Cone.... The QC5000 will then
open the applicable dialog and wait for the necessary data to come in from the probe.
Magnetic Plane... allows you to create a plane that will attract nearby points to this plane.
The Other menu includes measurement options for Part View and Results.

Back to the QC5000 Main Menu Bar

Datum — Allows you to conduct the following datum options:
Primary... allows you to create a Primary Plane, Primary Cylinder, or Primary Cone.
Secondary... allows you to create a Secondary Alignment.
Zero... allows you to establish a Machine Zero.
Projection allows you to establish the datum projection as either Auto, Off, XY, YZ, or ZX.
Magnetic Planes allows you to turn Magnetic Planes Off or On.
Rotate... displays the Rotate Coordinate System dialog which allows you to input a rotation value for
either the X, Y, or Z axis.
Reference Frame allows you to Save the current reference frame, switch to World Coordinates, or
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switch to a temporary (Temp) reference frame.

Back to the QC5000 Main Menu Bar

Probe — allows you to establish the way your probes will interact with the QC5000
Contact Probes
Probe Compensation
VED Probes
Laser Probes
Teach...
Probe Library...
Magnifications
Auto Enter
Probe Path Data
Filar Probes

Back to the QC5000 Main Menu Bar

Tools — 
Tolerance
Focus...
Filter...
Goto
Joystick
Motors Off
Capture Image...
Programming



QC5000 Main Menu

file:///D|/MANUAL/QC5KMAP1.HTM[6/28/2019 8:21:09 AM]

Customize
Options
Language

Back to the QC5000 Main Menu Bar

Windows — 
DRO
Part View
Results
New Template...
Open Template...
Save Templates...

Back to the QC5000 Main Menu Bar

Help — 
QC5000 Help Topics...
What's New?
Backup/Restore...
About QC5000...
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 QC5000 Window Components
 
In This Section...
QC5000 Title Bar Icons
QC5000 Status Bar
The DRO (Digital Read Out) window
The Results window
The Feature List window
The Feature Stamp window
The View Rotator

QC5000 Title Bar Icons Back to the QC5000 Image Map

MINIMIZE, MAXIMIZE, and CLOSE (left to right)

QC5000 Status Bar Back to the QC5000 Image Map

At the bottom of the QC5000 main screen is the status bar. The status bar can include information such as:

Date
Type of coordinates (Polar/Cartesian)
Selected units of measurement (in./mm)
Active Layer
Active probe tip
Projection Plane
Active Reference Frame
Angle Display Mode
SLEC Status
Recording or Editing Mode

The status bar can also be used to toggle between settings. Some of these terms may be unfamiliar to you right now .
. . don’t worry, we’ll talk about them later.

The DRO (Digital Read Out) window Back to the QC5000 Image Map

This window continuously updates the X, Y, and Z axis coordinates. This window can also be used to zero the

file:///D|/MANUAL/qc5kmap1.htm
file:///D|/MANUAL/index.htm
file:///D|/MANUAL/qc5kmap3.htm
file:///D|/MANUAL/qc5kmapx.htm
file:///D|/MANUAL/qc5kmapx.htm
file:///D|/MANUAL/qc5kmapx.htm


QC5000 Window Components

file:///D|/MANUAL/QC5KMAP2.HTM[6/28/2019 8:21:11 AM]

readout at the present location (just click on the X, Y, or Z button).

The Results window Back to the QC5000 Image Map

This window contains contains the following:

Feature specifications — discussed HERE.
Lock/Unlock Feature — discussed HERE.
Feature type diagram / Feature Stamp — A graphic example of the features geometric category. This small
diagram, when clicked on, launches the Feature Stamp window (discussed later in this section or click HERE
to go there).

Feature Specifications

This window displays information, as it relates, to the currently selected feature. This type of information displayed
depends on the individual feature. Information from a point feature contains basic information (such as X, Y, and Z
coordinates, et. al.). The data reported for a sphere feature contains coordinates, radius diameter, and other applicable
values.

A very useful capability of the Results window is the ability to drag and drop one or more feature specifications
onto a Part View window thus creating a special report view from that features selected data. This ability is
discussed in full in the Output section later in this manual, or click HERE to go there. 

Locked/Unlocked Features

A "locked" feature is always displayed in relation to the reference frame that it was measured in. An "unlocked
feature" is always displayed in relation to the current reference frame.

If you are measuring a part that has more than one datum, you can "unlock" any of the 0,0,0 points to view their
coordinates in relation to the current reference frame.

 To unlock a feature click the "lock icon" located in the upper right corner of the Results window.

file:///D|/MANUAL/qc5kmapx.htm
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Locked, this feature is shown in relation to the reference frame it was measured in . . . Unlocked, this feature is
shown in relation to the current reference frame (for which it is the datum). 

The Feature List window Back to the QC5000 Image Map

Essentially, this window contains a list of a part’s features (lines, planes, circles, etc…). This window is explained in
greater detail in the Feature List section of this manual. Click HERE to go there..

The Feature Stamp window Back to the QC5000 Image Map

 The feature stamp is a three dimensional representation of one or more features from your part. The feature stamp
displays all of the probed and constructed features that you select from the feature list or the part view. The feature
stamp also displays the points that were used to calculate each feature.

The best introduction to the feature stamp is to see it onscreen. The following two examples will show you how to
create a feature stamp for either one or multiple parts.

Example #1 - Display one (1) feature in the Feature Stamp window.
Example #2 - Display two or more features in the Feature Stamp window.

Feature Stamp - Example #1 - Single Feature

file:///D|/MANUAL/qc5kmapx.htm
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Select one feature from the Feature List. In this example, we selected a cone from a part with multiple features. To
select this cone, we can either select it from the Feature List by clicking on it with the mouse...

Feature List window with a cone feature selected

...or by selecting the desired feature from the Part View window. To select a feature, locate it in one of the view
panes, then click on it. When selected, the feature turn blue in all applicable panes to indicate that it has been
selected.

Part View window with a cone feature selected

The Results window will display the information relating to the feature as well as a small diagram of the feature in
the upper-left corner.

Results windows with the selected features data
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 Click on the small diagram in the upper left portion of the Results window to display the Feature Stamp window.

Note: The feature stamp can be rotated and viewed just like the part view panes; with pre-selected views or the
view rotator.

Feature Stamp - Example #2 - Multiple Features

In this example, we will select four features (a circle, a cone, and two cylinders) from a part with multiple features.
If you are working from the Feature List, hold down the Control (CTRL) key while selecting features from the
Feature List. 

Multiple selected features as they appear in the Feature List
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Or, if you are working from the Part View window, hold down the Control (CTRL) key while selecting features
from the Part View window.  To select multiple features, locate the features in a view pane. Hold down the Control
(CTRL) key while selecting them with the mouse. All of the selected features will appear as blue outlines to indicate
that they have been selected.

4 pane Part View with multiple features selected

The Results window will display the information relating to each of the features. Only one feature will be displayed
at a time. To display the result information for the other selected features, use the up and down arrows on the scroll
bar along the right side of the window.

The Results window with four features selected (Note the number 4 in the title bar).
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  Click on the small diagram in the upper left portion of the Results window to display the Feature Stamp window.

The Feature Stamp window with four features selected

Note: The feature stamp can be rotated and viewed just like the part view panes; with pre-selected views or the
view rotator.

The Part View window Back to the QC5000 Image Map

file:///D|/MANUAL/qc5kmapx.htm
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This window contains a graphical representation of the current part. This example shows the part view with four(4)
view ports active, you can also display the part view window as a large, single view port. Each port is independent
for purposes of viewing angle and magnification.

Additionally, each of the QC5000 windows can be moved to different locations on-screen, or removed from the
screen entirely. The three icon bar (Fig. 6) in the upper-right corner of each window can be used to minimize,
maximize, or close each window individually.

The View Rotator Back to the QC5000 Image Map

Another feature that can appear in the QC5000 main screen is the View Rotator window. To display this window,
select the "View Rotator"  from the View menu (a check beside the View Rotator option indicates that it is active). 

The View Rotator window

To use the View Rotator, place the mouse cursor over a quadrant in the View Rotator scope. Hold down the left
mouse button while moving the mouse. The  currently selected pane of the Part View window will periodically
update to display the parts new orientation.

file:///D|/MANUAL/qc5kmapx.htm
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To activate the View Rotator window, select View Rotator from the View drop menu

Additionally the View Rotator window can be opened by the View Rotator icon. By default, this icon is not present.
This icon can be added to the View Toolbar using the Customize option. See the Customize section (located HERE)
for more information.

The View Rotator icon

Note: The View Rotator will assist you when you begin to measure parts into the QC5000. This is covered in greater
detail in the View Control section.
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 2D / 3D Features
 
In This Section...
Projections
Auto Projection
Projection OFF
Summary
Tips
 

Projections 
Projection is the term used to describe the dimensions of a feature. The QC5000 can be set for three dimensional
projection, or any of the two dimensional projections, or auto (in which case the QC5000 determines the most
appropriate projection for each feature that you probe or construct). Three dimensional features that can not exist in
two dimensions (cones, cylinders) will always be projected three dimensionally. Three dimensional features are
unaffected by your projection setting. Features that can exist in two dimensions (lines, circles, arcs) are affected by
your projection setting, and will be projected onto the current projection plane. Some terms in this chapter may be
unfamiliar to you; this should help:

Terms:

Three dimensional (3D): A feature that has a length, width, and height value. Length, width, and height are the three
dimensions of any feature.

Two dimensional (2D): A feature that lacks any one of the three dimensions (length, width, height). In most cases
length is measured by the Y axis along the scale, width is measured by the X axis along the scale, and height is
measured by the Z axis. A two dimensional feature can exist on any plane that corresponds to two of these dimensions
(XY, YZ, or ZX). Two dimensional features are flat.

Projection plane: 2D features exist on a projection plane that describes which two dimensions they posses. If the
projection plane of a circle is XY, then the circle lies flat and has no height, as if a steamroller squashed it (Z is
generally assigned to represent the height dimension, and since this circle lacks height, it exists only in the X and Y
dimensions). If the projection plane of a circle is YZ, then it was hit by the same steamroller, and then stood upright (it
has height and length, but lacks width).

Projection: When we speak of "a feature’s projection," we are referring to its dimensions. A feature can have a 3D
projection (XYZ), or one of the three 2D projections (XY, YZ, ZX). Then you can say things like, "Hey, this circle has
a YZ projection."

When probing or constructing a feature, the new feature is created in accordance with the current projection plane.
Therefore, if you want to create an XY circle, but the projection is set to YZ, you must change the projection to XY
before probing or constructing the new circle. A simple demonstration will make this obvious:

Projection Demonstration

1. Select Datum from the main menu. The datum drop down menu appears.
2. Select Projection from the datum drop down menu. The projection sub-menu appears.
3. Select XY from the projection sub-menu. XY will now appear on the status bar if the status bar is set up

to show the projection plane.
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4. Probe a circle into the QC5000. The results window indicates that this circle is an XY circle (Pp indicates
projection plane in the results window). The circle appears in the part view, and on the feature list.

5. Select Datum from the main menu, then select Projection from the datum drop down menu. The
projection sub-menu appears.

6. Select YZ from the projection sub-menu. YZ will now appear on the status bar if the status bar is set up
to show the projection plane.

7. Construct a circle from the circle that you created in step four (4). The result window indicates that the
new circle is a YZ circle. The circle appears in the part view and on the feature list.

8. Notice the appearance of the two circles in the part view. Both of these circles were created from the same
data. Only the projection was changed. (graphic results on next page)

Note: If you want to specify the projection of a feature, you must do so before probing or constructing the new
feature (as was done in the preceding example—you changed the projection, and then constructed the new
circle).

One circle, Two projections

Select Datum>Projection>XY (a check always appears beside the current projection). You can also change the
projection by cycling through the projection on the status bar, if the status bar is set up to display the current
projection. [You will also use this menu to change the projection before constructing the second circle.]

Circle six (6) is probed, and circle seven (7) is constructed from circle six. This means that the exact same data is
used to produce both of these circles, the only difference is the projection. Circle six is an XY circle, and circle
seven is a YZ circle.
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The results window will indicate that circle 6 is probed from points, and that circle 7 is constructed from
another feature (your feature numbers will vary…if this is the first measuring you’ve done for the day, you may
have circle 1 and circle 2 instead of circle 6 and circle 7).

Auto Projection 
When projection is set to AUTO, the QC5000 will handle 3D features in the manner that it normally does, and it will
appropriately place probed 2D features on the correct projection plane. When constructing features in the AUTO
projection mode, the QC5000 follows a few rules that you might need to know:

Constructions in the AUTO projection mode

1. If both parent features are two dimensional (2D), and on different projection planes, the result will be three
dimensional (3D).

2. If one of the parent features is two dimensional (2D), and the other is three dimensional (3D), then the result is
two dimensional (2D). EXAMPLE: If an XY circle and a cylinder are used to construct a new feature, then the
resulting feature will be XY (unless, of course, you are constructing a feature that is 3D of necessity like a
cylinder, sphere, etc.).

3. If both parent features are three dimensional (3D), the result will be three dimensional (3D).
4. If both parent features are 2D, and on the same projection plane, then the result will correspond to the

parents’ projection plane.

Any time that you probe or construct a feature that is three dimensional of necessity, that feature will appear as a 3D
feature in the QC5000. Features that are 3D of necessity include cones, cylinders, and spheres. A feature is 3D of
necessity when it can not exist without all three dimensions (a cylinder could never exist without height, length, and
width, for example…therefore it is 3D of necessity).

Remember: The result of any measurement is always shown in relation to the current reference frame. If you construct
a new feature from parent features that are not members of the current reference frame, you may get a result in the
current reference frame. You may want this, you may not, so make sure that the current reference frame is the one in
which you want the new feature to appear.

Projection OFF 
This is a short but very important section! When the projection is set to OFF, all feature measurements and
constructions will default to three dimensional (3D). When in the OFF mode, lines, arcs, slots, and angles can not be
probed. If you attempt to probe these features when projection is OFF, the measurement will fail, and you will get very
frustrated.
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Summary: 
Projections are not difficult to manipulate and work with, a little practice and you should be able to do everything you
need to with projection. Keep in mind that certain features can not be probed when the projection is set to OFF. Lines,
arcs, slots, and angles will produce a "failed measurement" warning each time you attempt to probe one of these
features into the QC5000 with the projection set to OFF.

Tips: 
Keep projection set to AUTO when possible. Auto will place features in the appropriate projections for you.
Use the status bar to cycle through the projection options (Auto, Off, XY, YZ, ZX). If the status bar does not
display the projection, consult the status bar section of the Customizing chapter.
Remember: lines, arcs, slots, and angles can not be probed when projection is set to OFF.
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 CNC
 
In This Section...
General information on CNC
CNC menu items
CNC Options dialog box
 

General information on CNC
Dialogs may include data fields for axes that do not exist in your systems . These fields are gray if the axes do not
exist.

Discuss how the user could push the inch/mm toolbox button at any time so that the correct units may be used
during any dialog displays. Units field labels will change when units change ???

Discuss parsing all dialog inputs for arithmetic operators and parenthesis.

CNC menu items
The Tools main menu (shown with Goto menu items)

Note: Goto rotary will appear only if enabled in rotary table setup.

Goto Linear
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This function generates a coordinated movement in 3 axes. The optional fourth axis (W) is independent and has its
own dialog (see below). The specified position is relative to the current Reference Frame (part coordinate system).
The default values of the dialog are the last values entered. Relative move means in relation to the current position.
Error correction will not be used for "midcourse correction". The end point (target position) will use reverse
correction to determine the corrected machine position to go to. This also applies to all other positional closed loop
movements. The field labels are buttons that will allow the user to specify a movement in cylindrical polar
coordinates. The projection plane will be assumed to be XY for all moves, and the coordinate system (cart vs. polar)
will be displayed by default according to the current coordinate system display mode

Goto Selected Feature

For XY features, goto the XYZ of the feature. For Alternate plane or 3D features, goto the XY of the feature and
leave the Z height unchanged.

Joystick

Select either Fine Position or Axis Lock from the submenu below to learn more about each.

Motors on/off

Documented as a convenience. Not to be taken as a safety feature. If so specified in the CNC general setup dialog,
Motors off will set the inhibit line AND set the output to the drift voltage. The drift voltage may be set in CNC setup
options.

Items and references
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Goto
Joystick Positioning and movement modes
Motors on/off

Other Related Menu items

Manual execution - program control
Probe path data – probe options

CNC Options dialog box
To open the CNC Options dialog box, select Tools > Options > CNC Options... from the main menu.

The CNC Options dialog box contains the following tabbed items:

Select a tab from the image map below to learn more about that function

Supervisor [Return to the CNC Options image map]
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When the CNC Option dialog box first opens, all tabbed regions are grayed out. In order to activate all of the tabs in
this dialog box, you must enter the supervisor password, then select the "Verify" button.

By default, you will have to enter the supervisor password every time you access the CNC Options dialog box.
However, if you select the "Keep privileges until program is exited" option, then you will not have to re-enter the
supervisor password to access the other tabs options for the remainder of the current session. In other words, until
you close the QC5000 program.

Machine Zero [Return to the CNC Options image map]
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This section tells the VED system which axes will use reference marks or equivalent to establish a fixed machine
zero location at system startup or whenever the Set Machine Zero button is pressed. If the system has limit switches
that are wired to the QC5000 such that the system can sense the switch level, then these may be used in conjunction
with reference marks or to replace them entirely. The sequence of events for manual and automatic homing is
detailed below. The default value for all fields of this section is "off" or unchecked.

A repeatable machine zero is required if the SLEC, NLEC, or SW fence is active. It is also required to reestablish
the part coordinate system if measurements have been interrupted by a shutdown or power failure. The functions that
enable SLEC, NLEC, or the SW fence will automatically reset the Machine zero enable fields to "On" but will leave
them alone if the user disables these functions. If the user cancels the MZ sequence (see below), then an error
message will be displayed and the dependent functions will be disabled for that session. Successful completion of
the MZ sequence will re-enable the functions that may have been temporarily disabled

In a touch probe system, the machine zero may be located at the center of the datum retrieval ball or a fixed ring. In
that case, the user can establish the machine zero for the related axes by probing that fixed object. Auto homing by
this method is not required for V2.

If C-scale absolute position encoders are installed, the machine zero of those axes may be established (either
manually or automatically) by moving over two successive reference marks. If the C-scale is present, the auto home
sequence will by modified accordingly (see details below).

Auto Machine Zero Settings section
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This section tells the SW how to carry out the auto home sequence. The Initial Search Direction is the direction that
the system will move that (machine coordinate) axis to find a limit switch (or the end of travel, or the C-scale
reference marks). In the case of C-scales, if the axis is already at the end of travel, then the system should move
back the search distance and then restart the sequence. The search velocity is the velocity used for all moves of the
auto home sequence. It is entered as a percentage of the maximum system velocity. The reference search distance is
the maximum distance that the system would move that axis (from the end of travel) to find the reference mark that
becomes the machine datum for that axis.

Field Defaults

Field Default Range
Machine zero enable X, Y, Z, W disabled Enabled/Disabled
Auto machine zero disabled Enabled/Disabled
Initial search direction X+, Y+, Z+. W+ + or – (unchecked)
Search Velocity 25 1 - 100
Ref Search Distance 1 0 – 10000 mm

Machine Zero sequence

The Sequence starts with a warning message that may be disabled with the "Don’t show…" checkbox. (Note: All
warning messages in the system may be reactivated in the options dialog). The system will move all axes
simultaneously in the specified Initial Search Direction. The SW will determine when each axis has reached the limit
switch or end of travel. Then, if there are no Reference Marks, the SW will set the limit switch or end of travel
position to be the machine zero for that axis. If reference marks are enabled, the system will move each axis in the
opposite direction until either the search distance has been reached or the reference mark for that axis has been
found. If no reference mark is found, then an error message is displayed and the relevant MZ dependent functions
are disabled for that session. The reference mark position is set to be the MZ position for that axis.

In the case of a C-scale axis, the system will start with the same warning message ("Preparing to move…"), and
then will move in the designated Initial Search Direction until two sequential Reference marks have been found. The
SW may then set the machine zero as per the standard C-scale algorithm. If the axis is already at the end of travel,
then that axis will be moved to the search distance, and then will move along the Initial Search Direction as
described. Failure to locate the two sequential reference marks will generate an error as described above.

General [Return to the CNC Options image map]



CNC

file:///D|/MANUAL/CNC.HTM[6/28/2019 8:09:09 AM]

Inhibit Amplifier When Stopped

Settings available from this tab include:

Inhibit Amplifier when stopped — This setting will force the system to inhibit amplifiers after the completion
of each move. The system inhibit will occur after a specified delay (see below). By default, this option is not
checked (False).
Inhibit delay — This setting allows you to input the amount of delay, in seconds, that will inhibit the
amplifiers. The default is 1.0 seconds
VED Move Delay — The VED move delay will cause the subsystem to delay before signaling the completion
of a move. This allows the stage to come to a complete stop before firing a VED tool and is designed for
better accuracy and repeatability. The default is 0.2 seconds.

Software Fence [Return to the CNC Options image map]
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A Software Fence limits movement on one or more axes. There will be no method to move beyond the fence limits
while it is enabled. During a move, the subsystem will use a controlled deceleration to the fence. A machine zero
position has to be set in order to use a Software Fence (see Teach, below). A Software Fence may be one-sided.
This means that there is a limit of movement only in one direction. The teach sequence automatically determines the
safe direction.

Machine Fence

The Machine Fence is a Software Fence that will utilize the absolute values that the machine is capable of safely
moving is all applicable directions. Values can be entered manually, through the Software Fence tab on the CNC
Options dialog box, or automatically, using the Teach option.

Machine Fence section of the CNC Options dialog Software Fence tab

Maximum values can range from -100K to +100K (mm).
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User Fence

You can create an additional Software Fence to limit the movement of each or any axis. The User Fence is used on
an application basis (to prevent a collision on a tall part, for example).

User Fence section of the CNC Options dialog Software Fence tab.

Valid values can range from -100K to +100K (mm).

Note: The parameters you establish for a User Fence are saved with the part so that the User Fence can be restored
when the part is loaded into the QC5000.

User Fence Enable

This option toggles the use of a previously established User Fence. By default, this optioned is unchecked (Off).

Teach

There will be a teach sequence for each axis that is enabled. The SW will first check that a machine zero has been
explicitly set. If it has not, the user should be given the option to set the machine zero and then return to the SW
fence setup. The procedure consists of marking a point, moving in the safe direction, and marking another point.
That way, the software knows which side of the fence is "safe". If the security restrictions are such that the user has
permission to set the machine fence, he will prompted at the start of the wizard as shown below:

Pressing Next will display the following prompt:

The user will now select the axes that are to be taught. The disabled axes will be gray.
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When the user presses next the following prompt will be displayed:

Pressing Next will record the current position and display the following dialog:

Pressing Finish will define a one sided fence at either the max or min of travel. The direction that was moved will
determine whether the limit was max or min for that axis. Pressing Next will display the following prompt:

Pressing Finish will complete the SW fence setup and return to the SW fence setup options dialog.

Set Defaults

 

Programmability

After recording a user fence Teach, the system will automatically prompt the user as to what procedure or data
should be recorded. There are three possibilities. The first is to record nothing (but the new teach settings remain in
effect). The second choice is to record only the new settings. In that case, the recorded settings are recalled during
execution and remain in effect after the program ends. The third possibility is to record a teach step, so that the teach
prompt sequence is displayed and the user will define the new settings during execution.

User fence enable – a toolbox button will be available that toggles the state of User Fence Enable. This will allow
the user to turn off the user fence temporarily if he needs to perform a measurement outside the fence. When the
user fence is defined or redefined (teach), the button will assume the state assigned in the teach dialog.

X Axis [Return to the CNC Options image map]
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Y Axis [Return to the CNC Options image map]
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Z Axis [Return to the CNC Options image map]
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Digital Positioner [Return to the CNC Options image map]
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Digital Positioner – Configuration and user preferences

Joystick [Return to the CNC Options image map]



CNC

file:///D|/MANUAL/CNC.HTM[6/28/2019 8:09:09 AM]

The joystick can also be accessed from the Tools main menu (shown below).

Joystick - Calibration and user preferences
Joystick teach sequence (wizard)

Miscellaneous related
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Error messages on CNC conditions

External Manual interactive stage position controls

Allows manual interactive control of the stage movement. Also provide a means to immediately override (abort)
programmed movements. External controls override internal controls. The joystick overrides the digital positioners if
both are active at the same time.

Joystick control

The system will initially support up to 3 axes of joystick control. The joystick(s) are configured for closed loop
control. Provided the CNC setup has been successfully completed, the joystick should cause an immediate (within
50 milliseconds) response in the system, both in overriding a programmed movement, and in decelerating and
stopping any movement when the joystick is returned to the center or deadband position.

Note that it must be possible to move the stage under joystick control in order to characterize the encoders. A
separate encoder setup program will be provided which allows the stage to be moved under open loop control for
this purpose.

Startup checks

During startup, if the joystick has been enabled in the setup dialog, the joystick should be temporarily disabled until
it is determined that the joystick is in the deadband. If the joystick is out of the deadband, an error message should
be displayed

Control override and recovery

If the joystick is used to override a lower priority control, e.g. a programmed movement, the system will abort the
current control and move according to the joystick. The subsystem will report the joystick override condition so that
the system can take appropriate action. A program override, for example, is discussed in the programming
specification.

The joystick must be returned to the deadband to return to normal control. The same is true if any safety device is
encountered. These controls are of higher priority than the joystick.

Auto-retraction of the touch probe

If the joystick (or digital positioner) is used to probe a point with an automatic touch probe, auto-retraction should
occur. After the touch probe is triggered, the system will move the probe a small distance in the opposite direction
(of the approach vector). The distance will be a parameter of Probe Path data that is in probe properties. Auto-
retraction will occur only if either the joystick or the digital positioners are active. This rule prevents self-triggering.

The approach vector is a direction that can be determined by polling the position of the probe (in a manual system),
provided a reliable polling timer is available. Because auto retraction is intended to help prevent accidental damage
to the probe, it is required that the direction vector be accurate and up to date. In a CNC system, it may be more
reliable (and efficient) to substitute some other method to track probe direction.

Emergency stop and probe retraction during a program

Programmed movements will "know" when a point is expected, and will perform an emergency stop (without
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retraction), at any other time during program execution. When not executing a program, and if the touch probe is
selected, it will be assumed that a trigger may occur at any time. When a point is expected and a trigger occurs, the
probe will be retracted from the surface in much the same way as it is during auto-retraction. The distance of
retraction will be the same as that used in auto-retraction.

Calibration and user preferences

The dialog consists of four sections. The calibration section is characteristics of the joystick that are stored in the
system data file by default (supervisor privilege). The current values section is updated in real time to show the
voltage level at each of four analog inputs. It is used primarily to verify the hardware is properly connected and
working. The preferences section contains joystick profile data and is stored in the user data file by default. The
buttons section include Teach (calibration data), Apply (put the displayed values into effect), and Set Defaults (all
values to factory settings). Apply is a local OK command and Cancel will only discard new data which has not
already been applied.

Calibration

The calibration section displays the limit characteristics of the joystick and the configuration. There are default
values for each of these fields that may be reset by using the default button. For axes that do not exist, the enable
checkbox should be grayed as the W axis is in this example.

Field Defaults
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Field Default Range
Enabled X, Y, Z, W False True/False
Current none Not editable 0.00 – 5.00
Share With none (blank) blank, X, Y

Field definitions

Enable/Disable fields - Enabling any axis (and pressing Apply) will allow the user to test the current settings
(calibration and preferences).

Share with is a drop list. A button may be mapped to toggle a joystick axis between Z control and X or Y control for
example.. Blank means that there is an independent input for Z and/or W

Joystick Preferences

Preferences control joystick response. Because the data is stored in the user file (by default), different users may set
different response profiles.

Default and range values:

Field Default (all axes) Range
DB% 10 1 – 100 integer
Normal % 100 1 – 100 integer
Fine % 10 1 – 100 integer
Expo % 50 1 – 100 integer
Reverse False True/False
Mag scaling False True/False

Field definitions

The DB% is the percentage of movement in each direction that is to be considered a dead band. Note that the
deadband may be "wider" on one side of the joystick throw than the other if the center position is not in the physical
center of the throw.

Min Center Max
Dead Band=20

Normal % is a joystick throw scale factor. The software will scale the maximum system velocity by this percentage
to calculate the maximum velocity that the stage will move under joystick control.

Fine % is a fine positioning scale factor. When the system is in fine positioning mode, the normal velocity related to
the current joystick position is scaled by this percentage.

The Expo % governs how the percentage of throw of the joystick is non-linearly modified to allow "soft" response
near the deadband. The expo function takes percent of throw as input and generates another percent of throw as
output. The following table may be used for interpolating joystick position to find velocity by a four point
approximation. There should be no noticeable oscillation in velocity if the joystick output is oscillating over one of
these points. The first number is raw percent of throw (not counting dead band). The second number is new percent
of throw.

Expo Point 1 Point 2 Point 3 Point 4
0 0,0 33,33 66,66 100,100
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25 0,0 45,25 75,55 100,100
50 0,0 60,20 80,40 100,100
75 0,0 70,15 85,30 100,100
100 0,0 80,10 90,20 100,100

A higher Expo number represents a "softer" feel near the deadband position. Any algorithm that passes a usability
test may be substituted for the above segmented linearization. Note that the table of values is symmetric.

The Mag scaling checkbox determines whether the joystick response will be further scaled according to the current
calibration (magnification). The first 75% of the previously scaled joystick throw will be further scaled as the current
pixel size divided by the lowest mag pixel size. This means that magnification scaling has no additional effect at the
lowest magnification as the scale is 1 to 1. In the last 25% of the previously scaled throw, the throw will be scaled
between the 75% value and 100% of throw. The motion mouse section has a more complete explanation.

Reverse (direction) forces the system to move the stage in the opposite direction when compared to the normal
movement (unchecked state) at a given throw of the joystick.

The Teach Function

Pressing view calibration will display the following dialog. These fields are not editable. The purpose of the dialog
is simply to view the current teach settings.

Teach is used to find the output voltage level values of min, center, and max for each axis. The max voltage is
always displayed in the Max field, etc.

Teach will start a series of two prompt dialogs that have the two buttons : OK, and Cancel. Pressing Cancel at either
prompt will abort the teach and no values will change.

The dialog sequence first displays the prompt shown below:

The system will then display the dialog shown below:
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The teach algorithm will poll the joystick position on all axes and keep track of the min and max position for each
axis. The current, min, and max values will be reflected in the setup dialog so that the user can see the values
change. Pressing cancel will abort the teach function without saving values, but the Options dialog remain. Pressing
Finish will end the teach function, but the user will have to press Apply or OK to actually use and save the new
values.

Digital positioners

The system will support up to 4 axes of digital positioning controls.

Startup checks

Digital positioner activity will be sensed at startup. If any axis is out of the debounce zone, then an error dialog will
be shown with the cause: "Digital Positioner moving". The debounce zone is set in an INI file as 3 counts and does
not need to be in the user interface.

Control override and recovery

Movement of the digital positioners out of the debounce zone will cause a lower priority movement, e.g. a
programmed move, to be overridden and the digital positioners will assume control of the stage movement.

Using the digital positioners to probe a point with an automatic touch probe will cause the probe to auto-retract and
stop. The digital positioners will be ignored until they have remained within the debounce zone for ¼ second,
subject to experiment.

Configuration and user preferences
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The dialog contains three sections. Configuration controls how the Digital Positioners axes are mapped to the TTL
counter inputs. Current Values display the current count of the input. The fields are not editable. Preferences control
Digital Positioners response. Because the data is stored in the user file (by default), different users may set different
response profiles. Current values are updated in real time. The purpose is to verify that cabling is correct and the
counters are working. The Apply button makes the displayed values become the current values of the DP profile. Set
Defaults sets the following default values for all axes:

Default and range values:

Field Default (all axes) Range
Enable False True/False
Share With none (blank) blank, X, or Y (drop list)
Normal 1.00 0.01 – 100.0 float
Fine 0.50 0.01 – 100.0 float
Accel % 50 0 – 100 integer
Reverse False True/False
Mag scale False True/False

Field definitions

Enable/Disable: If a DP are not present on an axis, it should remain disabled.

Velocity: After debouncing, the number entered is multiplied by the DP delta count to find the relative stage
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movement in counts Each axis is independent.

Accel: The accel will be similar to a mouse movement accel. A movement of the DP trackball in any axis that
exceeds some threshold (of velocity) will cause the scale factor of all axes to be adjusted by a common multiplier so
that the stage movement will be proportionally larger for a given change in the DP counters. The adjustment will
only be active while the DP velocity is above the threshold, and will revert to normal when the velocity drops below
the threshold.

Reverse (direction): Reverse will cause the stage movement to be negative when the relative DP movement is
positive.

Share With: allows the user to use the same DP to control two axes. The axis that will be affected by the DP
movement could be based on an external or toolbox button.

Debouncing the digital positioners

The debounce distance or time will not accessible in the user interface, but will be accessible in a "met" file. The
basic purpose of debounce is to avoid having the stage move if vibration or noise has caused the DP encoder to
move slightly. It is also required, however, that the user be able to move the digital positioners at a very slow rate to
accomplish fine positioning. For example, assume that the debounce distance parameter is set to X counts. If the
normal velocity is set to 1.0, then the first criteria for movement is that the count must change at least X+1 counts
(that may occur over any length of time). The DP is now "awake". Any further movement of the digital positioner
will be taken as a control movement. Each time the count is polled, the time is marked. If the DP is not moved in
excess of X counts for a certain time period, the debounce time, then the digital positioner is put back to "sleep".

Positioning and movement modes

These modes make it possible to move in a direction other than the cardinal machine directions and/or very slowly
while manually probing or recording a program. All modes are independent, so it should be possible to activate all
of the modes simultaneously.

Fine Positioning

Fine positioning mode is a simple scale factor (a % in the user interface) which scales the velocity of the joystick or
the digital positioning movement. The additional scaling to magnification takes place during both normal and fine
positioning mode, with the final 25% of the joystick throw not using the magnification scaling. For the Digital
Positioning, the magnification scaling will occur at all digital positioners count rates.

Axis Lock

In this mode all axes are examined for activity. Only the largest (proportional) joystick offset out of the deadband is
used to move the stage. If part following is active, the movement occurs along the part axis. In the case of digital
positioners, the largest count / sample time will govern which axis will be moved.

Part following and Level Lock

The system will support both level lock and full part following in the first release. When part following is active, the
joystick will move the stage along axes defined by the current part coordinate system. SW note: a simple rotation
matrix may be used to achieve part following if the joystick control is first converted to a movement direction
vector.

The level plane is always the XY plane. The purpose of level lock is to keep the XY surface plane in focus or near
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focus. It will also occur during scan execution although this is not a joystick movement. Level lock is intended to be
active at all times during a move, not just at the end of the move as in the V1 code.

Positioning and CNC modes affect both the joystick and the digital positioners. The same fine positioning command
(button) will activate fine positioning for both DP and Joystick. The scaling factor may be different for each device,
and, in fact for each axis of each device as shown in the setup dialogs.

The positioning and movement modes are enabled and disabled through menu items in the CNC menu. They may
also be mapped to external buttons and may be configured to toggle on level or pulse. Button mapping will allow
multiple assignment, as in part following AND axis lock mapped to a button. See General I/O of the specification
for more details. We will also allow Multiple assignment to toolbox buttons.

Handling the quiescent condition

The inhibit lines will be tied together for the first release.

CNC general setup dialog

CNC setup dialog per axis

Dialog general information

The CNC setup dialog has one axis per page. Several fields show the data in the current units and the units labels are
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shown in the dialog. There are three sections in the dialog. The parameters section defines the motion algorithm for
that axis. The user may tune the system and improve the performance of the motion using the Axis Test. Test results
are displayed in a dialog that may be displayed by pressing the Show Results button. The Enable section allows the
user to turn off all outputs to the motors and perform a drift test. The sections are individually controlled in the
security table.

Field values

Field Range Default
Max Velocity 0.0 – 1000.0 mm 0.000 mm / sec
Acceleration 0.0 – 1000.0 mm 0.000 mm / sec / sec
Max following error 0.0 – 1000.0 mm 1.000 mm
Continuation zone 0.0 – 10.0 mm 0.010 mm
Proportional 0.0 - ??? 1.0
Derivative 0.0 - ??? 1.0
Jerk 0.0 - ??? 1.0
Drift Offset 0.0 - ??? 0.0
Reverse Motor True/False False
Test Distance 0.0 – 1000.0 mm 1.0 mm
Enable X,Y,Z,W True/False False

Field definitions

Max Velocity shows the maximum system velocity in labeled engineering units

Acceleration shows the max system acceleration in labeled engineering units

Both velocity and acceleration are used in any un-scaled CNC move

Max following error shows how much positional error can occur in the system before an error message is generated.

Continuation Zone: Although the CNC subsystem remains in control of the position (except under special
circumstances of amplifier inhibit), the subsystem signals the main SW that the move is complete if the stage
position is equal to or less than this distance from the current target position. Note that the "VED Move Delay"
described in the CNC general setup page must also be satisfied for the move to be complete.

Proportional, derivative, jerk, and drift offset parameters are used to control the motion algorithm at the
instantaneous level. Each parameter must be adjusted for a given system to optimize performance. Performance
consists of tracking accuracy, smoothness, and maximizing velocity. There are no real requirements for performance
other than the V2 CNC system should meet or exceed the performance of the V1 software as viewed by a typical
user.

Reverse motor is used to accommodate those systems that may have been incorrectly wired. The reversal simply
changes the sign of the output voltage. This incorrect wiring may cause a runaway condition in the system.

The Test Distance is the distance that this axis will move under test. The Test is fully described below.

CNC setup test results display

Pressing the Show Results button on any CNC axis setup will display the following dialog.
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Pressing Test (axis) or Test All will cause the system to move the stage to the test distance and display the results.
This dialog is for display only. There are no editable fields. The dialog is used to tune the CNC parameters for best
performance. The display should be updated as often as practical during the test move.

Note that the system should remain in control during all CNC movement tests. The continuation zone should be
disabled and following errors should be ignored.

Pressing Test a second time should cause the system to move in the opposite direction, and return the axis to the
previous start position.

Pressing Set Home will cause the current position to become zero. This makes it easier to tune the parameters as the
"current position" is approximately equal to the test distance (or zero). Because we do not want to modify the
machine zero, the Set Home button should set a part zero at the current position.

CNC Related Information
Control prioritization

For safety reasons, external controls described below have a higher priority in the system than internal interactive
controls or programmed controls. The joystick control is the highest priority. Using the joystick while the stage is
moving under internal or programmed control generates an override condition described in the joystick section. The
following shows the controls in order of priority:

Safety devices: Limit switches and Interlocks
External button mapped to stop
System software fence
User software fence
Auto-retraction (touch probe)
Following error detector

External controls: Joystick
Digital positioners
User event such as keyboard or mouse click (under certain conditions)

Internal controls: Goto dialog
Goto feature or Goto Click, Goto edge (autocircle)
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Programmed movement

Probe Path data

Probe path data (for touch probe) is set in probe properties.

Probe path data will generate a program step if it is modified during recording. This may be necessary to ensure that
a specific part program will run as intended. See programming specification for further info. The default values for
the four fields of the dialog are shown below

Field Default Range
Probing 50 0 – 100 integer
Non-probe 100 0 – 100 integer
Approach 5.0 (mm) 0.0 – 100.0 mm
Search 5.0 (mm) 0.0 – 100.0 mm
Retract 5.0 (mm) 0.0 – 100.0 mm

Automatic Zoom

The software will support both the Metronics and Nikon automatic zoom lens. The basic method of selecting a zoom
position will be to select a calibration in the VED menu. There will be up to 10 positions available for both lenses.

Additional devices

The V2 system must support all auxiliary devices that are supported in V1. The CNC devices include the TFI
(Tilting fiber illuminator), and the Automatic zoom. The user interface for these OEM options are minimal and will
be specified in the section on VED. The only requirement here is that there be an adequate number of stepper control
channels available to support these devices, and at least one additional channel for future devices. See also OEM
options.
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 Constructions
 
In This Section...
What is a construction?
Construction Conventions
     Point Constructions
     Line Constructions
     Circle Constructions
     Plane Constructions
     Arc, Sphere, Cylinder, and Cone Constructions
     Angle & Distance Constructions
Summary
Tips
 

What Is a Construction? 
Constructions are features that have been formed from other features. When you probe a line, you enter two points into
the QC5000 using a CMM. When you construct a line you do not use your CMM; instead, you select two points from
the feature list that have already been probed, and you tell the QC5000 to make a line from these points. Note:
Features are either probed or constructed, you can not generate a feature by combining a construction with probed
points.

Constructions are either single parent, two parent, or multiple parent in nature. These labels refer to the number of
features used to construct the new feature. If you duplicate an existing feature, then you have created a new feature by
copying the original feature: thus a single parent construction results. A two parent construction, like a "pierce point,"
requires two previously measured features (a plane and a cylinder, for example). Multiple parent constructions use the
position of existing features to produce a multi-point feature.

Single Parent: Use a single existing feature to create a new feature. Can include: duplications, projections,
extractions.
Two Parent: Two existing features combine to construct a new feature. Can include: relations, intersections,
offsets, symmetries.
Multiple Parent: Use the positions of existing features to produce a multi-point feature. Example: bolt hole
circle.

"Parent" simply refers to any feature that is used to construct a new feature. If two previously measured points are used
to construct a line, then the line is a two parent construction and the points are the two parents.

Construction Conventions 
Before you begin constructing features, there are a few conventions that you will need to know. Some constructions
require certain feature types in order to form the new, constructed feature. These feature types fall into categories.
Features within the same category can act as parents for the same types of constructions. If you will be constructing
features, you will want to be familiar with the following categories:

The Feature Categories:

Standard Feature: all features except slots.

file:///D|/MANUAL/view.htm
file:///D|/MANUAL/index.htm
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Linear Features: (Axis features). Lines, cylinders, cones.
Positional Features: point, circle, arc, sphere.
Radial Features: circle, arc, sphere, cylinder.

If the procedure for a construction states, "select a linear feature," then you know that you should select either a line,
cylinder, or cone. If the procedure for a construction states, "select a radial feature, " then you know you should select
either a circle, arc, sphere, or cylinder. Notice that cylinders are both linear (axis) features and radial features; this
means that they will work for constructions that require either a linear or a radial feature. Other overlaps exist: arcs are
positional and radial, for example.

Constructions, like features, are classified by category. Constructions are either universal, or else they require a certain
type of parent feature. Universal constructions can be formed from any feature type.

The Universal Constructions:

Duplication: Constructs a copy of the selected feature.
Offset: Constructs a copy of the selected feature at a specified distance from the original feature (not for
distances).
Best Fit: Constructs a "best fit" feature from positional features (not for angles).

Non-Universal Constructions Supported by the QC5000:

Anchor Point: The point on a linear feature that lies closest to a part’s origin.
Angle Type: Included angle, 360- angle, 180+ angle, 180- angle.
Bisector: Result feature is a line through an intersection point.
Distance type: Nearest, farthest, and center to center distances.
Extraction: The result is a simpler element of a single parent feature. For example: the center point of a
circle is extracted from the circle.
Intersection: The resulting feature defines where the surface or edge of the two parent features are
identical (in location).
Multi-point: The center points of positional parents are used in a best fit calculation.
Projection: The parent feature is projected (perpendicularly) on a parent line or plane.
Symmetry: Results in the mid-point of two positional features or the mid-line or mid-plane of two axial
features.
Synthetic: A feature is constructed by assembling its components (two existing lines form an angle).
Tangent: The result feature is tangential to both of the parent features.

The basic procedure for constructing features will always be the same. Select the type of feature you want to construct,
then select the parent feature or features that you want to construct the new feature from.

If you attempt a construction that the QC5000 does not support, a warning appears to let you know that you have
attempted an unsupported construction. You should either try the construction again (if you are sure that it is supported
by the QC5000); or, you should review the list of supported constructions.
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Note: If this warning appears, click on the "hide warning" button, and try the construction again. If the
warning repeats, you may want to check the list of constructions that the QC5000 supports. A complete
reference chart of constructions appears in this chapter.

Point Constructions 

Any time that you want to construct a point, your measurement will begin with this step: Select the POINT icon from
the toolbar. You always select the feature that you are going to construct first. There is no complicated procedure for
telling the QC5000 that you want to construct a point, just select the icon that you normally would to manually probe a
point. Now the QC5000 knows that the feature it is going to add to the feature list will be a point. In fact, the familiar
Measure Point dialogue box appears, just as you would expect.

You should be feeling right at home. The Measure Point dialogue box is onscreen, prompting you to probe a point.
Don’t probe a point; instead, select a circle from the feature list. If there is no circle on the feature list, probe one into
the QC5000 (you should already be an old pro at this, but don’t forget to re-select the point icon after you measure
your circle). Now you have a circle on the feature list, and the Measure Point dialogue box onscreen. You’re right
where you want to be. Select the circle by highlighting it on the feature list (or by selecting it in the part view). Now
select OK from the Measure Point dialogue box . . . the center point of the circle has been added to the feature list.

To Construct the Center Point of a Circle:

1. Select the Point icon from the Measure toolbar. The measure point dialogue box appears.
2. Select the circle from the feature list.
3. Select OK from the measure point dialogue box. The constructed point appears on the feature

list. The point appears in the part view. Information about the point appears in the result
window.
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 Here’s a circle…

 …Just select the point icon…

…Select the circle from the feature list (as pictured above)…

…and select OK from the measure point dialogue box (not shown):

The constructed point appears in the part view, and on the feature list. The results window contains information
about the point. This point is a "single parent construction" because it was derived from a single feature.

When you wanted to probe a point into the QC5000 the first step was to select the point icon. When you wanted to
construct a point the first step was also to select the point icon. Remember, the first step when constructing features
is ALWAYS to select the feature that you want to construct. . . no ifs, ands, or buts about it. You must tell the
QC5000 what you want it to construct before you can do anything else. Once you tell the QC5000 what type of feature
(line, point, plane, circle, etc.) you want to construct, then there are several ways to proceed, but first you have to tell
the QC5000 what the new feature will be.

If you do not feel comfortable with the procedure for finding the center point of a circle, then do it again, now . . .
select Point from the measure toolbar, select a circle from the feature list, select OK from the measure point dialogue
box. The QC5000 makes feature construction easy.
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Complete List of Point Constructions

Click To Enlarge

Center Point of a positional
feature, ellipse, rectangle, or slot.

Click: The POINT icon

Then Select: The positional feature such as a slot, circle, etc.

Change To: N/A

Click To Enlarge

Apex of cone or angle

Click: POINT icon

Then Select: The Cone or Angle

Change To: Midpoint (Application Point) ,Anchor Point, Bounding Points.

Click To Enlarge

Application Point (midpoint of
linear feature, or plane)

Click: POINT icon

Then Select: A Linear Feature or Plane

Change To: Anchor Point, Bounding Points

Click To Enlarge

Anchor Point (Point closest to
origin on linear feature or plane

Click: POINT icon

Then Select: A Linear Feature or Plane

Change To: Midpoint (Application Point, Bounding Points.
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Click To Enlarge

Center Point of a positional
feature or slot.

Click: POINT icon

Then Select: The positional feature, ellipse, rectangle, or slot.

Change To: N/A

Click To Enlarge

Bounding Points
(end points of linear feature, or
distance)

Click: POINT icon

Then Select: A Linear Feature or distance.

Change To: Midpoint, Anchor Point

Click To Enlarge

Intersection of two lines

Click: POINT icon

Then Select: Two Lines

Change To: Closest point of approach

Click To Enlarge

Closest point of approach between
two linear features

Click: POINT icon

Then Select: Two Linear Features

Change To: Intersection Point
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Click To Enlarge

Intersection of two circles
(Result will be 2 points)

Click: POINT icon

Then Select: The two circles

Change To: Midpoint

Note: (The point - Circle/Circle construction gives 2 points of intersection unless there is
no intersection)

Click To Enlarge

Midpoint of 2 circles

Click: POINT icon

Then Select: The two circles

Change To: Intersection Point

Note: (Midpoint construction will only occur if the circles do not intersect).

Click To Enlarge

Intersections of a line and circle
or line and a sphere

Click: POINT icon

Then Select: A line and circle or A line and a sphere.

Change To: Perpendicular Point

Note: (Result will be 2 points)

Click To Enlarge

Midpoint between two positional
features

Click: POINT icon

Then Select: Two Positional Features

Change To: N/A

Click: POINT icon
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Click To Enlarge

Perpendicular point on a plane or
line from a positional feature

Then Select: A plane or Line and a positional Feature

Change To: N/A

Click To Enlarge

Intersection of linear feature and
plane (The "Pierce Point" where
the axis intersects the plane)

Click: POINT icon

Then Select: A linear feature and a plane.

Change To: N/A

Click To Enlarge

Intersection of three planes

Click: POINT icon

Then Select: 3 planes

Change To: N/A

Changing a Construction

The Change option works as it does for Measure Magic. Select Edit from the main menu, then Change to view your
options (current option is checked). Or, select the Change icon from the Measure toolbar. The construction charts
present possible changes beside the Change To listing.

Line Constructions 
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Line construction is similar to circle construction. Every line that you construct will begin with this step: Select the
LINE icon from the measure toolbar. Just as you did when you constructed a point, you must first tell the QC5000
what type of feature it should construct. When you probed a line into the QC5000, you first selected the line icon (or
selected line from the main menu); constructing a line is no different: you first select the line icon.

Once you select the line icon, the Measure Line dialogue box appears. You’ve seen this dialogue box a number of
times (perhaps when creating reference frames). Select a cylinder from the feature list (if a cylinder is not available
probe one into the QC5000, or select a cone…remember to re-select the line icon when you are ready to construct a
line). Once you select the cylinder by highlighting it, the OK button on the Measure Line dialogue box becomes active.
Select OK from the dialogue box. The new line appears in the part view. The line is added to the feature list.
Information about the line appears in the results window.

To Construct a Line

1. Click on the line icon from the measure toolbar. The Measure Line dialogue box appears.
2. Select a cylinder from the feature list. The cylinder is highlighted on the feature list and in the part view.
3. Select OK from the measure line dialogue box. The new line appears in the part view; information about

the line appears in the results window; the line has been added to the feature list. (line 2 below)

When you construct a line from a cylinder the result is the cylinder’s axis. A line constructed from a cone would
produce the same result (an axis). As with features, line constructions can be Changed: make sure the feature is
selected on the feature list and use the change icon from the measure toolbar to view a list of possible changes (some
constructions, like some features, can not be changed).
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Complete List of Line Constructions

 
Click To Enlarge

Axis of linear feature

Click: LINE icon

Then Select: A linear feature (axis feature: cylinder, cone)

Change To: N/A

 
Click To Enlarge

Axis of plane

Click: LINE icon

Then Select: A Plane

Change To: N/A

Click To Enlarge

Lines of a slot (Results will be 2
lines)

Click: LINE icon

Then Select: The Slot

Change To: N/A

Click To Enlarge

Line between two positional
features

Click: LINE icon

Then Select: Two positional features

Change To: Tangent Lines if one is radial and one the same projection plane.
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Click To Enlarge

Tangent lines from point and a
radial feature or 2 radial features.

Click: LINE icon

Then Select: A point and a radial feature or two radial features.

Change To: Two point Line

 
Click To Enlarge

Intersection of two planes

Click LINE icon

Then Select: The Two Planes

Change To: N/A

Click To Enlarge

Bisector or perpendicular
bisector between two linear
features or planes.

Click: LINE icon

Then Select: The two linear features or planes

Change To: Bisector Line 2, Shortest, or Gage Line

Click To Enlarge

Line of closest approach between
two linear features (Also known as
Shortest)

Click: LINE icon

Then Select: Two Linear features

Change To: Bisector 1, Bisector 2, or Gage Line
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Click To Enlarge

Perpendicular Bisector between
two linear features

Click: LINE icon

Then Select: Two Linear features

Change To: Bisector 1, Shortest, or Gage Line

Click To Enlarge

Line from a positional to a linear
feature (perpendicular)

Click: LINE icon

Then Select: A positional feature and a linear feature.

Change To: Parallel

Click To Enlarge

Line parallel to a linear feature
through a positional feature

Click: LINE icon

Then Select: A positional feature and a linear feature.

Change To: Perpendicular

Click To Enlarge

Line from a positional feature to
a plane (perpendicular to plane)

Click: LINE icon

Then Select: A positional feature and a plane.

Change To: N/A

Click: LINE icon
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Click To Enlarge

Rotated line from line and angle
(30° )

Then Select: A line and the Angle.

Change To: N/A

Click To Enlarge

Gage line between two lines

Click: LINE icon

Then Select: 2 Lines

Change To: N/A

Note: Vertical - One line must be < 45° and the other between 0° & -45°. Horizontal - One
line between 45° & 90°, line 2 between 90° & 135°.

Note: You will be prompted to enter the length of the line.

Click To Enlarge

Line projected to a plane

Click: LINE icon

Then Select: The line and the plane.

Change To: N/A

Circle Constructions 

If you have read the sections on point and line constructions, then you know that the first step in constructing a circle
will always be to select the circle icon from the measure toolbar. Once you have selected this icon, the QC5000
knows that it will be creating a circle from whatever input (probed points, selected features) it receives.

Once you select the circle icon, the Measure Circle dialogue box appears. From the feature list or the part view, select
the features that you want to use to construct a circle. For example, if you are constructing a bolt hole circle, you
would select the bolt holes whose center points will determine the circumference of your circle:
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Circles A and C, and arcs B and D, have been used to construct a bolt hole circle that passes through the center points
of A, B, C, and D. The process is simple:

1. Select the circle icon
2. Select A, B, C, and D from the feature list (they have been previously measured)
3. Select OK from the dialogue box.

Here’s another circle construction (circle tangent to two lines):

1. Select the Circle icon from the measure toolbar. The measure circle dialogue box appears.
2. Select two lines from the feature list (remember, holding down CTRL will allow you to make multiple

selections with the mouse).
3. Select OK from the measure circle dialogue box. You are prompted to enter the circle’s radius.
4. Enter a radius for the circle and select OK to accept it. The newly constructed circle appears on the

feature list. Information about the circle appears in the results window. The circle appears in the part
view.

5. Experiment with the Change icon (on the measure toolbar) to see the different tangent options that you
are offered.

When you construct circles, often you may need to select several features. Remember: holding down the CTRL key
will allow you to make multiple selections with the mouse. This will work with many Windows applications.

Complete List of Circle Constructions

Click To Enlarge

Equator of sphere per
projection

Click: CIRCLE icon

Then Select: First select XY or YZ from projection, then select the sphere.

Change To: N/A

Click: CIRCLE icon

Then Select: Select the Cone. 
(You will be prompted to enter the circle’s diameter.)

Change To: N/A
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Click To Enlarge

Gage circle of a given
diameter in a cone

Click To Enlarge

Intersection of Plane and
~,coaxial cylinder or cone

Click: CIRCLE icon

Then Select: The plane and a ~coaxial cylinder or cone.

Change To: N/A

Click To Enlarge

Intersection of cylinder and
~coaxial cone

Click: CIRCLE icon

Then Select: Cylinder and ~Coaxial cone.

Change To: N/A

Click To Enlarge

Circle tangent to two lines

Click: CIRCLE icon

Then Select: Two Lines.

(You will be prompted to enter the circle’s radius.)

Change To: The other 3 possible tangent positions

  

Note: The tilde (~) means "very nearly," as it does in the results window. A circle that lies on the ~XY plane is very
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nearly and XY circle.

Plane Constructions 

The first step in constructing a plane will always be to: select the Plane icon. By selecting the plane icon, you tell the
QC5000 that the next feature it creates (whether probed or constructed) will be a plane. If you want to construct a
plane, select the plane icon . . . easy.

Once you select the plane icon, the Measure Plane dialogue box appears. Now you select the features from the feature
list that you want to use to construct your plane. When all of the features that you need are highlighted, select OK from
the measure plane dialogue box. The newly constructed plane appears on the feature list and in the part view.
Information about the plane appears in the results window.

The procedure should sound familiar; it is the same procedure that you follow for any feature construction. The
following example represents a typical plane construction.

To construct a plane through the midpoint of a line (using the line as an axis)

1. Select the Plane icon. The measure plane dialogue box appears.
2. Select a line from the feature list. If no line exists, cancel the plane measurement and probe a line into the

QC5000. Then return to step one (1) and perform the plane construction.
3. When the line is highlighted on the feature list, select OK from the measure plane dialogue box. The newly

constructed plane is added to the feature list. Information about the plane appears in the results window.
The plane appears in the part view.

Complete List of Plane Constructions

Click To Enlarge
 

Plane through the midpoint of a
line using the line as an axis

Click: PLANE icon

Then Select: The Line

Change To: N/A

Click: PLANE icon

Then Select: The axis line and a position feature.

Change To: N/A

file:///D|/MANUAL/common/construk/con-036.htm


Constructions

file:///D|/MANUAL/CONSTRCT.HTM[6/28/2019 8:09:18 AM]

Click To Enlarge
Plane using a line as an axis
through a positional feature

Click To Enlarge
 

Midplane  between two planes
 

Click To Enlarge
Perpendicular midplane between
two planes

Click: PLANE icon

Then Select: Two planes

Change To: Midplane 2

Click To Enlarge
Plane through a positional
feature parallel to another plane

Click: PLANE icon

Then Select: A plane and a positional feature.

Change To: N/A

Click: PLANE icon

Then Select: The line and the plane.

Change To: N/A
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Click To Enlarge
Plane through a line
perpendicular to another plane

Note: Some results from plane construction can be manipulated by using the Change feature. If you can not get a
change result that you want, check to see if your desired change is supported by the QC5000.

Arc, Sphere, Cylinder, and Cone Constructions 

Arc constructions, sphere constructions, and cylinder constructions are formed in the same way as all other
constructions (cone constructions are treated as cylinder constructions). Select the feature icon (arc, sphere, cylinder
or cone). This lets the QC5000 know that the next feature it creates will be an arc, sphere, cylinder, or cone
(depending on which you have selected).

After selecting the feature icon, the feature measure dialogue box appears. Now highlight, on the feature list, the
features that will be used to form your arc, sphere, or cylinder. Finally, select OK from the feature measure dialogue
box to accept the measurement.

Complete List of Arc, Sphere, Cylinder, and Cone Constructions

Arc Construction…

Click To Enlarge

Arcs of slot.
(Results will be 2 Arcs.)

Click: ARC icon

Then Select: The Slot.

Change To: N/A

Sphere Construction…
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Click To Enlarge

Gage ball of given diameter in a
cone

Click: SPHERE icon

Then Select: The Cone. (You will be prompted to enter a Diameter.)

Change To: N/A

Cylinder and Cone Construction…

Click To Enlarge

Two ~coaxial circle cylinder or
cone

Click: CYLINDER OR CONE icon

Then Select: Two ~coaxial circles

Change To: N/A

Angle and Distance Constructions 

Relations can also be constructed and added to the feature list. To construct an angle, you would select the angle icon,
and then select the features between which you want to determine the angle. Angle constructions can be altered with
the change option. Cycle through the changes until you find the angle that you want displayed on the feature list.

To construct a distance you select the distance icon, and then select the features between which you want to measure a
distance. Distances can also be changed with the change option. The following example will use an angle example to
demonstrate the construction of a relation.

To construct an Angle

1. Select the Angle icon from the measure toolbar. The measure angle dialogue box appears.
2. From the feature list, select two linear features, or a linear feature and a plane, or two planes. The two

features should now be highlighted on the feature list.
3. Select OK from the measure angle dialogue box. The newly constructed angle is added to the feature list.
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Information about the angle appears in the results window, The angle appears in the part view.

Complete List of Angle Constructions

Click To Enlarge

Angle between linear features, a
linear feature and a plane, or 2
planes.

Click To Enlarge

360°-Included Angle

Click To Enlarge

180°- Included Angle

Click To Enlarge

 

Click: ANGLE icon

Then Select: Two linear features, or a linear feature and a plane, or
2 planes.

Change To: 360- Included, 180- Included, and 180+ Included
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180°+ Included Angle

Complete List of Distance Constructions

Click To Enlarge

Length of axis
(of linear feature)

Click: DISTANCE icon

Then Select: The linear feature

Change To: N/A

Duplicate Distance

Click To Enlarge

Click: DISTANCE icon

Then Select: The distance

Change To: Reversed, Signed, and Absolute.

Note: You must have a duplicate distance to get these results.

Reverse direction Distance

Click To Enlarge

Click: DISTANCE icon

Then Select: The duplicated distance.

Change To: Duplicate, Signed, and Absolute.
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Absolute value of coefficients

Click: DISTANCE icon

Then Select: The feature

Change To: N/A

Add two distance distances (Sum)

Click To Enlarge

Click: DISTANCE icon

Then Select: Two distances. (Results will be from the end of
one distance to the beginning of the other.)

Change To: N/A

Click To Enlarge

Center to center distance between 2
positional features.

Click DISTANCE icon

Then Select Two positional features

Change To Nearest and farthest

Click DISTANCE icon

Then Select Two positional features

Change To Nearest or Farthest
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Click To Enlarge

Farthest distance between 2
positional features
(at least one is radial.)

Click To Enlarge

Distance from a positional feature
perpendicular to a linear feature.

Click DISTANCE icon

Then Select A positional feature and a linear feature

Change To N/A

Click To Enlarge

Nearest distance from a circle/arc to
a line.

Click To Enlarge

Farthest distance from a circle/arc
to a line.

Click DISTANCE icon

Then Select Circle or Arc and a Line.

Change To Nearest and farthest
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Click To Enlarge

Distance from a
positional feature to a
plane

Click DISTANCE icon

Then Select A positional feature and a plane

Change To N/A

Click To Enlarge

Nearest/Farthest distance
from a sphere to a plane

Click: DISTANCE icon

Then Select: A sphere and a plane

Change To: Nearest/Farthest

 

Bounded distance
between lines

Click To Enlarge

Click: DISTANCE icon

Then Select: Two Lines

Change To: Nearest bound line distance, Farthest bound line distance,
Unbounded distance.

  

Nearest Farthest Unbounded

Click: DISTANCE icon

Then Select: A cylinder and a ~coaxial Linear feature.
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Center Line Distance
between cylinder and
~coaxial linear feature
(axis)

Click To Enlarge

Change To: Center Line, Nearest, Farthest, Unbounded.

Nearest/Farthest between
cylinder and ~coaxial
linear feature

Click To Enlarge

Click: DISTANCE icon

Then Select: A cylinder and ~coaxial linear feature

Change To: Nearest/Farthest

Unbound distance
between linear features

Click To Enlarge

Click: DISTANCE icon

Then Select: Two linear features

Change To: Center Line, Nearest, Farthest, bounded.
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Distance between
~coaxial planes

Click To Enlarge

Click: DISTANCE icon

Then Select: Two ~coaxial planes

Change To: N/A

Summary: 
The QC5000 supports many constructions, and chances are that you will not remember them all. That’s okay. Don’t
forget, you can attempt any construction you want; an error message is the worst thing that can happen (for that, just
click "hide warning" and try another construction). Remember to use the change icon from the measure toolbar to
manipulate constructed features after you have finished constructing (sometimes the feature that you want is just a
quick change away…don’t limit yourself by ignoring this feature).

You should now be able to:

Construct features and relations (with the aid of the construction charts)
Change constructed features and relations with the change option
Know the difference between Standard (all except slots), Linear (lines, cylinders, cones), Positional (point, circle,
arc, sphere), and Radial (circle, arc, sphere, cylinder) features. (remember, cylinders are linear and radial).

Tips: 
The first step in constructing a feature is always to tell the QC5000 what type of feature you want to construct.
If you want to construct a line between two points, select the line icon first!…then the points.
To duplicate a feature, just select the feature icon, and then the parent feature. If you want to duplicate a line,
select the line icon, and then the line you want to duplicate.
Use the CTRL key to make multiple selections with the mouse (hold this key down and "point and click"
normally to make multiple selections.
Don’t be afraid to experiment with constructions and construction changes…practice makes perfect.
If you’ve constructed an angle with the correct features, but the result is the wrong angle, chances are you can
change the angle into your desired angle.
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 Datum Rotation
 
In This Section...
To Rotate The Datum
 

Using the QC5000 Rotate function, you can rotate the current reference frame. Before beginning a rotation, note the
position of the RFI (reference frame indicator) in relation to the part you are measuring.

To Rotate The Datum (Reference Frame) 
1. Select Datum from the main menu. The datum drop down menu appears.
2. Select Rotate from the datum drop down menu. The Rotate dialog box appears.
3. Select the axis around which rotation will occur. Do this by selecting the appropriate radio button.
4. Enter the rotation amount. If your system displays angles in degrees minutes seconds format, then enter the

amount of rotation in degrees, minutes, seconds units. If your system displays angles in decimal degrees format,
then enter the amount of rotation in decimal degrees.
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 Customize
 
In This Section...
Colors / Errors / Help
Status Bar
Toolbars
Summary
Tips
 

To get to the QC5000 Customize tab box, select Tools from the main menu, and then Customize from the tools drop
down menu. The Customize tab box appears. Click on the tab heading that you want to modify: Colors, Errors, Help,
Status Bar, or Toolbars.

Colors / Errors / Help 
Colors:

You can customize many aspects of the QC5000’s appearance. You already know how to move and resize windows,
but you can also change their color. Select Tools from the main menu, then select Customize. From the list, select the
window that you want to customize; the window is highlighted when selected. Now click on the Set Color button. The
Color dialogue box appears. Select a color by clicking on a color with the mouse pointer. Now select OK. The Color
dialogue box disappears. At this point you can select OK from the Customize dialogue box to accept the change; or,
you can select Apply to see the change and leave the Customize dialogue box open. Notice the "user settable" box at
the bottom of the Customize screen, if this is unchecked then you may not be able to customize the QC5000
colors.

Errors:

You can enable and disable the various QC5000 error messages. Beginning at the main menu, select Tools >
Customize > Errors. Select the error that you want to enable or disable. The error is highlighted on the list when
selected. Now select Enable to turn the error "on" so that it will be displayed; or, select Disable to turn the error "off"
so that errors of this type will be ignored by the QC5000. By default the errors are all enabled.

Notice the option to: Disable all system error messages. Select this if you do not want to be notified of any errors, but
remember, this does not mean that errors are not occurring. The Error tab box can be user settable, or non-user
settable, so you may not be able to modify the settings here.

Help:

 Cylindricity is the tool tip shown here. The mouse pointer is represented here by the

file:///D|/MANUAL/featlist.htm
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black arrow.

Everything under the HELP tab box should be checked. Once you, and everyone else who uses your QC5000
(employees, friends, relatives) know what every toolbar icon, every window, and every result mean; then you can clear
some of these check boxes. The tips appear only when the check boxes in this tab sheet are checked. Tips are the little
rectangular information boxes that pop up when the mouse pointer is hovering over something.

Status Bar 
You select the items that appear on the status bar. It can display the current reference frame, projection, probe tip,
current layer, measurement units (inch/mm), and Cartesian / Polar mode. You probably want to display all of these at
first, and then modify the status bar as necessary. Don’t forget: the status bar doesn’t just display settings, it can be
used to switch between settings as well. Just click on the setting you want to change with the mouse pointer to cycle
through the available options. For example, click the projection plane setting to cycle through Auto, Off, XY, YZ, ZX
settings.

To customize the status bar

1. Select Tools from the main menu. The tools drop down menu appears.
2. Select Customize from the tools drop down menu. The Customize tab box appears.
3. Select Status Bar from the Custom tab box. The Status Bar tab moves to the foreground (appears).
4. Select an item that you want to add to or remove from the status bar. The item is highlighted when selected.
5. Select Show to place an X in the box beside the selected item. The X indicates that the item will appear on the

status bar; OR, select Hide to remove an X from the box beside the selected item. An empty box indicates that
the item will not appear on the status bar.

6. Select OK to accept the changes and return to the main screen.
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Toolbars 
You can add and remove icons from the toolbars. You can also make custom toolbars that contain a convenient
grouping of buttons that you assign to the toolbar. The Custom toolbars act just like the standard toolbars, except that
they are "empty." You will add and remove icons from the custom toolbars in the same way that you add and
remove icons from the measure, datum, tolerance, view, and probe toolbars.

To add and remove buttons from toolbars:

1. Select Tools from the main menu. The tools drop down menu appears.
2. Select Customize from the tools drop down menu. The Custom tab box appears.
3. Select the Toolbar tab. The toolbar tab moves to the foreground.
4. Select the toolbar that you want to modify from the Toolbar list. If the selected toolbar already contains buttons,

they appear on the Buttons In Toolbar list. The toolbar is highlighted on the toolbar list when selected.
5. Select the button that you want to add to the selected toolbar by highlighting it on the All Possible Buttons list.

Now click on the Copy button to add the selected button to the buttons in toolbar list. If you don’t want to add
any buttons to a toolbar, skip this step.

6. Select the button that you want to remove from the selected toolbar by highlighting it on the Buttons In Toolbar
list. Now click on the Remove button to remove the selected button from the buttons in toolbar list. If you don’t
want to remove any buttons from a toolbar, skip this step.

7. Once the toolbar contains all of the buttons you want it to, and no extra buttons, select Apply to have your
changes take effect.

8. Select OK to accept the changes and return to the main screen.

Note: You can add any buttons to any toolbar. You can remove any buttons from any toolbar. You can even
have one giant toolbar that contains all of the possible buttons.

Customizing toolbars...
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The measure toolbar is selected, so any changes that you make affect the measure toolbar.

The Remove button will take the measure magic button off of the measure toolbar (because measure magic is
highlighted on the buttons in toolbar list).
The Copy button will add Cylinder to the measure toolbar. Select Apply, and then OK to have the changes
implemented.

Summary: 
You can customize the QC5000 colors, help tips, errors, status bar, and toolbars; all from the Tools > Customize
option on the main menu. With a little practice, you’ll be adding and removing toolbar buttons and changing the color
of main screen elements to fit your preferences.

Tips: 
Leave all of the help tips checked until everyone who uses the QC5000 knows all of the buttons, icons, and
items down cold.
Leave the status bar full, and don’t forget that it can be used for more than just display—you can toggle between
certain options with it as well.
Remember, all of the Custom options can be set up as "user settable" or "non-user settable," so you may not be
able to modify some or all of these settings (unless you’re the supervisor).
Remember…just because an error message is deactivated doesn’t mean that the error is not occurring.
You probably want to leave the standard toolbars set up as they are; create custom toolbars for special purposes.

You can always move and resize windows with the mouse pointer.
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 Features
 
In This Section...
What Is A Feature?
Measuring Features
     Points / Lines / Planes / Circles / Arcs / Cylinders / Cones / Slots / Spheres
Feature Properties
Feature List
Measure Magic
Summary
Tips
 

What Is A Feature? 
A feature is any shape that the QC5000 will measure. Points, lines, planes, cones, cylinders, spheres, and slots are all
features. Features are the basic shapes that make up any part you may measure with the QC5000. A coffee mug, for
example, is a cylinder. If the mug has a handle, then the mug is a cylinder with an arc attached to it.

Features, in turn, are made up of points. A line, for example, is a two point feature. Of course, many points can sit on a
line, but to measure a line only two points are necessary. A plane requires at least three points, a cylinder six. Every
feature has a minimum number of points required for measurement, and some features require specific placement of
targeted points. This chapter will deal with each feature that the QC5000 supports, and explain individually the
probing requirements for each feature.

Measuring Features 

Measure drop menu
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When measuring features you must let the QC5000 know which feature you want to measure. There are two ways to
do this. You can select Measure from the main menu, and then select the feature you want to measure; or, you can
select the feature icon from the Measure toolbar. Both the main menu and the toolbar will bring you to the same
dialogue boxes for each of the features you select.

Measure Toolbar

This chapter will present the procedure for measuring each feature from the Measure toolbar, but remember, selecting
a feature from the Measure drop down menu is just like selecting that same feature from the toolbar.

Measure Magic icon

Note 1: Before measuring features you may want to review the section on proper probing technique.

Note 2: Each of the following features (except the point feature) is accompanied by a point map that displays a
minimum measurement.

Points: (1 point) 

 Point icon
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To measure a Point:

1. Select the Point icon from the measure toolbar. The measure point dialogue box appears.
2. Probe the desired point into the QC5000. If you have a touch probe, bring the probe into contact with the

targeted point. The point is entered automatically. If you have a hard probe, bring the probe into contact with the
targeted point, and select the Enter Pt. button from the Measure Point dialogue box. The Measure Point dialogue
box should now indicate that one (1) point has been entered.

3. Select OK to accept the measurement. The point appears in the part view. Information about the point appears in
the results window. The point has been added to the feature list.

4. Notice the Results window. It contains: feature name, derivation (probed, constructed), reference frame,
projection plane, and XYZ position.

Every feature that you probe will follow this same, basic procedure. You will enter points to create the various shapes
that the QC5000 will display onscreen. The method for entering a point will never change. If you have a touch probe
the point should always enter automatically (if not, your QC5000 is not set up to take full advantage of the touch
probe, re-read the Probes chapter). If you have a hard probe, you will always need to enter each point with either a
foot switch, a button, or the mouse. You will always select OK to accept a measurement and add it to the features list.

Lines: (2 points) 

Line icon

To measure a Line:

1. Select the Line icon from the measure toolbar. The Measure Line dialogue box appears. A line requires two (2)
points.

2. Enter a point along the desired line. A touch probe may enter the point automatically; otherwise, select Enter Pt.
with a foot switch, button, or mouse to probe the point into the QC5000. The Measure Line dialogue box
indicates that one (1) point has been entered.

3. Enter a second point along the desired line. The Measure Line dialogue box indicates that two (2) points have
been entered.

4. Select OK with the foot switch, button, or mouse to accept the line measurement. The line appears in the part
view. Information about the line appears in the results window. The line has been added to the feature list.

5. Notice the Results window. It contains: feature name, derivation (probed, constructed), reference frame,
projection plane, form (straightness; how well the probed points "fit’ the calculated result), XYZ position of
midpoint of bound line.

Note: If possible, leave a fair amount of space between the points you probe along the line. It is a good habit to evenly
space points around any feature that you measure.

Line probe points
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Planes: (Minimum, 3 points) 

Plane icon

To measure a Plane:

1. Select the Plane icon from the Measure toolbar. The Measure Plane dialogue box appears.
2. Enter a point on the plane. The Measure Plane dialogue box indicates that one (1) point has been probed.
3. Enter a second point on the plane. The Measure Plane dialogue box indicates that two (2) points have been

probed.
4. Enter a third point on the plane. The Measure Plane dialogue box indicates that three (3) points have been

probed.
5. Select OK to accept the plane measurement. The plane appears in the part view. Information about the plane

appears in the results window. The plane has been added to the feature list.
6. Notice the Results window. It contains: feature name, derivation (probed, constructed), reference frame,

projection plane, form (flatness), orientation of a line normal to the plane, midpoint position of rectangular part
view representation.

Note: If possible, space points evenly across the plane. Also, you are not limited to probing three points when
measuring a plane; three points is the minimum number of points necessary for measuring a plane.

Plane probe points

Circles: (minimum, 3 points) 

Circle icon

To measure a Circle:

1. Select the Circle icon from the Measure toolbar. The Measure Circle dialogue box appears.
2. Enter a point on the circle. The Measure Circle dialogue box indicates that one (1) point has been

probed.
3. Enter a second point on the circle. The Measure Circle dialogue box indicates that two (2) points



Features

file:///D|/MANUAL/FEATURES.HTM[6/28/2019 8:09:37 AM]

have been entered.
4. Enter a third point on the circle. The Measure Circle dialogue box indicates that three (3) points

have been entered.
5. Select OK to accept the circle measurement. Select Cancel to abort the measurement. As always,

Remove last will delete the most recent point.
6. Notice the Results window. It contains: feature name, derivation (probed/constructed), reference

frame, projection plane, XYZ center position, size (radius/diameter), form (roundness).

Note: You are not limited to three points when probing a circle, three is the minimum number of points required for
measuring a circle. Again, space points evenly around the circle.

Circle probe points

Arcs: (minimum, 3 points) 

Arc icon

To measure an Arc:

1. Select the Arc icon from the Measure toolbar. The Measure Arc dialogue box appears.
2. Enter a point at one end of the arc. The Measure Arc dialogue box indicates that one point has been measured.
3. Enter a point at the opposite end of the arc. The Measure Arc dialogue box indicates that a second point has been

measured.
4. Enter a point on the arc that lies between the first two points (as pictured). The Measure Arc dialogue box

indicates that a third point has been entered.
5. Select OK to accept the arc measurement. Select Cancel to abort the arc measurement.
6. Notice the Results window. It contains: feature name, derivation (probed/constructed), reference frame,

projection plane, center position, size (radius/diameter), form (roundness), and arc length expressed as an angle.

Note: You are not limited to three points when measuring an arc. Three is the minimum number of points required for
arc measurement.

Arc probe points
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Cylinders: (minimum, 6 points) 

Cylinder icon

To probe a Cylinder:

1. Select the Cylinder icon from the Measure toolbar. The Measure Cylinder dialogue box appears.
2. Probe a point at the top of the cylinder. The Measure Cylinder dialogue box indicates that one point has been

probed.
3. Probe a second point at the top of the cylinder, across from the first point. The Measure Cylinder dialogue box

indicates that a second point has been probed.
4. Probe a third point at the top of the cylinder, spaced equally between the first and second points. The Measure

Cylinder dialogue box indicates that a third point has been probed.
5. Probe a fourth point at the bottom of (or at least deeper into), the cylinder. The Measure Cylinder dialogue box

indicates that a fourth point has been probed.
6. Probe a fifth point at the bottom of the cylinder, across from the fourth point. The Measure Cylinder dialogue

box indicates that a fifth point has been probed.
7. Probe a sixth point at the bottom of the cylinder, spaced equally between the fourth and fifth points. The

Measure Cylinder dialogue box indicates that a sixth point has been probed.
8. Select OK to accept the cylinder and add it to the feature list. Select Cancel to abort the measurement.
9. Notice the Results window. It contains: feature name, derivation (probed/constructed), reference frame,

projection plane, axis orientation, axis midpoint position, size, form (cylindricity).

Note: You are not limited to six (6) points when measuring a cylinder. Six is the minimum number of points needed
for cylinder measurements.

Cylinder probe points

Cones: (minimum, 6 points) 
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Cone icon

To measure a Cone:

1. Select the Cone icon from the Measure toolbar. The Measure Cone dialogue box appears.
2. Probe a point at the top of the cone. The dialogue box indicates that one point has been probed.
3. Probe a second point at the top of the cone, across from the first point. The dialogue box indicates that a second

point has been probed.
4. Probe a third point at the top of the cone, spaced equally between the first and second points. The dialogue box

indicates that a third point has been probed.
5. Probe a fourth point at the bottom of (or at least deeper into), the cone. The dialogue box indicates that a fourth

point has been probed.
6. Probe a fifth point at the bottom of the cone, across from the fourth point. The dialogue box indicates that a fifth

point has been probed.
7. Probe a sixth point at the bottom of the cone, spaced equally between the fourth and fifth points. The dialogue

box indicates that a sixth point has been probed.
8. Select OK to accept the cone and add it to the feature list. Select Cancel to abort the measurement.
9. Notice the Results window. It contains: feature name, derivation (probed/constructed), reference frame,

projection plane, axis orientation, position of apex, half angle or full angle of taper, form (conicity).

Note: You are not limited to six points when measuring a cone. Six is the minimum number of points required for cone
measurement.

Cone probe points

Slots: (minimum, 5 points) 

Slot icon

To measure a Slot:

1. Select the Slot icon from the Measure toolbar. The Measure Slot dialogue box appears.
2. Enter a point from one side of the slot (as shown above). The dialogue box indicates that one (1) point has been

entered.
3. Enter another point from the same side of the slot (as shown above). The dialogue box indicates that a second

point has been entered.
4. Enter a third point at one end of the slot (as pictured). The dialogue box indicates that a third point has been

entered.
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5. Enter a fourth point at the middle of the opposite side of the slot (as pictured above). The dialogue box indicates
that a fourth point has been entered.

6. Enter a fifth point at the opposite end of the slot (as pictured above). The dialogue box indicates that a fifth point
has been entered.

7. Select OK to accept the measurement and add it to the feature list. Select Cancel to abort the measurement.
8. Notice the Results window. It contains: feature name, derivation (probed/constructed), reference frame,

projection plane, center position, size (length/width), angle (2d only).

Note: You are not limited to five (5) points when probing a slot. Five is the minimum number of points required to
measure a slot.
Note: Square end slots are not supported in release version 1.1

Slot probe points

Spheres: (minimum, 4 points) 

Sphere icon

To measure a Sphere:

1. Select the Sphere icon from the Measure toolbar. The Measure Sphere dialogue box appears.
2. Probe a single point at the top of the sphere. The dialogue box indicates that a single point has been probed.
3. Probe a second point on the equator of the sphere. The dialogue box indicates that a second point has been

probed.
4. Probe a third point on the equator of the sphere, some distance from the second point. The dialogue box indicates

that a third point has been probed.
5. Probe a fourth point on the equator of the sphere, some distance from the second and third points. The dialogue

box indicates that a fourth point has been probed.
6. Select OK to accept the sphere and add it to the feature list. Select Cancel to abort the measurement.
7. Notice the Results window. It contains: feature name, derivation (constructed/probed), reference frame,

projection plane, center position, size, form (roundness).

Note: When measuring spheres you are not limited to four points. Four is the minimum number of points required for
sphere measurement.

Sphere probe points
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Feature Properties 
Every feature has properties. Feature name, feature type, layer, reference frame, date created and source are a few
properties that every feature will have.

To view a feature’s properties:

1. Select a feature from the Feature List. The selected feature is highlighted.
2. Select Edit from the main menu. The edit drop down menu appears.
3. Select Properties from the edit drop down menu. The Feature Properties dialogue box appears:

Feature Properties dialog box

 

The Feature Properties dialogue box contains information about the selected feature. Name, Type, Layer, and
Reference Frame can be changed. Source, and creation date can not be modified. The check boxes in the lower left
corner indicate how the feature will appear in the part view—a feature can be hidden (invisible), dashed lines
(phantom), or displayed with a label (show name). You can even write notes about the feature in the "Notes" section.
OK accepts any changes you have made, and Cancel leaves the feature properties unchanged.

A second method for getting to the Feature Properties dialogue box is:
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1. Select a feature from the features list. The feature is now highlighted.
2. With the mouse pointer, Right-click on the highlighted feature. The features edit menu appears. (Right-click

means to click with the right mouse button instead of the left.)
3. Select Properties from the features edit menu. The Feature Properties dialogue box appears.

By right-clicking on a feature in the feature list, you can access the Feature Properties menu. In this illustration,
Circle 1 is highlighted on the feature list. When you right-click, the feature edit menu (shown here) appears. Select
Feature Properties from the bottom of the feature edit menu, and the Feature Properties dialogue box will appear (as
shown above).

The Feature edit menu can be used to:

Cut and Copy features (for user programming).
Delete the selected feature.
Select All to highlight the entire feature list.
Change the shape of a feature (see the Measure Magic section of this chapter).
Print Features to send your features to a printer.

Feature List 
For detailed information on the feature list, click here. You can use the Internet Explorer's BACK button to return to
this section.

Measure Magic 

  Measure Magic icon

Will Work For Will not Work For
Points Slots
Lines Angles

Circles Distances
Planes  

Spheres  
Cylinders  
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Cones  

When Measure Magic is active the QC5000 will interpret your probe hits, and automatically determine the type of
feature that you have probed. You will not need to select any features from the main menu or from a toolbar. You will
simply probe features, and accept measurements with either a button or foot switch. You will not need to leave the
CMM.

Before measuring with Measure Magic, there are a few things you want to double-check:

1. Under the Tools > Options > Measure menus, be sure that the Start Measure Magic on a probe hit check box is
checked. You may not be able to edit this screen (it may be grayed-out), but you will still be able to see if there
is a check in the box next to this selection. If this selection is not checked, and you do not have access to the
check box, ask your supervisor to change the setting for you.

2. In the Probe Library, the box that states: Auto Enter Possible must be checked for the probe tip that you are
about to measure with (make sure that your probe tip is the highlighted probe tip on the probe list). If the Auto
Enter Possible box is not checked, check it.

3. Under Probe on the main menu, Auto Enter must be checked.

When your touch probe and QC5000 are set up in this manner, each probe hit will be entered as a point. Also, with
this setup, Measure Magic begins calculating your feature with your first probe hit. When you select OK with
either a foot switch or a button, your feature appears in the part view, and you can immediately begin to measure
another feature (no interaction with the computer is necessary).

Practice this procedure to get comfortable with Measure Magic:

1. Be sure that the QC5000 is set up as described (above).
2. Probe a single point (but do not select the point icon). The Measure Magic dialogue box appears indicating that

one point has been probed.
3. Select OK by pressing the foot-switch or designated button. The point appears in the part view.
4. Probe a plane (but do not select the plane icon). The Measure Magic dialogue box indicates each time a point is

probed (remember, 3 points is the minimum for a plane).
5. Select OK by pressing the foot-switch or designated button. The plane appears in the part view.
6. Probe a sphere (but do not select the sphere icon). The Measure Magic dialogue box indicates each time a point

is probed (remember, 4 points is the minimum for a sphere).
7. Select OK by pressing the foot-switch or designated button. The sphere appears in the part view.
8. Continue probing planes, spheres, cones, lines, and points without selecting their icons until you are comfortable

with Measure Magic.

Note: Measure Magic will not work for slots, angles, or distances.

If you need to measure a feature that Measure Magic does not support (slot), you can still select the feature icon from
the measure toolbar. Just click on the slot icon, for example, and the Measure Slot dialogue box will appear. Measure
Magic will not interfere with the slot measurement, nor will the slot measurement disable Measure Magic. Once you
have measured the slot in the usual manner, you may immediately continue to measure with Measure Magic (MM will
begin on the first probe hit after you select OK for the slot measurement). Relations (angles, distances) can also be
measured in their usual manner (see the relations chapter in this manual).

If Measure Magic does not start on a probe hit:

If Measure Magic does not start when your probe contacts the part you are measuring, then your QC5000 is not set up
as described at the beginning of this section. This may be the standard setup for your company’s QC5000s. If this is
the case, then you will need to select the Measure Magic icon from the measure tool bar in order to activate Measure
Magic.

If you click on the Measure Magic icon the Measure Magic dialogue box appears (below). As with any feature
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measure box, this one indicates the number of points entered as you probe them. This dialogue box also has the same
four buttons as other measure boxes: OK (to accept a measurement), Cancel (to abort a measurement), Enter Pt (for
manual point entry), and Remove Last (to delete the last point entered). When you finish a measurement, the dialogue
box disappears.

If you double-click on the Measure Magic icon the Measure Magic dialogue box appears (below), but the box is
slightly different. The OK button now reads OK & Repeat. Each time you accept a feature measurement by selecting
OK & Repeat (with a foot switch or button), Measure Magic will automatically prompt you for another measurement.
If you can not set your QC5000 to start Measure Magic on a probe hit, then double-clicking the Measure Magic icon
will allow you to measure continuously without pausing to select feature icons from the measure tool bar. (Note: If you
stop the OK & Repeat cycle to measure a feature without Measure Magic, like a slot, then you will need to double-
click the Measure Magic icon to reactivate the Measure Magic OK & Repeat option).

The Measure Magic dialogue box. The OK & Repeat mode can be activated by DOUBLE-CLICKING on the Measure
Magic icon (found on the toolbar). Notice, two points have been entered. The box also indicates the current probe tip
(your probe may be named differently).

If Measure Magic creates the wrong shape (the CHANGE option)

Occasionally Measure Magic might create the wrong shape. For example, you measure a cone, but the QC5000
displays a sphere in the part view. Or maybe a three point line is mistaken for a plane (or vice versa). Don’t worry, the
QC5000 has a Change feature to take care of just such a problem.

If you want to change the shape of a feature on the feature list, just highlight the feature, and select Edit from the main
menu. Then select Change from the edit drop down menu. The change sub-menu provides a list of feature shapes, one
of which may be the shape you want. If the shape you want is on the list, select it. The QC5000 will either apply the
new shape to the part view, or issue a warning. If the QC5000 applies your shape, you’re all set (notice the new shape
name). If the QC5000 does not list the shape you are looking for in the change sub-menu, or if the QC5000 issues a
warning when you select the shape you want, you should delete the wrong shape, and re-measure the feature (chances
are that a second, careful measurement will provide the QC5000 with the data it needs to compute the proper feature).

To experiment with the CHANGE option:

1. Probe several features into the QC5000 using Measure Magic (try a plane, sphere, cylinder, and 3 point line).
One of your features may come up as the wrong shape, or they may all come up correctly, either way, you can
experiment with whatever you have.

2. Select one of the features (one that you want to change) from the Feature list. Remember, the selected feature is
highlighted on the feature list and in the part view.

3. Select Edit from the main menu. The edit drop down menu appears.
4. Select Change from the edit drop down menu. The Change sub-menu appears. It may contain only the option

name (you can change the name of any feature), or it may contain a list of feature shapes.
5. Select a new feature shape; or, if the QC5000 doesn’t provide any different shapes, return to step two (2) and
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select a different feature.
6. The new shape appears in the part view and the new name appears on the feature list.

Note: If none of your features can be changed (no shapes are offered), and they are all the shape that you intended
them to be, then you are a good measurer. If you want, probe some more features into the QC5000, eventually, you’ll
be able to change a feature’s shape.

The Power To Change

Select Edit from the main menu. Then select Change from the edit drop down menu. You may see a list this long, you
may only see Name…listed. Select the correct shape if it is listed. If the shape you want is not listed, or if the shape
you want, when selected, produces a warning, delete the wrong feature from the Feature List and do a second, careful
measurement.

Before:



Features

file:///D|/MANUAL/FEATURES.HTM[6/28/2019 8:09:37 AM]

Sphere 6 and sphere 4 are listed on the Feature List and displayed in the Part View. Notice that sphere 6 is selected on
the Feature List. The selected feature will always be the feature that any change (name or shape) affects.

After:

By selecting CHANGE, and then ARC from the list of features that were offered by the QC5000, sphere 6 was
changed into Arc 6. Notice the name change that automatically occurred on the Feature List.

Summary 
You will probably come back to this chapter from time to time (the first time that Measure Magic gives you an
incorrect shape, for example). Or whenever you’re not sure of the proper probe points for a particular shape (don’t
forget about the point maps that are included for each feature).

You should now be able to:

Measure features into the QC5000.
Measure features using Measure Magic.
Change the shape of features (when the QC5000 lets you)
Change the names of features.
Locate the Feature Properties dialogue box

Tips 
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When you probe points, remember to space them evenly across the feature
Use the point maps included with each feature to remember where certain features should be probed
Probe more than the minimum number of points on all features for greater accuracy of measurement
Use the measure toolbar icons when measuring features
Right-Click on a feature from the Feature List to get the feature edit menu. This will allow you to view the
feature’s properties, change the feature’s shape, and delete the feature.
Double click the Measure Magic icon to get the OK & Repeat prompt.
Probe technique and point placement are always the same whether you are using Measure Magic or not
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 The Feature List
 
In This Section...
Feature List
Feature Template Properties
Feature List Column Properties
 

Feature List 
The Feature List is available from the Windows menu. To open a Feature List, select the applicable Feature List Title

Windows Menu (without previously opened lists)

Windows Menu (with previously opened FEATURES List and PROGRAMS List)

Feature List Window

Showing columns for feature number, feature icon, feature pass state, feature name, and alignment.

file:///D|/MANUAL/tempplts.htm
file:///D|/MANUAL/index.htm
file:///D|/MANUAL/customiz.htm
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Feature Template Properties 
Place the cursor is over the main body of the Feature List window. Then select and hold the right mouse button to
display the following menu:

Select Template Properties... with the left mouse button to display the Feature Template Properties dialog box.

From the Feature Template Properties dialog box, you can adjust:
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Display
Grid
Sections
Filters
Locked
Runs Template

Display

Horizontal Lines - Toggles the display of gray separator lines between each row in the Feature List window.
Vertical Lines - Toggles the display of gray separator lines between each column in the Feature List window.
Expand Images (VED systems only) - Toggles between full size or iconic display of images in the Feature List
window.

Grid

Snap To Grid - Toggles whether or not the Feature List fields grid will resize in increments of 10 during resizing.
Grid Size - Allows you to change the default value (10) that fields will snap to during resizing.

Sections

Show Report Header - Allows you to create a customized header for a specific portion of data. Used for reporting and
printing purposes. 
Show Report Footer - Allows you to create a customized footer for a specific portion of data. Used for reporting and
printing purposes. 
Show Page Header - Allows you to create a customized header that will appear at the top of every page of reported
data. 
Show Page Footer - Allows you to create a customized footer that will appear at the bottom of every page of reported
data.

Filters

The Filters option of the Feature Template Properties dialog allows you to establish conditional values that will
determine which part values will be displayed in the Feature List window. By default, all parts are displayed in the
Feature List. However, you may want part value to display only when specific conditions exist during measurement.
There are many ways that this functionality can assist you, such as:

Quality Control / Statistical Analysis - Produce reports and/or historical part data to ensure production
consistency, (e.g., Only display part values when tolerance thresholds have been exceeded.)
Reports - You can create and print out detailed reports on specific part values with letter-head quality headers
and footers (see Sections), using easy-to-understand customization options.

Show Features / Hide Features

Show Features / Hide Features radio buttons - When creating a feature filter, you must first decide the how this filter
will present itself in the Feature List window. By default, all part features are displayed in the Feature List. However,
the purpose of filtering is to isolate specific information. You must then decide if you want the Feature List to display
only entries that match the parameters of the filter (Show Features) or remove entries from the Feature List that apply
to this filter (Hide Features).
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That meet all conditions / That meet any conditions

That meet all conditions / That meet any conditions radio buttons - In instances where multiple filters are being
used, you will need to decide whether all of the filters will:

Only filter information if all of the conditions defined in each individual filter have been met (That meet all
conditions).
or filter information if at least one of the filters conditions have been met (That meet any conditions).

Add Filter Button

Selecting this button will display the Filter dialog box.

The Filter dialog box contains the following regions:

Filter - In this region, you can either manually input values that will define the filter, or monitor, add, and edit
values placed here by the four common value palette buttons located to the right of this region.
Fields > common value palette...
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The Fields > submenu contains a palette of part field(s) that can be used to construct the filter.

Functions > common value palette

The Functions > submenu contains a palette of advanced mathematical variables.

Operators > common value palette

The Operators > submenu contains a palette of common mathematical operators.

Tolerances > common value palette

The Tolerances > submenu contains a series of nested submenus of tolerancing operators.

Other > common value palette

The Other > submenu contains a palette of miscellaneous variables.
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Modify Filter Button

If you need to modify an existing filter, select the applicable filter that you want to modify from the Filter region of the
Feature Template Properties dialog box, then select the Modify button to display the Filter dialog box. The Filter dialog
box will display the current filter parameters in the filter region. Select either the entire filter or only the portion you
want to edit with the mouse, make whatever changes are required, then select the OK button to complete the process. If
you are finished modifying filters, select OK again to close the Feature Template Properties dialog box.

Remove Filter Button

Simply select the filter that you want to remove from the Filter region of the Feature Templates Properties dialog box,
then select the Remove button. You will be asked to confirm your request the delete the selected feature. Select OK to
complete the removal process.

Locked

Selecting Locked in the Feature Template Properties dialog box instructs the QC5000 that only individuals that have
entered the correct supervisor password can edit the Feature Template Properties dialog box options.

Runs Template

Select this option will instruct the Feature List to display in Runs mode.

Feature List Column Properties 
To add, edit, or remove a column appearing in the Feature List, you must:

If adding a new column to the Feature List

1. Place the mouse cursor over the next available column header in the feature list.
2. Right click, with the mouse, on the column header. The following drop menu will appear:

3. Select Column Properties... with the left mouse button. The Column Properties dialog box will appear:
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Appearance Tab - settings in this tab will define how the column will appear in the Feature List.

4. In the Name field - Enter a value that the Feature List will use for the column header.
5. In the Width field - Enter a value that will determine the columns width. The column width can also be set in

the Feature List main window by placing the mouse cursor over the column divider line (in between each column
header).

6. In the Title Alignment field - Select whether you want the column header title to flush to the left edge, the
middle, or the right edge of the column header bar.

7. In the Data Alignment field - Select whether you want the data that will appear in this column to flush to the
left edge, the middle, or the right edge of the column.

Formulas Tab - settings in this tab will define what information will be displayed for this column in the Feature
List.

8. Add - Select this button to add a formula to the selected column. The following dialog box will appear:
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Enter Equation - settings in this dialog box define the parameters of a column formula.

— Label - The descriptive text that you enter here will be displayed in front of all values in this column. For
example, if this column is displaying the X coordinate for a specific part (e.g., 3.00334), then entering "X = "
(without the quotes) in the Label field will define what the displayed value is being derived from (e.g., X =
3.00334).

— Feature - 

— Formula - The Formula region consists of the following options:
Formula region - In this region, you can either manually input values that will define the formula, or add
values available from the four common value palette buttons located to the right of this region.
Fields > common value palette...
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The Fields > submenu contains a palette of part field(s) that can be used to construct the formula.

Functions > common value palette

The Functions > submenu contains a palette of advanced mathematical variables.

Operators > common value palette

The Operators > submenu contains a palette of common mathematical operators.

Tolerances > common value palette

The Tolerances > submenu contains a series of nested submenus of tolerancing operators.

Other > common value palette

The Other > submenu contains a palette of miscellaneous variables.
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— Result type: - The values available from this drop list will determine the way the Feature List will treat the
data being produced by the formula. Applicable values are:

Inch/mm — Data is a linear dimension
Angular — Data is an angular variable
Numeric — Data is in common numeric format
Text — Data is a text-based variable

— User constants are: - The values available from this drop list will determine the way the Feature List will
treat the data being produced by the formula. Applicable values are:

Inch — Data is to be formatted in units of inches.
mm — Data is to be formatted in units of millimeters.
Radians — Data is to be formatted as a radius value.
Degrees — Data is to be formatted in degrees.
Fixed — Data is to be formatted in the manner in which it is received.

9. Modify - If you need to modify an existing formula, select the applicable formula that you want to modify from
the formula region of the Formula tab of the Column Properties dialog box, then select the Modify button to
display the Enter Equation dialog box. The Enter Equation dialog box will display with the current formula
parameters. Select the portions of the formula you want to edit, make whatever changes are required, then select
the OK button to complete the process. If you are finished modifying formulas, select OK again to close the
Column Properties dialog box.

10. Remove - If you need to remove an existing formula, select the applicable formula that you want to remove from
the formula region of the Formula tab of the Column Properties dialog box, then select the Remove button to
delete the selected formula. You will be asked to confirm your decision to remove the selected formula because
this process is irreversible. Select the Yes button to complete this process. If you are finished working with the
formulas in this column, select OK again to close the Column Properties dialog box.
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 General Output
 
In This Section...
Exporting, Printing, and Outputting
DDE
Summary
Tips
 

Exporting, Printing, and Outputting
Select either Export..., Print..., or Output... from the image map below

Exporting 

QC5000 data can be exported in different formats. For example, you may want to export QC5000 features to a CAD
program; in this case, you would export the QC5000 features in the .dxf format.
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When exporting features, keep in mind that the DXF format does not support relations (angles, distances), and it does
not support points. Aside from relations and points, however, you can export any QC5000 features by selecting them
from the feature list, and then selecting Export from the File drop down menu.

Look at the left hand side of the status bar. If the data was exported successfully the status bar indicates so. If you do
not see this indication, then the file did not export properly.

Printing 

The QC5000 will print feature data, part view graphics, and even the feature stamp. The print command is located
under the file menu. Just click on File, and then select Print from the file drop down menu. The QC5000 will guide
you through the print process.

To Print:

1. Select File from the main menu. The file drop down menu appears.
2. Select Print from the file drop down menu. The print dialogue box appears.
3. Select the print option that suites your needs. Do this by clicking on the down arrow at the right of the Print

What? box. (these options are described below).
4. Select OK. The Enter Report Header Data dialogue box appears.
5. Enter the report header data. Do this by clicking in the Job, Part, and Operator fields with the mouse, and

entering names with the keyboard.
6. Select OK. Printing begins.

The Print What? dialogue box...
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If you select selected features...

The QC5000 will print a report, without part view graphics, that includes all of the features highlighted on the feature
list. The header of this report will contain the date, time, job (as you entered it), part (as you entered it) and operator
(as you entered it).

The report contains six columns of information: Feature (name, projection, type, origin, tolerances performed);
Position (X, Y, Z); Dimension; Tolerance (the specified tolerance zone); Results (pass /fail tolerance, amount over
tolerance); and Fail (for a quick pass/fail view as the last column).

If you select all features...

The QC5000 will print the complete list of features in the format described above.

If you select part view...

The QC5000 will print the part view graphic from the selected view pane. If you are working in the four pane part
view mode; or, if the feature stamp is activated, then you should make sure that the pane you want to print is selected.
The selected pane can be any of the four part view panes, or the feature stamp…the QC5000 will print whichever is
selected.

If you select features and part view...

The QC5000 will print the selected view pane, and the selected features from the feature list. You can use the edit
command select all to select the entire list of features.

Remember, the feature stamp acts like a view pane, and will print if selected. The feature stamp can also be
zoomed and manipulated like the other view panes.

Your printed document will contain the graphic from only one view pane. Also, your printed document will contain
the graphic as it appears in the part view. If you elect to print the single pane part view, but you have zoomed the
pane so that only a single feature appears in the part view, then only that single feature will appear on the printed
document. The view pane prints in a what you see is what you get manner.

The Enter Report Header dialogue box...
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Use the mouse to place the cursor in each field, and use the keyboard to make entries. Once you select OK, printing
will begin.

Outputting 

The Output option (on the File drop down menu), allows you to send QC5000 data to other DDE compatible programs
(Excel, SPC). Select File from the main menu, and then Output, and the Output dialogue box appears:

The Output Dialogue Box...

Use the mouse to place the cursor in the Application field, and then enter the name of the target program with the
keyboard. Enter the File Name in the same way, but be sure to include the file extension (.xls in this case); without
the file extension the output will not be successful.

Designate the column and row in which the output data will begin, and then select the type of data to output. Click on
the down arrow at the right of the Data field to see the drop down list of data types. If multiple features are selected
on the feature list, this list will include only the data types common to all of the features. Here’s the procedure, step by
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step, for outputting data (using Excel as an example target application):

1. Both the QC5000 and Excel must be running for data exchange to take place. If Excel is not running, open it
now.

2. Save a blank Excel spreadsheet as "Part.xls". Return to the QC5000 but leave Excel running with the Part.xls
file open.

3. Select the features from the feature list that you want to output. For this example we are selecting several planes
(remember to use the CTRL key to make multiple selections on the feature list).

4. Select File from the main menu. Then select Output from the file drop down menu. The Output dialogue box
appears.

5. Click in the application field and Enter "Excel" with the keyboard (do not enter quotation marks).
6. Click in the File Name field and Enter "Part.xls" with the keyboard (do not enter quotation marks).
7. Click in the column field and Enter "B" (do not enter quotation marks).
8. Click in the row field and Enter "5" (do not enter quotation marks).
9. Click on the down arrow at the right of the data field. The data drop down list appears.

10. Select XY Angle from the drop down list. Click on it to select it. If you have chosen only planes on the feature
list, then XY Angle will be available to you. If you have chosen other features and relations, the XY Angle may
not be available to you. If this is the case, select an available data type and continue with the demonstration.

11. Select OK to accept your entries and choices.

Toggle back to Excel. This should be simple since Excel was open and running the entire time. If the output was
successful, you should see something similar to this:

Note that the data begins in B5, just as you specified. This leaves you room above to insert titles and column
headings. You may find it easier to build the spreadsheet before outputting data to it. For example, insert a title,
and row and column headings; then output the data to the appropriate column and row.

DDE 
The QC5000 provides a generic DDE dialogue box. Select Tools>Special Steps>DDE, and the DDE dialogue box
appears.
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You can use this box to enter specific DDE commands into QC5000 programs. Enter any command that your target
application supports into the command field. For information on DDE commands supported by your target application,
refer to the manual that accompanied that application.

Summary: 
There are several ways to output data from the QC5000. You can print data, output it to a spreadsheet or SPC program,
export it in a different format to another application, or enter your own Dynamic Data Exchange commands.

You should now be able to output data from the QC5000.

Tips: 
When outputting to a spreadsheet program, name the spreadsheet file before outputting. Also, set up the
spreadsheet with titles and labels before outputting, this can minimize post-output revision.
When printing the part view remember that only the selected pane is printed.
You can print a customized part view (views that have been zoomed and rotated).
When exporting features in the .dxf format, relations, distances, and points can not be exported.
When outputting to a spreadsheet program, output like features together…this will allow the full range of data
type selection.
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A

anchor point 73

angles 64

constructing 91-92

auto apex point 201

application point 77

arcs 49, 89-91

 

auto projection 29

automatic probes

disk - appendix C

cylindrical - appendix C

 

 

B

best fit 73

bisector 73

bolt hole circle 85, 145-148

Buttons (tab) 197
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C

change 59-60

constructions 80

features 59

circles 48

constructing 85-87

constructions 71-95

pre-selection of features 201

non-universal 73

universal 73

conventions 72

cones 51

constructing 89-91

CTRL key 86, 95

custom

probes 22

toolbars 172

cylinders 50

constructing 89-91

 

 

D

.dxf 182

Datum Magic 39

on first probe hit 200

datum retrieval ball 200

datum rotation - appendix D

DDE (dynamic data exchange) 183
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Display (tab) 198

display resolution 198

distances

absolute 201

DRO 4-5

update only on a probe hit 201

duplication 73

 

 

E

encoder resolution 199

Encoder Setup (encsetup.exe) 188-190

troubleshooting 191-194

mm 199

Encoders (tab) 199

reversing count 199

type 199

Excel 180

extraction 73

 

F

feature list 6

feature properties 54

feature stamp (iv)

features 43

linear 72

positional 72

pre-selection of 201

radial 72
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standard 72

freeze 190

 

 

G

gage

ball 90

circle 86

General (tab) 200

 

 

H

hard stops 200

hardware setup 186

hidden features (see feature properties)

hole finding probe - appendix C

 

 

 

 

L

layers 161-167

lines 46

constructing 80-84

LMC 110

lock window positions 198

locked / unlocked features viii
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M

machine zero 1-3

setting "now" 200

Magnetic Planes (v)

automatic 201

main menu 4

main screen 3

toolbars 8

windows 5

maximize 7

Measure (tab) 201

Measure Magic 56

start on probe hit 201

minimize 7

MMC 110

 

 

O

offset 73

offset alignment - appendix B

Options tab box 195

origin 36

 

 

P

pan 157

part leveling 31

Part View (tab) 203



Index

file:///D|/MANUAL/M-INDEX.HTM[6/28/2019 8:09:58 AM]

part view 6

phase 189

planes 47

constructing 87-89

points 45

auto finish 201

constructing 75-80

primary alignment 31

cone 32

cylinder 32

plane 31

printing 177

probe 15

adding new 26

auto enter 19

automatic cylinder - appendix C

automatic disk - appendix C

compensation 19

cylinder - appendix C

debounce time 202

direction threshold 202

disk - appendix C

drop down menu 17

library 21

movement threshold 202

options menu 24

taper - appendix C

teach 20
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teach not required 202

technique 16

Probes (tab) 202

programming 139

recording 137

running 142

sample 145

projection 97-102

auto 29, 100

 

 

Q

qualification sphere 2

setting diameter 202

 

 

R

rear panel 187

reference frame

indicator - appendix D

rotation - appendix D

saving 37

switching between 38

relations 63

report 178

results window 6

reference - appendix E

xy, yz, zx angles - appendix E (z-aa)

RFI - appendix D
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rotation - appendix D

 

 

S

setting machine zero 1

skewing 33

SLEC(segmented linear error compensation) 1

slots 52

Sounds (tab) 204

SPC (statistical process control) 180

 

special probes - appendix C

spheres 53, 89-91

squareness 212

starting the QC5000 1

status bar 5

customizing 171

supervisor setup 185

Supervisor (tab) 196

symmetry 74

 

 

T

tangent

taper probe - appendix C

teach probe 20

teach not required 202

tilde 87, 101
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tolerance 9, 103-132

angle 130

bi-directional 106

circularity 117

concentricity 113

coplanarity 125

flatness 121

mmc/lmc 110

parallelism 125

perpendicularity 123

runout 127

straightness 115

sphericity 117

true position 109

width 170

tool tips 170

toolbars

activating 10

customizing 172-173

troubleshooting

encoder setup 191

software setup 205

 

 

 

U

user message 140, 147

user settable 195

user settings 200
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saving 200

 

 

V

view 151

from probe 154-155

preset views 153-155

toolbar 9

View rotator 11, 152

 

 

W

warning 1

unsupported constructions 74

Windows(i-iii)

windows

activating 7

 

 

X

xy angle - appendix E

 

 

Y

yz angle - appendix E

 

Z

zero 35-36
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zoom 155

window 155

in 156

to fit part 203

 

zx angle - appendix E
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 Layer Control
 
In This Section...
Layer Demonstration
     First... / Second... / Third... / Fourth...
Layer Control Dialog Box (diagram)
Summary
Tips
 

Layer Demonstration 

 The Layer Control icon

When you probe and construct features with the QC5000, you can assign these features to different layers. You may
assign the reference frame features to a layer of their own. You may assign all cylinders to their own layer. You may
assign a bolt hole circle, and the features necessary to its construction, to a layer. Once a group of features share a
layer, they can be turned on and off as a group; they can be hidden as a group; they can be assigned a color as a group;
and they can be viewed as a group.

Layer control will allow you to remove features from the part view without deleting them or selecting them
individually. In the following example you will probe a reference frame into the QC5000. Then you will probe features
into the QC5000. Finally, you will construct distances between the features. Once you are done probing and
constructing features, you will begin assigning these features to layers. Once the layers are set up, you will manipulate
them by changing their color and appearance in the part view. Just follow the example step by step. . .

First... 

1. Turn the QC5000 on and set the Machine Zero.
2. Probe a reference frame (skew the part, probe a Y axis line, and establish a zero point).
3. Probe three cylinders (follow the rules for probing cylinders that you learned in the Features chapter).
4. Probe two planes (follow the rules for probing planes that you learned in the Features chapter).
5. Probe a slot (follow the rules for probing slots that you learned in the Features chapter).
6. Construct a distance between two of the cylinders (follow the rules for constructing distances that you learned in

the Features chapter).
7. Construct a point from the slot (select point from the measure toolbar, then select the slot, then select OK).
8. Construct a distance between the slot’s point and the remaining cylinder.

After you have completed these steps, your part view and feature list should look something like this (part view as seen
from the top view):
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Note: This graphic is based on the QC5000 demo block, but any multi-feature part will do. Just be sure you have a
good number and variety of features probed into the QC5000.

Second... 

1. Click on the Layers icon from the View toolbar. The layer Control dialogue box appears.
2. Select New from the dialogue box buttons. The new layer entry box appears.
3. Enter the name Primary Layer, and select OK.
4. Select the New button again. The new layer entry box appears.
5. Enter the name Cylinders, and select OK.
6. Select the New button again. The new layer entry box appears.
7. Enter the name Distances, and select OK.

The layer control dialogue box should look like this:
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Once you have entered Distances, the Layer Control dialogue box will look like this. The highlight bar indicates that
Distances is selected. The check beside Distances indicates that it is the current layer. Any new features that are probed
or constructed will be assigned to the current layer. To set a layer as the current layer:

1. Use the mouse to highlight the layer that you want to set current
2. Click on the Set Current button. The check will appear beside the current layer only.
3. Select OK from the Layer Control dialogue box. The box disappears.

Now you have probed a part into the QC5000, AND you have created three new layers (Primary, Cylinder, Distance).
All of your features, however, are currently on the Default Layer, because this was the current layer where the features
were probed into the QC5000. Therefore, the third part of this demonstration will deal with assigning features to new
layers.

Third... 

1. Select all of the features that make up your reference frame (primary plane, skew line, Y line, XY intersection
point, and zero point if applicable). These features will be highlighted on the feature list when selected.

2. Right Click the mouse. The Edit menu appears (this menu can also be accessed by selecting Edit from the main
menu).

3. Select Feature Properties from the bottom of the Edit menu. The Feature Properties dialogue box appears.
4. Click on the arrow at the right of the Layer box. The drop down list of layers appears.
5. Select Primary Layer from the list of available layers. Primary Layer now appears in the Layer box.
6. Select OK. The feature properties dialogue box disappears.
7. Select all of the cylinders (remember, the CTRL key allows you to make multiple mouse selections). The

cylinders are highlighted on the feature list when selected.
8. Right Click the mouse. The Edit menu appears.
9. Select Feature Properties from the bottom of the edit menu. The feature properties dialogue box appears.

10. Click on the arrow at the right of the Layer box. The drop down list of layers appears.
11. Select Cylinder from the drop down list of layers. Cylinder now appears in the layer box.
12. Select OK. The feature properties dialogue box disappears.
13. Assign the distances to the Distance Layer in the same way that you assigned cylinders to the cylinder layer.

You have probed a part into the QC5000. You have created new layers, and you have assigned different features to the
different layers. Now you can manipulate the features in the part view by their layers.
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Fourth... 

1. Select the Layers icon from the view toolbar. The Layer Control dialogue box appears.
2. Select the Primary Layer. It is highlighted on the layer list when selected.
3. Check the box at the bottom of the Layer Control dialogue box that states: Hide In Part View. A check appears

in the box.
4. Select OK. The Layer Control dialogue box disappears. The part view has changed; none of the features that you

assigned to the Primary Layer can be seen. Notice that they are still on the feature list. Select Plane 1 (primary
plane) from the feature list—it reappears in the part view. The layer is hidden, not off.

5. Select the Layers icon from the view toolbar.
6. Select the Cylinders layer. It is highlighted when selected.
7. Check the box at the bottom of the Layer Control dialogue box that states: Off. A check appears in the box.
8. Select OK. The Layer control dialogue box disappears. The part view has changed; none of the cylinders appear

in the part view. None of the cylinders appear on the feature list either—this layer has been turned off.
9. Select the Layers icon from the view toolbar.

10. Select the Distance layer. It is highlighted when selected.
11. Select the Set Color button. The Color dialogue box appears.
12. Select a color (whatever you like). Do this by clicking on the color square with the mouse pointer, and selecting

OK.
13. Select OK from the Layer Control dialogue box. The distances now appear in the chosen color.

It is recommended that you practice with the layer control. Change the color of the features in each layer, as you did for
distances. Hide each layer, and then select features from the hidden layers from the feature list. Turn each layer off and
on. Experiment with the layers until you are comfortable manipulating them. Suggestion: try reassigning features to
different layers. You can assign features to layers individually; in other words, you could move a cylinder onto the
distance layer (just select the cylinder from the feature list, and then right click to get the edit menu). Layers will seem
easy with a little practice.

Layer Control Dialog Box 
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You can Delete, Rename, or Set the Color of the selected layer by clicking the buttons at the right. Use the Apply
button to see the effects of your changes without closing the Layer Control dialogue box.

Summary: 
Layer control will allow you to focus on specific features, and groups of features. You can establish a reference frame,
and then hide it from sight so that only specific features show. You can assign colors to layers, and you can even move
features between layers. Layers will make a part with many features easier to work with.

Tips: 
New features will be assigned to the CURRENT layer. When the QC5000 is first started, the current layer is the
default layer.
The selected layer in the Layer Control dialogue box is not always the current layer. The selected layer is
highlighted, and it is the layer that changes will affect.
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 Tutorial

 
In This Section...
Lesson 1: Establishing A Reference Frame
Lesson 2: Saving a Part File
Lesson 3: Feature Measurement
Lesson 4: Constructions
Lesson 5: The QC5000 Demo Part
Lesson 6: Working With A Multi-Sensor System
Tips
 

This tutorial is designed to guide a new user through the basics of feature measurement, feature construction,
and feature creation. Additionally, this tutorial will familiarize users with file management (opening, closing,
saving). Please note: before beginning this tutorial the QC5000 setup should be complete and Machine Zero
should be set**. For information on setting Machine Zero, refer to the Introduction to this manual.

The first two lessons of this tutorial are self contained. You will establish a reference frame (which requires
the probing or constructing of a few features), and then you will practice file operations (saving, opening,
etc..). Beginning with lesson three, the exercises will direct you to other portions of this manual for procedures
to follow, but you can always return to the tutorial once you've completed a lesson. Feel free to experiment in
the middle of any lesson.

**Note: You can perform this tutorial without setting Machine Zero, but the QC5000 will be unable to perform any global corrections
(SLEC, etc…). Relative measurements will still be valid, assuming the probe is qualified.

Note: This tutorial will refer to the QC5000 demo block that accompanied the system. You may substitute another part for the demo
block, but it is recommended that you use a part with features that are fairly simple to measure. Once you get the hang of things, you
can start trying the fancy stuff.

Lesson 1: Establishing A Reference Frame 
About the lesson:

In this lesson you will designate a zero point for the part that you are measuring.
You will probe and construct features.
You will practice proper probing technique.
You will open a new part.

Before Beginning, Make Sure...

The QC5000 is running.
Machine Zero has been set (see note above).
You are familiar with the method for entering points on your machine.
You are familiar with proper probing technique (Probes chapter).

Follow These Steps...

1. Orient the QC5000 demo block to the CMM stage.

1. The largest surface of the part is the bottom.
2. The flat, slanted surface is the left most portion of the part.
3. On the right hand side, the corner closest to you should be rounded. If it is, then you have the QC5000

demo block oriented correctly.
4. Be sure the part is fixed securely to the stage.
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2. Open a new Part File.

1. Select File from the main menu. The file drop down menu appears.
2. Select New from the file drop down menu. The New flyout menu appears.
3. Select Part from the flyout menu. The QC5000 prompt appears.
4. Read and note the prompt. You will be asked this question each time you open a new part file.
5. Select Yes to indicate that you wish to begin a new part.

3. Probe a Primary Plane.

1. Select the Primary Plane icon from the Datum toolbar:
2. The Primary Plane dialog box appears. The Primary Plane dialog box will indicate the number of points

that you have entered. Enter four points on the top surface of the part(space the points evenly).
3. Use Remove Last (if necessary) to delete the last probed point.
4. Once you have entered four points, select OK.
5. The Part View, Results Window, and Feature List are all updated to display the new feature. Since it is

the first feature it is Plane 1. Since it is a primary plane, it is indicated as "current zero."

4. Probe a Secondary (skew) line.

1. Select the Secondary Line icon from the Datum toolbar.
2. The Secondary Line dialog box appears. The Secondary Line dialog box will indicate the number

of points that you have entered.
3. Enter two points, evenly spaced, along the front surface of the part. The front surface is the

surface that faces you.
4. Select OK.
5. The Part View, Results Window, and Feature List are all updated to display the new feature. Since

it is the second feature it is Line 2. It is indicated as the skew.

5. Probe the "Y" alignment line.

1. Select the Line icon from the Measure toolbar.
2. The Measure Line dialog box appears. This dialog box will indicate the number of points probed,

as you probe them.
3. Enter two points, evenly spaced, along the left side of the part. Do not probe the points along the

slanted surface; probe them below the slanted surface on the surface that forms a 90 degree angle
with the CMM stage.

4. Select OK.
5. The Part View, Results Window, and Feature List are all updated to display the new feature. It is

Line 3.

6. Construct the X/Y intersection point.
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1. Select the Point icon from the Measure toolbar.
2. The Measure point dialog box appears.
3. Select Line 2 and Line 3 from the Feature List. Features are highlighted when selected. If you

hold down the CTRL key, you can make multiple, non-adjacent selections with the mouse.
4. Once both parent features(Line 2, Line 3) are selected, select OK from the Measure Point dialog

box.
5. The Part View, Results Window, and Feature List are all updated to display the new feature. It is

Point 4.

7. Construct the Zero point.

1. Select the Zero icon from the Datum toolbar.
2. The Zero point dialog box appears.
3. Select Point 4 (x/y intersection point) and Plane 1(primary plane) from the Feature List. Features

are highlighted when selected. If you hold down the CTRL key, you can make multiple, non-
adjacent selections with the mouse.

4. Once both parent features(Point 4, Plane 1) are selected, selct OK from the Zero Point dialog box.
5. The Part View, Results Window, and Feature Listare all updated to display the new feature. It is

Point 5, and it is indicated as the zero point.

Lesson 2: Saving a Part File 
About This Lesson:

You will Save An Open, Unnamed Part File.
You will Open A New Part File.
You will Re-open A Saved Part File.

Before You Begin.

1. You must have an open, unsaved file. If you have just completed Lesson 1, then you are set up for
this lesson.

2. If you are familiar with Windows file operations, this lesson will seem very basic. You can skip it,
but if you run into problems saving and opening Part Files, return to this lesson.

Save An Open, Unnamed Part File:

1. Currently, the QC5000 Title Bar (at the very top), and the Status Bar (at the very bottom),
indicate that the part is Untitled. If they indicate something other than untitled, then this part has
already been saved.

2. Select File from the main menu. The File drop down menu appears.
3. Select Save from the file drop down menu. The Save Part dialog box appears.

file:///D|/MANUAL/tutorial.htm#Tutorial
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4. Save the file by entering a unique filename, and choosing a directory. Select OK for the save to
take affect.

Open A New Part File:

1. Once you have saved a file, you can open a new file without losing the saved data. Select New >
Part from the file menu. The QC5000 asks you if you really want to perform this action (if you've
forgotten to save your file, you have a last chance).

2. Select Yes to open a new part file. The Part View, Feature List, and Results Window are now
blank. You can begin measuring a new part.

Re-open A Saved Part File:

1. Select File from the main menu.
2. Select Open from the file menu. The Open Part dialog box appears.
3. Navigate through the directories on your computer until you find the file you want to open. This

should be fairly easy if you have saved all of your QC5000 part files in the same directory…the
Open Part dialog box defaults to the QC5000 directory.

4. Highlight the file and select OK. The QC5000 will ask you if you really want to perform this
action…again, this is just a last chance to save the current part if you have forgotten to. Select Yes
to open the part file that you just selected.

5. The part opens, and you can now work with this part file.

Lesson 3: Feature Measurement 
Go to the Measuring Features section of the Features chapter in this manual (return here afterwards).
You'll notice that each feature type is described on a page that contains the feature's toolbar icon, probe
point diagram, and measurement procedure.

Begin with the "point" feature type, then continue through the Measuring Features section. Follow the
procedure for feature measurement for each type listed. As you probe each feature type, you'll notice
that some features require careful point placement (slots, for example)--feel free to measure a feature
several times if necessary--when you finish this section of the tutorial you should be relatively
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comfortable with basic feature measurement.

Once you've probed the final feature type (sphere), return to this place in the tutorial and continue on.
If at any point you want to deviate from this tutorial and spend some time experimenting with a specific
feature type or application, feel free to do so.

***************************************************************

At this point you should have probed (at least once): a point, a line, a plane, a circle, an arc, a cylinder, a
cone, a slot, and a sphere. If you missed any of these features for some reason, you may want to return
to the Features chapter and try probing the feature(s) you missed.

Lesson 4: Constructions 
About this lesson:

You will practice constructing features from other features.

Before You Begin.

If you've just completed Lesson 3, then you have a variety of features on the Feature List. If this is not
the case, you should now probe 3-5 features (of varying type) into the QC5000. Include at least one
circle.

QC5000 Feature Construction

QC5000 feature construction always follows the same basic procedure: you select a type of feature, then
you select the parent features, then you select OK. It's easy…let's walk through a basic construction.

Construct the center point of a circle.

1. Select the point icon from the Measure Toolbar (you also had to select this in the previous
lesson, when you probed a point). The Measure Point dialog box appears.

2. Select a circle from the feature list. The circle is highlighted when selected. Make sure the
circle is the only feature selected.

3. Select OK from the Measure Point dialog box. The point is added to the feature list and part
view. It also appears in the results window.

That was pretty simple, right. All you did was tell the QC5000 what type of feature you
wanted, and then you told the QC5000 what to use to make the new feature…it did the rest.

Construct a line.

1. Select the Line icon from the Measure Toolbar. The Measure Line dialog box appears.
2. Select the point that you constructed in step 1 above. The point is highlighted on the Feature

List when selected.
3. Select another feature (preferably a positional feature like a circle or sphere, but any feature

will do). This feature and the previously selected point should now be highlighted on the
feature list. If you need to make multiple, non-adjacent selections with the mouse, you can
hold down the control (CTRL) key while you point and click on those features that you want
to include in the construction.

4. Once both features are highlighted, select OK from the Measure Line dialog box.
5. The new line appears on the Feature List, in the Part View, and in the Results Window. You

can now use this feature in future calculations and constructions.
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Practice constructing features.

1. Use the existing features on the Feature List to construct new features.

The QC5000 User's Manual contains a chapter devoted to Constructions (it can
easily be found using the thumb tabs). This chapter contains examples, lists of
possible constructions, term definitions, and other information relevant to
feature construction.

You should now understand the concept of feature construction using parent features. You should also
understand the basic procedure for performing a construction: select the type of feature you will
construct, select the parent features, select OK…now for a more advanced lessons.

Lesson 5: The QC5000 Demo Part 
So far this tutorial has covered some of the basic groundwork necessary to operate the QC5000. In the
first lesson you stepped through the process of establishing a reference frame. In subsequent lessons,
you worked individually with feature measurement, feature construction, and file management. Here
you'll use all of these concepts together…

Orient the QC5000 Demo Part.

Before you begin measurement certain conditions must be met. Make sure that each of the
following conditions describes the setup of your QC5000.

1. The axes must read positively in the correct direction. Z is positive in the "up" direction. X is
positive when moved right along the stage. Y is positive toward the back of the stage (away from
the user).

2. The QC5000 Demonstration Block must be oriented correctly on the stage. Although you can
measure in any orientation, this lesson will be easier if you position the block the same way that we
did when we wrote the tutorial. Correct orientation: The largest surface of the block is the
bottom. The slant surface is at the left hand side of the block. The rounded corner is at the right
hand side of the block and toward the front of the stage.

3. Begin a new Part File. Select New > Part from the File menu.

Establish a Reference Frame

1. Establish a Part Zero on the left hand side of the part, at the corner closest to you. The actual part
zero will exist above the slanted surface of the QC5000 demo part at the level of the primary
plane (part zero does not necessarily have to be an actual point on the part).

2. If you don't remember how to establish a reference frame, refer to the first lesson of this tutorial.
3. Probe four bolt hole circles/arcs into the QC5000. Construct the bolt hole circle.

 

 

 

 

a. Probe circles A and C. They appear in the Part
View, on the Feature List, and in the Results

window as they are entered.
b. Probe arcs B and D. They appear in the Part View, on the Feature List, and in the Results

window as they are entered.
c. Construct the bolt hole circle.
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1. Select Circle from the Measure toolbar. The Measure Circle dialog box appears.
2. Select A, B, C, and D from the Feature List.
3. When all four parent features are selected, select OK from the Measure Circle dialog

box.
d. The new circle is added to the Feature List, Part View, and Results window.

4. Probe the main cylinder and tolerance it for "cylindricity."
a. At the center of the bolt hole circle that you just constructed there is a cylinder. Probe this

cylinder into the QC5000.
b. Note the result of the cylinder measurement. Compare the observed diameter to the

diameter indicated in the preface to this manual. They should be very close.
c. Select the cylinder. Be sure that it is the only feature selected on the Feature List.
d. Select Tools > Tolerance from the main menu. The tolerance flyout menu appears.
e. Select Cylindricity from the tolerance flyout menu. The cylindricity tolerance dialog box

appears.
f. Enter a tolerance zone into the cylindricity tolerance dialog box (a more detailed

explanation of this tolerance can be found in the Tolerance chapter). For now, enter .01 as
the tolerance zone. If you are familiar with tolerancing, this number seems very large…you
have permission to adjust it if you want.

g. Select OK. The cylindricity tolerance results dialog box appears. It indicates a pass or fail
value, and places a pass/fail marker beside the cylinder on the Feature List. Select OK to
accept the tolerance, or Edit to go back and reenter the tolerance zone.

5. Continue to probe Demo Block features. Construct Demo Block features. Tolerance Demo Block
features.

Lesson 6: Working With A Multi-Sensor System
System requirements: QC5000 with VED and contact probes.
Material requirements: Metronics calibrated glass slide and sharp edge ring guide.

Preparation

Ensure that the following is true:

The first time you try this tutorial, you may want to try a measurement immediately after each
phase of the calibration process to determine if the calibration is correct. The instructions to test
the calibration are listed at the end of this tutorial.
The calibrations must be done in a certain order to be successful.
If you are unfamiliar with the different probes or proper probing techniques, you may want to
read the Probes section before proceeding.
Lighting should be turned on and illuminating the stage. Many calibrations rely on accurate and
repeatable video edge detection. The basic conditions are a clean slide and medium light intensity.
You may get a sense of the intensity by viewing the filter dialog. Make sure you can get edges. If
not, teach an edge using the simple probe. See section on Edge teach below.
The VED image window in the QC5000 should be displaying an image from the camera.
Calibration artifacts should be on the stage. It may be necessary to secure them to the stage (tape
or brace). It should be possible to specify the nominal size of these artifacts in either inch or
metric units, depending on the current units of the system. Note that 0.03937007874 inches = 1.0
mm and 0.0196850 in. = 0.5 mm. MM is recommended for calibration.

Metronics "Chrome on glass" Calibration Slide (with close up of artifacts)
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Metronics 12.7mm Sharp Edge Ring Gauge (with magnified view of the top plane)

 

Encoders should be operational and set to the correct resolution. The encoders should correspond
to a right-handed coordinate system (e.g., moving the probe away from you (front to back) should
increase the Y value in the QC5000 DRO window, moving the probe to the right should increase
the X value in the DRO window). If you need to make any changes to the current settings, open
the CNC Options dialog box (Tools > Options > CNC Options... from the main menu).
Verify that the apparent direction of movement of a crosshair probe in the VED window
corresponds to the direction of movement of the contact probe. If it does not, modify the camera
orientation settings in camera properties. Check that these corrections did take place by moving
the probe up, down and left and right.
Set measurement mode to millimeters (mm).

Auto Focus

For each magnification, do the following steps. Be sure that lighting is appropriate by checking the
Filter dialog. See Pixel Calibration for more detail on lighting.
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1. Select an artifact to focus on (such as the 1mm artifact on the glass slide). The artifact must have
good contrast within the region of the height probe. You may also use the circle probe or the
buffer probe to calibrate auto focus.

2. Go to the Probe Library and Select the "Auto Focus" tab of the first magnification (see below).

3. Press "Set Current" to set the magnification current.
4. Press "Teach..." and follow the prompts.
5. Verify the object is in focus and select "Finish".
6. The acquired "Search Distance" will be displayed in the Probe Library Auto Focus tab.

Pixel Calibration

It is best to use bottom lighting for calibrations and for measurements in general. It is a good idea to
position the artifact where you can focus on it prior to setting a magnification because this dialog will
prompt you to enter the artifact size.

1. Select Probe, Probe Library, from the camera options select a magnification
2. Select the Resolution tab, then select the Teach (Pixel Size) button.
3. Follow the dialog prompts. The first thing you will do is set the artifact size in the dialog to the

true artifact size of the feature.
4. Select the circle probe, place the artifact in the circle probe, check "High accuracy" mode and

focus on the artifact.
5. Once you have completed a calibration, the values of X & Y should be non-zero in the Resolution

tab. You may measure a circle to check the accuracy of the size calibration; verify that the
Diameter value is within +/- 0.1 % of the actual object size or 0.1 pixel.

Do this for each magnification. Be sure to select an artifact that fits well in the screen, is centered and
check that lighting is appropriate (not saturated). You can check the light by right clicking the mouse in
the video window and selecting Filter. This will display a graphic that represents a histogram of the
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lighting condition. Experiment by moving the light slider up and down. Each magnification is unique so
adjusting the light will also affect the brightness uniquely; it is generally a good idea to hold the "light"
portion of the histogram at about 200 and to keep this consistent between magnifications.

Camera Skew

You should use the lowest magnification and select a circle that is "small" (less than 1/10 of the X
dimension of the image). In this calibration you will need to measure the same circle twice. You will
measure it near the left edge of the FOV (field of view) and then near the right edge of the FOV.

1. Select Probe, Probe Library
2. Click on VED, Camera, select Orientation. Notice that Camera Skew displays the most recent

camera skew angle. Click on Teach. You will be prompted to measure the circle as mentioned
above.

3. When that is completed check that the Orientation now is a value other than zero. The value
represents an angle.

4. To verify the calibration measure the same circle again on the left and right side of the FOV. The
Y position should be nearly the same. Note that if the X position is significantly different, it is
NOT due to camera skew error. Recheck the pixel size calibration.

Probe Edge Teach

The VED probes can be taught at any point, it is generally good to teach them to obtain 'good' edges
prior to calibration. Always check your ability to get points on edges when lighting is poor or if the
edges are not well defined. If you are not getting enough points then you need to edge-teach in order to
teach the VED probe to obtain edges under the current circumstances.

1. Select the simple probe. Click the right mouse button over the image window, from the fly-out
menu select VED EdgeTeach.

2. Select Auto and then press Advanced.
3. You will see an Edge Teach graphic and the current (Simple) probe will display a red point where

it is obtaining an edge.
4. If you enter different values to Min Contrast you will observe the red point shifting its position on

the probe to that 'edge'. If the Min Contrast is set too high you may fail to get good edges.
5. Select Teach, and then OK to conclude.

The VED probes can also be taught in the probe library by selecting a VED probe and selecting AF
teach in the dialog box. This will run you through the same prompts as above.

Magnification Offsets (parcentricity & parfocality)

Here you will be measuring from one designated magnification, the Master, to calibrate the others to.
High is usually the Master and you can tell this because under the Offset tab, Reference is check
marked and the offsets are all zero. One artifact will be used for all offset calculations. Select the 1.0mm
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circle.

Remember that for each magnification you will need to adjust lighting and focus on the artifact.

1. Verify that in High magnification that Reference is checked and it's offsets are 0. Do not teach the
master, it is not necessary.

2. Select another magnification, and under the Offset tab click Teach. This will automatically set the
magnification for you to calibrate. Follow the prompts to complete this action.

3. Once this has completed, check that the offsets in the Offset tab are non-zero.
4. Repeat this for all magnifications on this machine.

In-house instructions only:

One way to verify that you have calibrated correctly is to measure the same circle in each
magnification. To do this select File, New, Part and then measure the object in High magnification.
Select Datum/Zero and check X,Y,Z to set the center of that feature to zero. Then for each
magnification selected, select Tools, Goto Linear and goto 0,0,0 (not relative). Then measure the same
circle. When you are finished, all of the circles should have very nearly the same position and diameter
(within a fraction of a micron, or a little worse at low magnification). Evaluate the errors to see if it is
great enough to cause a problem. If there is a problem then you should re-calibrate that magnification.

Touch Probe Calibration and Cross Calibration; Probe and Camera

In this exercise you will be calibrating the Probe tip(s) and determine the "Cross-calibration". The
cross-calibration determines the offset between the touch probe and the camera (master).

You will first determine the tip size and offsets, then cross-calibrate. Always be sure to move the camera
up away from the object being measured so that the probe tip is not compromised (crashed).

Tip Size

1. Under the General Options, Probe, verify that the sphere size is set to your artifact size, usually
12.7mm for the Metronics ring gage.

2. Select Probe Lib, Contact Probes then select the reference tip and press Teach under the
size/offset tab. The reference box will be checked.

3. Measure a sphere or ring gage as indicated in the prompt.
4. Measurement of the artifact will allow the software to determine the tip size. You can check the

calibration by re-measuring the artifact. The feature size should be nearly that of the nominal
setting. The offsets of the "reference" tip are 0.0.

5. The same procedure may be used to teach other touch probe tips in the system, although that will
not be necessary for cross-calibration.

Probe

1. Verify that the camera high magnification is still set as Reference and the XYZ values are 0.0
2. Then select Probe, Probe Library. On the left screen half Probes will be displayed, on the right

side the existing probes (VED, Contact Probes), select Contact Probe.
3. Under the Offset tab, verify that the Reference is NOT checked and then click Teach.
4. This will run you though an exercise to measure the inside of a part. Verify the size of the part

against the size of the object.

Once this is completed, re-measure the object with the touch probe and the camera to verify a match;
select File, New, Part and then measure the same object. When you are finished, the circles should have
nearly the same position and size.

Tips: 
You can find more information on tolerancing and constructing features in the Tolerancing and

file:///D|/MANUAL/tutorial.htm#Tutorial


QC5000 V2 Manual

file:///D|/MANUAL/NM-TUTOR.HTM[6/28/2019 8:10:03 AM]

Constructing chapters of this manual.
If you want an explanation of Projection, try the 2d and 3d section of this manual. You should
experiment with projection to understand it.
Relations (angles / distances) are treated as any other feature. Relations can be probed or
constructed. Check out the Relations section of this manual for more on this.
Remember…most sections of this manual contain graphic demonstrations of the concepts they
explain as well as step by step instructions…try a few demos if you don't understand something.
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 Offset Alignments
 
In This Section...
Aligning A Part Using Three Positional Features
     Before You Begin:
     To Perform The Offset Alignment:
Tips / Troubleshooting
 

Aligning A Part Using Three Positional Features 
Before You Begin:

You must know the nominal location of three points (the nominal center of a three dimensional positional feature is
acceptable).

To Perform The Offset Alignment:

1. The part must begin approximately aligned with the machine coordinate system. If the part is not aligned in this
manner, use the Datum Rotation function to bring the part into approximate alignment.

2. For this type of alignment, features must be non-projected positional features (e.g. Positional features with
Projection Plane equal to either "3d" or "off").

3. With projection set to off, perform all necessary measurement to get the three positional features that you will
use for alignment (remember, you must know their nominal positions).

4. Optional: delete all features from the feature list except the three points (or positional features) that you will use.
5. Select Datum > Primary > Plane. The Primary Plane dialog box appears.
6. Select Create. The Create Plane tab box appears.
7. Select the Offset tab. The offset tab screen should now be visible.
8. Indicate which type of plane you want to create (XY, YZ, ZX) by selecting the appropriate radio button.
9. Enter the nominal position for each of the three points (or positional features) on the feature list (e.g. for an

"XY" plane, enter nominal "Z" values) The position must be entered into these boxes, from top to bottom, in the
order that they appear on the feature list.

10. Select OK to close the Create dialog box. The Measure Plane dialog box is again active.
11. Select the three points from the feature list (by highlighting them), and then select OK from the Measure Plane

dialog box. Now the plane is created; all three points should exist at their nominal "Z" height.
12. Select Datum > Secondary Alignment, the Secondary Line dialog box appears.
13. Select Create from the bottom of the Secondary Line dialog box.
14. Select Offset from the Create Skew tab box.
15. Enter the nominal skew values for two of the points.

a. If the alignment (skew) is along the "X" axis, then enter the nominal "Y" positions for the first two
points of the three original points on the Feature List.

b. If the alignment (skew) is along the "Y" axis, then enter the nominal "X" positions for the first two
points of the three original points on the Feature List.

c. Be sure to enter the nominal positions in the same order as the features appear on the Feature List.
d. Select OK.

16. The Secondary Line dialog box should now be in the forefront. Select the two skew points (that you entered
values for in step 15) from the feature list by highlighting them, and then select OK from the Secondary Line
dialog box. These two points should now be located at the correct offset compared to the datum for which you
entered values.

17. Move the zero of the final axis to one of the original points (or positional features). To do this :
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a. Select Datum > Zero from the main menu. The Measure Zero dialog box appears.
b. Select any 1 (one) of the three original points (or positional features) by highlighting it on the Feature

List.
c. Place a check next to the axis you are zeroing (if you entered "Y" values in step 15, you will zero the

"X" in this step). Be sure to check only the axis that you will zero and leave Auto Zero checked. Note:
if you zero all the axes during this step, you have negated all of your previous work.

d. Once you have placed a check beside only the appropriate axis and selected one of the original points:
Select OK

18. Create the final zero point.
a. Select the point icon from the Measure toolbar.
b. Select the Create button from the Measure Point dialog box. The Create Point dialog box appears.
c. Two of these values will remain 0.0. One value will be the mathematical opposite of the nominal value

that you replaced with 0 in step 17c (e.g. if you zeroed the "X" axis of point "1" in step 17c, and the X
nominal of point "1" was 5.0, then you should enter -5.0 in the X field of the Create Point dialog box).

d. Select OK from the Create Point dialog box. The point is added to the feature list.
19. Now construct a zero.

a. Select the 0 (zero) icon from the Datum toolbar.
b. Select the point that you created in step 18 (by highlighting it on the feature list).
c. Select OK from the Measure Zero dialog box.
d. This point is added to the feature list; it's coordinates should be 0,0,0.

Tips / Troubleshooting: 
Nominal values for all three points must be known to perform a three dimensional offset alignment.
Don't be confused at step 15; you enter the nominal values for the axis that is not the skew.
At step 18, don't forget to reverse the sign of the nominal value that you enter.
You will expect to see deviations. Don't forget, the measured points that you use are not precisely at nominal--
their measurement will reflect their actual position.
Use the notes page. It will make this process easier if you write down information that helps you to perform
offset alignments.
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 Options
 
In This Section...
Options Dialog Box
     Supervisor Tab...
     Buttons Tab
     Display Tab
     Encoders Tab
     General Tab...
     Measure Tab
     Part View Tab
     Probes Tab
     SLEC Tab
     Sounds Tab
     Square Tab
Summary
 

Options Dialog Box 
The QC5000 V2 General Options dialog box (available from the "Tools" drop menu) tab box contains supervisory
settings. To make changes in a tab box, you must know the supervisor password. Once you have entered the password,
everything in the Options dialog box can be altered.

Each individual tab has three things in common with all of the other tabs. Each tab has a name that is always visible,
even when another tab is active. Click on the "name" portion of a tab to make it the currently active tab. Each tab has a
body that appears only when it is the selected tab; this portion of the tab contains setting options specific to the selected
tab. Finally, each tab has a user settable check box in the lower left corner of the tab. When this option is checked
anyone can enter the tab and make changes, the supervisor password is not necessary if the user settable box is
checked. Generally, you will want to leave the user settable check boxes empty since many of the settings in the
Options tabs are static, one-time settings.

To access the Options dialog box:

1. Select Tools from the main menu. The Tools drop down menu appears.
2. Select Options from the drop down menu. The Options tab box appears.

Options Dialog Box Settings Tabs:

IMPORTANT: When the Options dialog box appears, any one of the tabs may be active (in front). You will need
to select the Supervisor tab if you want to make any changes within the tab box. If you don't want to make
changes, you can view the grayed out tab boxes by clicking on their names.

Supervisor...
Buttons...
Display...
Encoders...
General...
Measure...
Part View...
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Probes...
SLEC...
Sounds...
Square...

Supervisor... - Back To Settings Tabs

Note that this screen contains no "user settable" box in the lower left corner…it is the only tab that lacks this
option. If you select, "Keep privileges until program is exited," you will be able to make changes in the tab box
until the QC5000 has been shut down.

Click on any of the tab names: Buttons, Display, Encoders, General, Measure, Part View, Probes, SLEC, etc. to display
the options for the selected tab.

The OK and CANCEL buttons are always visible. OK can be selected at any time to accept all changes. CANCEL can
be selected at any time to abort all changes. Both OK and CANCEL exit the Options screen.

Buttons... - Back To Settings Tabs
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The Buttons tab is used to specify the function of external buttons. These buttons can be small buttons held to the
CMM arm with Velcro, or a larger foot switch, or both. In any case, this tab allows you to designate the function of
button 1 and button 2.

Notice that most of the functions you can assign to the buttons are functions displayed in the measure dialogue boxes.
This options tab is important for optimizing the efficiency with which you operate your machine…set this tab up to
keep an operator from interacting constantly with the computer via the mouse or keyboard. (If Measure Magic starts on
a probe hit, one button is set for accept measurement, and the other is set for remove last, mouse interaction is
minimal).

Display... - Back To Settings Tabs
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In general, you should set your display resolution to the same value that you set your encoder resolution. Set your angle
resolution to an appropriate setting for encoders (a rotary encoder, for example, will have a finite angular resolution).

Once again, you are given the option of designating this tab as "user settable."

Encoders... - Back To Settings Tabs
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NOTE: TTL and Custom 1, 2, 3 are the only valid encoder type choices.

Enter your encoder resolution into this screen. Make sure that the millimeter boxes are checked (you can view your
results in inches on the main screen, but the resolution must be entered metrically here…the QC5000 will do the
conversion).

If one of your axes is counting "backwards" (negative in the direction that you want to be positive), just select the
"reverse" check box next to that axis.

Once again, the option to designate this tab as "user settable" exists.

Encoder Types

Be sure to select the correct encoder type on this screen. If you have TTL encoders: X, Y, and Z should all have TTL
Encoder selected in the list boxes. If you have any other type of encoder: X is Custom_1; Y is Custom_2; and Z is
Custom_3.

General... - Back To Settings Tabs
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The General tab allows you to save settings without exiting the Options screen. When you specify the method for
setting the machine zero on your CMM, you will do so here. Select Set Now to probe a datum retrieval ball, or move
your machine to its hard stop zero point.

If you do not set the machine zero when the QC5000 starts up, this is the only other way to do it. Generally, you should
set a machine zero right away (daily users will probably not have access to this screen).

If you want your first several features to compose an alignment every time you use your machine, then check the "Start
Datum magic on a probe hit if there are no alignments" box. Remember, if a user will be measuring parts for which no
alignment is necessary, this option could prove time consuming.

Measure... - Back To Settings Tabs
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The feature defaults section allows you to specify the default display characteristics of the four feature groups. Display
characteristics for any individual feature or layer can be altered in the feature properties and layer control dialog boxes.

If Start Measure magic on A Probe Hit is checked: the first probe hit after an acceptable measurement will always
restart Measure Magic. It is an automatic "OK and Repeat" mode.

If Allow pre-selection of features for constructions is checked: you will be able to select features from the feature list,
and then select a type of construction from the measure toolbar (instead of choosing the distance icon, and then two
points; this option allows you to choose two points, and then the distance icon).

If Update DRO only on probe hits is checked: the DRO will not count continuously, it will display the location of the
last probe hit.

If Create a point feature for the apex of angles is checked: the QC5000 will automatically add angle apex points to the
feature list.

If Always display distance values as positive is checked: distances will always be displayed as a positive measurement.

If Treat work planes as Magnetic Planes is checked: two dimensional features will snap up to the surfaces of planes
automatically.

Part View... - Back To Settings Tabs
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The 2 pane / 4 pane view can be toggled here, but this setting can be changed from the View toolbar as well. If you
want to lock a user into a certain view, you need to remove the 2 pane / 4 pane buttons from the view toolbar.

This tab allows you to set the size of measured "points." In this case a point will appear as a 5 pixel object in the part
view.

Probes... - Back To Settings Tabs
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This tab is also explained in the "Probes" chapter of the User's Manual. Enter the diameter of your qualification sphere
(make sure that mm is checked if you are entering millimeters). When you use "Star probe auto selection, the QC5000
needs to know how far the probe must travel along the intended axis before it acknowledges that a new tip has been
selected (this value is easily entered in millimeters or inches).

Probe hit debounce time allows time for the internal switch to settle on a probe hit, and the Probe direction threshold,
measured in scale counts, is the limit that the probe must exceed before the QC5000 determines that movement in the
given direction is intentional.

Check the "allow teach not required" box if you need to qualify non-spherical probes (automatic cylinder probes, disk
probes, etc…).

SLEC... - Back To Settings Tabs

Segmented Linear Error Correction

The QC5000 will perform segmented linear error compensation. To perform error compensation, select
Tools>Options>SLEC. You will probably need to enter the supervisor's password in order to make changes in the
SLEC tab . . . just click over to the Supervisor tab, enter the password, and click back to the SLEC tab. You will now
be able to make changes in this tab.

SLEC requires a repeatable machine zero. There is no way to perform SLEC if your machine does not have a
repeatable machine zero. All of the corrected points that you will enter during SLEC setup depend upon machine zero.

QC5000 SLEC does not need to begin at zero. You can enter negative values into the SLEC setup field to correct for
points that lie along the negative portion of each axis (as referenced from machine zero). Notice the QC5000 DRO
count . . . if it displays a negative number, and you want to correct the point, you should enter the standard as a
negative number (if the standard is -2.00, and the observed is -2.01, these are the numbers you should enter).
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You do not necessarily need to enter SLEC values in numerical order. You can enter the zero point before entering
standard -2; in fact, that's what we recommend . . . enter the zero point for each axis first. This is the easiest way to
begin SLEC with the QC5000 because your zero point will be uncorrected (standard and observed for the zero point of
each axis will be 0.00 [zero]).

Each axis will have two SLEC end-points: a positive and a negative. If your machine zero is at the bottom left hand
extreme of your stage, and the "z" zero sits on the stage itself, you may not have any negative space to measure in. In
this case, one of the end points for each axis will be zero, and the other end point for each axis will be some positive
number along the length of the axis. It is important to understand how the QC5000 handles the final SLEC point(s) of
an axis.

How the QC5000 Handles the last SLEC point(s) along an axis

There are two possibilities. The final SLEC point can be corrected, or uncorrected. If the point is uncorrected (any case
where standard and observed values are identical, including machine zero) then no correction will occur along the axis
beyond this point; in other words, observed values for points beyond the last SLEC point will not be altered.

In the second case--where the last SLEC point(s) along an axis is corrected (any case where the standard and observed
values differ)--correction will continue beyond the final SLEC point in a constant manner. If the final SLEC point
along an axis correct for an error of .5 microns, then every point beyond the corrected point will be corrected by .5
microns.

There is one final note about the final SLEC point along an axis. If you want the error correction beyond the final
point to taper off in some manner you can enter an artificial point with an identical standard and observed value.
Unless you know exactly what you're going after, though, you should probably enter SLEC points along the entire
'working' length of the stage.

The Steps...

The SLEC Tab (Options Dialog Box)
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The SLEC tab of the Option dialog box is not difficult to understand. Just be sure that all axes are disabled before you
begin entering points, or using the DRO as a guide. If the axes are enabled, and have correction, you can generate
some very inaccurate results. Also, remember to select a New X, Y, or Z after you've entered values into the Standard
and Observed fields.

1. The QC5000 is up and running, and the machine zero has been set.
2. Access the SLEC screen by selecting Tools>Options>SLEC (you may need to enter the supervisor password to

enable this screen…just click the Supervisor tab and enter the password).
3. Be sure that the three check boxes at the bottom right of the SLEC screen are clear (unchecked). If any of these

boxes is checked, you will be correcting the corrected points along that axis . . . this is a bad thing.
4. Click the New X button. The uncorrected zero point for the X axis is entered.
5. Click the New Y button. The uncorrected zero point for the Y axis is entered.
6. Click the New Z button. The uncorrected zero point for the Z axis is entered.
7. Now enter your first SLEC corrected point for the X axis. Do this by editing the standard and observed fields at

the bottom of the SLEC screen, and then clicking New X to enter the values into the SLEC point list.
8. Enter all of your X values in the same way. First enter the numbers into the Standard and Observed boxes, and

then click New X to send the numbers to the list.
9. Once X is done and correct, begin entering Y values in the same way (except click New Y to send values to the

list).
10. Enter Z values in similar fashion.
11. If you enter a point accidentally, or for any reason decide you want a point deleted from the list, highlight the

point on the list and click the Delete button.
12. Once the list contains all of the values you want it to, and no extra values, then you can enable the corrections.

Do this by placing checks in the "X axis on," "Y axis on," and "Z axis on" check boxes.
13. Make sure the "user settable" check box at the bottom left of the screen is clear (unchecked)--you don't want a

curious person getting in here and messing up your corrections.
14. Select OK from the right of the tab screen. Cancel will abort the error correction and you will lose all of the
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values you just entered.
15. You axes should now be corrected. If you want to disable error correction, you can return to the SLEC screen

and remove the check from any of the active axes.

Tips...

Remember to disable any SLEC correction before entering new corrections, or checking for, new corrections.
Practice with SLEC entries once before actually doing the formal correction…you will quickly get the hang of
entering values.
Enter zero as your first value, it is the first SLEC default entry.
If you must enter a value other than zero you will need to delete the default zero value (but why take this step,
you will be entering zero at some point).
The machine zero is very important. It must be repeatable. It must be set before you check for and enter error
correction, and it must be set each time the QC5000 is launched (if you want error correction to occur).

Sounds... - Back To Settings Tabs

Just place a check beside any item for which you want a sound. You can test the sounds by clicking on the
exclamation points. As always, this tab contains a "user settable" option.

Square... - Back To Settings Tabs

Software Squareness Correction

The perfect CMM has 90 degrees between each pair of axes. The QC5000 can correct for small deviations in CMM
"squareness".
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Before you begin:

Axis linear errors should be evaluated, and corrected if necessary (SLEC).
Apply mechanical adjustment to the CMM axes to get them very close to orthogonal (90 degrees to each other;
right angles).
You will need a "bar-ball."

To test for squareness, and then "square" the CMM axes:

1. Be sure that any existing squareness correction is turned off.
2. Position the ball-bar so that its axis is oriented at a 45 degree angle to the "X" axis of the CMM. This

orientation must be within 1 (one) degree of 45 degrees to adequately perform this procedure.
3. Measure the length of the ball-bar; note the length.
4. Position the ball-bar so that its axis is oriented at a 135 degree angle to the "X" axis of the CMM. This

orientation must be within 1 (one) degree of 135 degrees to adequately perform this procedure.
5. Measure the length of the ball bar; note the length.
6. Check the squareness. If the two lengths differ significantly, then the axes are out of square. If the two

lengths are nearly equal, then your axes are square. Continue to step 7 if your axes are not square;
discontinue this procedure if they are square.

7. If your axes are not square: select Tools > Options > Square. The Square tab appears.
8. Enter the observed length data under the "Square" tab. You can correct squareness in all three machine

planes by performing steps 1-6 for XY, YZ, and ZX orientation.
9. Activate the corrections.

Tips:

Once these corrections are enabled, the radial (45 degree orientation) and tangent (135 degree orientation) length
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measurements should be nearly equal and should also equal the average of the uncorrected tangent and radial
lengths.
Remember to correct for all three machine planes: XY, YZ, ZX.
Mechanical alignment should be done as carefully as possible; the software should be correcting for a
significant, but small error.

 

These two orientations (45 deg. And 135 deg.) must be measured for each of the three machine planes. Here X, Y is
pictured. The 45 degree orientation is termed radial; and the 135 degree orientation is termed tangent.

Summary: 
The Options screen contains a lot of settings that rarely change, so most of the options tabs are locked out with the
supervisor’s code. If you think you might need to change one of these "locked-out" settings, tell your supervisor.

IMPORTANT: You may need to change a setting in the QC5000 Options screen regularly…in this case, your
supervisor will most likely check the "user settable" box on the appropriate tab. If this box is checked, no code is
necessary to make the required changes in the appropriate tab.
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 Probe Calibration
 
In This Section...
Probe Calibration
     A. Setup
     B. General Comments
     C. Pixel Calibration
     D. Camera Skew
     E. AutoFOCUS
     F. VED Magnification Offsets
     G. Touch Probe Calibration
     H. Cross Calibration; Probe and Camera
Troubleshooting: Calibration Check
Summary
Tips
 

Probe Calibration 
Important: Be sure the Probe is in the up position before starting any procedure.

This section will cover the complete calibration of all the probes of a multiple probe and multiple magnification system
(i.e. VED and touch probe). 

Note: This scenario does not include multiple cameras or index probes. Multiple probe tips may be used as long as
they are interchangeable (e.g. TP20).

A. Setup

1. Obtain the necessary calibration artifacts - Metronics calibrated glass slide and "sharp edged" ring gage. You
may also use a sphere, if available, for touch probe calibration. It may be necessary to secure the artifacts on the
stage to avoid accidental displacement.

2. Check that the encoders are working properly and that they are set to the correct resolution. Verify that the
direction of the encoders corresponds to a right-handed coordinate system for the touch probe.

3. Verify that the direction of movement of a crosshair probe on the VED image corresponds to the direction of
movement of the touch probe (i.e., verify that moving the probe left decreases the value for X in the DRO and
that moving the probe forward (away from you) decreases the value for Y in the DRO). If it does not, modify the
camera orientation settings in Camera Properties.

4. Check that these corrections did take place by moving the probe up, down, left, and right and verifying that the
DRO is updating accordingly.

B. General Comments

1. Use a chrome-on-glass slide and/or ring gage for setup and calibration. Specify the nominal size of these artifacts
in the option tab.

2. Many calibrations rely on accurate and repeatable video edge detection. The basic conditions are a clean slide
and medium light intensity. You may get a sense of the intensity by viewing the filter dialog.

3. When calibrating, you may want to try a measurement immediately after each phase of the calibration process to
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determine that the calibration is correct.

C. Pixel Calibration

1. Display the probe library and select the camera on the left side of the page. Select a magnification on the right
side, Select the resolution page and press teach (Pixel Size). Follow the instructions.

2. Repeat for each magnification. You may want to use high accuracy mode when doing this calibration.

D. Camera Skew

You should select a circle that is small enough (< 1/10 of the X dimension of the image) to move from one side of the
screen to the other.

1. Select Probe, Probe Library
2. Click on VED, Camera, select Orientation. Notice that Camera Skew displays the most recent camera skew

angle. Click on Teach and follow the prompts.
3. When calibration is completed the camera angle displays a value other than zero. Verify that the skew is correct

by measuring the same circle on the far left and far right sides of the screen. The images should be superimposed
on one another in the Part View.

E. AutoFOCUS

1. Select an artifact to focus on. The artifact must have good contrast within the region of the height probe. You
may also use the circle probe or the buffer probe to calibrate autofocus.

2. Display the probe library and Select the autofocus tab of the first magnification.
3. Press teach then follow the prompts.
4. Repeat for all of the magnifications. You may want to set "High accuracy" mode to cause the system to perform

a two pass focus algorithm.
5. The taught search distance and focus offset will be displayed.

F. VED Magnification Offsets (parcentricity and parfocality)

Here you will be measuring from one designated magnification, the Master, to calibrate the others to. Decide which
magnification is to be the master (the highest is suggested).

1. Display the properties of the master magnification (offset tab). Check the "Reference" checkbox. The offset
values for this magnification will be zero (0).

2. Select another magnification, and under the Offset tab click Teach. Follow the prompts. Be sure to manually
focus or use auto-focus for each measurement.

3. Repeat this for all magnifications on this machine. There is no need to calibrate the master magnification.

G. Touch Probe Calibration

This calibration will determine the size of the probe tip and any offsets that might exist between the master tip and the
other defined tips of a group. We will calibrate two interchangeable tips (two tips which are members of a single
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group).

Note: If you have a probe rack, see the Probe Rack section for rack specific information.

1. Display the probe library and select the contact probe group on the left side of the dialog.
2. Decide which of the two defined tips will be the master. Select that tip on the right side panel.
3. Check the "Reference" checkbox on the size/offset page to force that tip to be the master of the group. Press

teach.
4. Follow the prompts. The master probe tip will be calibrated for size only. The offsets are zero by definition.
5. [For Non-Rack Probes] Select the other tip on the right panel. Physically change the tip on the machine. Select

the size offset page and press teach.
6. Follow the prompts. If you have no sphere, the system will prompt you to measure both a circle and a point.
7. The offsets now represent the difference between the master and alternate tip.

H. Cross Calibration; Probe and Camera

In this section, you will be calibrating the Probe to the camera. Decide whether the camera or the touch probe is to be
the master family. The camera (VED) is suggested.

1. Display the probe library and the properties of the master family (either "contact probes" or the defined camera.
On the offset tab, check the reference checkbox. The offsets associated with the reference are always 0.

2. Display the properties of the other family (the family that is not the master). From the offset tab, press teach and
follow the prompts.

Troubleshooting: Calibration Check 
If, after all calibrations are completed, you are significant differences, you can verify the calibration results. The
following series of measurements will complete the check:

1. Select the VED probes and select the highest magnification. Measure a smallish circle (around .5mm) that is
placed in near the middle of the field of view. Check the size. The wrong size indicates that the pixel resolution
data is incorrect for high mag. See Step C. Pixel Calibration above.

2. Measure the same circle on the lower left and lower right corner of the field of view. The measured position of
the circle features should be the same. A significant difference in the X position indicates that the X pixel size is
slightly off. A difference in the Y position indicates that the camera skew angle is incorrect. See Step C. Pixel
Calibration or Step D. Camera Skew, above.

3. Measure the same circle in the upper right corner of the field of view. Compare to the measurement of the lower
right. A shift in the Y position indicates that the Y pixel size is slightly off. See Step C. Pixel Calibration, above.

4. Select a circle that almost fills the field of view. Place it near the center and measure it. Now select each
magnification and re-measure the same circle. Don't forget to use auto-focus if available. It is OK to adjust the
probe position if necessary. All of the circle features should show nearly the same size and position. A difference
in size indicates that the pixel resolution of that magnification may be incorrect (Step C. Pixel Calibration). A
difference in position indicates that the parcentricity / parfocality offsets are incorrect. (Step F. VED
Magnification Offsets).

5. In the above test for position, significant differences in the Z position may be due to incorrect autofocus data.
Autofocus, however, is not as repeatable or accurate as X/Y edge detection. You may want to try a test of auto-
focus repeatability.

6. Switch to the contact probes and select the master tip. Measure a primary plane and a circle on the ring gage.
Construct an (XY) zero from the circle. An error in the size of the circle feature means that the tip size data is
incorrect. See Step G. Touch Probe Calibration, above. Switch to the other tip and change the tip on the machine.
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Measure the same plane (but not as a primary alignment) and the circle with the new tip. An incorrect size
indicates a problem with the size of the alternate tip. See Step G. Touch Probe Calibration, above.

7. After the above measurements, the new plane and circle should be located nearly at the zero positions measured
by the reference (master) tip. If not, the tip offset data may be incorrect. See Step G. Touch Probe Calibration,
above.

8. Measure the same circle with any of the VED magnifications. The positions should be the same as when
measured with the touch probe. A significant difference (i.e., greater than the machines repeatability) is due to
incorrect cross-calibration offset data. See Step H. Cross Calibration; Probe and Camera, above.

Summary: 
 

Tips: 
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 Probe Related
In This Section...
Working With The Probe Rack
 

Working With The Probe Rack 
Before you begin...

Using the probe rack capabilities of the QC5000 can greatly enhance your application capabilities. You must
remember though, the probe rack is extremely user dependant. You must be very precise when setting up and using the
probe rack. Failure to follow procedures can produce unfavorable results (e.g., damaged probes, inspection parts, etc.).
While all probe rack related procedures are important, their are several that you should keep in mind at all times. These
are:

Once the probe rack has been set up in an application, it can not be moved, in any way, from it's fixed position.
This includes accidental instances (the probe rack is bumped or a collision occurs that in any way changes the
probe racks original position and orientation).
All probe transitions must occur through the appropriate established methods. You must never manually change
a probe tip or manually place/remove probes from ports in the rack. Valid probe transitions can be set in the
Probe Library dialog box by selecting the probe you wish to switch to, then select the "Set Current" button.
Proper probe transitions can also be included in a program.
If at any time, either during normal operation or while a program is executing, the QC5000 fails to correctly
perform a probe change, then all probes will need to be unloaded from the probe rack, then reloaded.

Probe Rack Setup

The machine must have a repeatable zero in order to find the probe rack. For this reason it is necessary to zero the
machine each time you launch the QC5000.

Step 1: Mounting the Probe Rack

The first step in setting up the probe rack is to perform the mechanical attachment of the rack to the measuring table.
The rack can be placed in one of 4 orientations as shown below: 

+X Orientation +Y Orientation

Along the back edge of the table with the docking side of
the rack facing in the +X direction (see below).

Along the left edge of the table with the docking side of
the rack facing in the +Y direction (see below).
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-X Orientation -Y Orientation

Along the front edge of the table with the docking side of
the rack facing in the -X direction (see below).

Along the right edge of the table with the docking side of
the rack facing in the -Y direction (see below).

Step 2: Testing the orientation of the Probe Rack

Test locate the rack in one of the above positions with the center post over a mounting hole. Ensure that the currently
mounted probe can reach each of the ports. When satisfied with the general location, attached the mounting ring to the
table. Place the rack mounting post over the mounting ring and use the set screw to tighten it in place. Ensure that the
rack is mounted firmly and that there is no play in any of the joints.

Step 3: Preparing the QC5000

Start the QC5000 and verify the following:

NLEC or SLEC calibration has been performed first (if it is going to be used).
The machine axis's count correctly and in the correct direction.
The calibration artifact has been correctly defined.
The tip used to calibrate the rack (2.5mm tip on a 20mm stylus) has been defined and calibrated.

Step 4: Datuming the Probe Rack

1. Select the touch probe used for rack datuming (20x2.5mm).
2. Open the rack covers by pushing them back until they lock in place.
3. Measure a line along the front edge of the rack, touching the metal surface beside the first and last docking ports

(be sure to hold Z constant).
4. Verify that the angle of this line is less than 1.0 degree away from the nominal orientation. If it is not, loosen the

set screw at the base of the mounting post and re-adust the rotation.

Step 5: Load the DATRACK Part Program

Next, run the appropriate DATRACK part program to establish and save the coordinate system of the rack. Eight such
programs are provided:

- DATRACK4XP for a 4 port rack in the +X orientation
- DATRACK4YP for a 4 port rack in the +Y orientation
- DATRACK4XN for a 4 port rack in the -X orientation
- DATRACK4YN for a 4 port rack in the -Y orientation
- DATRACK6XP for a 6 port rack in the +X orientation
- DATRACK6YP for a 6 port rack in the +Y orientation
- DATRACK6XN for a 6 port rack in the -X orientation
- DATRACK6YN for a 6 port rack in the -Y orientation
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Step 6: Establishing the Reference Frame

You will be prompted to take 3 points at the corner of the first port to establish an approximate origin. The program
will then measure the rack and save the resulting reference frame.

Step 7: Docking the Probes

After running the program, use the joystick to manually dock the probe in the first slot (do this carefully). Center the
probe in the slot and move Z up until the probe module is released. Then carefully position the probe body so that you
can move down over the probe module and perform a smooth docking. If the probe tip were perfectly centered below
the probe module the location along the axis parallel to the rack (X or Y) should be zero, but it will probably be
something different. Record this position for later use.

Step 8: Determine Port Spacing

Determine the location center of the last docking port by measuring a midpoint between the ridges on the left and right
sides inside the port. This location should be very close to 90.0mm for a 4 element rack and 150.0mm for a 6 element
rack. Compute the average port spacing (reading divided by 3 for a 4 port rack, reading divided by 5 for a 6 port rack).
Record this number also.

Step 9: Fine Tuning the Probe Rack Settings

Open the Tools>Options>CNC Options Dialog box. Select the Probe Rack Settings tab. The tab should appear as
follows:
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Number of Ports — Click on "4 Ports" if the rack can hold 4 probe modules Click on "6 Ports" if the rack can hold 6
probe modules.

Orientation — Use one of the following combinations:

Select Axis "X" and direction "Positive", if a line from the first rack port toward the last port points in the
positive X direction. Usually on the back edge of the table.
Select Axis "X" and direction "Negative", if a line from the first rack port toward the last port points in the
negative X direction. Usually on the front edge of the table.
Select Axis "Y" and direction "Positive", if a line from the first rack port toward the last port points in the
positive Y direction. Usually on the left edge of the table.
Select Axis "Y" and direction "Negative", if a line from the first rack port toward the last port points in the
negative Y direction. Usually on the right edge of the table.

Port Spacing — Is nominally 30.0mm between each port. Can be adjusted based on the average spacing computed in
step 7 above.

Initial Clearance — The probe will move to a position this far in front of a rack port as the first move to dock a
probe. Note this number must be negative (usually -10 to -30 mm).

Docking Distance — The probe will move this far into the rack port in order to dock or pickup a probe. There is
usually no reason to change the nominal value (8.75mm), which must be positive.



Probe Related

file:///D|/MANUAL/PROBEREL.HTM[6/28/2019 8:20:54 AM]

Retract Distance —  The probe will move this far out from the rack port after a probe is docked. There is usually no
reason to change the nominal value (-8.5mm), which must be negative.

Dropping in Z — This is the Z height used for entry into the rack during a probe drop. The value is with respect to the
tip used to calibrate the rack (20 x 2.5mm). There is usually no reason to change the nominal value (-42.0mm), which
must be negative.

Pickup in Z — This is the Z height used for exit from the docking port during probe pickup. The value is with respect
to the tip used to calibrate the rack (20 x 2.5mm). There is usually no reason to change the nominal value (-42.0mm),
which must be negative.

Release in Z — This is the Z height used for exit from the docking port during a probe drop. The value is with respect
to the tip used to calibrate the rack (20 x 2.5mm). There is usually no reason to change the nominal value (-39.25mm),
which must be negative.

Approach in Z — This is the Z height used for entry into the rack during a probe pickup. The value is with respect to
the tip used to calibrate the rack (20 x 2.5mm). There is usually no reason to change the nominal value (-39.25mm),
which must be negative.

Port position offset — Probe DX This is the component of the offset between the center of the docking module and
the center of the probe tip used to calibrate the rack. The component is measured along the axis of the rack. Use the
position noted in step 6 above as follows:

If the rack orientation is X Positive: Enter the X value
If the rack orientation is X Negative: Enter the negative of the X value
If the rack orientation is Y Positive Enter the Y value
If the rack orientation is Y Negative Enter the negative of the Y value

Step 10: Finishing set up

Select OK to close this dialog, the probe rack should now be ready for use.
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 Probes
 
In This Section...
Probing Technique
Probe Drop Down Menu
Probe toolbar
Probe Options Menu 
Summary
Tips
 

All features are made up of points. Lines can be determined from two points. Circles can be determined from three
points (preferably more). Cylinders require six points. When we talk about measuring features, you’ll learn the exact
requirements for "probing" each feature that the QC5000 can measure. For now, we’ll deal with probing technique and
probe settings.

Probing Technique 
Probing technique is the way that you physically move the CMM (coordinate measuring machine) axes while entering
points with a touch probe. The QC5000 performs probe compensation in the direction that the probe is moving. This
means that each time you probe a point into the QC5000, the probe should be moving perpendicular to the surface of
the part. Also, the probe should start at least one(1) millimeter away from the part surface before each point is targeted.
The animated images below illustrate proper probing technique.

Proper Probing Technique

A part with "square" features can be measured by moving the probe up and down along the Z axis (so that the probe
approaches the part at a 90 degree angle), or left and right along the X axis (so that the probe approaches the part at a
90 degree angle). The Y axis is measured like the x axis, but the motion is forward and backward.

Example #1 - Horizontal & Vertical Approach

Click on the image for an animated example
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A part with slanting features can be measured by moving the probe so that it approaches the slanted plane at a 90
degree angle. To move the probe in this way, you must move it along the X, Y, and Z axes in a manner that will
produce a 90 degree angle.

Example #2 - Angular Approach

Click on the image for an animated example

Note: While a 90 degree angle is ideal for measurement, the QC5000 is designed to compensate for less than ideal
measurement. You should never probe a feature at an angle of 45 degrees, or less, to the surface of the part.

Warning: With the QC5000, Do not drag the probe across a part in order to get the most accurate measurement. Do
not drop a probe off the edge of a part to get the most accurate measurement. Instead, you approach features
perpendicularly, from a 90 degree angle.

Probe Drop Down Menu 
Most of the probe settings that you will use can be found under the "Probe" menu. Additionally, the "Probes" toolbar
provides quick access to several of the items listed under the Probe main menu.

Select "Probe" from the main menu to view the Probe Drop Down Menu:

The Probe drop menu
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The Probe drop down menu contains the following items:

Contact Probes
Probe Compensation
VED
Laser Probes
Teach...
Probe Library...
Magnifications
Auto Enter
Probe Path Data
Filar Probes

Note: Items available from this menu are system dependant.

Contact Probes

Items available from the "Contact Probes" sub-menu will depend on which probes you have entered into the Probe
Library. If no probes of this type are entered into the Probe Library, then the Groups sub-menu will not appear.

From the Groups sub-menu, you can select which probe of this type you want to use. 

Probe Compensation
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Select Probe from the main menu. The Probe Drop Down Menu appears. Probe Compensation is listed below the
menu of available probe tips. If the there is a check beside Probe Compensation, then it is active. If there is no check,
then no probe compensation is being performed. More than likely, you will want to leave this item checked.

Probe Toolbar (Probe Compensation highlighted)

Probe Compensation can also be toggled on or off using the Probe toolbar. If the probe compensation icon is
depressed, then probe compensation is active (you can double check this on the drop down menu).

Note: Probe compensation does not occur in crosshair mode.

VED Probes

Items available from the "VED Probes" sub-menu allow you establish which method the VED probe will operate with,
such as:

Crosshair — The Crosshair probe is the only probe that does not perform edge detection. This probe is used to
stake a point and send the X/Y coordinates to the QC5000.
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Blob — VED will use a "center of a mass tool". 
Simple — A Simple probe is used to find a single edge point.
Buffer — The Buffer probe is the only probe that will return multiple points to the QC5000. You can select
between 1 and 100 points on the Buffer probe.
Nearest — The Nearest probe is a block probe used to find the nearest X/Y coordinates from the direction of the
arrow. 
Farthest — The Farthest probe is a block probe used to find the farthest X/Y coordinates from the direction of
the arrow.
Average — The Average probe is a block probe used to find the average X/Y coordinates of a poorly defined
edge.
Circle — The Circle probe is used to find the diameter and center X/Y coordinates of a circle. 
Width — The Width probe will scan the edge of two lines and return one point on each edge.
Height — The Height probe will perform an autofocus and return a point with a critical "Z" value.
Pattern Finder — Pattern Finder is used to determine pattern recognition.
Video Charts — Displays an onscreen video chart.

Note: If your system does not support VED probes, then the VED Probes sub-menu will not appear.

Laser Probes

Items available from this menus "Groups" sub-menu will depend on which probes you have entered into the Probe
Library. If no probes of this type are entered into the Probe Library, then the Groups sub-menu will not appear.

From the Groups sub-menu, you can select which probe of this type you want to use.

Teach…

The methods required for "teaching" a probe will depend upon the type of probe you are using. An example for
teaching a Contact Probe follows:

Teach — Contact Probes

The Teach item appears on the main menu below Auto Enter. "Teaching" a probe is the same as
"qualifying" a probe. When you introduce a new probe or probe tip to the QC5000, or when an old probe
expires, or when you switch probe groups; you will need to qualify the probe. Sometimes you will change
a probe yourself, and then select the Teach item from the main menu. Sometimes the "Teach Probe"
dialogue box (below) will appear on its own (if you switch to an unqualified probe tip). In both cases,
follow the instructions on-screen prompting you to "probe points on the qualification sphere".
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Probe qualification is essential for probe compensation. Qualification allows a probe to compensate for its
own radius, and its own position in relation to other probe tips. The QC5000 makes this process painless:

TO TEACH A PROBE:

1. Select the teach probe icon from the probe toolbar or select the Teach item from the Probe drop
down menu. The Teach probe dialogue box appears prompting you to "Probe points on the
qualification sphere...".

2. Probe a point at the top of the qualification sphere. The Teach probe dialogue box indicates that one
point has been probed.

3. Probe a second point at the equator of the qualification sphere. The Teach probe dialogue box
indicates that a second point has been probed.

4. Probe a third point at the equator of the qualification sphere.
5. Probe a fourth point at the equator of the qualification sphere.
6. Select OK to accept the measurement and qualify the probe.
7. Select Cancel to exit the qualification process without teaching the probe.
8. Select Enter Pt. to manually enter probed points.
9. Select Remove Last at any time during the process to delete the last probed point.

When the probe has been qualified (taught), a date will appear beside it in the Probe Library indicating the
date on which it was qualified (or re-qualified as the case may be). Probes should be re-qualified
periodically to insure accurate measurement.

Probe Library

Detailed information on the Probe Library is located in another section. Click HERE to go there. 

Magnifications

This menu option will be available from the Probe menu if you have VED probes set up in the QC5000. Sub-menu
items will reflect all magnifications entered for VED.

Auto Enter

Auto Enter can be toggled on and off just like Probe Compensation: you can use the Probe drop down menu or the
probe toolbar. When Auto Enter is active the QC5000 treats every probe hit (each touch of the probe to the part) as an
entered point. This feature allows you to enter many points without having to manually accept each point with the
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mouse or the foot pedal. Auto Enter will not work with hard probes. When the hard probe group is selected, Auto
Enter is grayed out on the Probe drop down menu.

Groups

The QC5000 keeps a record of the various probes that you use to measure parts. This record is called the probe
library. The probe library includes information on probe type (spherical/crosshair), probe qualification (date), and
probe availability (show/hide). The QC5000 also organizes probes into groups. The three probe groups supported by
the QC5000 are: hard probes, touch probes, and star probes.

To view a list of the probes available in each group:

1. Select Probes from the main menu. The Probe drop down menu appears.
2. Select Groups. The Groups sub-menu appears.
3. Select a group. A check appears beside the active group, and the Teach Probe dialogue box appears (see note

below.)

The Probe > Groups sub-menu (touch probe selected):

Below the Groups item in the Probe Drop Down Menu is a menu of the available probe tips from the selected group.
If Hard Probe is selected in the Groups sub-menu, then only hard probes will appear on the menu of available probe
tips. If Touch Probe is selected in the Groups sub-menu, then only touch probes will be listed on the menu of
available probe tips. If Star Probe is selected on the Groups sub-menu (as it is in the above picture), then only star
probes will appear on the menu of available probe tips.

Note: Each time you change probe groups the Teach Probe dialogue box will appear, prompting you to, "Probe points
on a qualification sphere…". This procedure is the same as setting a machine zero, described in the introduction to this
manual (for more on qualifying probes, flip forward to the Teach section of this chapter).

Menu of Available Probe Tips

This section of the Probe drop down menu is simple: it is a listing of probe tips from the probe library that match the
selected probe group. If you are working with a star probe, then the tips listed on this menu will all be star probe tips.
If you are working with a hard probe, then the tips listed on this menu will all be hard probe tips.

There are two important things to remember about the menu of available probe tips:

1. Some probe tips from the active group (star, touch, hard) may not appear on the list if they are set
up in the Probe Library not to appear in the menu.

2. The list may include unqualified probes. However, the QC5000 will prompt you to teach (qualify)
the probe, and then you can continue.
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Probe Options Menu 
To get to the Probe Options Menu, select Tools from the main menu. The Tools drop down menu appears. Select
Options from the tools drop down menu. The Options dialogue box appears. Select the Probes tab from the options
dialogue box. The Probes tab moves to the foreground (the probe options appear on-screen).

You may not have access to these probe settings. If these options are not "user settable" then all of the options in the
Probes tab will be grayed out, and you will be unable to select or change anything. Notice the user settable toggle in
the lower left corner of the Probe tab. Every tab in the Options menu has one of these toggles, and during setup of the
QC5000 your supervisor determines which options you can change. If you do have access to the Probe options, the
screen will look like this:

 

The Probes Options Screen

The Probes Options Screen is used to modify the information that the QC5000 uses to perform probe compensation:

The Qualification data box contains information about the qualification sphere that you use to set the machine zero
and to teach probes. The QC5000 lets you enter the diameter of the qualification sphere in inches or millimeters. If the
mm box contains a check, then the QC5000 is set for millimeters. If there is no check in the mm box, then the QC5000
is set for inches.

The Star Probe Auto Selection box contains information that only applies to multi-styli (star) probes. If the Select tip
by moving in direction of tip box is selected, then changing the active tip on a star probe can be done automatically by
deflecting the probe until it beeps constantly, and moving the CMM axis in the direction of the desired tip. For
example, if you want to select a tip that points left along the X axis: 1) deflect the probe in any direction until it beeps
constantly; and 2) move the probe left along the X axis. The Movement threshold setting specifies how far along an
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axis the CMM must move before the QC5000 recognizes that you want to change probe tips (inches or millimeters; if
mm box is checked, the QC5000 is set for millimeters).

The Probe hit debounce time is a delay, measured in milliseconds only, that allows time for the internal switch to
settle. All switches have "bounce," and the QC5000 compensates for this.

The Probe direction threshold, measured in scale counts, is a limit that the probe must exceed before the QC5000
determines that movement in the given direction is intentional. This allows the QC5000 to compensate for the physical
"probe bounce" that occurs when a probe hits a target.

As always, select OK to accept the changes you have made. Select Cancel to exit the Probe options dialogue box
without accepting any changes.

Summary: 

You should now be able to:

Find and modify the various probe setting menus (Probe menu; Tools > Options > Probes; Probe toolbar).
Add new probes to the QC5000
Perform proper probing technique

Items under the Probe main menu should now be familiar to you. Items in the Tools menu should also be familiar, but
chances are those settings will be modified rarely.

Tips: 
Use the Probe toolbar to turn probe compensation on and off, to turn auto enter on and off, to re-qualify
(teach probe), and to access the probe library.
Always approach a part perpendicularly (from a 90 degree angle), to insure accurate measurement.
Remember, all of the available probes may not appear under the Probes main menu if they are set up, in the
library, not to show in the menu.

Back to the top 
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 Working With Probes
 
In This Section...
Overview
The Probe Library
Contact Probes
Video Edge Detection (VED)
 

Overview 
In order to setup and work with probes in the QC5000, you need to understand the method that the QC5000 recognizes
various probes. This section will instruct you how to work with multiple probes within this environment.

The Probe Library
The probe library dialog contains a tree-view control similar to that found in the windows explorer. The left-hand side
of the tree-view contains a hierarchical list of probe families, groups, and types (corresponding to directories) and the
right hand side contains a list of groups, probe positions or magnifications (corresponding to subdirectories or files).
When items are selected on the right side, appropriate tabbed properties data will be displayed on the bottom. The tree-
view control will operate in the standard way, with the ability to expand branches and select items at any level on the
left side.

The dialog has three sections: the tree view on the left, the detail list on the right, and the property tabs on the bottom.
Expanding the tree on the left will have no effect on the right side or the properties. Selection of items in the tree will
modify the items displayed on the right, and will display appropriate properties if any properties exist for that level.

In the example shown, the "root" is the item "Probes" at the top of the tree-view. When this is selected, the right side
will display the names of the installed families of probes, e.g. contact probes, VED probes, Laser probes, etc. When the
offset tab is selected, if there is cross calibration data (the distance between probe families).
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Adding Predefined Objects

Normally, your QC5000 should have all of the Probe Library elements installed when you first get your system. You
may need to add or reconfigure some elements from time to time. This section covers working with predefined objects.
To add a predefined object, select the family you want to add to from the left plane (e.g., VED, Contact Probes, etc.).
The following dialog will appear:

Select an item from the image below to learn more about it.

Depending on which family you are adding on to, only some options will be available. Click on an item in the above
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graphic to learn more about it.

Group (Contact Probe) - Return to New Probe dialog box

Selecting the Group Item allows you to establish a new Contact Probes group. This new item may be
either a new probe tip (single or star) or a probe rack (covered in greater detail HERE). The following
information is required for this item:

Name: - A unique identifier that will be assigned to this item.
Auto Change - A group may be auto-change capable, meaning that the probe group may be removed
from the system and then replaced without requiring re-qualification. The connections that hold the
group in place are fully repeatable. The default is unchecked.
Auto Enter - Select this checkbox to automatically register probe hits. The default is checked.
Probe Direction Distance - The probe direction distance is associated with a group because the
distance is likely to vary between the automatic probes case (Auto Enter capable probes) and the
hard probe groups. Hard probes generally require a much larger direction factor. The default is 0.10
mm and the limits are 0.01 – 5.00 mm.
Note: This number is not the same as Probe Retract Distance (PRD).

Once this new item has been entered, tabs relating to this item will appear in the lower section of the
Probe Library dialog box. This tab allows you to change the parameters used by this item, as shown below:

Group Properties - General Tab

Probe Tip (Contact Probe) - Return to New Probe dialog box

file:///D|/MANUAL/proberel.htm#Working With The Probe Rack
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Selecting the Group Item allows you to establish a new Contact Probe tip. This new item allows you to
establish a new probe tip. The following information is required for this item:

Probe Name: - A unique identifier that will be assigned to this item.
Probe Type - Select either Spherical or Cylinder/Disk
Stack Length - Enter the stack length attributed to this probe.
Show in menu - Check this box to enable the display of this item in all applicable menus. The
default is checked.

Once this new item has been entered, tabs relating to this item will appear in the lower section of the
Probe Library dialog box. This tab allows you to change the parameters used by this item as well as enter
any additional information required for this items use, as shown below:

Probe Tip Properties - General Tab

Probe Tip Properties - Size/Ofs (Offsets) Tab
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Magnification (VED) - Return to New Probe dialog box

Selecting the Group Item allows you to establish a new Camera Magnification. The following information
is required for this item:

Name: - A unique identifier that will be assigned to this item.

Once this new item has been entered, tabs relating to this item will appear in the lower section of the
Probe Library dialog box. This tab allows you to change the parameters used by this item as well as enter
any additional information required for this items use, as shown below:

Magnification Properties - Offset Tab

Magnification Properties - Resolution Tab
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Magnification Properties - Auto Focus Tab

Magnification Properties - Mag (Magnification) Tab

Camera (VED) - Return to New Probe dialog box
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Selecting the Group Item allows you to establish a new Camera. The following information is required for
this item:

New Camera Name: - A unique identifier that will be assigned to this item.

Once this new item has been entered, tabs relating to this item will appear in the lower section of the
Probe Library dialog box. This tab allows you to change the parameters used by this item as well as enter
any additional information required for this items use, as shown below:

Camera Properties - Offset Tab

Camera Properties - Orientation Tab

Camera Properties - General Tab
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Setting A Probe As Current

From The Main Menu Bar

Most of the probe settings that you will use can be found under the "Probe" menu. Additionally, the
"Probes" toolbar provides quick access to several of the items listed under the Probe main menu.

Select "Probe" from the main menu to view the Probe Drop Down Menu (see below):

From the Probe drop down menu, you can select which probe type you want to make current. In this
example, we will make a Contact Probe current. Select Probe > Contact Probes from the main menu.
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Select the Groups sub-menu to view all available contact probes currently stored in the Probe Library.

In this example, there are two contact probes available from the Groups sub-menu. Selecting "mmm" will
place a check mark beside it on the Groups sub-menu. This check mark indicates that "mmm" is the
current probe.

From The Status Bar

If you want to quickly toggle between probe families (e.g., switch from VED to Contact Probes), you can
use the status bar. Click on the fifth field (see below) on the status bar to toggle between probe families.



Working With Probes

file:///D|/MANUAL/PROBES2.HTM[6/28/2019 8:20:58 AM]

The QC5000 will remember the last used configuration for each family. For example, if your current setup
was using VED with magnification 3 and a blob tool, and you use the status bar to switch to Contact
Probes, then use the status bar again to switch back the VED, the QC5000 will remember that you were
using magnification 3 and a blob tool.

From Within The Probe Library

The current probe can be set from within the Probe Library dialog box. Select Probe > Probe Library...
from the main menu bar.

In the Probe Library dialog box, select "Contact Probes" in the left pane. In this example, two contact
probes are available (group_1 and mmm). Select "mmm" in the right pane, then select the "Set Current"
button (along the right side of the dialog box). Select the "OK" button to close this dialog. The contact
probe designated "mmm" is now the current probe used by the QC5000.

Select "Probe" from the main menu to view the Probe Drop Down Menu (see below):
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Family Offsets (Cross-calibration)

When a QC5000 is set up as a multi-sensor system (e.g., VED and contact probes being used simultaneously), it is
necessary to cross-calibrate all applicable probes to recognize the orientation and position of all of the other probes
being utilized. This ensures that all probes being used by the QC5000 apply proper compensation for their different
locations within the operating environment.

Contact Probe Cross-calibration (using the camera as the reference)

You will first determine the tip size, then cross calibrate. Always be sure to move the camera up away from the object
being measured so that the probe tip is not compromised (unable to collide with another object).

Tip Size

1. The nominal size of the calibration artifact (sphere or ring) is set in the "Probes" tab in General options (Tools >
Options > General Options). Verify that the sphere size is set to 12.7.
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2. Open the Probe Library dialog box by selecting Probe > Probe Library... from the main menu.

3. Select Probes > Contact Probes > (The tip you wish to calibrate). Verify the Reference box is checked and select
Teach in the size/ofs menu.
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3. Measure a sphere or ring gage as indicated in the prompt. Measurement of the artifact will allow the software to
determine the tip size. You can check the calibration by re-measuring the artifact. The size should be nearly that
of the nominal setting.

Probe

1. Verify that the camera high magnification is still set as Reference and the XYZ values are 0.0 (see below).
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2. Then select Probe > Probe Library from the main menu. On the left screen half Probes will be displayed, on the
right side the existing probes (VED, Contact Probes), select Contact Probe.

3. Under the Offset tab, verify that the Reference is not checked and then select Teach (see below).
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4. This will run you though an exercise to measure the qualification ring gage. Verify the size of the feature against
the size of the ring gage.

5. Once this is completed, re-measure the object with the touch probe and the camera to verify a match; select File,
New, Part and then measure the same object. When you are finished, the circles should have nearly the same
position and size.

Calibrating Touch Probes to the Master Touch Probe

In this exercise you will be calibrating the Touch Probe family members to the master touch probe.

1. Display the Probe Library dialog box (Probes > Probe Library... from the main menu). Go to the properties for
the master family (master reference). In the example below, the master family is VED. The main reference is set
to Camera 1 / Mag 270X. On the "Offset" tab for Mag 270X, make sure there is a check in the reference
checkbox. The offsets associated with the reference are always 0.
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2. Display the properties of another touch probe. From the offset tab select teach and follow the prompts.

Contact Probes
The contact probe family consists of groups of probes with the general properties shown below.



Working With Probes

file:///D|/MANUAL/PROBES2.HTM[6/28/2019 8:20:58 AM]

Most families of probes are interchangeable with other families. For example, after cross calibration, the VED and
touch probes may be used interchangeably. The cross calibration data is "persistent" as long as the system
configuration is not changed. At the group level of the hierarchy, tips of the group are assumed to be interchangeable,
but the groups may or may not be interchangeable with each other.

A group may be auto-change capable, meaning that the probe group may be removed from the system and then
replaced without requiring re-qualification. The connections that hold the group in place are fully repeatable. The
default is unchecked.

The probe direction distance is associated with a group because the distance is likely to vary between the automatic
probes case (AutoEnter capable probes) and the hard probe groups. Hard probes generally require a much larger
direction factor. The default is 0.10 mm and the limits are 0.01 – 5.00 mm.

The contact probes are auto-enter capable. The default is checked.

If your system is not equipped with a probe rack, the selection of a group on the left hand side will display all the
qualified tip positions of that group on the right side.
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Probe tip general properties include the type and stack length data. Probe types is a drop down list including spherical
or cylindrical/disk. Stack length is a placeholder for now. The default is 0.0 and limits are 0.0 – 1000.0.

In the case shown above, the tip is mounted in a probe rack, so the hierarchy will include an additional level for probe
positions as shown next.

If there is not a probe rack, the General and offset/size tabs will be displayed as part of the same properties (of tips).
The filed limits and defaults are as follows:

Size Default 0.0 Limits 0.0 – 100.0 mm
Offsets Default 0.0 Limits -1000.0 – 1000.0 mm

Video Edge Detection (VED)
The VED family is cross-calibrated at the camera level (see below). The Reference checkbox identifies the anchor
position of cross-calibration. The offsets will be zero for the reference.

The VED family camera cross calibration offsets
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Default cross calibration offsets are 0.0. Limits are –10000.0 – 10000.0.

VED family camera skew (orientation)
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Properties may include more than one calibration (e.g., a VED camera has both an Offset (cross-calibration) and an
orientation (camera skew) calibration). The selection of a tab in properties will display the appropriate calibration
dates, if any, in the detail list on the right. The selection of a tab does not change the items in the detail list, but the
dates may be altered. In the example above, the dates shown on the right are those of orientation calibration. Only
VED and the laser probe are affected.

If a family has no orientation calibration, the fields are filled with dashes. If the family uses orientation cal., but is not
calibrated, the item displays "Not calibrated" in the date and time field.

Limits of camera skew are –3.00 – 3.00 degrees. The default is 0.0 degrees.
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The general tab at the camera level should indicate general properties of the camera (other than offset and orientation).
This could include data such as the configuration data. In the example above, the VED general properties are
duplicated, but the settings would affect the system regardless of which camera is selected.
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 General Programming
 
In This Section...
Recording a Program
Running a Program
Sample Program
Summary
Tips
 

The QC5000 is programmable, it can store a series of steps, and then prompt a user to perform the same steps at a later
date. Programs are useful if you will be measuring the same type of part often. Every program that you will create with
the QC5000 is tied to a specific part; there is one program per part, and a program is never independent of a part. The
QC5000 allows you to record programs, save programs, and run saved programs.

Recommended: This section contains a sample program (located here). After you have completed this section, you
should perform the sample program straight through at least once on your QC5000.

Recording A Program 
You will tell the QC5000 exactly what you want it to do at each step, and it will play the program back in the same
manner. Here we will create a small program, and we will save the program (this section will use the QC5000
demonstration part, but any multi-feature part may be substituted). Datum Magic does not work during
programming.

The Program Toolbar

Before we begin programming; we should review the Program toolbar. If this toolbar is not displayed, select VIEW >
TOOLBARS... from the main menu. Select "Program" then select the "Show" button. Click "OK" to continue.

The Program toolbar:

Select an icon in the toolbar above to learn about its functionality.

  Record/Edit Program — Places the QC5000 into Record/Edit Mode. All actions performed from this point
will be applied to the program. To exit this mode, select the Pause Program icon (see below) [Return]

  Pause Program — Stops a currently running program. The Program window will highlight the last executed
step performed in the program before it was paused. [Return]

  New Run — Begins running the program from the first step, regardless of which step was selected in the
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Program window. [Return]

  Run Program From "Current" Step — Begins running the program from the "currently" selected step. [Return]

  Run Just "Current" Step — Executes only the "currently" selected step, then pause the program after
execution. [Return]

  Toggle Break Point — Attaches a marker to the currently selected step. This marker will instruct the program
to stop when this step is reached in the program. To remove this marker, simply select this step again, then select the
"Toggle Break Point" icon to clear it. Break Points can be placed on more than one step within a program. [Return]

  Edit Steps — Allows you to edit the currently selected step. The options you will be presented with will depend
on which functionality is associated with the currently selected step (e.g., manually change point coordinates, toggle
the display of a position indicator, modify probe path data, etc..) [Return]

  If-Goto Statement — Allows you to create a conditional argument for the currently selected step. If, the
selected step is executed during the program, and the conditions you have placed on this step are met, then the
program will "goto" a different step within the program.

Example, if the value of the X coordinate exceeds a defined value, goto a specified step within the program. [Return]

  If-Then Statement — Allows you to create a conditional argument for the currently selected step. If, the
selected step is executed during the program, and the conditions you have placed on this step are met, then perform
the function you have specified. If the conditions have not been met, then continue running without change.

Example, if the value of the X coordinate exceeds a defined value, apply an offset to the value to X before
proceeding to the next step. [Return]

  Else Statement — Used in conjunction with either an If-Then statement or an Else-If statement. If the
conditions set by either the If-Then statement or the Else-If statement have not been met, then skip the steps that the
If-Then or Else-If statement would have executed and execute the steps after the Else statement.

Example, an If-Then statement within a program instructs the QC5000 to execute a second inspection if an
inspected distance is less than 5mm. The next line in the program sets an Else statement that instructs the QC5000 to
stop executing the program if the same inspected distance is greater than 6mm. If the distance returned during the
programs execution is 4.7mm, then the QC5000 will execute a second inspection. If the distance returned during the
programs execution is 6.2mm, then the QC5000 will stop the program. If the distance returned during the programs
execution is 5.4mm, then the QC5000 continue the program skipping both the Then condition steps (second
inspection) and the Else condition steps (stop program).  [Return]

  Else-If Statement — This statement is the same as the Else statement, except that an additional condition needs
to be met to see if the statements after the Else-If are performed  [Return]

  Goto Label — Allows you to direct the program to proceed to a "labeled" section within the program. When
selected, you will need to enter the name of the label you want to go to. You must enter the name exactly as it appears
in the destination label (e.g., if the label step appears as Label "Find-Diameter-1"..., then you would enter "Find-
Diameter-1" without the quotes). For more information, see Label.  [Return]

  Label — Allows you to place a labeled marker within the program. This marker can divide your program into
sections. The name you enter must not contain any spaces or special characters. These sections can then be switched
to during the program, when used in conjunction with the Goto Label option.
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Example, You have a program that has the following:

Steps 10 through 18 — find the center of Circle 1
Steps 19 through 27 — find the center of Circle 2
Steps 28 through 36 — find the center of Circle 3

You insert Labels at the beginning of each process as follows:

Step 10 - Label "Find-Diameter-1"...
Steps 11 through 19 — find the center of Circle 1
Step 20 - Label "Find-Diameter-2"...
Steps 21 through 29 — find the center of Circle 2
Step 30 - Label "Find-Diameter-3"...
Steps 31 through 39 — find the center of Circle 2

Elsewhere in the program, you can insert a step that uses the "Goto Label" option to send the program to one of these
locations (Find Diameter 1, Find Diameter 2, or Find Diameter 3). [Return]

  Loop — Allows you to repeat a selection of steps (loop) a selected number of times (e.g., repeat program steps
4 through 10  for 5 loops then continue on to step 11.) [Return]

  Offset Positions — Allows you to manually enter a coordinate that will offset the current coordinate.

Example, suppose the X coordinate in Step 3 is 1.03621. In Step 4 the X coordinate moves to 1.13621. In Step 5 you
want the X coordinate to be the same value it was in Step 3. You would then: select Step 4, select the Offset Positions
icon, then input the value you wish to offset by (in this example, X = -0.10000). A program step will be added after
Step 4 that will offset the coordinate. Step 5 (now Step 6) will begin with the same X coordinate that Step 3 began
with. [Return]

  SuperStep — Allows you to group a selection of steps into a collapsible group (SuperStep). This can assist
programmers by organizing and shortening the display of large programs in the Program window.

Example, a program uses Steps 12 through 24 to plot a series of points that are required to determine a specific
coordinate. To reduce the space that all of these steps will take up in the Program window, select Steps 12 through 24
with the mouse, then select the SuperStep icon. You will be prompted for a name to identify this SuperStep. After
entering a name and selecting OK, the Program windows will update to show two new steps. Step 12 is now the
SuperStep with the title you specified. You can collapse this group by selecting the minus (-) symbol in the third
column (default), then select the plus (+) symbol to expand the group. Steps 13 through 25 (originally 12 through 24)
are the program steps you selected to group. Step 26 indicates the end of the SuperStep.
To delete a SuperStep, select it in the Program window, then either, select Edit > Delete from the main menu or
select the delete key on your keyboard. [Return]

  Program Comment — Allows programmers to enter a note into the program for future reference. This note
will not perform a function.

Example, at Step 12, you want to enter a note that explains the programs current functionality (e.g., finding the radius
of the first circle in a program), you would select Step 12, select the Program Comment icon, then  enter the comment
"Finding Radius #1" (without quotes) into the Enter Program Comment dialog box, then select OK. Step 12 will now
display the comment "Finding Radius #1" and the // symbol will be present in the third column (default). [Return]

Run/Edit Program

This section will guide you through a typical VED program for the QC5000. This example inspects the "QC Quickie"
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demo part. The inspection process will incorporate two looping cycles and the exporting of individual inspection results
to a Microsoft® Excel® spreadsheet (manual.xls).

To Record a Program:

Launch the QC5000, if necessary, and establish machine zero.
Verify that all applicable probes are qualified and cross-calibrated.
Verify that the joystick is setup properly.*
Ensure that the "QC Quickie" is properly oriented and secured to the stage.
In this example, information is exported to an Excel spreadsheet. To prepare for this, launch Microsoft Excel,
then save a blank spreadsheet named "manual.xls" into the QC5000 directory. Keep Excel running in the
background (with the manual.xls file loaded) while the QC5000 is running in the foreground.
Begin with a new part file (select File>New>Part... from the main menu).

The "Simple Probe" icon  on the VED toolbar (Probes>VED Probes>Circle from the main menu).
"High Accuracy" mode is currently selected. To select "High Accuracy" mode, right click with the mouse over
the Live Video window, then select Other>High Accuracy. A checkmark next to this item indicates that it is
active (see below).

QC5000 parameters that are unique to this program:

"Magnification 27x" is entered in the Probe Library and available from the Probe toolbar
(Probe>Magnifications>mag_27, from the main menu).
"Magnification 90x" is entered in the Probe Library and available from the Probe toolbar
(Probe>Magnifications>mag_90, from the main menu).

* Tip: The "Goto Here" command is issued very frequently during programming. It is suggested that this
command be assigned to one of the three joystick buttons. This can be accomplished by setting the
appropriate button (usually Button 3) in the "External button assignments" field of the Buttons tab in the
General Options dialog box (Tools>Options>General Options...) as shown below.
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Important: Once the QC5000 begins programming, every step you make will be recorded into the program. Ideally,
you should have every step in a new program planned in advance. It is common for some programs to require several
rehearsals before they are considered complete. Also, due to the sensitivity of a programs environment, if a program
creates an error condition during either the programming or the execution phase, it is recommended that this program
be deleted and a new one created with appropriate corrective action taken to eliminate the initial error condition. 

This program will instruct you to perform various actions. Some of these actions assume that your QC5000 is
operating in a default state. For example, the program may include a line that instructs you to select magnification 3,
which may already be selected. You may be therefore inclined to disregard this step, but remember, this program may
be run on a later occasion at which time magnification 3 may not be selected. Regardless of the QC5000's current
configuration, all required system variables must be included in the program to ensure that all future executions are
successful.

1. Select the Record/Edit Program icon  (Tools>Programming>Record/Edit Mode, from the main tool bar) to
initiate the recording process.

2.  

 

 

 

1. Select File>New>Part from the main menu to clear anything from the QC5000 feature list and part view. Save
any data you want to save, delete any unimportant data. Make sure to begin programming with a "blank slate."

2. Once you are in a clear workspace, select Tools>Programming>Record/Edit Mode from the main menu. The
Program View window appears labeled Recording. Everything that you do from this point forward is recorded by
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the QC5000.
3. Now Measure features into the QC5000 in the normal way (select the feature icon from the measure toolbar,

probe points, select OK).
4. Now Construct features from your measured features (i.e. intersection points, datum). You might probe a

primary plane, a skew line, and a Y axis line as your first three features, and then construct a zero point
(reference frame).

5. Add a user message to the program. The user message will appear at the same point in the program each time.
(see graphic on adding a user message).

6. Tolerance a feature (see note at end of section ).
7. Select Tools from the main menu. Select End Recording from the tools drop down menu to stop recording

program steps. The title of the program window changes to Editing, and you may now Cut, Paste, and Delete
program steps using the edit functions from the Edit option on the main menu.

8. When you are finished editing, click on the X icon from the three icon bar in the upper right corner of the
program window (as you would to close a window). The QC5000 asks you if you want to save the program….

9. Select Yes to save the program. Select No to abort the creation of this program. If you select Yes, the Save Part
As dialogue box appears. Select a name for the part file (as you would any Windows file), and select OK. This
program is now associated with this part file; any time you want to run this program, you will open this file.

Programming:

Select Tools from the main menu…

 …the tools drop down menu appears.

Place your cursor over "Programming", the resulting sub-menu appears:
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By default, "View Only Mode" is selected and the QC5000 status bar indicates that you are in editing mode:

Once you select Record/Edit Mode from this menu, the QC5000 V2 will remember every step that you take from that
point forward. The status bar will indicate this as follows:

The Program View window…

Each step will be added to the window as you perform it. Steps include:
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Measuring features
Constructing features
Tolerancing
Adding user messages.

When you’re done recording…select Tools > Programming > View Only Mode or the "Pause" icon on the
Programming toolbar. The status bar changes to "Editing," now you can cut, copy, and paste program lines. 

Save the program.

Remember: User Messages, Constructions, and Tolerancing are all possible within programs. Form
Constructions as you normally would, Tolerance as you normally would. Insert User Messages as described
below.

To Insert A User Message

You may want a user message to appear onscreen at certain times during a program. A user message can say anything
you want it to. It can be a reminder to the user to complete a step, it can be a direction for the user to follow, it can be
anything. You can insert multiple messages into any program. Each time you insert a user message, you will have to
change the text of the previous message (you can check the program window to double check the text of the message
that will be displayed).

User Message

1. Select Tools from the main menu. The tools drop down menu appears.
2. Select Special Steps from the tools drop down menu. The special steps sub-menu appears.
3. Select User Message from the special steps sub-menu. The user message text entry box* appears.
4. Enter the user message from the keyboard.
5. Select OK to accept the message, and add it to the program. Select Cancel to abort the user message.

* User Message: select TOOLS > SPECIAL STEPS > USER MESSAGE…

Once you select OK, the text message is added to the program list. The program will execute sequentially, and the
message will appear at its designated place in the program.

Important Notes On User Programming

The QC5000 programs execute sequentially. If you perform a tolerance that requires a reference feature, the reference
feature must have already been measured. If you construct a feature, both parents must be present on the feature list
prior to construction. Here are some simple rules that will help keep your programs hassle free:

1. Only use features measured before the toleranced feature as reference features.
2. Do not accidentally delete a parent feature that a construction depends upon.
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Rule one (1) will not prevent you from tolerancing in your normal manner. You can duplicate any feature (single
parent construct); therefore, any feature can be the last feature on the feature list . The last feature on the feature list
can use any previous feature offered by the QC5000 as a reference feature. Circle 5 can use any of the features listed
for a reference feature in a program. Circle 4 can use circle 1, 2, or 3 for a reference feature within a program. Circle 3
can use circle 1 or 2 for a reference feature. If you want to use circle 5 for a reference feature for circle 1, you must
construct another circle (circle 6) using circle 1 as a single parent, and then tolerance circle 6.

Running A Program 
Running a previously saved program is easy. You simply open the part file that the program is associated with, and
then select New > Run from the file menu. Here’s the procedure:

Running a Program

1. Select File from the main menu. The file drop down menu appears.
2. Select Open from the file drop down menu. The QC5000 Open Part dialogue box appears.
3. Select the part that is associated with the program you want to run. The part is highlighted on the file

list when selected.
4. Select OK to open the part. The QC5000 "delete" warning appears.
5. Select Yes to clear this warning and open your file. Select No if there is unsaved material on the

main screen that you want to save. If you select YES . . .
6. . . . The Part appears on the feature list and in the part view.
7. Select File from the main menu (this is the second time in this procedure that you select File).
8. Select New from the File menu. The New sub-menu appears.
9. Select Run from the sub-menu (if you select Part here, the QC5000 thinks you want to change

programs) . . . A measure dialogue box appears prompting you to perform the first step in the
program. A blinking cursor in the part view indicates the part feature that this measurement
corresponds to.

10. Complete the program by following each step. If there are tolerances, they are calculated as you
measure. If there are messages, they appear at their designated times.

11. When the program is complete, the part remains onscreen. To run the program again, select File >
New > Run from the main menu. To work with a new part (or part program), select File > New >
Part from the main menu, and then select the part from the Open part dialogue box.

Running a Saved Program

1. Select File > Open...

...the Open Part dialogue box appears.
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2. The selected file appears on screen.

Selected files Feature List.

Selected files Part View.
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3. Now select File > New > Run to run the program

A measure box will prompt you for the correct feature, and number of points. In this example you are prompted to
probe a four point circle. Once the fourth point is probed the QC5000 automatically accepts the measurement
(backward annotation).
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The Program Window reads "waiting," and displays the program steps. The program window also indicates which step
should be performed (indicator to the left of the program). This window may be hidden behind the "Measure" window
(move windows by clicking on the title bar and dragging).

The feature that corresponds to the current program step is highlighted in the part view, as well as indicated by the
flashing dot.

Sample Program 
Here we will make a sample program, in total. For this program you can use the QC5000 demonstration part, but any
multi-feature part will do. The program will prompt the user to establish a reference frame. Then the program will
prompt a user to probe four circles. Then the program will instruct the user to construct a circle using the four original
circles (bolt hole circle). Finally, the program will perform a True Position tolerance on the bolt hole circle. There may
even be a user message or two just to keep things interesting. We’ll do it in sections, but just follow straight through
and you won’t get lost.

1. Start the QC5000 and set the Machine Zero.
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2. Begin recording

Select Tools from the main menu. The tools drop down menu appears.
Select Record from the tools drop down menu. The program window appears; it says,
"Recording." The QC5000 records everything from this point forward.

3. Establish a reference frame

Probe a Primary Plane
Probe a secondary alignment line (skew line).
Probe a "Y" axis alignment line.
Construct a point at the intersection of the X and Y lines.
Construct a zero point from the XY intersection point and the Primary Plane.

These should appear somewhere on your screen (your part view should look similar to this, and your feature list
should show these features):

4. Probe four bolt holes (if using the QC5000 demo block, the four holes are actually two holes and two arcs.)

Once the holes and arcs are probed, your program window and part view should look similar to this .
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5. Construct the Bolt Hole Circle from the four bolt holes.

Construct the circle in the normal manner (select the circle icon, and select the four circles). Your program window and part view
should look similar to this:
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Note: here the constructed circle appears in "phantom view." It’s okay if it doesn’t; it’s okay if it does.

6. Perform True Position tolerancing on the Bolt Hole Circle. 

Select the bolt hole circle (the last feature on the list) from the feature list and tolerance for True Position in the normal manner.
The tolerance step does not appear in the program window, but notice the pass / fail indicator on the feature list. The tolerance step
is part of the program.
The part view and program window do not change, but your feature list does:

The tolerance appears on the feature list, but not in program window. Each time the QC5000 gets to this point in the program, it will
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tolerance circle 11 for True Position (according to the nominal and deviation values that you entered while programming). If you followed
this sample program exactly, this final circle will be circle 10 on your feature list.

7. Add a User Message 

Select Tools > Special Steps > User Message
Enter the text, "If this bolt hole passes tolerance, begin a new run. Click File>New>Run to begin a new run." Then select OK.
Close the User Message by clicking on the X in the upper right corner.
Your text box will look like this:

Click on the X in the upper right corner to close this text box. Notice that the message has been added to the program window.

8. Stop recording

Select Tools from the main menu.
Select EndRecording from the tools drop down menu.
The Program Window changes to "Editing."
You can now cut, paste, copy, and delete steps.

Notice that step 00006 is selected, any cut, copy, or delete action that you perform will affect this step of the program.

9. Save the Program 

Click on the "X" in the upper right corner of the program window.
The QC5000 asks you if you want to save the program, select YES.
Now save the program under the name "Sample" as you would any Windows program (enter the name, select OK).

10. To run the program

Select File > Open
Select "Sample"
Select File > New > Run from the main menu.
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Summary: 
User programming may take some practice, but before long it will seem easy. Remember, you do everything as you normally would, and
the QC5000 remembers it. Because programs are tied so closely to their part, you will always open a part when you want to run a program.
You will open the part that is associated with the program you want to run.

Tips: 
Remember the rule for tolerancing: the reference feature must appear before the toleranced feature in the program.
Tolerancing does not appear in the program, but it does appear on the feature list. It is part of the program.
Don’t accidentally delete a parent feature upon which a construction depends.
Practice, practice, practice. You should be able to set up a simple program for the QC5000 demonstration block after reading this
chapter.
Double click on a program step within the Editing window to expand the step and view the sub steps (individual points
measurement instructions).
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 QC5000 Toolbars
 
In This Section...
Activating / Deactivating toolbars
Customizing toolbars
Datum toolbar
Measure toolbar
Probe toolbar
View toolbar
Tolerance toolbar
Program toolbar
VED toolbar

The other features that you see on the QC5000 main screen are toolbars. The QC5000 provides five primary toolbars:
Measure, View, Tolerance, Probe, and Datum. Several of these will be visible on the QC5000 main screen (if not,
don’t worry, just keep reading). Here is a quick introduction to the QC5000 toolbars:

Activating / Deactivating toolbars Back to the QC5000 Image Map

There are two ways to access the Toolbars dialog window, as follows:

From the Main Menu

1. Select "View" from the main menu. The View drop menu appears.

2. Select "Toolbars..." from the drop down menu. The Toolbars dialog box appears:

file:///D|/MANUAL/qc5kmap2.htm
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Proceed to Step 3 - Click HERE

From an existing Toolbar

1. Right click with the mouse over an icon from any existing Toolbars to display the following drop menu.

2. Select "Toolbars..." from the drop down menu. The Toolbars dialog box appears:

Note: This submenu can also be used to quickly activate and deactivate toolbars.

3. Select the toolbar you wish to activate or deactivate by clicking on the toolbar name. The selected name is
highlighted.

4. Select the "Show" button if you want the toolbar to appear on the main screen or select the "Hide" button if
you do not want the toolbar to appear on the main screen. An "X" in the box beside a toolbar indicates that the
toolbar is active, and will appear on-screen. An empty box indicates that the toolbar is inactive, and will not
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appear on-screen.
5. Select "OK" to accept the changes you have made or select "Cancel" to reject the changes and return to the

main screen.

Note: "Cancel" leaves the screen unchanged, as if you hadn’t entered the Toolbars dialogue box.

Customizing toolbars Back to the QC5000 Image Map

The QC5000 also allows you to create, modify, activate, and deactivate your own custom toolbars. This information,
available in the Customize section. Click HERE to go there.

The Datum toolbar Back to the QC5000 Image Map

This toolbar is used for the various Datum operations. Datums are explained in greater detail in the Reference
Frame section. Click HERE to go there.

The Measure toolbar Back to the QC5000 Image Map

This toolbar is used to select feature types for measurement by the QC5000. Feature types include points, lines,
circles, planes, cones, spheres, and slots. This toolbar is explained in greater detail in the Features section. Click
HERE to go there.

The Probe toolbar Back to the QC5000 Image Map

This toolbar is used for modifying the various probe functions and settings.

The View toolbar Back to the QC5000 Image Map

The view toolbar is used to adjust the on-screen view of a part, and to activate the View Rotator. Layer control and
Toolbars can also be accessed here. This toolbar is explained in greater detail in the View section. Click HERE to go
there.

The Tolerance toolbar Back to the QC5000 Image Map
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This toolbar is used for performing tolerances on selected features. Tolerances include: runout, concentricity,
parallelism, true positions, etc.. This toolbar is explained in greater detail in the Tolerance section. Click HERE to
go there.

The Program toolbar Back to the QC5000 Image Map

This toolbar is explained in greater detail in the User Programming section. Click HERE to go there.

The VED toolbar Back to the QC5000 Image Map

This toolbar is explained in greater detail in the Probes section. Click HERE to go there.
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 Reference Frame
 
In This Section...
The Datum Toolbar
Setting Auto Projection
Primary Alignment (part leveling)
Secondary Alignment (skewing)
Establishing A Zero
Saving The Reference Frame
Using Datum Magic (to establish a Reference Frame)
Magnetic Planes
Summary
Tips
 

Before you begin measuring features, you will want to establish a reference frame for the part that you are about to
measure. The reference frame enables the QC5000 to accurately measure features, and the relations between features
(angles, distances). The reference frame accounts for imperfection in the alignment of your part on the CMM, and
provides an absolute zero (part coordinate) from which all part features will be measured. The three steps in
establishing a reference frame are: 1) Primary alignment, 2) Secondary alignment, and 3) Establishing a zero.
Before you establish a reference frame, you should already have set a machine zero. Additionally, you should be sure
that all of your probe settings are correct, and that the current probe is a qualified probe.

The Datum menu

The Datum menu

The Datum Toolbar

This toolbar contains the following functionality.

   Datum Magic — See Using Datum Magic (in this section).

file:///D|/MANUAL/proberel.htm
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   Primary Plane — See Primary Alignment (in this section).

   Primary Cone — See Primary Alignment (in this section).

   Primary Cylinder — See Primary Alignment (in this section).

   Secondary Line — See Secondary Alignment (in this section).

   Zero Point — See Establishing A Zero (in this section).

   Save Reference Frame — See Saving the Reference Frame (in this section).

Setting Auto Projection 
Ordinarily, you should set projection to "Auto" before establishing a reference frame. There are several ways to do
this. The easiest way to determine the current projection.

is to check the status bar. If the status bar has been set up to display the current projection plane, then it will look
similar to this when set for Auto projection:

If the status bar contains an XY, YZ, ZX, or OFF setting, just click on the setting to cycle through the projection plane
settings. When the status bar reads AUTO, the projection has been set to AUTO.

The Datum Projection Submenu is set to Auto
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You can also change the projection by selecting Datum from the main menu, and then selecting Projection from the
datum drop down menu. The Projection sub-menu appears, and the current projection has a check beside it. Select
AUTO if it is not checked. When using Auto Projection, the QC5000 will automatically determine whether you are
probing datum features on either the XY, YZ, or ZX plane.

Primary Alignment 
Part Leveling

Primary alignment, or part leveling, is the first step in establishing a reference frame. Primary alignment can be
performed by probing a plane, cone, or cylinder. If a cylinder or cone is used to perform the primary alignment, then
the alignment occurs on a plane that is perpendicular to the axis of the cone or cylinder.

To perform primary alignment by probing a PLANE

The Primary Plane icon (located on the datum toolbar)

1. Select Datum > Primary > Plane... from the main menu or select the Primary Plane icon from the Datum
toolbar (above). The Primary Plane dialog box appears. (this box contains information about probing and
constructing primary planes that you may find useful as you gain experience with the QC5000).

2. Probe the primary plane. (As you would any plane. For complete instructions on probing a plane look under
planes in the Features chapter of this manual). Remember, a plane requires at least three points (spread out
across the parts surface). Additionally, you can construct a plane from previously measured features (e.g., a
midplane may be constructed from two previously probed planes, etc.).

3. Select OK with the mouse or the foot switch to accept the measurement of the plane. The plane appears in the
part view. Information about the plane appears in the result window. The plane is also added to the feature list.

To perform primary alignment by probing a CYLINDER

The Primary Cylinder icon (located on the datum toolbar)
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1. Select Datum > Primary > Cylinder... from the main menu or select the Primary Cylinder icon from the Datum
toolbar (above). The Primary Cylinder dialogue box appears.

2. Probe the primary cylinder. (As you would any cylinder. For complete instructions on probing a cylinder, look
under cylinder in the Features chapter of this manual).

3. Select OK with the mouse or the foot switch to accept the measurement. (As always, Cancel will abort the
measurement with no changes being made). The cylinder appears in the part view. Information about the cylinder
appears in the results window. The cylinder has been added to the feature list.

To perform primary alignment by probing a CONE

The Primary Cone icon (located on the datum toolbar)

1. Select Datum > Primary > Cone... or select the Primary Cone icon from the Datum toolbar (above). The
Primary Cone dialogue box appears.

2. Probe the primary cone. (As you would any cone. For complete instruction on probing a cone look under cones
in the Features chapter of this manual).

3. Select OK to accept the measurement. The cylinder appears in the part view. Information about the cylinder
appears in the results window. The cylinder has been added to the feature list.

Secondary Alignment 
Skewing the Part
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Once the primary alignment has been performed, you can perform the secondary alignment (also known as skewing the
part). For accurate measurement, the part must be aligned perfectly with the CMM. This degree of alignment is
unlikely, at best, and so the QC5000 compensates for a skewed part by converting machine coordinates into part
coordinates. Essentially, the QC5000 establishes an X axis that corresponds to the X axis of the part. This new,
skewed, X axis becomes the X axis for the reference frame that you are creating. 

The skew feature will be a line that runs along either the X, Y, or Z axis of your part. A line requires at least two points
(For complete instructions on probing a line look under lines in the Features chapter of this manual). We will be using
an X axis skew in our example.

To establish a secondary alignment (Skew)

The Datum menu (with Secondary highlighted)

The Secondary Line icon (located on the datum toolbar)

1. Select Datum > Secondary... or select the Secondary Line icon from the Datum toolbar (above). The Secondary
Line dialogue box appears.

2. Probe the Secondary (skew) line (As you would any line. For complete instructions on probing a line click here,
then select the Backspace key to return to this point.) or you can construct the skew line from previously probed
features (e.g., create a line between two probed circles, or a line that is the intersection between the Primary
Plane and another plane.)

3. Select OK to accept the measurement, or CANCEL to abort the secondary alignment.
4. The secondary line appears in the part view (below). Information about the secondary line appears in the result

window. The line has been added to the feature list (below).

file:///D|/MANUAL/features.htm#Lines: (2 points)
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Establishing A Zero 
When you leveled your part (primary alignment), you established the zero for the Z axis. When you skewed your part
(secondary alignment), you established the zero for the X axis. The final step in creating a reference frame is
establishing a zero, and as you may have guessed, this step involves a Y axis measurement.

To establish a Y axis measurement

Note: You should already have performed a primary and secondary alignment.

1. Select Measure from the main menu. The measure drop down menu appears.
2. Select Line from the measure drop down menu. The measure line dialogue box appears.
3. Probe a line along the Y axis (as you would any line. For complete instructions on probing lines look under lines

in the Features chapter of this manual).
4. Select OK to accept the measurement. The new line appears in the part view. Information about the line is

displayed in the results window. The line has been added to the feature list.

Note: Select the Line icon (from the measure toolbar) as a shortcut to step 3.

Now you have three features in the part view. All three are also listed on the feature list. These three features are used
to create the zero point, you will not need to measure any further points with the CMM to set the zero. Instead, you
will find the point that is created by the intersection of the X and Y lines that are already on the feature list. Then you
will use this point to create a second point at the Z zero level (the primary plane). This second point is your zero
point.

To create the zero point:
Note: When establishing the part zero, you must already have performed a primary, secondary, and Y axis alignment.
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1. First measure a point at the intersection of the X and Y axes.
1. Select Measure from the main menu. The measure drop down menu appears.
2. Select Point from the measure drop down menu. The Measure Point dialogue box appears (as a shortcut to

this step select the point icon from the measure toolbar).
3. From the Feature List select the X and Y lines by clicking on them with the left mouse button. Hold down

the CTRL button to allow multiple selection. When selected, the lines are highlighted on the feature list (if
you have followed this procedure they should be Line 1 and Line 2).

4. Select OK when both lines are highlighted on the feature list . The new point appears in the part view.
Information about the point appears in the results window. The point is added to the feature list.

 The zero point icon

2. Then measure the zero point on the Z plane.
1. Select Datum from the main menu. The datum drop down menu appears.
2. Select Zero from the datum drop down menu. The Zero Point dialogue box appears (see graphic on next

page). Be sure the Auto Zero box is checked (as a shortcut to this step, select the Zero icon from the datum
toolbar).

3. From the Feature List select the X/Y point (from the above procedure), and the primary plane. Hold down
the CTRL button to make multiple selections with the mouse (click on each feature while holding down
CTRL). If you have followed this procedure, you should select Plane 1 and Point 4.

4. Select OK when both features are highlighted. The zero point appears in the part view. Information about
the zero appears in the results window (all zeroes of course). The point has been added to the feature list
(with the word zero beside it).

Note: Once the zero is set, all subsequent measurements will be in reference to this zero point

The Zero Point dialogue box

The Zero Point dialogue box appears when you select the Zero Point icon or the Zero option from the datum menu.
Like all measure and datum dialogue boxes, this one contains information about probing and constructing the feature.
Like all measure and datum dialogue boxes, this one contains an OK button to accept a measurement, an Enter Pt
button for manually entering points, a Remove Last button to remove the most recently entered point, and a Cancel
button to abort the measurement. The Zero Point dialogue box also contains check boxes, for specifying which axis
will be zeroed. For establishing a reference frame, only Auto Zero should be checked (as pictured). If any of the other
boxes are checked (X, Y, or Z), click on them to remove the check.
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The zero point that you have set is the origin of your part. The black dot in this graphic illustrates where your zero
point should be. The dot sits at the X, Y intersection, at the level of the primary plane (which corresponds to the
part’s upper surface in this graphic). By convention, X is the horizontal axis, Z is the vertical axis, and Y shows depth.

The Feature List for a complete reference frame. Notice the primary, skew, and zero labels beside the primary plane,
skew line, and zero point.

The Part View for a complete reference frame. Notice the two points. The lower point is the intersection of X and Y.
The upper point is the zero point, it has been raised to the level of the primary plane.

Saving The Reference Frame 
 

Your reference frame is temporary until you save it. It is listed as Temp on the status bar and in the results window.
When a reference frame is temporary, any Datum function will change the zero or alignment of the existing frame.
If you set a new zero for any of the axes, or if you auto zero the axes, you will be altering the reference frame that you
created by following the procedures in this chapter. If you need to use several reference frames on a single part, you
will want to save reference frames.

The QC5000 will save up to nine (9) reference frames under names that you determine. Once you "name" a reference
frame, it becomes permanent, and any subsequent datum functions will automatically create a new reference frame
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with the Temp designation. The new temporary frame will not erase an existing frame if you have "named" the
existing frame. You might only use a single reference frame with each part, or you might use two reference frames for
each part, you might use four frames, or eight . . . up to nine reference frames for each part you measure.

Once you have more than a single reference frame, you can cycle between them by clicking on the reference frame
button on the status bar, or, you can toggle a reference frame on and off by clicking on its icon on the datum toolbar.

To save a reference frame

1. Select Datum from the main menu. The datum drop down menu appears.
2. Select Reference Frame from the datum drop down menu. The Reference Frame sub-menu appears.

3. Select Save from the reference frame sub-menu. The Save Reference Frame dialogue box appears.
4. Either: type a name in the new name box, or, leave the pre-selected name unchanged. If you leave the name

unchanged, the reference frame number will correspond to the frame number indicated by the datum toolbar
reference frame icons (see graphic below).

5. Select OK to accept the reference frame name and permanently save the reference frame. The reference frame is
now active. You can switch between different reference frames from the Datum toolbar or the Status bar.

The Datum toolbar contains a row of numbered buttons (1-9). These buttons are used to switch between reference
frames, each number will correspond to a frame that you have saved. Use the Save Reference Frame icon as a shortcut
to step 4 above. (The Save icon is directly to the left of the icon labeled 1).

Remember: Among the information displayed in the Results window is an indication of a feature’s RF (reference
frame).

Using Datum Magic 
Datum Magic can be used to simplify the process of establishing a reference frame. You can select Datum Magic by
selecting Datum from the main menu, and then selecting Datum Magic from the datum drop down menu; or, you can
select Datum Magic by clicking on the Datum Magic icon (located on the datum toolbar).

When you select Datum Magic, the Datum Magic dialogue box appears. It prompts you to, "Probe the datum features
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and then press OK." The dialogue box also contains more information about probing datum features that you may want
to read, but for now, follow the manual procedure for establishing a reference frame.

The Datum Magic dialog box

To establish a reference frame using Datum Magic

1. Select Datum from the main menu. The datum drop down menu appears.
2. Select Datum Magic from the datum drop down menu. The Datum Magic dialogue box appears.
3. Probe a plane (Datum Magic will automatically recognize this as the primary plane). Select OK with the mouse

or foot switch to accept the measurement.
4. Wait for the Datum Magic dialogue box to reappear. Probe a line along the X axis (Datum Magic will

automatically recognize this as the secondary alignment). Select OK to accept the measurement.
5. Wait for the Datum Magic dialogue box to reappear. Probe a line along the Y axis (Datum Magic will

automatically recognize this as the tertiary alignment). Select OK to accept the measurement. Datum Magic
computes for a moment, and then displays your results. The zero point was automatically established at the
intersection of your X, Y, and Z axes. The reference frame was automatically saved (if this is your first
reference frame, it was saved as Ref. #1).

Note: Use the Datum Magic icon (from the datum toolbar) as a shortcut to step 3.

Selecting Datum Magic from the main menu

The Datum Magic icon

Datum Magic minimizes the amount of operator interaction with the computer. Combined with a foot switch, Datum
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Magic allows you to establish a reference frame (set a datum) without touching the computer between feature
measurements. Additionally, Datum Magic eliminated the need to probe intersection points; instead, the zero point was
automatically calculated from the three probed features. Just remember the sequence: primary plane, X axis, Y axis,
and you’ll never have trouble with Datum Magic.

Magnetic Planes 
The Magnetic Planes icon (on the Measure toolbar)

A Magnetic Plane will attract two-dimensional features to its surface. If a two-dimensional feature is probed near a
Magnetic Plane, that feature will automatically shift to rest on a Magnetic Plane. If you are probing a part on which
several features exist on the same plane, you will want to use Magnetic Planes. Also, if you are performing reverse
engineering operations you will find Magnetic Planes useful.

Magnetic Planes are always aligned to the current reference frame, so they are always created parallel to the XY, YZ,
or ZX plane of the part. Magnetization may also be applied to an existing plane, but the QC5000 will adjust the
Magnetic Plane to correspond to an XY, YZ, or ZX plane (this will be obvious in the part view).

To activate Magnetic Planes you first need to probe one into the QC5000.

To probe a Magnetic Plane into the QC5000:

1. Select the Magnetic Plane icon from the Measure toolbar. The Magnetic Plane dialog box appears.

2. Probe a single point for each Magnetic Plane that you want to create. The QC5000 will create planes parallel to
the current reference frame XY, YZ, or ZX plane for each point that you probe.

3. Select OK to accept the points and create the Magnetic Planes.

Note: A Magnetic Plane can also be constructed from an existing plane via a single parent construction.

Once you have created one or more Magnetic Planes in the QC5000, you still need to activate them if you want them
to attract two-dimensional features to their surfaces. Do this by selecting Datum > Magnetic Planes > On from the
main menu (a checkmark will appear next to the On menu item to indicate that it is active.) Once the Magnetic Planes
are probed and activated, two-dimensional features will be drawn to the Magnetic Planes surfaces.

The Magnetic Planes sub-menu
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You also have the option to treat work planes as magnetic planes. Select Tools > Options > General Options from the
main menu. The Options dialog box will appear. Select the Measure tab, then select the "Treat work planes as magnetic
planes" option (see below.) A check mark in this field indicates that the functionality is turned on.

The Measure tab of the Options dialog box

Summary: 
After reading this chapter you should be able to establish a reference frame for the part that you want to measure. You
should be able to use either Datum Magic, or the manual method to establish this reference frame. You should also
know how to save a reference frame, and how to toggle between reference frames.

Tips: 
Remember that Datum Magic automatically saves the new reference frame for you, and names it according to the
numbers on the datum toolbar.
Use the datum toolbar to set the projection plane for Auto.
Use the datum toolbar to toggle between reference frames.
Use the datum toolbar to activate Datum Magic
Use the datum toolbar to save Temp reference frames.
Remember that a feature’s reference plane is displayed in the results window.
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 Relations
 
In This Section...
What Is A Relation?
Measuring Relations
     Angles
     Distances
Summary
Tips
 

What Is A Relation? 
Relations exist between features. The QC5000 supports two relations: distances and angles. The QC5000 treats
relations exactly as it treats features: you can probe relations into the QC5000 by choosing a relation’s icon, or you can
probe relations into the QC5000 by selecting Measure from the main menu, and then selecting the relation that you
want to measure. Remember: Measure Magic does not work with relations.

As with other features, distances and angles can be measured by selecting Measure from the main menu, and then the
relation; or by clicking on the relation’s icon. Relations are added to the feature list just like any other feature.
Information about the relation appears in the results window. The relation also appears in the part view.

Note: Before measuring relations, be sure that projection is set to Auto.

Measuring Relations 

Angle / Distance icons (use these as shortcuts when measuring relations)

Angles:

Select Measure from the main menu and the measure drop down menu appears. Select Angle from the measure drop
down menu. The Measure Angle dialogue box appears (you can also click the measure icon to get here):
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The Measure Angle dialog box

To Probe an Angle:

1. Select Measure from the main menu. The measure drop down menu appears.
2. Select Angle from the measure drop menu. The Measure Angle dialogue box appears (pictured above).
3. Probe a line that corresponds to one side of the angle. For complete information on probing a line see the line

section of the features chapter.
4. Select OK to accept the line. The Measure Angle dialogue box remains onscreen (you don’t need to select

anything). The line appears in the part view. The line has been added to the feature list. Information about the
line does not appear in the result window.

5. Probe the line that corresponds to the other side of the angle.
6. Select OK to accept the line (Cancel aborts). The Measure Angle dialogue box disappears. The line, apex point,

and angle have been added to the feature list. Information about the angle appears in the result window.

Note: As a shortcut to step three (3), use the angle icon.

Note: A bound line is simply a line for which you have designated end-points.

Notice that the measurement of an angle actually produces four features: two legs, the apex point, and a dotted arc that
indicates the angle itself. Each of these features appears in the part view and on the feature list. The results window
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contains information about the angle: Name (angle 18), Derivation (from two features), degree (<), XY/YZ/ZX angles,
reference frame (this angle exists in a Temp. frame), and projection plane (the tilde[~] in front of the XY projection
plane indicates that this angle is "very nearly" an X/Y angle). Angles can be projected to any plane, Auto projection
will assign an angle the most appropriate projection.

Distances:

Distances are measured between fixed points. Lines are infinite (they extend in each direction, endlessly). When a
distance is measured between two points along a line, the line that corresponds to this distance is bound. Bound means
that a feature (a line in this case), has fixed points at which it begins and ends. Bound means that a feature has
boundaries, and that is does not extend endlessly in any direction. When you measure a distance, the result will always
equal the length of a bound line that corresponds to the distance. Think of lines as highways that go on forever, and
think of points as exits. When you measure a distance, you are measuring a section of the highway between two exits.
The exits are the boundary (the start and finish points) of the measurement.

To measure a distance select Measure from the main menu. Then select Distance from the measure drop down menu.
The Measure Distance dialogue box appears. You can also use the distance icon to get here:

   

Measure Distance dialogue box

To probe a distance:

1. Be sure that the projection is set to Auto (see the setting Auto projection section of the Reference Frame chapter
in this manual).

2. Select Measure from the main menu. The measure drop down menu appears.
3. Select Distance from the measure drop down menu. The Measure Distance dialogue box appears.
4. Enter the first point (the point should correspond to a terminal point of a bound line that represents the distance;

in other words, probe one of the points between which you want to measure the distance).
5. Enter the second point (the point should correspond to the other terminal point of a bound line that represents the

distance; in other words, probe the other point between which you want to measure the distance).
6. Select OK to accept these points as the points between which the measurement will occur. The distance appears

in the part view. Information about the distance appears in the result window. The distance has been added to the
feature list.

Note: As a shortcut to step four (4) use the distance icon.
Note: A bound line is simply a line for which you have designated end-points.



Relations

file:///D|/MANUAL/RELATION.HTM[6/28/2019 8:21:19 AM]

Plane 8 is shown here only for perspective…a distance can be measured independently of the features between which
it exists.

  

The results of a distance measurement: length; X/Y/Z co-ordinates; reference frame; projection plane; origin.

Summary: 
The procedure for measuring relations is the same as the procedure for measuring features. You use the main menu, or
an icon, to get a measure dialogue box on screen. Then you probe points into the QC5000. Just remember: an angle is
formed by two lines (so you will always probe two lines when probing and angle), and a distance is formed by two
points (so you will always probe two points when probing a distance). In the next chapter (Constructions) you will
learn a variety of ways to add features and relations to the feature list by using features and relations that have already
been measured. You will be able to create distances between circles, planes, etc. . . . You will be able to create angles
with planes, cylinders, etc. . . . Remember, there are many ways to construct angles and distances, but only one way to
probe each of them.

You should now be able to:
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Probe Angles into the QC5000
Probe Distances into the QC5000

Tips: 
Use the angle icon to get to the angle dialogue box
Use the distance icon to get to the distance dialogue box
Remember to set projection to auto while measuring relations
Don’t get hung up on the difference between bound and unbound features. Just remember that when
measuring a distance, you must specify a start point and a finish point.

 



Results Reference

file:///D|/MANUAL/RESULTRF.HTM[6/28/2019 8:21:21 AM]

 Results Reference
 
In This Section...
Results Window Reference Legend
   Cylinders/Cones
   Planes
   Angles
   Lines
 

Results Window Reference Legend 
~ (tilde) — Appearing before a feature's projection plane, the tilde indicates "very nearly." The tilde can indicate a five
(5) degree swing in a feature's orientation.

al (arc length) — A measurement that produces an arc will produce the arc length result.

d (diameter) — Indicates a features diameter.

f (form) — The form result indicates how well the points used to calculate a feature "fit" the feature type. The form
value represents a width within which the probed points that compose a feature exist. When you perform a form
tolerance, you specify the maximum width within which all points must fall…if points lie outside this width, then the
feature fails tolerance.

l (length) — Indicates the length of a feature (distances).

p (projected angle) — Indicates the angle of a slot (projected).

pp (projection plane) — Indicates the plane (XY, YZ, ZX, or 3d) on which a feature exists. Obviously, three
dimensional features are un-projected.

r (radius) — Indicates a feature's radius.

rf (reference frame) — Indicates the reference frame in which the feature exists. You have control over a reference
frame's name, although temp will always be indicated as such.

t (taper angle) — This result indicates the angle at which a cone tapers toward its apex.

w (width) — Indicates the width of a feature.

x (position, distance) — For most features, this indicates the x-axis location of a feature's midpoint. For a distance, this
indicates the x-axis distance between the parent features (or probed points).

xy (xy angle) — The xy angle result for axial features (cylinders, cones) is the angle between the axis of the feature,
projected to the xy plane, and the x axis of the reference. See notes below for more information.

y (position, distance) — For most features, this indicates the y-axis location of a feature's midpoint. For a distance, this
indicates the x-axis distance between the parent features (or probed points).

yz (yz angle) — The yz angle result for axial features (cylinders, cones) is the angle between the axis of the feature,
projected to the yz plane, and the y axis of the reference frame. See notes below for more information.

z (position, distance) — For most features, this indicates the z-axis location of a feature's midpoint. For a distance, this

file:///D|/MANUAL/toleranc.htm
file:///D|/MANUAL/index.htm
file:///D|/MANUAL/prog-bas.htm


Results Reference

file:///D|/MANUAL/RESULTRF.HTM[6/28/2019 8:21:21 AM]

indicates the z-axis distance between the parent features (or probed points).

zx (zx angle) — The zx angle result for axial features (cylinders, cones) is the angle between the axis of the feature,
projected to the zx plane, and the z axis of the reference frame. See notes below for more information.

Note: The Projected Angle (xy, yz, zx) results occur for a variety of features, and may need further clarification.
Remember that these results are always produced by first projecting an axis, angle, or plane's normal to the two
dimensional projection plane indicated by xy, yz, or zx. Following is a description of these projection angle
results by feature type; if you do not understand projection, you may want to review the "2D and 3D" section of
this manual.

Cylinders/Cones 

To determine the xy, yz, and zx angle of a cylinder or cone, the QC5000 projects the axis of the feature (cylinder /
cone) to the indicated projection plane. The xy result indicates the angle between the feature axis, projected to the xy
plane, and the x-axis of the reference frame. The yz result indicates the angle between the feature axis, projected to the
yz plane, and the y-axis of the reference frame. The zx result indicates the angle between the feature axis, projected to
the zx plane, and the z axis of the reference frame.

Planes 

The xy, yz, and zx normal angle results produced by a plane measurement are very similar to the results produced by a
cylinder measurement. The key to understanding a plane's projected-angle results is understanding the term "normal."
Essentially, a line that exists normal to a plane is perpendicular to the plane (90 degrees). It is this line, this normal,
that is projected in the same manner that the axis of a cylinder is projected to determine projected angle results. One
way to envision the normal of a plane is to picture the plane with a cylinder that pierces it in perpendicular fashion.
The axis of this imaginary cylinder is the normal of the plane.

Angles 

The result of an angle measurement provides three projected-angle results. These projected angle results are produced
by projecting the original unprojected result of the angle measurement to each of the three 2d projection planes.

Lines 

The projected-angle results of a line are perhaps the easiest of this group to understand. There is no three-dimensional
feature to strip away, no axis to find, and no angle to mentally twist. The line is simply projected to the two
dimensional plane indicated (xy, yz, zx), and then the angle between the line and the reference frame x, y, or z is
calculated.
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 Special Probes
 
In This Section...
"Special Probes" Are:
Finding Machine Zero
Qualifying A Special Probe
     Basic Qualification
     Qualifying special probes that are used interchangeably
 

"Special probes" Are: 
Automatic disk probes
Automatic cylindrical probes
Hole-finding (taper) probes
Hard cylindrical probes

Qualifying A Special Probe: 
This topic will be presented as two sections: basic qualification, and qualifying special probes that are used
interchangeably.

1. Basic Qualification:

This method is ideal when only a single probe will be used, and no part measurement will extend into a second
QC5000 session. Remember, if there is no repeatable machine zero, then all measuring of any single part must occur in
a single session.

In this scenario, the diameter of the probe must be determined, but offsets are not necessary.

1. Be sure that probe compensation is off.
2. Select a probe for qualification.
3. Access the Probe Library and create a new probe: name it, designate its name, type and group.
4. Click No Need To Qualify to mark the probe as "qualified" and bypass the probe "teach" procedure.
5. Measure the equator of a gage ball (or ring gage) of known size, and note the result.
6. Find the difference between the standard (known) size of the gage ball and the result noted above. This will

result in the diameter of the cylinder or disk probe.
7. Note the diameter of the probe.
8. Enter the diameter into the Diameter field of the Probe Library.
9. Activate probe compensation.

10. Measure the gage ball to confirm that the probe has been qualified and is measuring correctly. Your result should
equal the known value of the gage ball.

Notes:

A hole finding (taper) probe is always defined as a zero diameter hard probe.
For thin disk probes, measuring the gage ball equator may not give repeatable results because it will be difficult
to be sure that the disk is aligned with the equator. Use a ring gage.
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2. Qualifying special probes that are used interchangeably:

This scenario requires that probes be fully qualified for both size and offset. Again, if no repeatable machine zero can
be established, then all measurement of a given part must occur within the same QC5000 session. If you lose power,
experience a freeze, close down the QC5000 without finishing your measuring, or accidentally unplug the power chord
with your foot; you will need to begin measuring from the very first point.

You can determine the size of each probe that you will use in the manner described above. Essentially: measure an
artifact of known diameter, then subtract the known diameter from the result of the measurement. This new number
equals the diameter of the probe.

The "Notes" from above also apply in this second scenario . . . so pay close attention to them when determining the
size of a special probe.

Determine The Offsets Of Each Probe

Before you begin:

For this procedure we assume that the probe is used to measure features of the XY plane. The procedure may be
modified if the probe is held in some other orientation.
If you are using hard stops as a machine zero, you must turn SLEC off, and temporarily use a gage ball (or ring
gage) as machine zero. This temporary machine zero can be any convenient location on the stage.

1. The size of each probe has been determined previously (see "basic qualification" if you need a method for
determining probe size). All probe offsets are 0,0,0. Leave probe compensation on.

2. Once this procedure is complete, one probe will have 0,0,0 offset. We will refer to this probe as the "master
probe." With the master probe, measure the qualification sphere as a circle. It is not required to find the exact
equator.

3. Establish an XY zero at the center of this circle.
4. Now install the next probe. In the Probe Library, this probe's offsets should be set to 0.0, and this probe's

diameter should be predetermined and entered into the Diameter field.
5. With this probe, measure the qualification sphere as a circle.
6. The XY position of this circle is the offset needed to unify the two probes. In the Probe Library, enter the XY

offsets for this probe. Remember, if the XY measurement of the gage ball is .5mm (positive), then the offset
necessary to compensate for that is -.5mm (negative).

7. Mark the probe as qualified (again, this method is currently undetermined, but should be fairly obvious). This
will bypass the "Teach" function.

8. Check this qualification by re-measuring the gage ball. The circle center should come out as 0,0.

Notes:

If you needed to establish a temporary machine zero to replace a hard stop machine zero, you can now begin
using the hard stops again. These probe offsets are relative to the master probe, not machine zero. If you want to
re-qualify the master probe, you will need to re-qualify all probes with offsets based on the master.
You can continue to perform the offset procedure without re-establishing the XY zero point. This only should be
established once during qualification.
If you want to cross calibrate the Z axis you will need to probe a point at the top of the gage ball (with the
master probe). Now move the Z datum to that position (only the Z datum!!). Each subsequent measurement of
the Z datum will produce the necessary Z offset that relates the new probe to the master probe.
If a normal probe is already qualified, then the center of the qualification sphere will represent a 0,0 offset--
calculate accordingly.
Always check every qualification attempt by re-measuring the gage ball. The circle center (XY in this case)
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should always be 0,0. The height (Z) should be one of two numbers: if qualified at the top it should be 0,0; if
qualified at the center it should be the gage ball radius.
Offsets are defined in relation to machine zero: if the qualification sphere is at machine zero, then repeat
measurements of this sphere with qualified probes will produce a 0,0,0 location (as well as a correct result for
sphere diameter).
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 Templates
 
In This Section...
Working with templates
Template window general properties
Template window column properties
Runs Template - Charts
 

Working with templates
Nesting windows

There are four windows in the QC5000 interface that can be nested within a single window. These are:

Features Window
Program Window
Runs Template
Report Template

To nest a window within another, select its title bar, then drag the entire window and drop it onto the title bar of the
window you want to nest in. For example, the image below shows the Program window in front of the Features
window.

If you place the mouse cursor over the Program window title bar, then (while holding down the left mouse button) drag
the Program window until the top left corner of it is directly over the Features window then release the left mouse
button.
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The window, that previous contained only the Features window, now contains tabbed items for both the Features and
the Programs windows. To switch between each, select the appropriate tab with the left mouse button.

Template window general properties
Each template windows properties have unique options that are specific to the functionality of that template.
Additionally, there are some properties that are present for all templates. Select an option below to learn more.

Standard template properties (present in all windows)
Features window template properties
Program window template properties
Runs window template properties
Report window template properties

Standard template properties
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Place the cursor is over the main body of the Feature List window. Then select and hold the right mouse button to
display the right-click context sensitive menu. One of the following menu items will be "Template Properties..." (see
below). 

Select "Template Properties..." with the left mouse button to display the Template Properties dialog box.

The Template Properties dialog box contains three tabbed sections (Display, Filters, and Misc.). The descriptions for
each tab follows.

Display tab

Display
Grid
Sections
Set Text Color
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Set Line Color
Font Size

Display

Horizontal Lines - Toggles the display of gray separator lines between each row in the Feature List window.
Vertical Lines - Toggles the display of gray separator lines between each column in the Feature List window.
Expand Images (VED systems only) - Toggles between full size or iconic display of images in the Feature List
window.

Grid

Snap To Grid - Toggles whether or not the Feature List fields grid will resize in increments of 10 during resizing.
Grid Size - Allows you to change the default value (10) that fields will snap to during resizing.

Sections

Show Report Header - Allows you to create a customized header for a specific portion of data. Used for reporting and
printing purposes. 
Show Report Footer - Allows you to create a customized footer for a specific portion of data. Used for reporting and
printing purposes. 
Show Page Header - Allows you to create a customized header that will appear at the top of every page of reported
data. 
Show Page Footer - Allows you to create a customized footer that will appear at the bottom of every page of reported
data.

Set Text Color / Set Line Color / Font Size

These options allow you to change the way information is displayed in the template window. Selecting either the "Set
Text Color" or the "Set Line Color" buttons will display the Color selection dialog box.

Select a color that will be used for the selected item (Text or Line), then select OK. By default, both the Text and Line
colors are black.



Templates

file:///D|/MANUAL/TEMPPLTS.HTM[6/28/2019 8:21:26 AM]

Entering a numerical value in the Font Size option will change the size of the font used in the template window. The
default font size is 10.

Template window prior to changing colors:

Template window with blue text, red lines, and font size 12:

Filters tab

The Filters option of the Feature Template Properties dialog allows you to establish conditional values that will
determine which part values will be displayed in the Feature List window. By default, all parts are displayed in the
Feature List. However, you may want part value to display only when specific conditions exist during measurement.
There are many ways that this functionality can assist you, such as:

Quality Control / Statistical Analysis - Produce reports and/or historical part data to ensure production
consistency, (e.g., Only display part values when tolerance thresholds have been exceeded.)
Reports - You can create and print out detailed reports on specific part values with letter-head quality headers
and footers (see Sections), using easy-to-understand customization options.
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Show Features / Hide Features

Show Features / Hide Features radio buttons - When creating a feature filter, you must first decide the
how this filter will present itself in the Feature List window. By default, all part features are displayed in
the Feature List. However, the purpose of filtering is to isolate specific information. You must then decide
if you want the Feature List to display only entries that match the parameters of the filter (Show Features)
or remove entries from the Feature List that apply to this filter (Hide Features).

That meet all conditions / That meet any conditions

That meet all conditions / That meet any conditions radio buttons - In instances where multiple filters
are being used, you will need to decide whether all of the filters will:

Only filter information if all of the conditions defined in each individual filter have been met (That
meet all conditions).
or filter information if at least one of the filters conditions have been met (That meet any
conditions).

Add Filter Button

Selecting this button will display the Filter dialog box.

The Filter dialog box contains the following regions:

Filter - In this region, you can either manually input values that will define the filter, or monitor,
add, and edit values placed here by the four common value palette buttons located to the right of this
region.
Fields > common value palette...
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The Fields > submenu contains a palette of part field(s) that can be used to construct the filter.

Functions > common value palette

The Functions > submenu contains a palette of advanced mathematical variables.

Operators > common value palette

The Operators > submenu contains a palette of common mathematical operators.

Tolerances > common value palette

The Tolerances > submenu contains a series of nested submenus of tolerancing operators.

Other > common value palette
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The Other > submenu contains a palette of miscellaneous variables.

Modify Filter Button

If you need to modify an existing filter, select the applicable filter that you want to modify from the Filter
region of the Feature Template Properties dialog box, then select the Modify button to display the Filter
dialog box. The Filter dialog box will display the current filter parameters in the filter region. Select either
the entire filter or only the portion you want to edit with the mouse, make whatever changes are required,
then select the OK button to complete the process. If you are finished modifying filters, select OK again to
close the Feature Template Properties dialog box.

Remove Filter Button

Simply select the filter that you want to remove from the Filter region of the Feature Templates Properties
dialog box, then select the Remove button. You will be asked to confirm your request the delete the
selected feature. Select OK to complete the removal process.

Misc. tab

Locked
Runs Template
Append to file when exported
Include headers when exported

Locked
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Selecting Locked in the Feature Template Properties dialog box instructs the QC5000 that only individuals that have
entered the correct supervisor password can edit the Feature Template Properties dialog box options.

Runs Template

Select this option will instruct the Feature List to display in Runs mode.

Template window column properties
Each template window can have columns added, re-ordered, modified, or removed. Each template windows column
properties have unique options that are specific to the functionality of that template. Additionally, there are some
column properties that are present for all templates. Select an option below to learn more.

Standard column properties

To add, edit, or remove a column appearing in the Feature List, you must:

If adding a new column to the Feature List

1. Place the mouse cursor over the next available column header in the feature list.
2. Right click, with the mouse, on the column header. One of the following menu items will be "Column

Properties..." (see below).

3. Select Column Properties... with the left mouse button. The Column Properties dialog box will appear:

Appearance Tab - settings in this tab will define how the column will appear in the Feature List.

4. In the Name field - Enter a value that the Feature List will use for the column header.
5. In the Width field - Enter a value that will determine the columns width. The column width can also be set in

the Feature List main window by placing the mouse cursor over the column divider line (in between each column
header).
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6. In the Title Alignment field - Select whether you want the column header title to flush to the left edge, the
middle, or the right edge of the column header bar.

7. In the Data Alignment field - Select whether you want the data that will appear in this column to flush to the
left edge, the middle, or the right edge of the column.

Formulas Tab - settings in this tab will define what information will be displayed for this column in the Feature
List.

8. Add - Select this button to add a formula to the selected column. The following dialog box will appear:

Formula - settings in this dialog box define the parameters of a column formula.

— Label - The descriptive text that you enter here will be displayed in front of all values in this column. For
example, if this column is displaying the X coordinate for a specific part (e.g., 3.00334), then entering "X = "
(without the quotes) in the Label field will define what the displayed value is being derived from (e.g., X =
3.00334).

— Feature - 
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— Formula - The Formula region consists of the following options:
Formula region - In this region, you can either manually input values that will define the formula, or add
values available from the four common value palette buttons located to the right of this region.
Fields > common value palette...

The Fields > submenu contains a palette of part field(s) that can be used to construct the formula.

Functions > common value palette

The Functions > submenu contains a palette of advanced mathematical variables.

Operators > common value palette
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The Operators > submenu contains a palette of common mathematical operators.

Tolerances > common value palette

The Tolerances > submenu contains a series of nested submenus of tolerancing operators.

 

Other > common value palette

The Other > submenu contains a palette of miscellaneous variables.

— Result type: - The values available from this drop list will determine the way the Feature List will treat the
data being produced by the formula. Applicable values are:

Inch/mm — Data is a linear dimension
Angular — Data is an angular variable
Numeric — Data is in common numeric format
Text — Data is a text-based variable

— User constants are: - The values available from this drop list will determine the way the Feature List will
treat the data being produced by the formula. Applicable values are:

Inch — Data is to be formatted in units of inches.
mm — Data is to be formatted in units of millimeters.
Radians — Data is to be formatted as a radius value.
Degrees — Data is to be formatted in degrees.
Fixed — Data is to be formatted in the manner in which it is received.
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9. Modify - If you need to modify an existing formula, select the applicable formula that you want to modify from
the formula region of the Formula tab of the Column Properties dialog box, then select the Modify button to
display the Enter Equation dialog box. The Enter Equation dialog box will display with the current formula
parameters. Select the portions of the formula you want to edit, make whatever changes are required, then select
the OK button to complete the process. If you are finished modifying formulas, select OK again to close the
Column Properties dialog box.

10. Remove - If you need to remove an existing formula, select the applicable formula that you want to remove from
the formula region of the Formula tab of the Column Properties dialog box, then select the Remove button to
delete the selected formula. You will be asked to confirm your decision to remove the selected formula because
this process is irreversible. Select the Yes button to complete this process. If you are finished working with the
formulas in this column, select OK again to close the Column Properties dialog box.

Runs Template - Charts 
The Runs Template allows you create graphical charts from collected data. To access this functionality, you must have
a Runs Template with at least two or more results from a specific part. 

Right click the mouse while the cursor is over a column header in the Runs Template. A context menu will appear.
Select the "Charts" menu item, the chart type sub-menu will appear (see below).

Three chart types are available:

X Bar Chart - Run Column
R Bar Chart - Run Column
Simple Data Chart - Run Column
X Bar Chart - Circle Column
R Bar Chart - Circle Column
Simple Data Chart - Circle Column

X Bar Chart - Run Column
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R Bar Chart - Run Column

 

Simple Data Chart - Run Column
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X Bar Chart - Circle Column

 

R Bar Chart - Circle Column
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Simple Data Chart - Circle Column
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If you want to see a list of possible tolerances: select Tools from the main menu, and then select Tolerance. The
tolerance sub-menu appears containing a list of possible tolerances that can be performed on the selected feature.

The following example displays the possible tolerances for a circle, notice that Angle, Straightness, Parallelism,
Perpendicularity, Width, Cylindricity, and Flatness do not appear on the menu because they can not be performed on
this circle.

file:///D|/MANUAL/2d-3d.htm
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Select a circle from the feature list.

Now select Tools > Tolerance from the main menu:

Notice that several of the Tolerance Toolbar options do not appear on this sub-menu. The QC5000 lists only those
tolerance operations that can be performed on the selected feature (Circle 1 above). From the sub-menu you can select
any of the tolerances by clicking on them with the mouse.

The tolerance toolbar and tolerance menu provide two ways to tolerance features. Both will bring you to the same
dialogue boxes (we’ll look at these in a minute), and both are accessed easily by pointing and clicking. The only
difference to keep in mind is that the toolbar doesn’t change (unless you resize it), while the tolerance sub-menu is
tailored to the feature that you highlighted on the feature list.

Tolerance Toolbar 
Tolerance Toolbar
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The tolerance toolbar can be activated like any other toolbar (select View from the main menu, and then select
Toolbars. An "X" beside Tolerance indicates that the toolbar will be displayed on the main screen. There are twelve
icons on the tolerance toolbar: Bi-directional, True Position / MMC (Maximum Material Condition) / LMC (Least
Material Condition), Runout, Circularity / Sphericity, Concentricity, Angle, Straightness, Parallelism / Coplanarity,
Perpendicularity, Width, Cylindricity, and Flatness (see graphic on following page).

The tolerance toolbar can be moved and sized like any other toolbar. To move a toolbar, click on the title bar and drag
the toolbar with the mouse. To size a toolbar, place the mouse pointer on the edge of the toolbar so that it becomes the
sizing arrow: you can now adjust the way that the toolbar is displayed.

Tolerance Toolbar Icons 

You can not perform every tolerance on every feature. For example, you can not perform a cylindricity tolerance on a
point. If you choose a tolerance operation that is not appropriate for a selected feature, the QC5000 will not allow you
to perform the tolerance (the QC5000 may beep to indicate that something can not be done).

By selecting the Tolerance option from the Tools drop down menu, you can view a list of possible tolerances for your
selected feature.

Bi-Directional Tolerance 

 The Bi-directional tolerance icon

Bi-directional tolerance is a location tolerance available for circles, points, arcs, and spheres. This tolerance allows you
to 1) specify a nominal position and size for the selected feature, 2) specify the upper and lower deviation allowed
from the nominal position and size, and 3) calculate the pass / fail results of the tolerance.

Here we’ll use bi-directional tolerancing on a circle as an example, but the same procedure applies to any feature that
can be bi-directional toleranced.
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Use Bi-directional Tolerance on a circle

1. Select a circle from the feature list. If there is no circle on the feature list, probe one into the QC5000 in the
normal fashion (see circles in the Features chapter). The circle is highlighted on the feature list when it is
selected.

2. Select the Bi-directional tolerance icon. The Bi-directional Tolerance Entry dialogue box appears. The nominal
X, Y, and Z values are taken directly from the results window. You will probably want to change these values.

3. Change the default Nominal X, Y, and Z values to the X, Y, and Z values that your circle should conform to. Do
this by clicking on the X value with the mouse, and then entering a new value from the keyboard. Do the same
for the Y and the Z values.

4. Change the default Size setting (which is taken directly from the result window) to the size setting to which your
circle should conform. Do this by clicking on the size value with the mouse, and entering a new value with the
keyboard. (Size can also be set as either a radius or diameter, just click on the R (or D) button in the size section
to toggle between radius and diameter settings). The QC5000 will automatically calculate the change between
radius and diameter.

5. Enter the nominal+ and nominal- values for the X, Y, Z, and Size settings. The nominal+ is the amount that the
actual measurement can exceed the nominal value (nominal+ is an inclusive value). The nominal- value is the
amount that the actual measurement can fall short of the nominal value (nominal- is an inclusive value).

6. Select OK to accept the nominal and deviation values. The QC5000 will calculate for a moment, and then
produce the Bi-directional Tolerance Results dialogue box. If the axes pass the tolerance, a green P appears
beside them. If one or any axes fail the tolerance, that axis has a red F beside it. If the size passes the tolerance, a
green P is shown beside it. If the size fails the tolerance, a red F is shown beside it.

7. Select OK to accept the tolerance. A green (pass) or red (fail) indicator appears beside the toleranced circle on
the feature list OR select EDIT to return to the Bi-directional Tolerance Entry dialogue box, and reenter
tolerance data.

Note: Rather than enter Nom+ and Nom- values, you can enter specific High Limit and Low Limit values.
Instead of entering a nominal value and then an acceptable deviation, you enter actual coordinates for each axis
within which the measurement must fall. To do this, click on the Nom+ label in the Bi-directional Tolerance
Entry dialogue box. The Nom+ label will change to High Limit. Change the other Nom+ and Nom- labels in the
same manner.

For any feature that you tolerance Bi-directionally, you will always be comparing the measured location of a center
point (on at least one axis), to the nominal (specified) location of that feature’s center point. Additionally, you will be
comparing the measured size (radius) of a feature to the specified, expected size that the feature should be. If you have
high and low limit specifications feel free to enter the upper and lower limits (see note above, and graphic on following
page). If your measurement falls below the lower limit, or exceeds the upper limit, you will be notified by a red F, and
a red circle beside the feature on the feature list.

The Bi-directional Tolerance Entry dialogue box:
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The Bi-directional Tolerance Results dialogue box contains information that may be valuable for generating reports.
Nominal value, Actual value, Deviation, Low Limit, and High Limit are displayed for each axis and for the feature
size. Notice that you can select Edit from this dialogue box to return to the Entry dialogue box and modify your
tolerancing. P indicates pass; F fail.

True Position / MMC / LMC 

 The True Position icon

True Position is a location tolerance, and as with bi-directional tolerancing, you will be required to enter nominal X,
Y, and Z coordinates . True position tolerancing is available for: circles, points, arcs, and spheres. This tolerance allows
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you to 1) specify a nominal position and size for the selected feature, 2) specify the upper and lower deviation allowed
from the nominal position and size, and 3) calculate the pass / fail results of the tolerance. True Position tolerancing
acts RFS (Regardless of Feature Size).

Here we will perform a True Position tolerance on an arc, but the method for this type of tolerancing will be the same
regardless of feature type.

True Position Tolerancing (on an arc)

1. Highlight an arc on the feature list.
2. Select True Position from the Tolerance toolbar or the Tools>Tolerance menu. The True Position Tolerance

Entry dialogue box appears.
3. Change the X, Y, Z, and Size values from the default settings (which are taken directly from the result window)

to the specified, nominal settings. Do this by clicking on the default value with the mouse, and entering a new
value with the keyboard.

4. Enter the Specified tolerance diameter.
5. Enter the Nom+ and Nom- size values. These can also be entered as coordinate High and Low limits (click on

the Nom+ and Nom- labels to toggle between the two setting options)
6. Select OK to accept the entered values. Select Cancel to abort the tolerance. If you select OK, the True Position

Tolerance Results dialogue box appears.
7. Select OK to accept the Pass / Fail results; or, select Edit to return to the Entry dialogue box.

Note: Position and Size may have a different Pass / Fail result from each other; however, the feature list will
display a red Fail result if either one of the True Position results is a failure.

Remember, you can get to any possible tolerance by selecting Tools from the main menu, and then Tolerance
from the drop down menu…so if you’re ever confused by a toolbar icon, use the main menu.

True Position Tolerancing Results

A True Position tolerance that produces a pass and a fail result will display a red fail marker on the feature list. Notice
the exaggerated diameter values used here to produce the failing result. Notice that the passing Size result is the product
of leaving the nominal radius unchanged (e.g. not entering a nominal radius, but rather leaving the feature’s default
radius which was taken from the main result window).

True Position tolerancing is RFS (regardless of feature size) tolerancing. The size and position are independent, and do
not function together to produce true position bonuses. MMC (Maximum Material Condition) and LMC (Least
Material Condition) will calculate bonuses.
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MMC / LMC

Maximum material condition and Least material condition are tolerances used for bores and bosses. When parts fit
together, there is a certain amount of specified deviation that can occur. For example, a bore can be slightly larger than
its nominal specification, and still function normally. A bore that is slightly larger than its specification, however, will
derive a certain amount of bonus. If you use MMC and LMC tolerancing, the QC5000 factors the true position bonus
into its calculations, and prevents the rejection of tolerance passing parts.

MMC and LMC allow you to: 1) specify nominal X, Y, Z positions for your feature, 2) specify a nominal diameter for
your feature, 3) specify a nominal size for your feature, 4) specify a boss or bore setting, and 5) calculate the pass /
fail results of the tolerance.

Here we will perform MMC tolerancing on a circle (to perform LMC you would simply select LMC at the appropriate
step (step 4), and enter your Least Material Condition nominal values).

MMC Tolerancing on a Circle

1. Select a circle from the feature list. The circle is highlighted when selected.
2. Select Tools from the main menu. The tools drop down menu appears.
3. Select Tolerance from the tools drop down menu. The tolerance sub-menu appears.
4. Select MMC from the tolerance sub-menu. The MMC Tolerance Entry dialogue box appears (see following

page).
5. Replace the default X, Y, Z, and Radius values with the specified, nominal X, Y, Z, and Radius values. Do this

by clicking on the default value with the mouse, and entering a new value with the keyboard.
6. Enter a Tolerance Diameter in the Tol. Dia. Box. Do this by clicking in the empty Tol. Dia. Box with the

mouse, and entering the specified value.
7. Enter Nom+ and Nom- values in the empty boxes in the Size section. You can enter High and Low Limits

instead of Nom +/- values by clicking on the Nom+ and Nom- labels above the empty boxes (the labels change
to High Limit and Low Limit labels).

8. Select the Boss or Bore radio button (depending on whether you are tolerancing a boss or a bore). The selected
button will contain a dot.

9. Select OK to accept all of your tolerance entries. Select Cancel to abort the tolerance. If you select OK…the
MMC Tolerance Results dialogue box appears (see following page).

10. Select OK to accept the results. Select Edit to return to the Entry dialogue box and edit the values. A Pass / Fail
indicator appears beside the feature on the feature list.

Remember: The procedure for LMC is the same, just choose LMC from the Tolerance sub-menu at step four
(4).

The MMC Tolerance Entry dialogue box...
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The MMC Tolerance Results dialogue box . . .

Notice the Bonus calculation that the QC5000 has performed. In this case, both Position and Size are within
tolerance, and a Pass indicator will appear on the feature list beside the feature. If one portion of the tolerance
fails, however, a Fail indicator appears on the feature list beside the feature.

Concentricity 

 The Concentricity icon
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Concentricity is a location tolerance that can be performed on circles and arcs. This tolerance is very similar to true
position tolerance, except that the actual (measured) position of the feature to be toleranced is compared to the actual
(measured) position of another, concentric feature. The actual position of the basis feature becomes the nominal
position for the feature being toleranced.

Because the concentricity tolerance requires two features, this tolerance will not always be possible. The QC5000 will
prompt you for a reference feature during the tolerance process, and you will select one from the Reference Feature
drop down menu (you access this by clicking on the arrow to the right of the Reference Feature prompt (note the
graphics that follow the numbered procedure).

Here we will perform a concentricity tolerance on a circle using a second circle as a reference feature, although any
combination of circles and arcs is possible (make sure there are at least two circles available on your feature list before
beginning).

Concentricity (on two circles)

1. Select the circle to be toleranced. This is the circle beside which a pass / fail indicator will appear when the
tolerance is complete. The circle is highlighted on the feature list.

2. Select the Concentricity icon from the Tolerance toolbar. The Concentricity Tolerance Entry dialogue box
appears.

3. Enter a tolerance zone by clicking in the Tol. Zone box and entering a value. The tolerance zone is a diameter
around the reference feature’s center point. The center point of the toleranced feature must fall within this
tolerance zone in order to pass the concentricity tolerance.

4. Select a reference feature from the reference feature list. The reference feature list appears when you click on the
down arrow at the right of the Reference Feature box. If no features are listed here, then a concentricity tolerance
is not possible. The reference feature will now appear in the reference feature box by itself.

5. Select OK to accept the Tol. Zone and the Reference Feature. The Concentricity Tolerance Results dialogue box
appears indicating the actual deviation in concentricity between the two circles, and indicating whether the
feature passes or fails the tolerance.

6. Select OK to accept the results. Select Edit to return to the tolerance entry dialogue box and edit the values. If
you select OK, a pass / fail indicator appears beside the feature on the feature list.

Step 1: Select the feature to be toleranced...
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Note that circle 8 is selected, and will be toleranced. Circle 7 will be used as a reference feature to tolerance
circle 8. Concentricity tolerancing is used to make sure that one feature’s center point is aligned with another’s.

Step 2: Select the concentricity icon…the Concentricity Tolerance Entry dialogue box appears.

Here only one reference feature is available (circle 7); but often you will have a variety of features to chose from.
Be sure to chose the right one for your tolerance.

Step 3 (Step 5 above): …the Concentricity Tolerance Results dialogue box appears.

From here you can select Edit… to return to the previous dialogue box and edit the values that you entered there, or
select OK to accept the tolerance.
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Straightness 

The Straightness icon

Straightness is a form tolerance that can be performed on: lines. The straightness tolerance allows you to: 1) enter a
tolerance zone, 2) calculate the straightness of a line, and 3) assign a pass / fail indicator to the line. This tolerance can
be initiated by using the straightness icon from the tolerance toolbar, or by selecting Tools>Tolerance>Straightness
from the main menu.

When the QC5000 performs a straightness tolerance, it considers each point that you have plotted along the line to be
sure that each point lies within a specified tolerance zone. It is worth noting that if a line is constructed from two
features, or probed into the QC5000 using only two points, then the line will never fail the straightness tolerance. This
is because a two point line will have no deviation between the points; these points are connected in a "straight" manner
by the QC5000 when it calculates them. Therefore: the minimum number of points necessary for determining the
straightness of a line is 3 (three). Of course, the more points the better, more points will always produce a higher
degree of accuracy.

Straightness of a Line

1. Select a line from the feature list. The line should be a probed feature that was created from at least three points.
The line is highlighted when selected.

2. Select the Straightness Icon from the tolerance toolbar. The straightness tolerance entry dialogue box appears.
3. Enter the specified tolerance zone into the Tol. Zone space. Do this by clicking in the empty Tol. Zone box, and

entering a value with the keyboard.
4. Select OK to accept the Tol. Zone and perform the tolerance. Select Cancel to abort the tolerance. If you select

OK, the Straightness Tolerance results dialogue box appears.
5. Select OK to accept the tolerance. Select Edit… to return to the Straightness Tolerance Entry dialogue box and

edit the value. Once you select OK, a pass / fail indicator appears beside the line on the feature list.

Remember: A line must be composed of three or more points to make the straightness tolerance valid.

Straightness Tolerance...
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1. Select a line from the feature list.
2. Select the straightness icon from the tolerance toolbar.
3. Enter the specified tolerance zone in the straightness tolerance entry dialog box.

Note: The QC5000 calculates the tolerance, assigns a Pass / Fail, and allows you to edit the tolerance.

Circularity / Sphericity 

 The Circularity / Sphericity icon

Circularity and Sphericity are form tolerances. Obviously, circularity is a tolerance for the form of circles, and
sphericity is a tolerance for the form of spheres. If a sphere is selected on the feature list, then selecting the icon
(pictured above) will bring you to the Sphericity Tolerance Entry dialogue box. If a circle is selected on the feature list,
then selecting the icon will bring you to the Circularity Tolerance Entry dialogue box. In other words, the tolerance
will automatically default to the required feature (circle or sphere). This is also true for the Tolerance sub-menu under
the Tools main menu selection. This menu will display the appropriate tolerance automatically (sphericity if a sphere is
selected, circularity if a circle is selected).

The procedure for tolerancing circularity is the same as the procedure for tolerancing sphericity, except for the obvious
difference in feature shape. The icon on the tolerance toolbar is the same. The tolerance entry box is the same. The
tolerance results box is the same. The process is the same. Here we will tolerance a sphere, but the procedure for
tolerancing a circle would be the same.

Remember: Circularity and sphericity are form tolerances, and require MORE THAN THE MINIMUM
NUMBER OF PROBED POINTS for valid tolerancing. As with any measurement, the accuracy will increase
with the number of probed points. A circle can not be toleranced for form based on three points. A sphere can
not be toleranced for form based on four points.

Circularity / Sphericity Tolerance (using a sphere)

1. Select a sphere from the feature list. The sphere is highlighted on the feature list when it is selected.
2. Select the Sphericity icon. Don’t forget, the sphericity icon is the "Circularity / Sphericity icon", but in this case

we refer to it as the "Sphericity icon" because we are measuring a sphere. The Sphericity Tolerance Entry
dialogue box appears.

3. Enter the specified tolerance zone in the empty Tol. Zone box. Do this by clicking in the box with the mouse,
and entering a value with the keyboard.

4. Select OK to accept the tolerance zone. Select Cancel to abort the tolerance. If you select OK, the QC5000
calculates, and the Spherical Tolerance Results dialogue box appears.

5. Select OK to accept the results. Select Edit… to return to the spherical tolerance entry dialogue box and edit the
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values. Once you select OK, a pass / fail indicator appears beside the feature on the feature list.

Sphericity...

The sphericity tolerance entry box.

Enter the specified tolerance zone in the Tol. Zone box.

The sphericity tolerance result dialogue box.

It tells you the Tol Zone that you specified, the actual deviation, and whether the feature pass / failed.

As always, a pass / fail indicator appears beside the feature on the feature list.

Cylindricity 

 The Cylindricity icon

Cylindricity is a form tolerance that is performed only on cylinders. The cylindricity tolerance allows you to: 1) enter a
specified tolerance zone, 2) compare the actual measurement to the specified tolerance zone, 3) assign a pass / fail
value to the cylinder, and 4) edit the tolerance values subsequent to tolerancing.

You need a cylinder that was created from more than six probe points to perform the cylindricity tolerance. As
always, the accuracy of a feature’s measurement increases with the number of probed points.

Cylindricity

1. Select a cylinder from the feature list. The cylinder should be a probed feature created from more than six
points. The cylinder is highlighted on the feature list when it is selected.
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2. Select the cylindricity icon from the tolerance toolbar. The cylindricity tolerance entry dialogue box appears.
3. Enter the specified tolerance zone in the empty Tol. Zone box. Do this by clicking on the empty box with the

mouse, and entering a value with the keyboard.
4. Select OK to accept the tolerance zone. Select Cancel to abort the tolerance. If you select OK, the Cylindricity

Tolerance Result dialogue box appears.
5. Select OK to accept the results and add the Pass / Fail indicator to the feature list (the Pass / Fail indicator

appears beside the toleranced feature). Select Edit to return to the cylindricity tolerance entry dialogue box, and
edit the values.

The cylindricity tolerance determines whether the actual measured points that were used to create the cylinder fit the
specified tolerance zone that you input during step 3 above. The tolerance zone specifies a "width" around the
circumference of the cylinder within which all of the probed points must fall in order for the cylinder to pass tolerance.

Cylindricity...

Select a cylinder from the feature list...

The cylinder is highlighted when selected...

Select the Cylindricity icon...

The cylindricity tolerance entry dialogue box appears.
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The tolerance zone is a "width" around the cylinder within which all of the probed points must fall in order for the
cylinder to pass tolerance.

Select OK...

The cylindricity tolerance result dialogue box appears.

This cylinder fails tolerance due to poor form. Either a bad measurement or a bad part is to blame. Points used to
create the cylinder fell outside the form tolerance zone.

Flatness 

 The Flatness icon

Flatness is a form tolerance available for planes. The flatness tolerance allows you to: 1) specify a flatness tolerance
zone, 2) assign a pass / fail value to the toleranced plane, and 3) edit the tolerance values. As with any form tolerance,
this tolerance requires MORE THAN THE MINIMUM NUMBER OF PROBED POINTS for valid tolerancing.
In the case of a plane, more than three probed points are required for a valid flatness tolerance. Measurement accuracy
will always increase with the number of probed points.

The flatness tolerance zone is a "width" or "sleeve" above and below the plane. For a plane to pass tolerance, all of the
probed points must fall within this zone.

Flatness

1. Select a plane from the feature list. When selected, the plane is highlighted on the feature list.
2. Select the flatness icon from the tolerance toolbar. The Flatness Tolerance Entry dialogue box appears.
3. Enter the specified tolerance zone in the empty Tol. Zone box. Do this by clicking on the empty box with the

mouse, and entering a value with the keyboard.
4. Select OK to accept the tolerance zone. Select Cancel to abort the tolerance. If you select OK . . .
5. The QC5000 calculates, and the Flatness Tolerance Results dialogue box appears. It displays the Tol. Zone that

you specified, the actual deviation, and a pass / fail indicator.
6. Select OK to accept the results. Select Edit to return to the entry box and edit the values.

Flatness

Select a plane from the feature list . . .

The plane is highlighted when selected
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The Flatness Tolerance Entry dialogue box...

Enter the flatness tolerance zone here. The flatness tolerance zone sandwiches the plane above and below, the width
from the bottom to the top of the "sandwich" is the tolerance zone.

The Flatness Tolerance Results dialogue box...

Results displayed: Tol, Zone from the previous dialogue box, Actual deviation (expressed as a zone width), and a pass
/ fail indicator.

Pass / Fail indication on the feature list...

This plane passes.

Perpendicularity 

 The Perpendicularity icon

Perpendicularity is an orientation tolerance available for lines, cylinders, and cones. The perpendicularity tolerance
allows you to: 1) select the feature to be toleranced, 2) select the reference feature (to which the test for
perpendicularity will apply), 3) view the results of the tolerance, and 4) edit the values of the tolerance.

Perpendicularity tolerancing is performed using the axis of a feature. When you enter a specified tolerance zone into
the QC5000, it is the zone around this axis that you are specifying. Technically, the tolerance zone is cylindrical in
shape, and shares an axis with the feature that you are tolerancing. You specify the diameter of this cylindrical zone
when you specify a tolerance zone.
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Here we will tolerance a cylinder for perpendicularity to a plane; however, keep in mind that lines and cones can be
toleranced as well, and, that a variety of reference features may be offered to tolerance features against.

Perpendicularity (of a cylinder to a plane)

1. Be sure that a cylinder and a plane appear on the feature list. Also, be sure that they are roughly perpendicular
(the QC5000 demonstration part has a large central cylinder and a top plane that are ideal for this
demonstration).

2. Select a cylinder from the feature list. The cylinder is highlighted when selected.
3. Select the perpendicularity icon from the tolerance toolbar. The Perpendicularity Tolerance Entry dialogue box

appears.
4. Enter the specified tolerance zone in the empty Tol Zone box. Do this by clicking in the empty Tol. Zone box

with the mouse and entering the value with the keyboard.
5. Select a reference feature. To view the list of available reference features click on the arrow at the right of the

empty Reference Feature box. A drop down list of reference features appears. Select the feature to which your
cylinder will be toleranced (plane 3 in this case). When selected, the feature appears in the Reference feature
box.

6. Select OK to accept the reference feature. Select Cancel to abort the tolerance. If you select OK . . .the
Perpendicularity Tolerance Results dialogue box appears.

7. Select OK to accept the results, or select Edit to return to the entry dialogue box and edit the values. Once you
select OK, a pass / fail indicator appears beside the toleranced feature on the feature list.

 The perpendicularity tolerance entry dialogue box...

Click in the Tol. Zone box and enter a value with the keyboard. Click on the arrow to select a reference feature from
the reference feature list. Here Plane 2 is selected.

The perpendicularity tolerance result dialogue box...
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This box displays the specified tolerance zone, the actual zone of deviation, the reference feature, the pass / fail value.
And, here you have the option to edit the tolerance.

Parallelism / Coplanarity 

 The Parallelism / Coplanarity icon

Parallelism is an orientation tolerance that can be performed on cylinders and cones. To tolerance a cylinder or cone
for parallelism, you select the cylinder or cone, and then select a reference feature. The QC5000 determines if the
tolerance feature is parallel to the reference feature (within a specified tolerance zone).

Coplanarity is very similar to parallelism, but this tolerance occurs only between planes. To tolerance a plane for
coplanarity, you select the plane that you want to tolerance, and then you select a reference feature. In the case of
coplanarity, your reference feature will always be a second plane. The QC5000 determines if the tolerance plane is
coplanar to the reference plane (within a specified tolerance zone).

Here we will tolerance a cylinder to see if it is parallel with a plane, but the procedure for tolerancing a cone is the
same, as is the procedure for tolerancing the coplanarity of one plane to another.

Parallelism (of a cylinder to a plane)

1. Select a cylinder from the feature list. The feature is highlighted when selected.
2. Select the Parallelism / Coplanarity icon from the tolerance toolbar. The Parallelism Tolerance Entry dialogue

box appears.
3. Enter the specified tolerance zone into the empty Tol. Zone box. Do this by clicking on the empty box with the

mouse, and entering a value with the keyboard.
4. Select the reference feature. Do this by clicking on the arrow at the right of the empty Reference Feature box.

The drop down list of available reference features appears. Select the reference feature that your tolerance feature
will be compared to.

5. Select OK to accept the tolerance zone and reference feature. Select Cancel to abort the tolerance. If you select
OK . . . the Parallelism Tolerance Results dialogue box appears.

6. Select OK to accept the results. Select Edit to return to the entry dialogue box and edit the values.

Parallelism / Coplanarity
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The Part View...

Note: More features appear on the feature list than in the part view. These features are hidden from view (this
option is in the feature properties dialogue box). Cylinder 2 is selected for tolerancing.

The Parallelism Tolerance Entry dialogue box...

Note: More features appear on this list than are visible in the part view. Some features are hidden in the part
view. This option is in the feature properties dialogue box. Get there by selecting a feature from the main
feature list , and right clicking. Select properties from the menu that appears.

The Parallelism Tolerance Result dialogue box...
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The results box indicates the specified tolerance zone (that you entered previously), the actual zone of deviation, the
reference feature, and a pass / fail indicator. Select OK to accept the results, select EDIT to edit the values.

Circular Runout 

The Runout icon

Circular Runout is a tolerance available for circles. Circular runout allows you to: 1) select the circle to be toleranced,
2) enter a specified tolerance zone, 3) select a reference feature to which the toleranced circle will be compared, and 4)
calculate results and a assign a pass / fail indicator to the toleranced feature.

To perform a runout tolerance, both the tolerance feature and the reference feature (both circles) must share the same
projection plane. When you select the runout icon, the runout tolerance entry dialogue box appears, and allows you to
select a reference feature from a drop down list of available reference features. This list is composed of circles whose
projection plane matches that of the feature selected for tolerancing.

Here we will perform a runout tolerance on an XY circle, using a second XY circle as a reference frame. Before
beginning: make sure that two circles of the same projection (XY, YZ, or ZX) are listed on the feature list.

Circular Runout

1. Select the circle to be toleranced from the feature list. The circle is highlighted when selected.
2. Select the Runout icon from the tolerance toolbar. The runout tolerance entry dialogue box appears.
3. Enter the specified tolerance zone into the empty Tol. Zone box. Do this by clicking on the empty box, and

using the keyboard to enter a value.
4. Select a reference feature. Do this by clicking on the arrow at the right of the empty Reference Feature box. The

drop down list of reference features will appear (this list contains all of the circles that share a projection plane
with the circle you are tolerancing). Click with the mouse on the feature you want to use as a reference feature.

5. Select OK to accept the tolerance zone and the reference feature. Select Cancel to abort the tolerance. If you
select OK . . . the runout tolerance results dialogue box appears.

6. Select OK to accept the tolerance results. Select Edit to return to the entry dialogue box and edit the values.
Once you select OK, a pass / fail indicator is added to the feature list beside the toleranced feature.

Runout: the Part View...
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This part view contains several circles, but for a runout tolerance of circle one (1), only circle two (2) would appear on
the reference feature list. Neither of the other two circles (3 & 4) share the same projection plane as circle one. In the
graphic an axis has been drawn for each circle to add perspective. (circles 1 and 2 are XY circles; circle 3 is a YZ
circle; circle 4 is a ZX circle).

 The Runout Tolerance Entry dialogue box...

The Runout Tolerance Result dialogue box...
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This dialogue box displays the specified tolerance zone, the actual zone of deviation, a reference feature, and a pass /
fail indicator. Select OK to accept the results, select EDIT to return to the entry dialogue box and edit the values.

Angle 

 The Angle tolerance icon

The angle tolerance allows you to: 1) select an angle to tolerance, 2) enter nominal angle values, and 3) assign a pass /
fail indicator to the toleranced angle. The angle tolerance entry dialogue box will prompt you to enter nominal values
for the appropriate projection of the tolerance angle. An XY angle will require a specified, nominal XY value. A YZ
angle will require a specified, nominal YZ value. A ZX angle will require a specified, nominal ZX value. An angle that
does not fit one of these projections (although the angle may very nearly fit as indicated by the tilde[~]), will prompt
you for nominal values for all three projections (you need only change the nominal value of the projection for which
you are tolerancing, or you can change all of the values. The default nominal values are the actual measurements of the
angle, and are taken directly from the main screen result window).

Here we will perform a tolerance on an XY angle (because tolerancing commonly occurs on angles that have been
projected to two dimensions), but you can follow the same procedure to tolerance any projected or un-projected (3D)
angle.

Angle Tolerance (on an XY angle)

1. Select the angle that you want to tolerance. The angle is highlighted on the feature list when selected.
2. Select the angle tolerance icon from the tolerance toolbar. The angle tolerance entry dialogue box appears.
3. Replace the default nominal values with the specified nominal values (these default values are the actual

measurements of the angle taken directly from the main screen results box). Do this by clicking in the nominal
boxes and entering values with the keyboard (see graphic).

4. Enter Nom+ and Nom- values. Do this by clicking in the empty nom+ box, and then entering a value with the
keyboard. Repeat the procedure for the nom- value. You can enter high and low limit values, rather than nom +/-
values; just click on the Nom labels to change them to Limit labels.

5. Select OK to accept the entries. Select Cancel to abort the tolerance. If you select OK, the angle tolerance
results dialogue box appears.

6. Select OK to accept the results. Select Edit to return to the entry dialogue box and edit your entries. Once you
select OK, a pass / fail indicator appears beside the angle on the feature list.

The part view...
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The Angle Tolerance Entry dialogue box...

Notice that Angle 6 (an XY angle), is only toleranced for it’s projection. The other projections indicate N/A, not
available.
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The Angle Tolerance Result dialogue box...

Notice that the QC5000 assigns pass values to those projections that were not toleranced (this is normal). The QC5000
also leaves blank the Low / High Limit boxes that were not entered on the previous screen (even if they are boxes that
are relevant to the tolerance). This angle was right on tolerance, we checked to see if it was within .05 degrees of 90
degrees, and it was. An 89’ 57’ 00" angle would also have passed.

Width 

 The Width tolerance icon

The Width tolerance is performed on distances. To tolerance the width between two lines, you must first measure a
distance between the lines (by using the distance icon from the measure toolbar), and then tolerance the distance for
width. This tolerance allows you to: 1) select a distance for tolerancing, 2) enter nominal X, Y and Z values, and 3)
assign a pass / fail indicator to the tolerance distance. Here we will tolerance the width (distance) between the center
points of two circles, but the width tolerance can be performed on any distance.

Width (between the center points of two circles)

1. Construct a distance between two circles. Refer to the constructions chapter for information on constructing
distance. Refer to the features chapter for information on measuring circles.

2. Select the distance. The distance is highlighted on the feature list when selected.
3. Select the Width icon from the tolerance toolbar. The Width Tolerance Entry dialogue box appears.
4. Change the default values to the specified, nominal values. Do this by clicking on the nominal boxes and

entering values with the keyboard.
5. Enter Nom+ and Nom- values in the empty boxes. You need only enter values for the length that you are

tolerancing (total length, X length, Y length, etc.). Enter these values by clicking in the empty boxes and entering
values with the keyboard.

6. Select OK to accept the entries. Select Cancel to abort the tolerance. If you select OK . . .the Width Tolerance
Result dialogue box appears.

7. Select OK to accept the results. Select Edit to return to the entry dialogue box and edit the entries. Once you
select OK, a pass / fail indicator appears beside the distance on the feature list.

The Part View...
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Distance 3 is indicated as the dotted (phantom) line between the two circles. This distance runs from the center point of
circle 1 to the center point of circle 2. Remember, to get nearest and farthest distances, use the CHANGE option Edit
main menu option.

The Width Tolerance Entry dialogue box...
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Notice that this distance (between the center points of two circles), lies almost entirely on the Y axis. Most of the total
distance occurs along the Y axis, a small amount occurs along the X axis, and none occurs along the Z axis.

The Width Tolerance Results dialogue box...

The results dialogue box displays all of the information that you previously entered, as well as the deviation, and a pass
fail result. Notice that the QC5000 converts Nom+ and Nom- values into a High and Low limit. Here the distance
passes tolerance for total length (individual axes were not toleranced). At the Entry dialogue box, the nominal was
changed from 63.4790 to the specified 63.000.

Remember: The default nominal value for all tolerances is the actual measurement—this must be changed to the
nominal value specified on your tolerance call out.

Summary: 
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This is not a perfect world. That’s why we have tolerances: so that we can measure an acceptable amount of deviation.
You do not have to understand every tolerance, or know every equation, to understand the basic concept. More
importantly, you do not have to understand every tolerance to perform every tolerance. The QC5000 calculates
positions, orientations, and bonuses so that you don’t need to. This chapter showed you, step by step, how to perform
each tolerance that the QC5000 supports.

You should now be able to perform all of the tolerances listed at the beginning of this chapter.

Tips: 
Click on Nom+ and Nom- buttons if you want to enter Low and High Limits instead of +/- values.
When performing form tolerances, remember that many points are necessary for an accurate tolerance. The
form tolerances are: straightness, circularity, sphericity, cylindricity, flatness.
Remember, a feature can undergo multiple tolerances. Sometimes features are even assigned two pass / fail
values within the same tolerance operation. But, any time a feature fails even one aspect of a tolerance, it
receives a Fail indicator.
Remember to Change default values to nominal values . . . your tolerance is worthless if you don’t. (Default
values are simply the feature’s actual measurements; check the default value against the main screen result
window and see for yourself).
Any tolerance is performed on a single feature, so always select just the single feature from the feature list.
Remember: any possible tolerance of a feature can be accessed by selecting Tools>Tolerances from the main
menu. If the toolbar is denying you access to a tolerance and you don’t think it should be, or if you can’t gain
access to the desired tolerance via the toolbar, try the main menu.
Tolerancing seems tricky at first, but with a small amount of practice you won’t believe it ever seemed difficult.
It is really just a matter of choosing a feature, choosing a tolerance, entering values for the "perfect" feature, and
then entering values that say how "less than perfect" a feature can be.
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 Tutorial
 
In This Section...
Lesson 1: Establishing A Reference Frame
Lesson 2: Saving a Part File
Lesson 3: Feature Measurement
Lesson 4: Constructions
Lesson 5: The QC5000 Demo Part
Lesson 6: Working With A Multi-Sensor System
Tips
 

This tutorial is designed to guide a new user through the basics of feature measurement, feature construction, and
feature creation. Additionally, this tutorial will familiarize users with file management (opening, closing, saving).
Please note: before beginning this tutorial the QC5000 setup should be complete and Machine Zero should be set**.
For information on setting Machine Zero, refer to the Introduction to this manual.

The first two lessons of this tutorial are self contained. You will establish a reference frame (which requires the
probing or constructing of a few features), and then you will practice file operations (saving, opening, etc..). Beginning
with lesson three, the exercises will direct you to other portions of this manual for procedures to follow, but you can
always return to the tutorial once you've completed a lesson. Feel free to experiment in the middle of any lesson.

**Note: You can perform this tutorial without setting Machine Zero, but the QC5000 will be unable to perform any global corrections (SLEC,
etc…). Relative measurements will still be valid, assuming the probe is qualified.

Note: This tutorial will refer to the QC5000 demo block that accompanied the system. You may substitute another part for the demo block, but it is
recommended that you use a part with features that are fairly simple to measure. Once you get the hang of things, you can start trying the fancy
stuff.

Lesson 1: Establishing A Reference Frame 
About the lesson:

In this lesson you will designate a zero point for the part that you are measuring.
You will probe and construct features.
You will practice proper probing technique.
You will open a new part.

Before Beginning, Make Sure...

The QC5000 is running.
Machine Zero has been set (see note above).
You are familiar with the method for entering points on your machine.
You are familiar with proper probing technique (Probes chapter).

Follow These Steps...

1. Orient the QC5000 demo block to the CMM stage.

file:///D|/MANUAL/setup.htm
file:///D|/MANUAL/index.htm
file:///D|/MANUAL/about.htm
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1. The largest surface of the part is the bottom.
2. The flat, slanted surface is the left most portion of the part.
3. On the right hand side, the corner closest to you should be rounded. If it is, then you have the QC5000 demo

block oriented correctly.
4. Be sure the part is fixed securely to the stage.

2. Open a new Part File.

1. Select File from the main menu. The file drop down menu appears.
2. Select New from the file drop down menu. The New flyout menu appears.
3. Select Part from the flyout menu. The QC5000 prompt appears.
4. Read and note the prompt. You will be asked this question each time you open a new part file.
5. Select Yes to indicate that you wish to begin a new part.

3. Probe a Primary Plane.

1. Select the Primary Plane icon from the Datum toolbar:
2. The Primary Plane dialog box appears. The Primary Plane dialog box will indicate the number of points that you

have entered. Enter four points on the top surface of the part(space the points evenly).
3. Use Remove Last (if necessary) to delete the last probed point.
4. Once you have entered four points, select OK.
5. The Part View, Results Window, and Feature List are all updated to display the new feature. Since it is the first

feature it is Plane 1. Since it is a primary plane, it is indicated as "current zero."

4. Probe a Secondary (skew) line.

1. Select the Secondary Line icon from the Datum toolbar.
2. The Secondary Line dialog box appears. The Secondary Line dialog box will indicate the number of points

that you have entered.
3. Enter two points, evenly spaced, along the front surface of the part. The front surface is the surface that

faces you.
4. Select OK.
5. The Part View, Results Window, and Feature List are all updated to display the new feature. Since it is the

second feature it is Line 2. It is indicated as the skew.

5. Probe the "Y" alignment line.

1. Select the Line icon from the Measure toolbar.
2. The Measure Line dialog box appears. This dialog box will indicate the number of points probed, as you

probe them.
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3. Enter two points, evenly spaced, along the left side of the part. Do not probe the points along the slanted
surface; probe them below the slanted surface on the surface that forms a 90 degree angle with the CMM
stage.

4. Select OK.
5. The Part View, Results Window, and Feature List are all updated to display the new feature. It is Line 3.

6. Construct the X/Y intersection point.

1. Select the Point icon from the Measure toolbar.
2. The Measure point dialog box appears.
3. Select Line 2 and Line 3 from the Feature List. Features are highlighted when selected. If you hold down

the CTRL key, you can make multiple, non-adjacent selections with the mouse.
4. Once both parent features(Line 2, Line 3) are selected, select OK from the Measure Point dialog box.
5. The Part View, Results Window, and Feature List are all updated to display the new feature. It is Point 4.

7. Construct the Zero point.

1. Select the Zero icon from the Datum toolbar.
2. The Zero point dialog box appears.
3. Select Point 4 (x/y intersection point) and Plane 1(primary plane) from the Feature List. Features are

highlighted when selected. If you hold down the CTRL key, you can make multiple, non-adjacent
selections with the mouse.

4. Once both parent features(Point 4, Plane 1) are selected, selct OK from the Zero Point dialog box.
5. The Part View, Results Window, and Feature Listare all updated to display the new feature. It is Point 5,

and it is indicated as the zero point.

Lesson 2: Saving a Part File 
About This Lesson:

You will Save An Open, Unnamed Part File.
You will Open A New Part File.
You will Re-open A Saved Part File.

Before You Begin.

1. You must have an open, unsaved file. If you have just completed Lesson 1, then you are set up for this
lesson.

2. If you are familiar with Windows file operations, this lesson will seem very basic. You can skip it, but if
you run into problems saving and opening Part Files, return to this lesson.
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Save An Open, Unnamed Part File:

1. Currently, the QC5000 Title Bar (at the very top), and the Status Bar (at the very bottom), indicate that
the part is Untitled. If they indicate something other than untitled, then this part has already been saved.

2. Select File from the main menu. The File drop down menu appears.
3. Select Save from the file drop down menu. The Save Part dialog box appears.

4. Save the file by entering a unique filename, and choosing a directory. Select OK for the save to take affect.

Open A New Part File:

1. Once you have saved a file, you can open a new file without losing the saved data. Select New > Part from
the file menu. The QC5000 asks you if you really want to perform this action (if you've forgotten to save
your file, you have a last chance).

2. Select Yes to open a new part file. The Part View, Feature List, and Results Window are now blank. You
can begin measuring a new part.

Re-open A Saved Part File:

1. Select File from the main menu.
2. Select Open from the file menu. The Open Part dialog box appears.
3. Navigate through the directories on your computer until you find the file you want to open. This should be

fairly easy if you have saved all of your QC5000 part files in the same directory…the Open Part dialog
box defaults to the QC5000 directory.

4. Highlight the file and select OK. The QC5000 will ask you if you really want to perform this action…
again, this is just a last chance to save the current part if you have forgotten to. Select Yes to open the part
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file that you just selected.
5. The part opens, and you can now work with this part file.

Lesson 3: Feature Measurement 
Go to the Measuring Features section of the Features chapter in this manual (return here afterwards). You'll
notice that each feature type is described on a page that contains the feature's toolbar icon, probe point diagram,
and measurement procedure.

Begin with the "point" feature type, then continue through the Measuring Features section. Follow the
procedure for feature measurement for each type listed. As you probe each feature type, you'll notice that some
features require careful point placement (slots, for example)--feel free to measure a feature several times if
necessary--when you finish this section of the tutorial you should be relatively comfortable with basic feature
measurement.

Once you've probed the final feature type (sphere), return to this place in the tutorial and continue on. If at any
point you want to deviate from this tutorial and spend some time experimenting with a specific feature type or
application, feel free to do so.

***************************************************************

At this point you should have probed (at least once): a point, a line, a plane, a circle, an arc, a cylinder, a cone, a
slot, and a sphere. If you missed any of these features for some reason, you may want to return to the Features
chapter and try probing the feature(s) you missed.

Lesson 4: Constructions 
About this lesson:

You will practice constructing features from other features.

Before You Begin.

If you've just completed Lesson 3, then you have a variety of features on the Feature List. If this is not the case,
you should now probe 3-5 features (of varying type) into the QC5000. Include at least one circle.

QC5000 Feature Construction

QC5000 feature construction always follows the same basic procedure: you select a type of feature, then you
select the parent features, then you select OK. It's easy…let's walk through a basic construction.

Construct the center point of a circle.

1. Select the point icon from the Measure Toolbar (you also had to select this in the previous lesson,
when you probed a point). The Measure Point dialog box appears.

2. Select a circle from the feature list. The circle is highlighted when selected. Make sure the circle is
the only feature selected.

file:///D|/MANUAL/features.htm#Measuring Features
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3. Select OK from the Measure Point dialog box. The point is added to the feature list and part view. It
also appears in the results window.

That was pretty simple, right. All you did was tell the QC5000 what type of feature you wanted, and
then you told the QC5000 what to use to make the new feature…it did the rest.

Construct a line.

1. Select the Line icon from the Measure Toolbar. The Measure Line dialog box appears.
2. Select the point that you constructed in step 1 above. The point is highlighted on the Feature List

when selected.
3. Select another feature (preferably a positional feature like a circle or sphere, but any feature will

do). This feature and the previously selected point should now be highlighted on the feature list. If
you need to make multiple, non-adjacent selections with the mouse, you can hold down the control
(CTRL) key while you point and click on those features that you want to include in the construction.

4. Once both features are highlighted, select OK from the Measure Line dialog box.
5. The new line appears on the Feature List, in the Part View, and in the Results Window. You can

now use this feature in future calculations and constructions.

Practice constructing features.

1. Use the existing features on the Feature List to construct new features.

The QC5000 User's Manual contains a chapter devoted to Constructions (it can easily be
found using the thumb tabs). This chapter contains examples, lists of possible
constructions, term definitions, and other information relevant to feature construction.

You should now understand the concept of feature construction using parent features. You should also
understand the basic procedure for performing a construction: select the type of feature you will construct,
select the parent features, select OK…now for a more advanced lessons.

Lesson 5: The QC5000 Demo Part 
So far this tutorial has covered some of the basic groundwork necessary to operate the QC5000. In the first
lesson you stepped through the process of establishing a reference frame. In subsequent lessons, you worked
individually with feature measurement, feature construction, and file management. Here you'll use all of these
concepts together…

Orient the QC5000 Demo Part.

Before you begin measurement certain conditions must be met. Make sure that each of the following
conditions describes the setup of your QC5000.

1. The axes must read positively in the correct direction. Z is positive in the "up" direction. X is positive
when moved right along the stage. Y is positive toward the back of the stage (away from the user).

2. The QC5000 Demonstration Block must be oriented correctly on the stage. Although you can measure in
any orientation, this lesson will be easier if you position the block the same way that we did when we wrote
the tutorial. Correct orientation: The largest surface of the block is the bottom. The slant surface is at the
left hand side of the block. The rounded corner is at the right hand side of the block and toward the front
of the stage.
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3. Begin a new Part File. Select New > Part from the File menu.

Establish a Reference Frame

1. Establish a Part Zero on the left hand side of the part, at the corner closest to you. The actual part zero
will exist above the slanted surface of the QC5000 demo part at the level of the primary plane (part zero
does not necessarily have to be an actual point on the part).

2. If you don't remember how to establish a reference frame, refer to the first lesson of this tutorial.
3. Probe four bolt hole circles/arcs into the QC5000. Construct the bolt hole circle.

 

 

 

 

a. Probe circles A and C. They appear in the Part View,
on the Feature List, and in the Results window as they

are entered.
b. Probe arcs B and D. They appear in the Part View, on the Feature List, and in the Results window

as they are entered.
c. Construct the bolt hole circle.

1. Select Circle from the Measure toolbar. The Measure Circle dialog box appears.
2. Select A, B, C, and D from the Feature List.
3. When all four parent features are selected, select OK from the Measure Circle dialog box.

d. The new circle is added to the Feature List, Part View, and Results window.
4. Probe the main cylinder and tolerance it for "cylindricity."

a. At the center of the bolt hole circle that you just constructed there is a cylinder. Probe this cylinder
into the QC5000.

b. Note the result of the cylinder measurement. Compare the observed diameter to the diameter
indicated in the preface to this manual. They should be very close.

c. Select the cylinder. Be sure that it is the only feature selected on the Feature List.
d. Select Tools > Tolerance from the main menu. The tolerance flyout menu appears.
e. Select Cylindricity from the tolerance flyout menu. The cylindricity tolerance dialog box appears.
f. Enter a tolerance zone into the cylindricity tolerance dialog box (a more detailed explanation of this

tolerance can be found in the Tolerance chapter). For now, enter .01 as the tolerance zone. If you
are familiar with tolerancing, this number seems very large…you have permission to adjust it if you
want.

g. Select OK. The cylindricity tolerance results dialog box appears. It indicates a pass or fail value, and
places a pass/fail marker beside the cylinder on the Feature List. Select OK to accept the tolerance,
or Edit to go back and reenter the tolerance zone.

5. Continue to probe Demo Block features. Construct Demo Block features. Tolerance Demo Block features.

Lesson 6: Working With A Multi-Sensor System
System requirements: QC5000 with VED and contact probes.
Material requirements: Metronics calibrated glass slide and sharp edge ring guide.
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Preparation

Ensure that the following is true:

The first time you try this tutorial, you may want to try a measurement immediately after each phase of
the calibration process to determine if the calibration is correct. The instructions to test the calibration are
listed at the end of this tutorial.
The calibrations must be done in a certain order to be successful.
If you are unfamiliar with the different probes or proper probing techniques, you may want to read the
Probes section before proceeding.
Lighting should be turned on and illuminating the stage. Many calibrations rely on accurate and
repeatable video edge detection. The basic conditions are a clean slide and medium light intensity. You
may get a sense of the intensity by viewing the filter dialog. Make sure you can get edges. If not, teach an
edge using the simple probe. See section on Edge teach below.
The VED image window in the QC5000 should be displaying an image from the camera.
Calibration artifacts should be on the stage. It may be necessary to secure them to the stage (tape or
brace). It should be possible to specify the nominal size of these artifacts in either inch or metric units,
depending on the current units of the system. Note that 0.03937007874 inches = 1.0 mm and 0.0196850 in.
= 0.5 mm. MM is recommended for calibration.

Metronics "Chrome on glass" Calibration Slide (with close up of artifacts)

 

Metronics 12.7mm Sharp Edge Ring Gauge (with magnified view of the top plane)

 

Encoders should be operational and set to the correct resolution. The encoders should correspond to a

file:///D|/MANUAL/probes.htm
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right-handed coordinate system (e.g., moving the probe away from you (front to back) should increase the
Y value in the QC5000 DRO window, moving the probe to the right should increase the X value in the
DRO window). If you need to make any changes to the current settings, open the CNC Options dialog box
(Tools > Options > CNC Options... from the main menu).
Verify that the apparent direction of movement of a crosshair probe in the VED window corresponds to
the direction of movement of the contact probe. If it does not, modify the camera orientation settings in
camera properties. Check that these corrections did take place by moving the probe up, down and left and
right.
Set measurement mode to millimeters (mm).

Auto Focus

For each magnification, do the following steps. Be sure that lighting is appropriate by checking the Filter dialog.
See Pixel Calibration for more detail on lighting.

1. Select an artifact to focus on (such as the 1mm artifact on the glass slide). The artifact must have good
contrast within the region of the height probe. You may also use the circle probe or the buffer probe to
calibrate auto focus.

2. Go to the Probe Library and Select the "Auto Focus" tab of the first magnification (see below).

3. Press "Set Current" to set the magnification current.
4. Press "Teach..." and follow the prompts.



Tutorial

file:///D|/MANUAL/TUTORIAL.HTM[6/28/2019 8:21:41 AM]

5. Verify the object is in focus and select "Finish".
6. The acquired "Search Distance" will be displayed in the Probe Library Auto Focus tab.

Pixel Calibration

It is best to use bottom lighting for calibrations and for measurements in general. It is a good idea to position
the artifact where you can focus on it prior to setting a magnification because this dialog will prompt you to
enter the artifact size.

1. Select Probe, Probe Library, from the camera options select a magnification
2. Select the Resolution tab, then select the Teach (Pixel Size) button.
3. Follow the dialog prompts. The first thing you will do is set the artifact size in the dialog to the true

artifact size of the feature.
4. Select the circle probe, place the artifact in the circle probe, check "High accuracy" mode and focus on

the artifact.
5. Once you have completed a calibration, the values of X & Y should be non-zero in the Resolution tab. You

may measure a circle to check the accuracy of the size calibration; verify that the Diameter value is within
+/- 0.1 % of the actual object size or 0.1 pixel.

Do this for each magnification. Be sure to select an artifact that fits well in the screen, is centered and check
that lighting is appropriate (not saturated). You can check the light by right clicking the mouse in the video
window and selecting Filter. This will display a graphic that represents a histogram of the lighting condition.
Experiment by moving the light slider up and down. Each magnification is unique so adjusting the light will
also affect the brightness uniquely; it is generally a good idea to hold the "light" portion of the histogram at
about 200 and to keep this consistent between magnifications.

Camera Skew

You should use the lowest magnification and select a circle that is "small" (less than 1/10 of the X dimension of
the image). In this calibration you will need to measure the same circle twice. You will measure it near the left
edge of the FOV (field of view) and then near the right edge of the FOV.

1. Select Probe, Probe Library
2. Click on VED, Camera, select Orientation. Notice that Camera Skew displays the most recent camera

skew angle. Click on Teach. You will be prompted to measure the circle as mentioned above.
3. When that is completed check that the Orientation now is a value other than zero. The value represents an

angle.
4. To verify the calibration measure the same circle again on the left and right side of the FOV. The Y

position should be nearly the same. Note that if the X position is significantly different, it is NOT due to
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camera skew error. Recheck the pixel size calibration.

Probe Edge Teach

The VED probes can be taught at any point, it is generally good to teach them to obtain 'good' edges prior to
calibration. Always check your ability to get points on edges when lighting is poor or if the edges are not well
defined. If you are not getting enough points then you need to edge-teach in order to teach the VED probe to
obtain edges under the current circumstances.

1. Select the simple probe. Click the right mouse button over the image window, from the fly-out menu select
VED EdgeTeach.

2. Select Auto and then press Advanced.
3. You will see an Edge Teach graphic and the current (Simple) probe will display a red point where it is

obtaining an edge.
4. If you enter different values to Min Contrast you will observe the red point shifting its position on the

probe to that 'edge'. If the Min Contrast is set too high you may fail to get good edges.
5. Select Teach, and then OK to conclude.

The VED probes can also be taught in the probe library by selecting a VED probe and selecting AF teach in the
dialog box. This will run you through the same prompts as above.

Magnification Offsets (parcentricity & parfocality)

Here you will be measuring from one designated magnification, the Master, to calibrate the others to. High is
usually the Master and you can tell this because under the Offset tab, Reference is check marked and the offsets
are all zero. One artifact will be used for all offset calculations. Select the 1.0mm circle.

Remember that for each magnification you will need to adjust lighting and focus on the artifact.

1. Verify that in High magnification that Reference is checked and it's offsets are 0. Do not teach the master,
it is not necessary.

2. Select another magnification, and under the Offset tab click Teach. This will automatically set the
magnification for you to calibrate. Follow the prompts to complete this action.

3. Once this has completed, check that the offsets in the Offset tab are non-zero.
4. Repeat this for all magnifications on this machine.

In-house instructions only:

One way to verify that you have calibrated correctly is to measure the same circle in each magnification. To do
this select File, New, Part and then measure the object in High magnification. Select Datum/Zero and check
X,Y,Z to set the center of that feature to zero. Then for each magnification selected, select Tools, Goto Linear
and goto 0,0,0 (not relative). Then measure the same circle. When you are finished, all of the circles should have
very nearly the same position and diameter (within a fraction of a micron, or a little worse at low
magnification). Evaluate the errors to see if it is great enough to cause a problem. If there is a problem then you
should re-calibrate that magnification.

Touch Probe Calibration and Cross Calibration; Probe and Camera

In this exercise you will be calibrating the Probe tip(s) and determine the "Cross-calibration". The cross-
calibration determines the offset between the touch probe and the camera (master).

You will first determine the tip size and offsets, then cross-calibrate. Always be sure to move the camera up
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away from the object being measured so that the probe tip is not compromised (crashed).

Tip Size

1. Under the General Options, Probe, verify that the sphere size is set to your artifact size, usually 12.7mm
for the Metronics ring gage.

2. Select Probe Lib, Contact Probes then select the reference tip and press Teach under the size/offset tab.
The reference box will be checked.

3. Measure a sphere or ring gage as indicated in the prompt.
4. Measurement of the artifact will allow the software to determine the tip size. You can check the

calibration by re-measuring the artifact. The feature size should be nearly that of the nominal setting. The
offsets of the "reference" tip are 0.0.

5. The same procedure may be used to teach other touch probe tips in the system, although that will not be
necessary for cross-calibration.

Probe

1. Verify that the camera high magnification is still set as Reference and the XYZ values are 0.0
2. Then select Probe, Probe Library. On the left screen half Probes will be displayed, on the right side the

existing probes (VED, Contact Probes), select Contact Probe.
3. Under the Offset tab, verify that the Reference is NOT checked and then click Teach.
4. This will run you though an exercise to measure the inside of a part. Verify the size of the part against the

size of the object.

Once this is completed, re-measure the object with the touch probe and the camera to verify a match; select
File, New, Part and then measure the same object. When you are finished, the circles should have nearly the
same position and size.

Tips: 
You can find more information on tolerancing and constructing features in the Tolerancing and
Constructing chapters of this manual.
If you want an explanation of Projection, try the 2d and 3d section of this manual. You should experiment
with projection to understand it.
Relations (angles / distances) are treated as any other feature. Relations can be probed or constructed.
Check out the Relations section of this manual for more on this.
Remember…most sections of this manual contain graphic demonstrations of the concepts they explain as
well as step by step instructions…try a few demos if you don't understand something.
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 Updates
 

Metronics is dedicated to keeping you and your QC5000 up-to-date. In pursuit of this goal, we will be posting
updates for the QC5000 V2 on our web-site. You are encouraged to check our site periodically, to ensure that you
are up-to-date.

The following links require you to be connected to the internet!

To visit our web-site, click here.

To check for software updates, click here.

To check for manual updates, click here.

file:///D|/MANUAL/about.htm
file:///D|/MANUAL/index.htm
file:///D|/MANUAL/contact.htm
http://www.metronics.com/
http://www.metronics.com/software.htm
http://www.metronics.com/manual.htm
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 View Control
 
In This Section...
The View Toolbar
The Part View
The View Rotator
Preset Views
Zoom
Pan
Toolbar Activation
Summary
Tips
 

The View Toolbar - Expanded 

The View Toolbar contains everything that the View Menu contains. You can access any of the pre-set viewpoints
from the toolbar. You can switch between a four pane and a single pane part view from the toolbar. You can activate
the view rotator. You can activate and deactivate any of the toolbars from the view toolbar. You can use any of the
zoom features, and you can access Layer Control.

When the mouse pointer touches one of the toolbar icons, the name of the icon should appear. If these tool tips do not
appear on the toolbar (any toolbar), then select Tools > Customize > StatusBar, and then make sure that the tool tips
box is checked.

The View toolbar (as it appears when the QC5000 is launched for the first time)

file:///D|/MANUAL/relation.htm
file:///D|/MANUAL/index.htm
file:///D|/MANUAL/constrct.htm
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The View toolbar (shown with added icons)

Note: You can move and resize the View Toolbar as you would any toolbar.

Don’t be afraid to experiment with the View Toolbar…you are only changing the perspective from which you view
your part, not the part data.

The Part View 

The part view can display a single view pane, or four view panes. If the QC5000 is in 4 pane mode, then each view
pane is independent for purposes of view rotation and manipulation. Simply stated, you can rotate and flip any one of
the four panes, and the other three will not be affected. In four pane mode, you can have four entirely different views
of your part onscreen at the same time. In single pane mode, you will only have one view of your part onscreen.
Essentially, single pane mode works well with parts that will only be using an XY plane (2D); Four pane mode works
well with parts that will use the Z axis (3D).

Switch between the two modes by clicking on the view toolbar icons that correspond to each mode. This QC5000
feature is very easy to use and understand; just remember, switching between views does not change your part…it
changes how you see your part.

The View Rotator 

The View Rotator icon

Click the View Rotator icon. The View Rotator appears onscreen. It looks like a target. The view rotator window can
be moved and sized like any other window. Once you are comfortable using the view rotator, you may want to reduce
its size to make room for other toolbars and windows.

Note: If the view rotator does not appear on the first click, click the icon again. If the view rotator appears after the
second click then it was originally active, but hidden. The first click deactivated it.
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To Practice with the View Rotator

1. Open any saved QC5000 program; OR, Probe several features into the QC5000 (the demonstration is more
effective if the part view displays an entire part, rather than 2 or 3 features).

2. Activate the view rotator. Do this by clicking on the view rotator icon from the View Toolbar.
3. Select a view pane from the part view (if you are in single pane mode, then the single large pane is

automatically selected). When in 4 pane mode, the view rotator can be used to manipulate the view in any of the
four panes. The selected view pane is affected by the view rotator.

4. With the mouse pointer, click anywhere in the "target area" of the view rotator. While depressing the left mouse
button, drag the mouse pointer in a circular motion. Notice the movement in the part view. Moving the mouse
forward and back will pitch the view; moving the mouse left and right will apply yaw to the view.

5. Try right clicking and moving the mouse. The part rotates around the Z axis.
6. Continue to manipulate the part until you are comfortable with the view rotator.

Remember: If the QC5000 part view is in four pane mode, each pane can be rotated individually. Select the pane you
want to rotate by clicking in it (it becomes outlined), and then use the view rotator as you normally would.

Preset Views 

You can also manipulate the part view by applying any of the QC5000 preset views. With the preset views, you can
view your part from a variety of perspectives simply by selecting the preset view icon that corresponds to the view you
want. Each preset view can be applied to any individual view pane. When the QC5000 part view is in four pane mode,
each pane can display a different preset view because each pane acts independently of the other three panes. This
means that you can have four preset views, or four custom views created by the view rotator, or any combination of
custom and preset views (one view per pane). In short, the QC5000 will show you what you want to see.

To apply a preset view to a pane

1. Select the pane you want to apply a view to. Just click in the pane you want, the pane is outlined when selected.
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2. Select the view you want to apply. Do this by clicking on the view toolbar icon that corresponds to the view you
want. In other words: click the top view icon if you want to view your part from the top, or click the bottom view icon
if you want to view your part from the bottom. Once you select a view, the part view will change accordingly.

Here, the TOP view has been applied to the main pane. The Southeast (SE) view has been applied to the top left pane,
the Northeast (NE) view has been applied to the middle left pain, and the bottom left plane displays a custom view
produced with the view rotator (notice the lack of a preset view indicator in the upper-left corner).

View From Probe icon

The view from probe icon works like a preset viewpoint. When you click this icon, the selected view pane displays a
view of the part from the current position of the probe. If you move the probe, and click the icon again, the view
changes to match the new probe view.

Zoom 
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The QC5000 View toolbar contains a variety of zoom icons. Zoom In, Zoom Out, Zoom All, and Zoom Selected
Features all affect only the selected view pane. Zoom Window works a bit differently. Zoom Window allows you to
select a rectangular area within one of the view panes for enlarging.

Zoom Window

1. Select the Zoom Window icon from the View Toolbar. The mouse pointer changes into the magnifying glass.
2. Position the magnifying glass at the top-left corner of the area that you want to zoom.
3. Click and Drag the magnifying glass to the bottom-right corner of the area that you want to zoom.
4. Release the mouse button. The selected area (the area inside the rectangle) zooms into view. The mouse pointer

returns to normal.

The mouse pointer will turn into the magnifying glass, which looks something like this…

Zoom In

1. Select the view pane that you want to zoom. The pane becomes outlined.
2. Click the zoom in icon until the part appears as you want it to.

Zoom Out

1. Select the view pane that you want to zoom. The pane becomes highlighted.
2. Click the zoom out icon until the part appears as you want it to.

Zoom All

1. Select the view pane that you want to zoom. The pane becomes highlighted.
2. Click the zoom all icon once. The part is fit to the view pane.

Zoom Selected Features

1. Select the features that you want to zoom within the view pane that you want to zoom them. (With one click you
actually select the feature and the pane).

2. Click the zoom features icon until the feature appears as you want it to.

Pan 

The Pan icon.
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The QC5000 provides a pan option for orienting a part within the part view. The pan option allows you to grab a piece
of the part, and drag the part to another place within the part view.

To Use Pan

1. Select the pan icon. The mouse pointer becomes the pan "hand."
2. Position the hand at the "grab" point (where you want to grab the part).
3. Click and Drag the mouse to move the part (notice the line that indicates your distance from the original

point..
4. Release the mouse button. The pointer returns to normal.

Use Pan To:

 Hand Cursor

Grab this off center circle by clicking on it with the "hand’ cursor. . . drag the hand to the new position…
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...release the mouse button...

...now the circle can be seen in the part view. You have not changed its size, only its position in the part view.

Toolbar Activation 

 The Toolbar icon

You can activate and deactivate any of the QC5000 toolbars by clicking the toolbar icon on the View toolbar. This
icon brings up the Toolbars dialogue box, which was discussed in the toolbars section of the Introduction to this
manual. If you deactivate the View toolbar, you can reach the toolbars dialogue box by selecting View > Toolbars
from the main menu.

Summary: 
Some of the view options provided by the QC5000 may take a little practice to master; but soon, you’ll think the view
options are easy. The Zoom Window and the Pan feature may seem strange at first because the mouse pointer takes on
a different form, but you’ll get used to that in no time. The View Rotator takes a little practice to manipulate correctly
—but remember, you aren’t hurting the part data, part program, or the QC5000 when you practice with the view
rotator, so go crazy.

In general, the view options merely change the way you see the part; they do not affect the part data.
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You should now be able to:

Zoom
Pan
Use the preset views
Use the view rotator
Switch between 4 pane and single pane part views

Tips: 
If the view rotator is "lost," check the bottom of the screen; it may be minimized, or hidden by other windows.
Remember, all four panes in the four pane view are independent, and can be manipulated individually with the
view options.
Practice zooming and panning; they are skills that can be learned quickly.

If a view pane is empty, select it, and zoom all. The part may have been zoomed out beyond sight, or in to a blank
area.
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Proper Probing Techniques
Example #1 - Horizontal & Vertical Approach

Click Here To Return To Probes
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Proper Probing Techniques
Example #2 - Angular Approach

Click Here To Return To Probes
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 Glossary
 

In This Section...
# A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

#
 

A
aberration
A broad term covering several types of image defects in a lens or lens system.

 
absolute system
A system of units in which a small number of units is chosen as fundamental and all other units are derived from this group.

 
absorption
(1) The loss of energy in traveling through a medium.  ie: A yellow filter absorbs all wavelengths except yellow just as red paint
will absorb all colors except red which is reflected.  (2) The internal taking up of one material by another.  (3) Transformation of
radiant energy into other forms of energy when passing through a material substance.

 
acceleration
(1) A rate of change in velocity per unit time. Positive acceleration means an increase in velocity while negative acceleration
means a decrease in velocity per unit time. Avoid the use of the term "deceleration."   (2) The time rate of change of velocity in
either magnitude or direction. Cgs Unit: cm/sec.

 
accuracy
The term accuracy refers to how close we are to the nominal value. In the past we have used this term to indicate error in a
measurement device. For instance, the accuracy of a standard cell is plus or minus 0.01 percent. Use of the word accuracy in
this sense is incorrect because what we mean is the inaccuracy or error is plus or minus 0.01 percent. However, this is still a
common method of describing accuracies. To remedy this practice, the National Bureau of Standards has dropped the term
accuracy, when used in this respect, and uses instead the term "uncertainty."

 
achromat
A lens doublet, to two lenses combined to eliminate chromatic aberration.

 
achromatic
Free from hue

 
activation energy
The energy necessary to start a particular reaction.

 
actual value (true value)
It is not possible to determine a completely true value of a quantity as there is always some error in every measurement.
Theoretically we could say the "true" value of a measured quantity can be derived by taking the average of an infinite number of
measurements assuming that the conditions contributing to deviations act is a completely free and random manner.

 
acuity
Visual acuity is the resolving power of the eye, normally taken as 1 minute arc. Vernier acuity is the ability of the eye to make
coincidence settings.

file:///D|/MANUAL/toc.htm
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adsorption
The adhesion of one substance to the surface of another.

 
algebra
A continuation of arithmetic in which letters and symbols are used to represent definite quantities whose actual values may or
may not be known.

 
algorithm
Step-by-step procedure for the solution to a problem. First the problem is stated and the algorithm is devised for its solution.

 
alignment telescope
A telescope specifically designed to be mounted and used in conjunction with an end target in order to form a fixed line of sight.
Can also be used to measure linear displacement (alignment of a rail for straightness) by using the optical micrometers.

 
alloy
A mixture of two or more metals, such as brass (zinc and copper), bronze (copper and tin), and manganin (nickel, manganese,
and copper).

 
alnico
An alloy consisting chiefly of aluminum, nickel, and cobalt. It has high retentivity and is used to make powerful small-size
permanent magnets which hold their magnetism indefinitely.

 
alpha
The current amplification factor when connected in a common base configuration.

 
alpha particle
(1) Particle identical with a helium nucleus emitted from the nucleus of a radioactive atom.  (2) A helium nucleus, consisting of
two protons and two neutrons, with a double positive charge. Its mass is 4.002764 a mu (mass units).

 
alpha ray
A stream of fast-moving helium nuclei; a strongly ionizing and weakly penetrating radiation.

 
alphanumeric
Set of all alphabetic and numeric characters.

 
alternation
One half of a complete cycle, consisting of a complete rise and fall of voltage or current in one direction. There are 120
alternations per second in 60 Hz alternating current.

 
altimeter
An aircraft instrument that indicates the elevation in respect to a reference. The aneroid altimeter is referenced to sea level, while
an electronic altimeter uses the radar method. See barometer.

 
ambient temperature
The temperature of the air in the immediate vicinity.

 
ambiguity
The quality of having more than one meaning.

 
amici prism
direct vision prism, beam of light is dispersed into a spectrum without mean deviation.

 
ammeter
An instrument used for measuring the amount of current in amperes. A meter that indicates the current value in milli-amperes is
a milli-ammeter, and one that indicates values in micro-amperes is a micro-ammeter.

 
amplitude
The extent of a vibrator movement measured from the mean position to an extreme.
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amplification
As a related to detection instruments, the process (either gas, electronic, or both) by which ionization effects are magnified to a
degree suitable for their measurement.

 
angle of incidence
The angle formed by the line of an incident ray and a perpendicular line arising from the point of incidence.

 
angle of lag
The angle with which one alternating electrical quantity lags behind another quantity in time,

 
angle of reflection
The angle formed by the line of a reflected ray and a perpendicular line arising from the point of incidence.

 
angle of refraction
The angle formed between the line of a refracted ray and a perpendicular line drawn through the point of refraction.

 
angular acceleration
The time rate of change of angular velocity either in angular speed or in the direction of the axis of rotation (precession). Cgs
unit, 1 radian/sec/sec.

 
angular velocity
(1) The speed of a rotating object measured in radians per second and generally designated by the lower case Greek letter
omega. In the case of a periodic quantity, such as alternating current, the angular velocity is equal to a 2 p f.  (2) The time rate
of angular motion about an axis. Cgs unit: radians/sec. If the angle described in time t is q , the angular velocity , w = q / t , q in
radians and t in seconds gives w in radians per second.

 
angstrom unit
10 cm, a convenient unit for measuring wavelength of light. Abbreviation: A.

 
antilogarithm
Number from which the log was derived. Obtained as a result of using the inverse procedure of obtaining a log. It is often written
as "antilog."

 
aperture
An opening or gap. In optics, the effective aperture is the portion of an objective lens that is actually used.

 
aplantic lens
A lens that is corrected for spherical, coma, and chromatic aberrations.

 
apparent power
The power value obtained in an alternating current circuit by multiplying the effective values of voltage and current. The result is
expressed in volt-amperes, and must be multiplied by the power factor to secure the average or true power in watts.

 
apses
The point at which an orbiting body is the greatest or least distance from the center of attraction. The greatest distance is called
the higher apses and the least distance is called the lower apses.

 
arc
A portion of the circumference of a circle.

 
Archimedes' principle
When a body is placed in a fluid, it is buoyed up by a force equal to the weight of the displaced fluid.

 
astigmatism
(1) A visual aberration caused by lack of sphericity of the cornea.  (2) A blurring of the trace of an oscilloscope.

 
atom
Smallest particle of an element that can enter into combination with other elements.

 
atomic number
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(1) The number of protons in the nucleus, hence the number of positive charges on the nucleus.  (2) The number of protons in
the nucleus, hence the number of positive charges on the nucleus. It is also the number of electrons outside the nucleus of a
neutral atom. Symbol: Z.

 
atomic weight
(1) The relative weight of the atom of an element based on an atomic weight of 16 for the oxygen atom as the usual chemical
standard. The sum of protons plus neutrons is the approximate atomic weight of an atom.  (2) The weight of an atom according
to a scale of atomic weight units, awu, valued as one-twelth of the carbon atom (C12 = 12.00000). Thus is identical to the mass
number.

 
attached method (optics)
A method of measuring when all test equipment and standards are physically located on the same reference plane.

 
Autocollimation
A process in which collimated rays of light emanating from an instrument, and carrying the image of a reticule, are aimed at a
reflective surface. The reticule image is reflected back into the focal place of the telescope for comparison with the actual
reticule as a measure of relative tilt, between the optical axis and the reflective surface. An instrument used for this purpose is
called an Autocollimator.

 
Autocollimator
A telescope provided with both an eyepiece and a focal plane target. The basic operating principle is to align a plane with a
reflective capability at right angles to the autocollimator axis and/or measure the out-of-squareness of a plane to the
autocollimator axis.

 
autoreflection
A process in which the reflected image of a target surrounding the front end of a telescope is compared with the telescope
reticle as a measure of relative tilt. (The focal length is twice the dimension from the instrument to reflective surface.)

 
autumn equinox
First day of autumn in the northern hemisphere. It usually falls on September 21st in the northern hemisphere. There are about
12 hours of light and 12 hours of darkness every place on the Earth during an equinox.

 
average value
(1) The value obtained by dividing the sum of a number of quantities by the number of quantities represented.  (2) The average
of many instantaneous amplitude values taken at equal intervals of time during an alternation (half-cycle). The average value of
an alternation of a pure sine wave is 0.637 times its maximum or peak amplitude value.

 
avogadro's law
The hypothesis that equal volumes of all gases at the same pressure and temperature contain equal numbers of molecules.
Hence the number of molecules contained in 1 cm3 of any gas under standard conditions is a universal constant.

 
avogadro's number
The number of molecules in a gram-molecular weight of any substance (6.03 x 1023 molecules); also, the number of atoms in a
gram-atomic weight of any element.

 
axis
A straight line, real or imaginary, passing through a body, on which the body revolves.

 
axis, optical
A line formed by the coinciding principal axis of a series of optical elements.
 
axis, principal
A line through the centers of curvature of a refracting lens.

 
azimuth
Horizontal direction or bearing of one object with respect to another, expressed as an angle measured in a horizontal plane and
in a clockwise direction from the north (true north, unless otherwise indicated).
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B
B+ (B plus)
The positive terminal of a B battery or other plate-voltage source for a vacuum tube, or the plate-circuit terminal to which the
positive source terminal should be connected.

 
B- (B minus)
Symbol used to designate the point in a circuit to which the negative terminal of the plate supply is to be connected.

 
B-H curve
A characteristic curve showing the relation between magnetic induction (B) and magnetizing force (H) for a magnetic material. It
shows the manner in which the permeability of a material varies with flux density. Also called "magnetization curve."

 
backlash
A form of mechanical hysterysis (lag) in which there is a lag between the application of a driving force and the response of the
driven object.

 
barn
The unit expressing the probability of a specific nuclear reaction taking place in terms of cross-sectional area. It is 10-24 cm2 .
(See Cross Section.)

 
barometer
An instrument for measuring atmospheric pressure. There is a direct relationship between atmospheric pressure and altitude and
many barometers are equipped with an altitude scale. Two types of barometers are "mercury" and "aneroid." The aneroid
barometer with an altitude scale is an altimeter.

 
beam
A beam of light can be regarded as the path traced by a small section of an advancing wave front, which is comprised of an
infinite number of light rays.

 
Bernoulli's principle
With a fluid in motion, if the velocity is low, the pressure is high and vice versa.

 
beta
The current amplification factor of a transistor when connected in a common-emitter configuration.

 
beta particle
(1) Particle identical to an electron emitted from the nucleus of a radioactive atom.  (2) A charged particle emitted from the
nucleus and having a mass and charge equal in magnitude to those of the electron.

 
beta ray
A stream of beta particles, more penetrating but less ionizing than alpha rays; a stream of high-speed electrons.

 
bifilar winding
A method of winding transformers in which the wires are placed side by side, and wound together.

 
bilateral
Having, or arranged upon, two sides.

 
binding energy
The energy represented by the difference in mass between the sum of the component parts and the actual mass of the nucleus.

 
bimetallic element
Two strips of dissimilar metal bonded together so that a change in temperature will be reflected in the bending of the element,
as a result of differential expansion. Used in thermostats, dial thermometers, and temperature compensating devices in the better
pressure gages.

 
boiling
Rapid vaporization which disturbs a liquid, and which occurs when the vapor pressure within a liquid is equal to the pressure on



Glossary

file:///D|/MANUAL/GLOSSARY.HTM[6/28/2019 8:09:44 AM]

its surface.
 

bonded strain gage
A thin metallic resistance element, usually of wire or foil, chemically cemented to a device being subject to loading or stress. As
the load (stress) changes, the electrical resistance of the strain gage changes. Thus, for a fixed value of applied voltage, the
output voltage from the strain gage varies in proportion to the strain and provides an indication proportional to the load causing
the stress and resultant strain.

 
bourdon element
A curved, hollow tube sealed at one end. When fluid under pressure is forced in the tube it has a tendency to straighten out.
With a pointer attached to the sealed end and allowed to move across a scale it becomes a bourdon gage.

 
Boyle's Law
If the temperature of a gas is kept constant, then the volume of the gas will be inversely proportional to the pressure.

 
bridge circuit
An electrical network that is basically composed of four branches connected in the form of a square. One pair of diagonally
opposite junctions is connected to the input, and the other pair is connected to the output circuit which contains an indicating
device.

 
bridge rectifier
A full-wave rectifier with four elements connected as in a bridge circuit. Alternating voltage is applied to one pair of junctions.

 
British Thermal Unit (BTU)
The amount of heat that will raise the temperature of 1 pound of water 1 °F at maximum density (39.1 °F).

 
bucking-in
To place an instrument so that its line of sight passes through two given points or fulfills two requirements simultaneously.
Usually the first operation in setting up control is to establish a width plane.

 
buoyancy
The power to float or rise in a fluid.

 
buoyant force
The upward force which any fluid exerts on a body placed in it.

C
calibrate
To determine by measurement or comparison the correct value of each scale reading on a meter or other device being
calibrated. To determine the settings of a control that corresponds to particular values of voltage, current, frequency, or some
other characteristic.

 
calorie
The amount of heat required to raise the temperature of 1 gram of water 1 °C at 15 °C.

 
candela
Unit of luminous intensity. It is of such a value that the luminous intensity of a full radiator at the freezing temperature of
platinum (1773 °C) is 60 candela per centimeter squared. Candela was formerly termed candlepower, or simply candle.

 
capillarity
The characteristic of a liquid to be raised or depressed in a tube or small bore. This action is caused by a combination of
cohesive, adhesive, and surface tension forces.

 
celestial
Of the sky or the heavens. A celestial telescope is one in which the image appears inverted, as in astronomical telescopes with
no erector.
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Celsius temperature scale
A temperature scale based on mercury in glass thermometer with the freezing point of water defined at 0 °C and the boiling
point of water defined at 100 °C, both under conditions of normal atmospheric pressure.

 
center of instrument
In optics, the intersect point of the vertical, horizontal, and optical axis of a transit or similar instrument when perfectly calibrated.

 
certify
To attest a being true or as represented, or to meet a certain standard.

 
centripetal force
The force required to keep moving mass traveling in a circular path. The force is directed toward the axis of the circular path.

 
Cgs system
The common metric system of units (centimeter-gram-second).

 
chain reaction
Any chemical or nuclear process in which some of the products of the process are instrumental in the continuation of
magnification of the process.

 
Charles Law
The volume of a gas is directly proportional to its absolute temperature, providing the pressure is constant.

 
chemical compound
A pure substance composed of two or more elements combined in a fixed and definite proportion by weight.

 
chromatic aberration
A property of lenses that causes the various colors in a beam of light to be focused at various points, this causing a spectrum to
appear.

 
clinometer
The clinometer is, in principle, a level mounted on a rotatable member, whose angle of inclination relative to its base can be
measured by a circular drum scale.

 
coefficient of linear expansion
The change in unit length in a solid when its temperature is changed 1 °.

 
coefficient of volume expansion
The change in unit volume of a solid when its temperature is changed 1 °.

 
cohesion
The force that causes molecules which are brought close together, as in liquids and solids, to stick together. This force is
especially strong in solids when the distance between molecules is very small.

 
coincidence
Exact correspondence; aligning two lines; placing one beside the other. In optics, a coincidence bubble is equipped with a
prismatic or mirror arrangement for simultaneously viewing both ends of the bubble for more precise adjustment.

 
collimate
To render parallel.

 
collimation
The process of making light rays parallel. Also; The process of aligning the optical axis of optical systems to the reference
mechanical axes or surfaces of an instrument, or the adjustment of two or more optical axes with respect to each other.

 
collimator
An instrument designed to produce collimated (parallel) rays of light, usually equipped with displacement and tilt graticules.

 
collinear
Lying on or passing through the same straight line
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complex number
The expression resulting when a real number is united with an imaginary number by a plus or minus sign.

 
complex vibration
The combination of two or more sinusoidal vibrations existing simultaneously.

 
compound
Two or more substances combined in definite proportions by weight and united chemically.

 
concave
A lens that is thicker at the ends than the middle. A concave lens diverges (spreads) rays of light.

 
concentricity
Having a common center, as circles or spheres one within another.

 
condensation
The change of state from a gas or vapor to a liquid.

 
conservation of energy
The principle that energy can neither be created nor destroyed, and therefore the total amount of energy in the universe is
constant. This law of classical physics is modified for certain nuclear reactions. (See Conservation-of-Mass-Energy.)

 
conservation of mass-energy
The principle that energy and mass are interchangeable in accordance with the equation E = mc2 ; where E is energy, m is
mass, and c is velocity of light.

 
correction
The correction is the value in proportional parts, that must be algebraically added to the nominal value to obtain the certified
value. The correction is equal in absolute magnitude but opposite in sign to the error. Correction is what must be done to the
nominal to reach the actual.

 
cosmic rays
Rays of higher frequency than radioactive gamma rays; highly penetrating, of unknown origin, traversing interplanetary space.

 
coulomb
Unit of quantity of electricity. The quantity of electricity transported in 1 second by a current of 1 ampere, or a movement of 6.28
X 1018 electrons past a given point in 1 second.

 
Converge
Tend to meet at a point.

 
convex lens
A lens that is thicker in the middle than the ends. A convex lens converges rays of light.

 
creep
The long term change in dimensional characteristics of a body under load, in an elastic force measurement device. This term
refers to the change in reading which occurs when a constant load is applied for a period of time.

 
critical angle
The angle between and at which there is neither refraction or internal reflection.

 
critical size
For fissionable material, the minimum amount of a material which will support a chain reaction.

 
cross section (Nuclear)
The area subtended by an atom or molecule for the probability of a reaction; that is, the reaction probability measured in units of
area.

 
cryogenic
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The science of refrigeration pertaining to the methods for producing and measuring very low temperatures.
 

cycle
(1) The complete sequence of instantaneous values of a periodic event that occurs during one period.  (2) In electricity, one
complete positive alternation and one complete negative alternation of an alternating current.  (3) 1 cycle expressed in degrees
= 360° or expressed in radians = 2 p radians.

D
damping
(1) The prevention of free swinging or vibration by some means, usually friction or resistance.  (2) The dissipation of energy with
motion or time.

 
decade box
In measurement work, a special device containing two or more sections. Each section is divided into 10 equal parts and has a
value of 10 times the value of the preceding section. Switching arrangements permit selection of any desired value in its range.

 
decay
The disintegration of the nucleus of an unstable element by the spontaneous emission of charged particles and/or photons.

 
decay time
The time required for the trailing edge of a pulse to decrease from 90 percent to 10 percent of its maximum amplitude. Also
referred to as fall time.

 
deionization potential
The potential at which the ionization of the gas within a gas-filled tube ceases and conduction stops.

 
density
The mass per unit volume. Cgs unit: gm/cm .

 
detached method
A very flexible method of optical tooling. The instruments are mounted on stands or on optical tooling bars which are free of the
actual work.

 
deuterium
A heavy isotope of hydrogen having 1 proton and 1 neutron in the nucleus. Symbol: D or d.

 
deuteron
The nucleus of a deuterium atom or the ion of deuterium. Its structure contains one proton and one neutron.

 
dew point
The temperature at which the water vapor in the air begins to condense. At this temperature the relative humidity is 100 percent.

 
dial indicator
This is a mechanical lever system used for amplifying small displacements and measuring it be means of a pointer which
transverses a graduated dial.

 
differential voltmeter
A voltmeter that operates on the potentiometric principle. The unknown voltage is compared to an adjustable calibrated voltage
developed within the differential voltmeter.

 
differentiating circuit
A circuit in which the output voltage is proportional to the rate of change of the input voltage. In an RC circuit the output is taken
across the resistor, and in an RL circuit it is taken across the inductor.

 
diffraction
The bending of waves, light, sound, or radio, as they pass an obstruction or pass through a small aperture.

 



Glossary

file:///D|/MANUAL/GLOSSARY.HTM[6/28/2019 8:09:44 AM]

diffusion
(1) The penetration of one type of particle into a mass consisting of a second type of particle.  (2) To spread out in all directions.

 
digit
Sign or symbol used to convey a specific quantity of information either by itself or with other numbers of its set; 2, 3, 4, and 5
are digits. The base or radix must be specified and each digit's value assigned.

 
digital voltmeter
An automatic electronic measuring instrument which displays its measurements directly in the decimal system. It is an automatic
potentiometric measurement.

 
dimensional analysis
A process whereby the metrologist separates a quantity into its constituent parts to facilitate the solution to a problem.

 
diopter
The unit of lens power, is usually denoted by D and is the power of a lens of 1 meter focal length.

 
displacement
(1) The amount of change in position from a reference.  (2) Misalignment from a line of sight, usually measured vertically and
horizontally.

 
displacement graticule
A graduated reticle used in Collimators measuring vertical and horizontal displacement. Generally in terms of linear
displacement.

 
distortion
Any deviation from the desired waveform.

 
diverge
To spread out, as in the effect of a concave or negative lens. Diverges away from the focal point.

 
dove
A prism which inverts the image without displacement. Also called a rotating prism.

 
dyne
That unit of force which, when acting upon a mass of 1 gm, will produce an acceleration of 1 cm/sec/sec.

E
Edison effect
The emission of electrons from hot bodies. The rate of emission increases rapidly with temperature. Also known as thermionic
emission.

 
effective mass
The mass of a body which is being acted upon by the buoyant forces of air. The effective mass of a weight is its true mass
minus the buoyant force of air displaced by the weight.

 
effective value (RMS)
The alternating current value that will produce the same amount of heat in a resistance as the corresponding direct current
value. All alternating current meters, unless otherwise marked, indicate effective values of voltage or current. The effective value
is also called RMS (root-mean-square) value.

 
efficiency
The ratio of useful output energy to input energy, usually expressed as a percentage. A perfect electrical device would have an
efficiency of 100 percent.

 
elasticity
The property of material to return to its original shape after stress is removed.



Glossary

file:///D|/MANUAL/GLOSSARY.HTM[6/28/2019 8:09:44 AM]

 
elastic limit
The maximum unit stress which can be obtained in a structural material without causing permanent deformation.

 
E Layer
An ionized layer in the E region of the ionosphere. This layer occurs during daylight hours; its ionization depends on the angles
of the sun.

 
electric field intensity
The magnitude of the intensity of an electric field at a particular point, equal to the force which would be exerted upon a unit
positive charge placed in the field at that point. The direction of the electric field is the direction of this force.

 
electron
(1) A subatomic particle possessing a unit negative charge.  (2) A negatively charge particle which is a constituent of every atom.
A unit of negative electricity equal to 4.80 x 10-10 esu. Its mass is 0.00548 mu.

 
electronics
That branch of physics which relates to the emission behavior and effects of electron conduction through a vacuum, gaseous
media or semiconductors.

 
electronic switch
An electronic circuit designed to cause a start and stop action or a switching action.

 
electrostatic field
The region surrounding an electric charge in which another electric charge experiences a force.

 
electrostatic unit of charge (Statcoulomb)
That quantity of electric charge which, when placed in a vacuum 1 cm distant from an equal and like charge, will repel it with a
force of 1 dyne. Abbreviation: esu.

 
element
(1) In chemistry, one of the 100-odd primary substances that cannot be divided into simpler substances by chemical means.  (2)
A pure substance consisting of atoms of the same atomic number, which cannot be subdivided by ordinary chemical means.

 
elevation
The vertical distance above a reference level, usually sea level, to a point or object on the surface of the Earth, as distinguished
from altitude, which refers to points above the Earth's surface.

 
empirical
Based on actual measurement, observation, or experience without regard to science and theory.

 
endoergic reaction
A reaction which absorbs energy.

 
energy
Capacity for performing work. Energy due to the motion of a piece of matter is called kinetic energy. Energy due to the position
of a piece of matter is called potential energy.

 
equilibrium
a condition in which all forces processes or tendencies present are exactly counterbalanced by equal and opposite forces,
processes, or tendencies.

 
erect
Not inverted, the normal position.

 
erector lens
Additional optics fitted to the eyepiece lens system enabling the image to be viewed in the normal (erect) position.

 
erg
The unit of work done by a force of 1 dyne acting through a distance of 1 cm. The unit of energy which can exert a force of 1
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dyne through a distance of 1 cm. Cgs units: dyne-cm, or gm-cm2/sec2.
 

error
The error is the difference between an observed value or calculated value and the true or actual value.

 
evaporization
The change of state from a liquid to a gas.

 
exoergic reaction
The reaction which liberates energy.

 
exponent
Power of ten by which a number is multiplied, used in floating point representation. For example, the exponent in the decimal
number 0.9873 X 107 is 7.

 
exponential
Pertaining to varying exponents or to an expression having varying exponents. Any constant base affected with an exponent is
exponential.

 
eyepiece
An essential component of a telescope which receives a real image in its focal plane and forms a magnified virtual image.

F
Fahrenheit scale
A thermometric scale on which the freezing point of water is 32 ° and boiling point 212 °, at 760 mm Hg (standard pressure).

 
field of view
Expressed as an angle and representing the arc through which observations are possible through a telescope. The field angle is
controlled by the aperture of the eye lens and decreases as magnification increases.

 
filar
Also known as; cross hair, reticle. In optics a superimposed reference line. For two parallel lines called; bifilar  See also; reticle .

 
fission products
The elements and/or particles produced by fission.

 
fixed point
The point where all heat energy applies or removed is used to change the state of a substance.

 
flux
(1) A material used to promote fusion or joining of metals in soldering, welding, or smelting. Rosin is widely used as a flux in
electric soldering.  (2) A general term used to designate collectively all the electric or magnetic lines of force in a region.

 
focal length
The distance from the optical center of a lens to the point where light rays converge.

 
focal plane
A plane that is perpendicular to the optical axis at the focal point. All light coming from infinity will focus somewhere on the focal
plane.

 
focal point
The point at which light rays converge after passing through a convex (positive) lens.

 
focus
Correct adjustment of a lens to produce a clear image.

 
force
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A push or pull. That which produces or prevents motion or has a tendency to do so.
 

force measurement device
Refers to any device by which a quantitative determination of an applied force can be made.

 
forced vibration
Motion caused by some mechanical excitation.

 
foot-candle
The amount of illumination which a standard source of 1 candle (candlepower) will throw upon a surface placed 1 foot away and
at right angles to the rays of light.

 
free vibration
Vibration that occurs without forcing, as after a tuning fork is struck.

 
frequency
The number of recurrences of a periodic phenomenon in a unit of time. In specifying electrical frequency, the unit of time is the
second.

 
frequency meter
An instrument for measuring the frequency of an AC signal.

 
fundamental mode of vibration
The lowest natural frequency.

 
fusion (heat)
The change of state from a solid to a liquid.

G
gage
An instrument for measuring or testing; a device for determining whether specific dimensions are within specified limits.

 
gage block
A block of alloy steel, usually rectangular, with two gaging surfaces. The standard length as nominally represented on the side is
in inches between the two gaging surfaces with an uncertainty in the neighborhood of 6 microinches.

 
Galilean telescope
Devised and constructed by Gailieo in 1609. The device consists of a positive objective lens and a negative eyepiece with their
focal points in coincidence. The system is suitable for two or three power magnification and produces an erect image.

 
galvanometer
A D'Arsonval laboratory instrument usually of the suspension type capable of measuring very small electrical currents. It is
usually used to indicate a null. Since the galvanometer is used in this application, to indicate whether or not a current is present,
and not necessarily the actual magnitude of the current, the primary requirement of the galvanometer is to show a readable
deflection for the smallest current that is significant for a particular measurement.

 
gamma ray
Radiant energy of extremely short wavelength emitted spontaneously by a radioactive substance.

 
gas
The state of matter that has no definite shape or volume. The molecules of a gas have almost no cohesive forces, hence the
expansion of a gas in free space is almost unlimited.

 
gauss
Unit of magnetic induction (also called magnetic flux). One gauss represents one line of flux per square centimeter.

 
geometry
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Study of the properties, measurement, and relations between lines, angles, surfaces, and solids.
 

Go and No-go gages
These are gages that do not measure actual size but merely determine whether parts are within specified limits.

 
grain
A measure of mass in the English gravitational system equal to one seven-thousandth (1/7000th) pound.

 
gram
Metric unit of mass or weight. One pound is equal to 453.59 grams.

 
gram-atomic weight
The relative atomic weight of an element, expressed in grams.

 
gram-molecular weight (Gram-Mole)
The relative molecular weight of a compound, expressed in grams.

 
graph
A pictorial presentation of the relation between two or more variable quantities.

 
graticule
A scale on a transparent material in the focal plane of an optical instrument for the location and measurement of objects.

 
gravity
Any two bodies in the universe attract each other with a force that is directly proportionate to the product of their mass and
inversely proportionate to the square of their distance apart.

 
gravitational acceleration
The acceleration due to the force of gravity.

 
gravitational units or "G" units
The usual way of expressing acceleration intensity, in terms of gravitational constant, is equal to the acceleration in
inches/sec/sec divided by 386.087 inches/sec/sec.

 
gross error
A gross error is simply a mistake.

 
ground
A reference point in an electrical circuit which is usually a connection between an electrical circuit and the Earth or some
conducting body serving in place of the Earth.

 
group velocity
The axial velocity at which a signal travels through a waveguide. Group velocity is always less than the velocity of a signal in
open air.

H
half life
The length of time during which half of a given number of atoms of a radioactive element will disintegrate.

 
half thickness
The thickness of absorbing material necessary to reduce the intensity of radiation by one-half.

 
hardness
The internal resistance of an object to having its molecules forced further apart or closer together.

 
harmonic
A sinusoidal component of a periodic wave or quantity having a frequency that is an integral multiple of the fundamental
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frequency. Thus, a component whose frequency is twice the fundamental frequency is called the second harmonic.
 

heat
The energy of molecular motion measured in terms of the effect on some material substance.

 
heat of fusion
The amount of heat needed to melt a unit mass or weight of a substance at its normal melting point.

 
heat of vaporization
Heat required to vaporize a unit mass or weight of a liquid at its normal boiling point.

 
heavy water
The popular name for water which is composed of 2 atoms of deuterium and 1 atom of oxygen.

 
hertz
A unit of frequency equal to 1 cycle per second.

 
Hooke's Law
Within the limits of perfect elasticity, stress is directly proportional to strain.

 
hunting
Refers to a tendency of a mechanical system to oscillate about a normal condition, or about the point of alignment.

 
humidity
See relative humidity.

 
hydrogen atom
The atom of lightest mass and simplest atomic and nuclear structure, consisting of 1 proton with 1 orbital electron. Its mass is
1.008123 mu.

 
hydrometer
An instrument used to determine the specific gravity of liquids.

 
hydraulics
The study of liquids in motion.

 
hydrostatics
The study of liquids at rest.

 
hygrometer
Any of several instruments for measuring the humidity of the atmosphere.

 
hygroscopic
Readily absorbing and retaining moisture, often reflecting this absorption by changing physical appearance and shape.

 
hysteresis
(1) The word hysteresis means "lag." One example is the lagging of the magnetic flux, in a magnetic material, behind the
magnetizing force which is producing it. Another example is the lag of a standard cell in returning to its initial voltage following a
change in temperature.  (2) In force measurement, hysteresis may refer to the difference in indication for two identical loads, one
obtained by reducing from a larger load and the other built up from a lesser value.

I
ice point
0.00 °C,  0.01 °C below the triple point of water.
 
illumination
To supply or brighten with light.
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image
(1) A virtual image is the impression of an object as viewed by an observer. Rays do not pass through, but only appear to come
from the image.  (2) A real image is one through which rays actually pass and can be projected onto a screen.

 
incident ray
A ray of light entering into a lens or mirror.

 
inclination
Refers to a difference between the slope of the line or place in question and some other reference line or plane.

 
increment
Adding the value one to the contents of a register or memory location.

 
index of refraction
The ratio of the speed of light in a vacuum to its speed in a given substance.

 
inertia
That property of mass which resists a change in motion.

 
infinite
Subject to no limitation or external determination, extending indefinitely.

 
infinite line
A transmission line having characteristics corresponding to those which would be obtained with an ordinary line that is infinitely
long.

 
infinity (optical)
An infinite distance from which collimated or parallel light rays are assumed to emanate (approximately 2000 yards).

 
initialization
Setting a system to a known state.

 
instability
An undesired change over a period of time, which change is unrelated to input, operating conditions, or load.

 
intensity of radiation
The amount of radiant energy emitted in a specific direction per unit time and per unit surface area.

 
interface
In optics, a boundary between two media in which light travels with different velocities.

 
interference
In optics, when two sets of light waves of equal wave length and amplitude from the same source meet, so that the crests of one
coincide with the troughs of another, they cancel out. Similarly, if two sets of light waves meet when the crests of one coincide
with the crests of the other they reinforce each other.

 
interferometer
An instrument that is used to measure minute linear displacement through the phenomena of light interference.

 
interferometry
The use of light interference patterns for measurements with apparatuses such as the optical flat.

 
interpolation
The process of estimating in a transmission line due to power dissipation.

 
inversion
The condition that exists when both axes of an image are reversed.

 
inverter
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Any mechanical or electrical device for converting direct current into alternating current.
 

ion
An atomic particle, atom, or chemical radical (group of chemically combined atoms) bearing an electrical charge, either positive
or negative, caused by an excess or deficiency of electrons.

 
ionization
The process by which molecules of a gas are converted into positive ions by loss of electrons, or into negative ions by gain of
electrons. Ionization can be produced in a number of ways, by collisions of ions with electrons, by the action of ultraviolet light or
other radiations.

 
ionization potential
The potential necessary to separate 1 electron from an atom.

 
ionizing event
An event in which an ion is produced.

 
isobars
Elements having the same mass number but different atomic numbers.

 
isotope
One of two or more forms of an element having the same atomic number (nuclear charge) and hence occupying the same
position in the periodic table. All isotopes are identical in chemical behavior, but are distinguishable by small differences in
atomic weight. The nuclei of all isotopes of a given element have the same number of protons but have different numbers of
neutrons.

 
ionosphere
That region of the atmosphere, 70 to 250 miles above the surface of the Earth, containing layers of highly ionized air that are
capable of bending or reflecting radio waves back to Earth. Reflection from the ionosphere makes possible long distance
reception of radio waves.

J
jitter
Small, rapid variations in a waveform due to mechanical disturbances.

 
joule
Unit of energy. The work done when the point of application of 1 newton is displaced a distance of 1 meter in the direction of
the force.

K
K
Symbol for 1000 (103). When referring to bits or words, K=1024 (210).

 
Kelvin temperature scale
The absolute temperature scale in the Cgs system. Kelvin is equal to degrees Celsius plus 273.15.

 
kilogram
Unit of mass. The mass of a particular cylinder of platinum-iridium alloy, called the International Prototype Kilogram, which is
preserved in a vault at Sevres, France, by the International Bureau of Weights and Measures.

 
kinetic energy
Energy due to motion.
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L
lapping
A smoothing or polishing operation.

 
laser
An optical cavity capable of oscillating in the visible and nonvisible light spectrum. The laser is a true light amplifier because light
energy is used for excitation.

 
lateral
From the side. Usually refers to movement of a given reference made from left to right to left.

 
lens
A body of glass or similar material ground to fine limits, used to either converge or diverge rays of light by refraction.

 
level
Perpendicular to the force of gravity. Also, a device for determining true level by means of a gravity seeking level.

 
light
A narrow band of radiation which is the visual section of the electromagnetic spectrum. It consists of wavelengths of 15.7 to 27.5
microinches.

 
line of sight
A straight line that passes through the cross hairs and the principal point of lens is called the line of sight or the line of
collimation; it always strikes the object where the cross hairs appear to fall. Accordingly, the cross hairs and the principal point
of the lens are said to define the line of sight.

 
linear
A relation such that any change in one of two related quantities is accompanied by an exactly proportional change in the other.

 
liquid
The state of matter which has definite volume but no definite shape.

 
load cell
A type of force transducer designed primarily for the measurement of load or weight. Electric load cells usually employ bonded
strain gage resistance elements to provide an electrical output signal proportional to the load. Hydraulic and pneumatic load cells
generally make use of a bourdon-type device, such as a Heise gage.

 
loading effects
An error of measurement resulting in a change of the system under test caused by insertion of the test instrument.

 
logarithm
The logarithm of a number is the power to which a second number, called the base, must be raised in order to yield the original
number. Bases in common use are 10 and 2.718.

 
lumen
Unit of luminous flux. It is the luminous flux emitted in a solid angle, 1 steradian, by a uniform point source having an intensity of
1 candela.

M
magnet
Any object which has the property of attracting iron, nickel, or cobalt objects with forces which are much greater than those of
gravitation and which do not depend on the presence of electric charges on either body.

 
magnetic deflection
Method of bending electrons in a CRT by means of the magnetic field produced by coils placed outside the tube.
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magnification
The value of magnification is the apparent size of an object viewed through a telescope divided by the size it appears to the
unaided eye from the same distance.

 
malleability
The property of a metal which allows it to be hammered or rolled into sheets.

 
mantissa
Fractional value used as part of a floating point number. For example, the mantissa in the number 0.9873 X 107 is 0.9873.

 
mass
The measure of the quantity of matter that a body contains.

 
mass density (r )
Mass per unit volume.

 
mass number
The number of protons and nutrons in the atomic nucleus of an element. (equal to the atomic number)

 
mass unit
A unit of mass based upon 1/18 the atomic weight of an oxygen atom taken as 18.00000. Abbreviation: mu, or atomic mass unit,
amu.

 
master flat
A surface plate, usually round rather than square with a high degree of surface flatness.

 
matter
Anything which has weight and occupies space.

 
Mcleod gage
A primary instrument for the measurement of pressure in a vacuum system. The gage consists of a glass bulb with a vertical
capillary tube at the top.

 
mean free path
The average distance a particle moves between collisions. Abbreviation: mfp, symbol, I.

 
mean solar day
The average of all apparent solar days in a given year.

 
measurand
A particular quantity subject to measurement.

 
measurement
The overall process that a person goes through in reaching a decision as to the magnitude of some quantity.

 
mechanical axis
The true centerline of the mechanical components within the telescope. For a perfectly calibrated instrument the mechanical axis
would be coincident with the optical axis.

 
meniscus
The curved upper surface of a column of liquid which is concave when the walls of the container are wet and convex when the
walls of the container are dry.

 
mercury
A heavy, silver-colored metal which is liquid at ordinary room temperatures.

 
meson
A short-lived particle carrying a positive, negative, or zero charge, and having a variable mass in multiples of the mass of the
electron. Also called mesotron.



Glossary

file:///D|/MANUAL/GLOSSARY.HTM[6/28/2019 8:09:44 AM]

 
metastable state
An excited state of nucleus which returns to the ground state by the emission of a gamma ray over a measurable half life.

 
meter
(1) Unit of length. The length of exactly 1,650,763.73 wavelengths of the radiation in vacuum corresponding to the unperturbed
transition between the levels 2p10 and 5d of the atom of Krypton 86, the orange-red line.  (2) The length of  the path traveled by
light in a vacuum during a time interval of 1/299,792,458 of a second.(1984 GCWM)

 
metrology
The science of measurement.

 
mev
The abbreviation for million electron volts. See Electron-Volt.

 
micron
A unit of length equal to one-millionth of a meter.

 
minute
A minute is 1/60th of a degree. This is more correctly described as a "minute of arc."

 
MKS system
The meter-kilogram-second system.

 
molecule
The smallest particle of any substance which can exist free and still exhibit all properties of the substance.

 
molecular weight
The sum of the atomic weights of all the atoms in a molecule.

 
moment arm
The length of a torque wrench from the center of pivot to the point where force is applied.

 
momentum
The product of the mass of a body and its velocity. Cgs unit: gm-cm/sec.

 
monochromatic light
Light of only one wavelength or color.

N
nadir
The point of the celestial sphere that is directly opposite the zenith and vertically downward from the observer.

 
National Institute of Science and Technology (NIST)
Formerly the National Bureau of Standard (NBS). An independent agency of the U.S. Department of Commerce charged with the
improvement and maintenance of all kinds of standards. The bureau operates radio stations WWV, WWVH, WWVB, and WWVL
which broadcast accurate frequency and time standards.

 
Negative lens
A concave lens, thicker at the edges than the center, which diverges or spreads rays of light through refraction.

 
Negative mirror
A convex mirror curved out. Produces reflected diverging light rays away from the focal point.

 
neon
An inert element which is a gas at room temperature. When ionized by current flow it produces a bright orange-red glow.
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neutron
An elementary nuclear particle with a mass approximately the same as that of a hydrogen atom and electrically neutral; a
constituent of the atomic nucleus. Its mass is 1.00894 mu.

 
neutrino
A particle with zero rest mass and zero charge, emitted to preserve spin, momentum, and energy in decay and other processes.

 
newton
Unit of force. That force which gives to a mass of 1 kilogram an acceleration of 1 meter per second. One newton equals 100,000
dynes.

 
Newtonian fluid
A fluid whose absolute viscosity is the same for all values of shear stress.

 
nominal value
This is normally the value indicated by the manufacturer. Also the indicated value of an instrument under test.

 
nomograph
A chart or diagram with which equations can be solved graphically by placing a straightedge on the two known values and
reading the answer where the straightedge crosses the scale of the unknown values.

 
nonsinusodial wave
Any waveform that differs from that of a sine wave.

 
normal
Perpendicular to a tangent at a point of tangency.

 
nuclear fission
A special type of nuclear transformation characterized by the splitting of a nucleus into at least two other nuclei and the release
of a relatively large amount of energy.

 
nuclear fusion
The act of coalescing two or more nuclei.

 
nucleon
The common name for the constituent parts of the nucleus. At present applied to protons and neutrons, but will include any other
particle that is found to exist in the nucleus.

 
nucleus
The heavy central part of an atom in which most of the mass and the total positive electric charge are concentrated. The charge
of the nucleus, an integral multiple Z of the charge of the proton, is the essential factor which distinguishes one element from
another. Z is the atomic number.

 
nuclide
A general term referring to all nuclear species--both stable (about 270) and unstable (about 500)-- of the chemical elements, as
distinguished from the two or more nuclear species of a single chemical element which are called isotopes.

 
null method
Any method of measurement in which the reading is taken at zero. Galvanometers, sensitive voltmeters, oscilloscopes, and
earphones are used as null detectors.

O
objective lens
The objective lens of a telescope optical system causes a real image to be formed which, when adjusted to lie within the focal
plane of the eyepiece lens can be magnified as a virtual image.

 
ohm
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Unit of electrical resistance. The electric resistance between two points of a conductor when a constant difference of potential of
1 volt, applied between these two points, produces in this conductor a current of 1 ampere, this conductor not being the source
of any electromotive force.

 
ohmmeter
An instrument for measuring resistance.

 
Ohm's Law
A fundamental electrical law which expresses the relationship between voltage, current, and resistance in a DC circuit, or the
relationship between voltage, current, and impedance in an AC circuit.

 
opaque
Neither reflecting nor emitting light.

 
optical axis
Centers of curvature of a lens define a line called the axis of the lens. When several lenses combine to form an optical system,
the line defined as these axis' is called the optical axis.

 
optical flat
A piece of glass or quartz which is accurately flat to within one-tenth of a wave length on one or both surfaces, used as a
reference (proof plane) for comparison of flatness.

 
optical infinity
A section of a wave front which has advanced a great distance from its source and assumed essentially a zero curvature. In
optics approximately 2000 yards

 
optical pyrometer
An instrument designed to estimate the temperature of glowing surfaces.

 
optical tooling
The geometric method of optically establishing a precise line and/or reference plane.

 
optics
The branch of physics which deals with the phenomena of light.

 
optimum
The most favorable degree or condition.

 
out of phase
Having waveforms that are of the same frequency but not passing through corresponding values at the same instants.

 
out-of-round
The high and low spots in a true circle. It is also the ovality or lobing effect which causes a change of true roundness of
cylindrical objects.

 
overload
A load that is greater than the device is designed to handle.

 
overshoot
The initial transient response to an unidirectional change in input which exceeds the steady state response.

 
oxide
An element combined with oxygen. Rust is an oxide of iron.

P
packing fraction
The difference between the atomic weight in mass units and the mass number of an element divided by the mass number and
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multiplied by 10,000. It indicates nuclear stability. The smaller the packing fraction, the more stable the element.
 

pair production
The description of an electron leaving the valence band to enter the conduction band due to absorption of energy (usually heat).
This provides a free electron carrier and a free hole carrier at the same time.

 
parallax
The apparent displacement of the position of an object caused by a shift in the point of observation. Thus, the pointer of a meter
will appear to be at different positions on the scale depending on the angle from which the meter is read. To eliminate errors in
meter reading due to parallax, the line of sight should be perpendicular to the pointer.

 
parallel (optical)
A piece of glass with one side parallel to the other side. An optical parallel gives linear displacement.

 
parameter
(1) In mathematics, one of the constants entering into a functional equation and corresponding to some characteristic property, or
dimension.  (2) In an electronic circuit, a characteristic element or constant factor, such as: resistance, capacitance, or
inductance values.

 
Pascal's Law
The pressure applied on a confined fluid is transmitted undiminished in every direction.

 
peak-to-peak amplitude
The amplitude of an alternating quantity measured from positive to negative peak. This is the value indicated on an oscilloscope.

 
peak-to-peak value
The algebraic difference between extreme values (as DA or double amplitude is twice the single amplitude).

 
pentaprism
A five-sided prism which deviates rays of light by 90° without reversing or inverting the image.

 
pentavalent impurity
Any impure atom that has five electrons in its valence band.

 
period
The time corresponding to one cycle of a periodic phenomenon. The period of a galvanometer is the elapsed time between
consecutive passages of the pointer in the same direction through its zero point.

 
perpendicular
Being at right angles to a given line or plane.

 
photoelectric effect
The electrical effect of light or other radiation. This effect can be emission of electrodes, penetration of voltage, or a change in
electrical resistance upon exposure to light.

 
photometry
The measurement of luminous intensity from a light source by comparison to a known standard.

 
photon
Small particles of light energy according to the quantum theory of light.

 
photon generator
A light source.

 
physics
The physical science which deals with matter and energy and with the transformations of energy.

 
physi-optics
Physi-optical practices combine the use of specific physical measuring standards with optical instruments and physical indicating
apparatus.
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plunge
To rotate the telescope of a Theodolite 180° about the horizontal axis of the instrument.

 
pointer
The needle-shaped rod that moves over the scale of a meter or dial.

 
polarized light
Light in which vibrations occur in a single plane perpendicular to the ray.

 
polyethylene
A tough, flexible, plastic compound that has excellent insulating properties, even at the ultra high frequencies. It is widely used
as the insulating material in coaxial cable.

 
polystyrene
A clear thermoplastic material having very desirable dielectric properties. Many standard capacitors use polystyrene as dielectric.

 
porosity
Small openings or spaces between particles of matter.

 
porro prism
A prism which causes an image to be rotated 180°, or reflected. The image is reversed in the plane in which the reflection takes
place.

 
positive lens
A convex lens, thicker at the center than at the edges, which converges rays of light through refraction.

 
positive mirror
A concave mirror that is curved toward the middle, which converges rays of light through refraction.

 
positron
A nuclear particle equal in mass to the electron and having an equal but opposite charge. Its mass is 0.000548 mu.

 
potential
The amount of voltage or charge between a point and a zero reference point. Bodies with an excess of electrons have a
negative potential. Bodies with a deficiency of electrons have a positive potential. The electric potential at any point in an electric
field is equal to the work done on a unit charge to bring the charge to that point from a place where the potential is zero.

 
potential difference
The difference in potential between any two points in a circuit; the work required to carry a unit positive charge from one point to
another.

 
potential energy
Energy due to position.

 
potentiometer (pot)
A variable resistance unit having a rotating contact arm that can be set at any desired point along a resistance element. The
voltage source is connected to the end terminals of the resistance element, and the output circuit is connected between one end
terminal and the moveable contact to give a voltage dividing action.

 
potentiometric measurement
DC voltage can be most accurately measured using the potentiometric method. It consists of comparing the unknown voltage
with a known voltage from a calibrated potentiometer.

 
precision
The term precision can best be defined as repeatability. If a measurement is made a number of times and nearly the same value
is read each time, it is a precise measurement, the readings may be all wrong. Care should be taken not to confuse precision
with accuracy.

 
pressure
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(1) Force per unit area (closed system).  (2) Height times density (open system).
 

primary colors
Colors in terms of which all colors may be described or from which all colors may be evolved by mixtures.

 
primary electron
The electron ejected from an atom by an initial ionizing event, as caused by an photon or beta particle.

 
primary standard
A unit established by some authority or developed through practical exact application of a formula. Secondary standards are
calibrated against the primary standard.

 
principal focus
A point to which rays parallel to the principal axis converge, or from which they diverge after reflection.

 
principal quantum number
The number, n = 1, 2, 3, . . . . which describes the basic state of atomic system in quantum theory.

 
prism
A transparent body bounded in part by two plane faces that are not parallel, used to deviate or disperse a beam of light.

 
probability
The likelihood of the occurrence of any particular form of an event, figured as the ratio of the number of ways in which that form
might occur to the whole number of ways in which the event might occur in any form.

 
proving ring
An elastic ring in which the deflection of the ring, when loaded along a diameter, is measured by means of a micrometer screw
and a vibrating reed. Note that all ring-type elastic force measuring devices are not proving rings, and such devices which do not
make use of a micrometer screw and vibrating reed should not be called proving rings.

 
proving ring deflection
The difference between the reading for a given load and the reading for no load.

 
proton
A positively charged particle occupying the nucleus of an atom that has a charge equal to that of an electron.

 
psychrometer
An instrument for measuring relative humidity.

 
pyrometer
A device for measuring high temperatures.

Q
quadrant
One of the four sections in which a plane is divided by two perpendicular lines.

 
quantum
One of the very small parts into which many forms of energy are subdivided.

 
quantum level
An energy level of an electron or of any atomic system, distinct from any other of its energy levels by discrete quantities
dependent upon Planck's constant.

 
quantum mechanics
The science of description of atomic systems in terms of discrete quantum states.

 
quantum number
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One of a set of integral or half-integral numbers, one for each degree of freedom, which determines the state of an atomic
system in terms of the constants of nature.

 
quantum state
A term defining the way in which an atomic system exists at any specific time. This state is often described by means of a
complex mathematical function called quanta.

 
quantum theory
The transfer of light and matter occurs only in discrete quantities proportional to the frequency of the energy transferred.

R
radian
The angle for which the arc length is equal to the radius. There are 2 p radians in 1 revolution (360°). A radian represents an
angle of approximately 57.3°.

 
radiant energy
Energy in the form of electromagnetic radiation such as radio waves, heat waves, light waves, ultra violet rays or X-rays.

 
radiation
A method of transmission of energy.  Specifically: (1) Any electromagnetic wave (quantum). (2) Any moving electron or nuclear
particle, charged or uncharged, emitted by a radioactive substance.

 
radioactivity
The process whereby certain nuclides undergo spontaneous atomic disintegration in which energy is liberated, generally
resulting in the formation of new nuclides. The process is accompanied by the emission of one or more types of radiation, such
as alpha particles, beta particles, and gamma radiation.

 
radius
The shortest distance from the center of a circle or arc, to a point on the circumference.

 
random error
Random errors are sometimes called "accidental" errors because they are as likely to occur in one direction as the other. They
are the error left when all gross errors and systematic errors have been corrected.

 
range
(1) Extent of coverage of effectiveness.  (2) Measure of distance.

 
Rankine temperature scale
A temperature scale which corresponds to the Kelvin scale, but is based on the absolute zero of  the Fahrenheit system, so that
0 °Fahrenheit = 459.67 °Rankine.

 
ratio bridge
A bridge circuit that uses a calibrated resistive or calibrated inductive voltage divider for one side of the bridge. Precision
resistors, inductors, and capacitors are measured with ratio bridge circuits.

 
ratio transformer
A precisely wound auto transformer used as an AC voltage divider.

 
ray of light
Can be considered as the path traced by a point on an advancing wave front.

 
reaction
Any process involving a chemical or nuclear change.

 
real image
A real image is one through which light rays actually pass and can be projected onto a screen.

 



Glossary

file:///D|/MANUAL/GLOSSARY.HTM[6/28/2019 8:09:44 AM]

reference line
A line from which all other measurements are taken.

 
reference plane
A reference line that has been rotated through 360°.

 
reflection
The change in direction of waves after striking a surface.

 
refraction
The bending of a ray of light, heat, sound, or a radio wave passing obliquely from one medium into another in which the velocity
of propagation is different from the first medium.

 
relative humidity
The ratio of the amount of water vapor in the air at a given temperature to the maximum water vapor (capacity of the air) at the
same temperature.

 
repulsion
A force tending to separate objects or particles having like electrical charges or magnetic polarities.

 
resilience
The resilience of a body measures the extent to which energy may be stored in it by elastic deformation.

 
resolution
(1) The term resolution pertains to the scale of an instrument. It is the smallest readout at calibrated points. Resolution is
sometimes referred to as "least count."  (2) When uncalibrated adjustments are made, resolution is the smallest change which
can be obtained by manipulation of the instrument controls. Resolution can be increased by use of vernier scales.

 
resonance
The frequency whereby any system responds with maximum amplitude to an applied force having a frequency equal or nearly
equal to its own.

 
resultant
An entity or quantity obtained by means of, or as a result of, a given process.

 
restoring force
The constant mechanical force provided.

 
rest point
The equilibrium point or the point at which the pointer of the balance would come to rest once it has been set into oscillation.

 
reticle
Cross lines found in the telescope of sight levels, transits, and theodolites. Initially in the form of a fine hair. They are now
produced by engraving glass with a diamond point to achieve a line of 2.5 to 3 seconds thickness. Also known as; cross hair,
filar, (For two parallel lines called); bifilar

 
reverse
In optics, to rotate a Theodolite 180° about the vertical axis.

 
rho
The magnitude of the reflection coefficient.,

 
rhomboid prism
A prism which displaces the axis of a beam without introducing and without reverting the image.

 
right angle prism
A simple prism used when deviations of 90° are required. Reversion of the image takes place.

 
roentgen
The quantity of X or radiation which produces 1 esu of positive or negative electricity/cm3 of air at standard temperature and
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pressure or 2.083 x 109 ion pairs/cm of dry air.
 

rosin-core solder
Solder made up in tubular form with the inner space containing rosin flux for effective soldering.

 
rotary motion
Motion in which every particle of a body moves in a circle and all the circles have their centers on the same straight line.

 
rotor
(1) A rotating member such as the armature of a motor, generator, or synchro.  (2) The rotating plates of a variable capacitor.

S
saturation
The point in operation where an increase in a given quantity will have a negligible effect on the output or end result.

 
scale
(1) Something graduated when used as a measure or rule. A series of spaces marked by lines to indicate the magnitude of
some quantity.  (2) A weighing device.

 
schematic diagram
A diagram which shows all of the electronic parts by means of symbols.

 
scintillation counter
A device used for the detection of radioactivity.

 
second (ephemeris second)
Unit of time. Exactly 1/31,556,925.9747 of the tropical year of 1900, January, 0 days and 12 hours ephemeris time.

 
secondary emission
Electron emission that is the direct result of the impact of electrons against a surface.

 
Seeback effect
The EMF produced in a circuit containing two contacting conductors of different metals having two junctions at different
temperatures.

 
sensitivity
(1) The degree of response of a circuit to signals of the frequency to which it is tuned.  (2) An indication of the gain of a
receiver.  (3) A measure of the minimum signal to which a device shows a measurable response.  (4) The ratio of a small
change in instrument reading to the change in the measured quantity required to produce it.  (5) Ratio between electrical output
to mechanical output.

 
servo system
An electromechanical system which is used for positioning one element of a system in relation to another, for example, a PPI
sweep in relation to the antenna. The change in position of one element of the system results in the reproduction of an error
voltage that is used indirectly to cause a motor to drive the other element of the system to the point where the error voltage no
longer exists.

 
shear
An action or stress from applied forces that causes two contacting parts of a body, to slide relative to each other, in a direction
parallel to their place of contact.

 
shell
One of a series of concentric spheres, called signals, which are designated in the order of increasing distance from the nucleus
of an atom, as K, L, M, N, O, P, and Q shells. The number of electrons contained in each shell is limited.

 
sinusoidal vibration
A simplified back and forth motion of a constrained object which varies sinusoidally with time.
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Snell's Law
(Index of refraction) x (sine of incident angle) = (index of refraction) x (sine of refracted angle).

 
solder
An alloy of lead and tin which melts at a fairly low temperature (about 500° F) and is used for making permanent electrical
connections in electrical circuits.

 
solder bridge
Glob of excess solder that shorts two conductors. A common problem on production PC boards.

 
solid
The state of matter which has a definite shape and definite volume.

 
solid state physics
That branch of physics which deals with the structure and properties of solids. In electronics, solid state refers to those devices
which can control current without the use of moving parts, heated filaments or vacuum gaps.

 
sonar
Sound navigation and ranging. Electronic equipment used for underwater detection of objects and determination of their range.

 
sound
A vibration of a body which can be heard by human ears. The extreme limits of human hearing is 20 Hz to 20 kHz. Sound can
travel through any medium which possesses the ability to vibrate; the vibrations are called sound waves.

 
space charge
The negative charge produced by the cloud of electrons existing in the space between the cathode and plate of a thermionic
vacuum tube; formed by electrons emitted from the cathode in excess of those immediately attracted to the plate.

 
specific gravity
The ratio of the density of a substance to the density of a standard (distilled water).

 
specific heat
The ratio of the heat capacity of a body to its mass or weight.

 
spectrum
(1) The entire range of wavelengths within which electromagnetic radiations occur.  (2) A segment of wavelengths which has a
special function or possesses special properties.

 
spherical aberration
The failure of parallel rays to meet at a single point after reflection, causing a blurred image.

 
spin
The inherent, intrinsic angular momentum of an atomic particle; a quantum number in modern atomic theory.

 
spindle axis
An axis found on theodolites and transits that goes directly through the center of the instrument.

 
spring equinox
First day of spring in the northern hemisphere. It usually falls on March 21st in the northern hemisphere.There are about 12
hours of light and 12 hours of darkness every place on the Earth during an equinox. 
stadia lines
Lines or marks on a reticle used to determine distances to objects of a known height or width by using trigonometric principles.

 
Standard
Anything taken as a basis of comparison. An authorized weight or measure having recognized excellence. It is desirable that the
standard have an uncertainty that is one-tenth or less than the equipment being calibrated. A standard is a physical embodiment
of a unit. In general it is not independent of physical condition, and it is a true embodiment of the unit only under specified
conditions, for example, a yard standard has a length of one yard when at some definite temperature and supported in a certain
manner.
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standard deviation
The square root of the sum of the squares of the deviations from the arithmetic mean of a frequency distribution. The deviations
from the arithmetic mean are squared and added, and the square root of this sum is the standard deviation.

 
standard pressure
The pressure exerted by a column of mercury exactly 760 mm high.

 
standard temperature
The temperature of melting ice.

 
steradian
One-fourth of the solid angle around a point.

 
Stoke’s Law
the basis of kinematic viscosity which states that the terminal velocity of a sphere (or any object) falling freely through a fluid is
controlled by the density of the sphere and the absolute viscosity of the fluid.

 
strain
Deformation of a material body under the action of applied forces (stress).

 
straightness
This is the uniformity of direction throughout the extent of that feature, such as the freedom from bend, warp, or twist of a shaft.

 
stress
Mutual force between contacting surfaces of bodies caused by an external force, such as tension or shear.

 
stress testing
Introducing mechanical, electrical, or thermal stress on electrical devices so as to modify their operation and allow intermittent
problems to be observed.

 
stroboscope
An instrument used to determine the speed of a rotating body. It creates the optical illusion of slowing down or stopping the
motion of an object by illuminating it with flashes of intense light at regular intervals.

 
sublimation
The change of state from a solid to a vapor or gas without going through the liquid state.

 
summer solstice
Longest day of the year. It usually falls on June 21st in the northern hemisphere. The sun casts its shortest shadows in the
summer solstice.

 
surface tension
The tendency of the surface of a liquid to contract.

 
synchro
The universal term applied to any of the various synchronous devices such as the "selsyn", "autosyn", "motor-torque generator",
"magslip" and "siemens." The standard signal and control synchro today has two-pole single-phase rotor field and a delta or Y-
wound single-phase variable-voltage stator.

 
systematic error
Systematic errors tend to bias all the measurements in one direction. The same error is occurring in measurement after
measurement. Systematic errors can usually be blamed for trends, jumps, or drifts in a reading. They are also called persistent
errors.

T
table
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Collection of data in a form suitable for ready reference, frequently stored in sequential memory locations.
 

table look-up
Obtaining a value from a table of values stored in the computer.

 
tachometer
An instrument for measuring rotational speed in revolutions per minute (rpm).

 
telescope
An instrument for making objects appear nearer and larger. The telescope forms the basis upon which physi-optical instruments
are designed, such as the transit and Theodolite.

 
temperature
The quantitative measure of the relative hotness or coldness of an object.

 
temperature coefficient
A numerical value that indicates the relation between a temperature change and the resulting change in another property. The
numerical value can be either negative or positive.

 
tensile strength
The force required to break a rod or wire of unit cross-sectional area.

 
terminal Linearity
Ratio of the actual error voltage in the output to the total input voltage. This will vary with the setting of the ratio voltage divider.

 
terrestrial
Relating to earthly matters. A terrestrial telescope is one in which the image appears normal, not reversed or inverted.

 
termination
The load connected to the output end of a circuit or transmission line.

 
testing machine
A machine for applying forces to specimens of steel and other material to determine the applied force which the test specimen
will withstand.

 
test instrument
The device which is being compared with the calibration standard. The test instrument is the instrument whose accuracy is being
tested.

 
test set
A combination of instruments needed for making a particular combination of tests, or for servicing a particular type of equipment.

 
Theodolite
An optical instrument used for measuring horizontal or vertical angles.

 
thermal agitation
Random movement of free electrons in a circuit due to the presence of heat.

 
thermal energy
The potential and kinetic energy of the particles of a body which can be evolved as heat.

 
thermal runaway
A result of a regenerative increase in collector current and junction temperature.

 
thermal capacity
The amount of heat required to produce a unit temperature change. Water has the highest thermal capacity of any common
substance.

 
thermistor
A resistor whose value varies with temperature in a definite desired manner, used in circuits to compensate for temperature
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variations in other parts. It may have either a negative or a positive temperature coefficient. One type is made from a
semiconducting material such as uranium oxide or silver sulfide, having a relatively large negative temperature coefficient of
resistance. The name is a contraction of thermal resistor.

 
thermocouple
Two dissimilar metals joined at one end. When a difference of temperature exists between the ends, and EMF is generated
across the thermocouple. This DC voltage is proportional to the heat applied to the thermocouple junction.

 
threshold sensitivity
Refers to the smallest fractional load which will cause a pressure system to indicate that a load is starting to be applied.

 
tilt graticule
A graduate reticule used in Collimators for measuring vertical and horizontal tilt, or angular deviation.

 
time
The period during which an action or process continues; measurement of duration.

 
torque
The cause of rotary motion. Torque is equal to the applied force multiplied by the distance from the center of rotation. (lb/ft, oz/in,
etc..)

 
torque wrench
A wrench with which the mechanic can apply specific amounts of torque, usually as indicated by the setting of the handle.

 
torr
1/760 of an atmosphere - 1 mm Hg.

 
total force
The force acting against the entire area of a particular surface.

 
transient
The instantaneous surge of voltage or current that occurs as the result of a change from one steady-state condition to another.

 
transient vibration
Abrupt changes or shocks in the levels of other motion.

 
transit
Similar to a Theodolite; can only make measurements with the use of accessories. Readings are linear deviation.

 
transmutation
A change in the identity of a nucleus because of a change in its number of protons.

 
transparent
Having the property of transmitting light without appreciable scattering so that bodies lying beyond are entirely visible.

 
trivalent impurity
Any impure atom that has three electrons in its valence band.

 
troubleshoot
To seek the cause of a malfunction or erroneous program behavior in order to remove the malfunction.

 
troubleshooting tree
Flow diagram consisting of tests and measurements used to diagnose and locate faults in a product.

 
tropical year
The time between two successive vernal equinoxes. Our calendar is based on the tropical year. It is equal to 365 days, 5 hours,
48 minutes, and 49.7 seconds.

 
true mass
Mass as measured in a vacuum.
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true value
The value of a physical quantity that would be attributable to a material object or physical system if that value could be
determined without error.

 
twisted pair
A cable composed of two insulated conductors twisted together either with or without a common covering.

U
ultraviolet
A range of invisible radiation frequencies beyond the visible spectrum at the high frequency end, and extending into the region of
low frequency X-rays.

 
uncertainty
A parameter (such as standard deviation), associated with the result of a measurement, that characterizes the dispersion of the
values that could reasonably be attributed to the measurand.

 
unifilar
Having or using one fiber, wire or thread.

 
unit
A value, quantity, or magnitude in terms of which other values, quantities, or magnitudes are expressed. In general, a unit is
fixed by definition and is independent of such physical conditions as temperature. Examples:  yard, pound, gallon, meter, liter,
gram.

V
vacuum
Any pressure below atmospheric. In gage pressure measurement, 5 psig vacuum means 5 psi below atmospheric pressure. In
absolute pressure measurements, any pressure from zero psia (perfect vacuum) up to atmospheric pressure.

 
valence
The number representing the combining or displacing power of an atom; number of electrons lost, gained, or shared by an atom
in a compound; the number of hydrogen atoms with which an atom will combine, or the number it will displace.

 
valence band
The outermost orbit of an atom that will contain electrons at absolute zero.

 
valence electrons
Electrons which are gained, lost, or shared in chemical reactions.

 
vaporization
The production of a vapor or gas from matter in another physical state.

 
velocity
The time rate of change of position.

 
velocity constant
The ratio of the velocity of propagation in a transmission line to the velocity of light.

 
vernal (spring) equinox
First day of spring in the northern hemisphere. It usually falls on March 21st in the northern hemisphere. There are about 12
hours of light and 12 hours of darkness every place on the Earth during an equinox.

 
vernier
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An auxiliary scale made to work in conjunction with the divisions of a graduated instrument for indicating parts of a division.
 

vertically polarized wave
An electromagnetic wave in which the electric field (E) is perpendicular to the horizon and the magnetic field (H) is horizontal
(parallel to the Earth's surface).

 
vertical
Perpendicular to the horizontal plane. The direction of gravity.

 
vertical axis
The axis about which the telescope rotates when sweeping a horizontal plane.

 
vibration
Mechanical oscillations or motion about a reference point or equilibrium.

 
virtual image
The impression of an object as viewed by the observer. Light rays do not pass through, but only appear to come from the image.

 
viscosity
The internal friction of a fluid. Also a quantitative measure of a fluid's lubricity.

 
VLSI
Very Large Scale Integration.

 
volatile
Readily vaporizable at a relatively low temperature.

 
volume
The amount of space which matter occupies.

W
wave front
A surface composed at any instant of all the points just reached by a vibrational disturbance in its propagation through a
medium.

 
wedge
A weak prism, used when very small deviations of a beam are required. The wedge is also used in conjunction with penta and
other prisms for corrective purposes.

 
weight
The force of gravity acting on an object.

 
winter solstice
Shortest day of the year. It usually falls on December 21st in the northern hemisphere. The sun casts its longest shadows in the
winter solstice.

 
work
That which is accomplished when a force acts on matter and moves it. (ft/lb, in/oz, etc...)

X
 

Y
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Z
zenith
The point of the celestial sphere that is directly opposite the nadir and vertically above the observer.
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